
Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

In deze gids worden de configuratie en het gebruik beschreven van de Interchangeable Lens Digital Camera ILME-FR7 /
ILME-FR7K.

Raadpleeg deze handleiding en de gebruiksaanwijzingen van bijbehorende apparaten voor zover nodig.

Overzicht

Gebruikelijke toepassingen

Systeemconfiguratie

Een enkel apparaat bedienen met de meegeleverde infraroodafstandsbediening

Een enkel apparaat bedienen met een tablet of computer

Een enkel apparaat bedienen met een externe afstandsbediening

Meerdere apparaten bedienen met een externe afstandsbediening

Plaats en functie van onderdelen

Vooraanzicht

Achteraanzicht

Aansluitblok

Zijaanzicht

Bovenaanzicht

Onderaanzicht

Objectiefsteun

Locatie en functie van onderdelen van de infraroodafstandsbediening (meegeleverd)

Webapp-scherm

Overzicht van het webapp-scherm

De structuur van het gemeenschappelijke deel van de schermen

De structuur van het live-bedieningsscherm

De structuur van het afspeel-bedieningsscherm

De structuur van het instellingenvenster
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Voorbereiding

Het cameramenu

Het cameraschermbeeld

Het apparaat monteren

Rechtop monteren op een vaste locatie

Rechtop monteren op een hoge vaste locatie

Montage op een plafond

Een objectief bevestigen/verwijderen

Voorzorgen bij het bevestigen/verwijderen van een objectief

De objectiefschakelaars controleren

Voorzorgen bij gebruik van een zoomobjectief

Een objectief bevestigen

Een objectief verwijderen

Kabels aansluiten

Het apparaat aansluiten op een netwerkapparaat via een kabel

Een voeding aansluiten

Netstroom gebruiken

PoE++-voeding gebruiken

De zwenk-/kantelfunctie terugstellen

Configureren vóór filmen

Het apparaat initialiseren met de webapp

De webapp openen vanuit een webbrowser

Het apparaat initialiseren

Basisbediening configureren

Geheugenkaarten voorbereiden

Ondersteunde geheugenkaarten

Geheugenkaarten plaatsen

Een geheugenkaart uitwerpen
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Filmen

Geheugenkaarten formatteren (initialiseren)

De resterende opnametijd controleren

Geheugenkaarten herstellen

Basisbediening

Starten en stoppen met opnemen

Overschakelen tussen geheugenkaarten

De audio controleren

Tijdgegevens instellen

Een opname controleren (Rec Review)

De kadrering aanpassen

Het aanpassingsscherm voor kadrering

De opnamerichting aanpassen

De richting van filmen aanpassen met de webapp

De bedieningssnelheid voor zwenken/kantelen instellen

De bedieningsversnelling voor zwenken/kantelen instellen

De richting van filmen aanpassen met de meegeleverde infraroodafstandsbediening

De Zoom aanpassen

Het type zoom instellen

De zoom aanpassen met de webapp

De bedieningssnelheid voor zoom instellen

De zoom aanpassen met de meegeleverde infraroodafstandsbediening

De zwenk-/kantel-/zoompositie (voorkeurspositie) opslaan/herstellen

Een objectief met E-bevestiging kalibreren

Zwenken/kantelen, zoompositie en scherpstellingsinstelling opslaan/herstellen met de webapp

Voorkeursposities hernoemen met de webapp

Een opgeslagen voorkeurspositie vervangen door een nieuwe positie met de webapp

Een opgeslagen voorkeurspositie wissen met de webapp

Zwenken/kantelen en zoomen/scherpstellen synchroniseren bij het herstellen van een voorkeurspositie
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De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie

Zwenken/kantelen en zoompositie opslaan/herstellen met de meegeleverde infraroodafstandsbediening

Camera-kadreringshandelingen (PTZ-tracering) opnemen/afspelen

Camera-kadreringshandelingen opnemen met de webapp

Camera-kadreringshandelingen afspelen met de webapp

Opgenomen camera-kadreringshandelingen verwijderen met de webapp

Camera-kadreringshandelingen opnemen met de meegeleverde infraroodafstandsbediening

Camera-kadreringshandelingen afspelen met de meegeleverde infraroodafstandsbediening

De scherpstelling aanpassen

Het aanpassingsscherm voor scherpstelling

De scherpstelling handmatig aanpassen (Manual Focus)

Handmatig aanpassen met de webapp

Handmatig aanpassen met de meegeleverde infraroodafstandsbediening

Scherpstellen door een scherpstelpositie op te geven ("Spot Focus")

Automatische scherpstelling tijdelijk gebruiken (Push Auto Focus (AF))

Eenmalig automatische scherpstelling gebruiken (Push Auto Focus (AF-S))

De scherpstelling automatisch aanpassen (Autofocus)

Automatisch aanpassen met de webapp

Automatisch aanpassen met de meegeleverde infraroodafstandsbediening

Het gebied of de positie van automatische scherpstelling instellen (Focus Area)

Het scherpstellingsgebied snel wijzigen (Focus Setting)

Het scherpstelkader verplaatsen met aanraakbediening (scherpstellingsgebied)

De automatische scherpstelactie aanpassen (AF-overgangssnelheid, AF-gevoeligheid onderwerpverplaatsing)

Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp

Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde infraroodafstandsbediening

Handmatige scherpstelling tijdelijk gebruiken tijdens automatische scherpstelmodus (Push Manual Focus)

Volgen met behulp van gezichts-/ogendetectie (Face/Eye Detection AF)

Een bepaald onderwerp volgen (AF-volgen in echttijd)

De helderheid aanpassen
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Handige functies

Het aanpassingsscherm voor helderheid

De basisgevoeligheid instellen

Het doelniveau voor automatische helderheidsaanpassing instellen

Het diafragma aanpassen

Het diafragma automatisch aanpassen

Het diafragma handmatig aanpassen

De versterking aanpassen

De versterking automatisch aanpassen

De versterking handmatig aanpassen

De sluiter aanpassen

De sluitertijd automatisch aanpassen

De sluitertijd handmatig aanpassen

Het lichtniveau aanpassen (ND-Filter)

Het ND-filter

Aanpassen in voorkeuzemodus

Automatisch aanpassen in variabele modus

Handmatig aanpassen in variabele modus

Aanpassing voor natuurlijke kleuren (witbalans)

Scherm bij witbalansaanpassing

De witbalans automatisch aanpassen

De witbalans handmatig aanpassen

Automatische witbalans uitvoeren

De audio voor opname configureren

Het audioconfiguratiescherm

Het audio-invoerapparaat selecteren

Het audio-opnameniveau automatisch aanpassen

Het audio-opnameniveau handmatig aanpassen

Handelingen directmenu
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Toewijsbare knoppen

Slow & Quick Motion

Intervalopname (Interval Rec)

Beelden in cache opnemen (Picture Cache Rec)

Opnemen op geheugenkaart A en B tegelijkertijd (2-slot Simul Rec)

Videosignaalmonitor

Clipvlaggen

Ademcompensatie

Proxy-opname

Overzicht van proxy-opname

Een proxy opnemen

Filmen met het gewenste uiterlijk

Overzicht van uiterlijk

Een uiterlijk selecteren

Een gewenst basisuiterlijk importeren

Een uiterlijk aanpassen

Een uiterlijk opslaan

Een basisuiterlijk verwijderen

Filmen met uiterlijkaanpassing in postproductie

Filmen met uiterlijkaanpassing in postproductie

Een LUT toepassen op HDMI-uitvoer en streamen

Een LUT wijzigen

De verdeling van donkere en lichte gebieden in het opgenomen beeld wijzigen

RAW-opname

RAW video opnemen

RAW-video opnemen in de modus Slow & Quick Motion

Bokeh aanpassen (functie Bokeh Control)

De functie Bokeh Control in-uitschakelen
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Netwerkfuncties

Pictogrammenscherm

Het cameramenu en gedetailleerde instellingen

Het bokeh-niveau aanpassen

Configuratiegegevens opslaan en laden

Overzicht van configuratiegegevens opslaan en laden

Een ALL-bestand opslaan

Een ALL-bestand laden

Bestanden overdragen

Bestanden overbrengen

Een doel voor bestandsoverdracht registreren

Een bestand selecteren en uploaden

Proxy-bestanden op een geheugenkaart vanaf het pictogrammenscherm uploaden

Originele bestanden op een geheugenkaart vanaf het pictogrammenscherm uploaden

De status van de bestandsoverdracht controleren

Uploaden met veilige FTP

Streamen configureren

Over streamen

De streamindeling instellen

De video-codec voor streamen instellen

De audio-codec voor streamen instellen

Starten en stoppen met streamen

Pictogrammenscherm

Clips afspelen en andere clipacties

Opgenomen clips afspelen

Acties op opgenomen clips

Het cameramenu configureren

Het cameramenu gebruiken

Het cameramenu gebruiken
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Een reeks tekens invoeren

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menu Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look Menu

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Zwenken/kantelen

P/T Acceleration

TC/Media Menu

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menu Audio
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Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer

Menu Maintenance

Language

Clock Set

Hours Meter

Instellingen en standaardwaarden menu Shooting

ISO/Gain-instellingen en -standaardwaarden
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Het webmenu en gedetailleerde instellingen

AGC Limit-instellingen en -standaardwaarden

Beeldkwaliteitsinstellingen opgeslagen voor elke opnamemodus

Configuratie van het webmenu

Bediening van het webmenu

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Menu

Base Look

Menu Zwenken/kantelen

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio

Audio Input

11



Audio Output

Menu Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 t/m 3

SSL

Referer Check

Brute Force Attack Protection

Menu Streamen

Stream

Video Stream

Audio Stream

Menu Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Aansluiting met een extern apparaat

Appendix

Service

EULA

Software

Externe monitors en opname-apparaten aansluiten

Een RCP/MSU (optioneel) aansluiten

Verbinding maken met een RCP/MSU

Eén-op-éénverbinding tussen het apparaat en een RCP

Het apparaat gebruiken in een multicameraomgeving met een MSU/camera-afstandsbedieningssoftware

Lijst met ondersteunde functies

Bediening met een afstandsbediening RM-IP500 (optioneel)

Bediening met een afstandsbediening RM-IP500 (optioneel)

Verbinding maken met een afstandsbediening RM-IP500

Synchroniseren met een extern apparaat

Synchroniseren met een extern apparaat

De fase van het videosignaal synchroniseren (Genlock)

De tijdcode met die van andere apparaten vergrendelen

Een externe microfoon of extern geluidsapparaat aansluiten

Clips beheren/bewerken met behulp van een computer

Een glasvezelsignaal uitvoeren

Een tallysignaal aansluiten

Volggegevens uitvoeren (free-d)

Een objectiefcontroller aansluiten

De zoom aanpassen met een objectiefcontroller

Voorzorgsmaatregelen voor gebruik

Uitvoerindelingen en beperkingen

Problemen oplossen

Fout-/waarschuwingsmeldingen
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Lijst met menu-onderdelen

Opgeslagen onderdelen in voorkeuzes

Blokschema's

De software van een objectief met E-bevestiging bijwerken

De afdekking voor de objectiefvrijgaveknop bevestigen

Licenties

Specificaties

Merken
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Systeemconfiguratie

Dit apparaat kan worden gecombineerd met randapparatuur en zo verschillende configuraties vormen.

Objectief met E-bevestiging1.

A-bevestigingsadapter LA-EA3/LA-EA42.

Infraroodafstandsbediening (meegeleverd)3.

Geheugenkaarten CFexpress Type A / SDXC4.

Kaartlezer CFexpress Type A / SD5.

Microfoon ECM-680S, ECM-678*, ECM-674*6.
EC-0.5X3F5M 3 pins → 5 pins-XLR-adapterkabel is vereist.*

Netadapter (meegeleverd)7.

Videomonitor8.

Afstandsbediening RM-IP5009.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een enkel apparaat bedienen met de meegeleverde infraroodafstandsbediening

U kunt een enkel apparaat op afstand bedienen met de meegeleverde infraroodafstandsbediening.

 Videosignaal
 Signaalstroom

5-041-957-73(1) Copyright 2022 Sony Corporation

Infraroodafstandsbediening (meegeleverd)1.

Videomonitor2.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een enkel apparaat bedienen met een tablet of computer

U kunt een tablet of computer aansluiten op het apparaat en dan het apparaat bedienen vanuit een webbrowser.

 Videosignaal
 Afstandsbedieningssignaal

  Signaalstroom

5-041-957-73(1) Copyright 2022 Sony Corporation

Videomonitor1.

Tablet2.

Computer3.

Toegangspunt4.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een enkel apparaat bedienen met een externe afstandsbediening

U kunt een enkel apparaat op afstand bedienen met een afstandsbediening.

 Videosignaal
 Afstandsbedieningssignaal

  Signaalstroom

5-041-957-73(1) Copyright 2022 Sony Corporation

Videomonitor1.

Afstandsbediening RM-IP5002.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Meerdere apparaten bedienen met een externe afstandsbediening

U kunt tot 100 apparaten op afstand bedienen met een enkele afstandsbediening.

 Videosignaal
 Afstandsbedieningssignaal
 Tally-/contactsignaal

  Signaalstroom

5-041-957-73(1) Copyright 2022 Sony Corporation

Videomonitor1.

Videoschakelaar2.

Ethernethub3.

Afstandsbediening RM-IP5004.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vooraanzicht

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op de voorkant van het apparaat.

Hint

In deze beschrijving wordt verwezen naar de illustratie van het apparaat zonder bevestigd objectief.

Camerakop

Opmerking

Stel de camera niet bloot aan harde schokken.

1.

Opname-/tallylampje
Wanneer de lamp is geconfigureerd als opnamelampje, gaat hij rood branden wanneer u opneemt naar een
geheugenkaart. De lamp knippert wanneer de resterende ruimte op het opslagmedium krap wordt of als er een fout
optreedt.

2.
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Voor nadere informatie raadpleegt u "Fout-/waarschuwingsmeldingen".

Wanneer de lamp is geconfigureerd als tallylampje, gaat hij rood of groen branden, afhankelijk van het externe
tallysignaal.

Voor nadere informatie raadpleegt u "Een tallysignaal aansluiten".
Beeldsensor

Opmerking

Niet direct met uw handen aanraken.

3.

Vrijgaveknop objectief
Druk hier om het objectief te verwijderen.

Voor nadere informatie raadpleegt u "Een objectief verwijderen".

4.

Signaalcontacten objectief

Opmerking

Niet direct met uw handen aanraken.

5.

POWER-lampje6.

NETWORK-lampje
De status van het apparaat wordt aangegeven door de combinatie van kleur en status (brandend, knipperend of uit)
van de lampjes POWER en NETWORK.

7.

POWER-
lampje

NETWORK-
lampje Status van apparaat

Groen
brandend*1

Groen
brandend

Ingeschakeld (netwerk verbonden)

Uit Ingeschakeld (netwerk niet verbonden)

Groen
knipperend

Uit Opstartprocedure is bezig

Oranje
brandend

Uit Stand-bystand

Geel
knipperend

Uit Software wordt bijgewerkt

Langzaam
oranje
knipperend*2

Langzaam
groen
knipperend*2

Het apparaat kan niet normaal werken. Voor nadere informatie raadpleegt u
het systeemlogboek. Als het probleem blijft bestaan, zelfs nadat u het
apparaat in stand-bymodus heeft geplaatst of het apparaat uit- en weer
ingeschakeld hebt, neemt u contact op met uw Sony
servicevertegenwoordiger.

Snel oranje
knipperend*3

Snel groen
knipperend*3

Er is een fout opgetreden in het apparaat. Neem contact op uw Sony
servicevertegenwoordiger.

 Knippert groen als er een opdracht wordt ontvangen van de meegeleverde infraroodafstandsbediening.*1

 Langzaam knipperend: eenmaal per seconde knipperend*2

 Snel knipperend: viermaal per seconde knipperend*3
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Verwant onderwerp

Fout-/waarschuwingsmeldingen

Een tallysignaal aansluiten

Een objectief verwijderen

5-041-957-73(1) Copyright 2022 Sony Corporation

Sensor infraroodafstandsbediening
Ontvangt het bedieningssignaal van de meegeleverde infraroodafstandsbediening.

8.

Luchtinlaat

Opmerking

Blokkeer de luchtstroom niet. Dit kan een storing tot gevolg hebben.

9.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Achteraanzicht

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op de achterkant van het apparaat.

Verwant onderwerp

Zijaanzicht

5-041-957-73(1) Copyright 2022 Sony Corporation

Vergrendelingsbeugel camerakop
Vergrendelt de beweging naar voor/achter van de camerakop.

Opmerking

Stel altijd in op vergrendelingspositie wanneer u het objectief niet vervangt.

Verwijder altijd het objectief en stel de vergrendelingspositie in wanneer u het apparaat vervoert.

Schakel het apparaat uit en vergrendel de camerakop horizontaal met de zwenk-/kantelvergrendeling voordat u de
vergrendelingsbeugel bedient om te voorkomen dat u uw vingers beknelt. Voor nadere informatie over de
zwenk-/kantelvergrendeling raadpleegt u "Zwenk-/kantelvergrendeling" bij "Zijaanzicht".

1.

Schuifvoet2.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aansluitblok

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op het aansluitblok van het apparaat.

 aardaansluiting
Sluit deze aan op de aarde door haar te verbinden met een aardaansluiting van een stopcontact of een
aardingsstaaf.

1.

DC IN-aansluiting (standaard gelijkstroomstekker)
Sluit een netadapter aan.

Opmerking

Gebruik geen andere netadapter dan de meegeleverde. Het aansluiten van een andere netadapter kan brand of een defect
veroorzaken.

2.

 LAN- (netwerk-) aansluiting (RJ-45)
Sluit een netwerkkabel aan (categorie 5e of hoger) voor netwerkcommunicatie en PoE++-voeding*.

Weergavestatus snelheids-led
Geeft de snelheid weer van de netwerkaansluiting.

3.

PoE++: Power Over Ethernet Plus Plus. Voldoet aan IEEE802.3bt (type 4 klasse 8). Voor nadere informatie over het aansluiten raadpleegt u
de gebruiksaanwijzing van de voeding.

*
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Weergavestatus Link-/ACT-led
Geeft de status weer van de netwerkaansluiting.

Opmerking

Wanneer u dit product aansluit op het internet, maak dan verbinding via een systeem dat beveiliging biedt, zoals een router of
firewall. Als u verbinding maakt zonder dergelijke bescherming kunnen beveiligingsproblemen ontstaan.

Weergave  Verbindingssnelheid

Uit
10 Mbps-verbinding

100 Mbps-verbinding

Oranje brandend 1000 Mbps-verbinding

Weergave  Verbindingsstatus

 Uit Geen verbinding

Groen knipperend Verbinding tot stand gebracht, gegevens actief

Groen brandend Actieve verbinding

TC IN-aansluiting
Sluit een extern referentie-tijdcodesignaal aan.

Voor nadere informatie raadpleegt u "De tijdcode met die van andere apparaten vergrendelen".

4.

HDMI-aansluiting
Hier wordt de video vanaf het apparaat uitgevoerd als HDMI-signaal.

Voor nadere informatie raadpleegt u "HDMI-aansluiting (aansluiting type A)" onder "Externe monitors en opname-
apparaten aansluiten".

5.

Bevestigingsschroef HDMI-kabelbevestigingsplaat
Om te voorkomen dat de HDMI-kabel wordt losgetrokken, bevestigt u de meegeleverde HDMI-kabelbevestigingsplaat
met de meegeleverde bevestigingsschroef (M2.6×6) en bevestigt u de HDMI-kabel met een in de handel verkrijgbare
kabelbinder of -band.

Voor nadere informatie over het bevestigen van de HDMI-kabelbevestigingsplaat raadpleegt u "Kabels
aansluiten".

6.

OPTION-aansluiting
Gebruik dit om een tallysignaal aan te sluiten vanaf een extern apparaat of objectiefcontroller.

Voor nadere informatie raadpleegt u "Een tallysignaal aansluiten" en "Een objectiefcontroller aansluiten".

7.

Kabelklem
Hiermee zet u de netadapterkabel vast.

8.

RESET-schakelaar
Houd deze ten minste 5 seconden ingedrukt met de punt van een pen of iets dergelijks om de instellingen van het
apparaat terug te stellen naar de fabrieksinstellingen.
Met de schakelaar SETUP 1 kunt u kiezen of u alleen de netwerkinstellingen wilt terugstellen of alle instellingen.

9.

Uitgang OPTICAL10.
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Hier wordt een SDI-signaal uitgevoerd dat is geconverteerd naar optische indeling wanneer een SFP+-module
(optioneel) is aangesloten.

Voor nadere informatie raadpleegt u "Een glasvezelsignaal uitvoeren".
SETUP-schakelaars

Hiermee configureert u de volgende instellingen.
Schakelaar 1: stelt in welke instellingen worden teruggesteld wanneer u de RESET-schakelaar indrukt.

Schakelaar 2: stelt in of de +48 V-voeding (phantomvoeding) wordt in- of uitgeschakeld wanneer u een
geluidsinvoerapparaat aansluit. De instelling wordt onmiddellijk toegepast.
Deze functie is ingeschakeld wanneer [Audio] > [Audio Input] > [AUDIO IN Select] is ingesteld op [MIC] in het
cameramenu.

Opmerking

Wanneer u schakelaar 2 in de stand ON zet en een microfoon aansluit die niet compatibel is met +48 V kan het aangesloten
apparaat beschadigd raken. Controleer de instelling, alvorens het apparaat aan te sluiten.

Schakelaar 3: schakelt VISCA over IP-communicatie in en uit. De instellingen worden toegepast wanneer u de
camera inschakelt.
Kies de stand ON wanneer u het apparaat aansluit op een afstandsbediening (RM-IP500).

Opmerking

Als het beheerderswachtwoord niet is geconfigureerd, is VISCA over IP-communicatie uitgeschakeld, ongeacht de instelling
van de schakelaar. Voor nadere informatie over het configureren van het beheerderswachtwoord raadpleegt u "Het apparaat

11.

Instelling Beschrijving

OFF
(standaard)

Alleen de netwerkinstellingen worden teruggesteld. De netwerkinstellingen,
beveiligingsinstellingen en gebruikersgegevens (gebruikersnaam en wachtwoord) van het
apparaat worden teruggesteld.

ON Alle instellingen worden teruggesteld naar de fabrieksinstellingen.

Instelling Beschrijving

OFF
(standaard)

Geen +48 V-voeding (phantomvoeding). Configureer deze instelling wanneer u een extern
geluidsapparaat (zoals een mixer), een dynamische microfoon of een microfoon met ingebouwde
batterij gebruikt.

ON
Er wordt +48 V-voeding (phantomvoeding) geleverd voor een met phantomstroom compatibele
microfoon die is aangesloten op de AUDIO IN-aansluiting (CH-1 of CH-2).

Instelling Beschrijving

OFF (standaard) Reageert niet op VISCA over IP-opdrachten.

ON Accepteert VISCA over IP-opdrachten.
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Verwant onderwerp

De tijdcode met die van andere apparaten vergrendelen

Externe monitors en opname-apparaten aansluiten

Kabels aansluiten

Een tallysignaal aansluiten

Een objectiefcontroller aansluiten

Een glasvezelsignaal uitvoeren

Het apparaat initialiseren

De fase van het videosignaal synchroniseren (Genlock)

Een externe microfoon of extern geluidsapparaat aansluiten
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initialiseren".

Schakelaar 4: wijzigt de snelheid van zwenk-/kantelacties die worden verzonden vanaf de
infraroodafstandsbediening. De instelling wordt onmiddellijk toegepast.

Instelling Beschrijving

OFF (standaard) Werkt op normale snelheid.

ON Werkt op maximale snelheid.

SDI OUT-aansluiting
Hier wordt de video vanaf het apparaat uitgevoerd als 12G/6G/3G/HD-SDI-signaal.
Het apparaat kan ook worden geconfigureerd voor invoer van RAW-signalen.

Voor nadere informatie raadpleegt u "SDI OUT-aansluiting (BNC type)" onder "Externe monitors en opname-
apparaten aansluiten".

12.

 Sensor infraroodafstandsbediening (achter)
Infraroodsensor voor de meegeleverde infraroodafstandsbediening.

13.

Ventilatie-/luchtuitlaat
Hier kan warmte het apparaat verlaten.

Opmerking

Bedek de luchtuitlaat niet. Dit kan een storing tot gevolg hebben.

De omgeving van de luchtuitlaat kan heet worden.

14.

GENLOCK-aansluiting
Gebruik deze om een extern synchronisatiesignaal in te voeren.

Voor nadere informatie raadpleegt u "De fase van het videosignaal synchroniseren (Genlock)".

15.

AUDIO IN-aansluiting (XLR-type, 5 pins)
Gebruik deze om het signaal in te voeren van een externe microfoon of geluidsapparaat.
Deze functioneert als een AUDIO IN CH-1-aansluiting of AUDIO IN CH-2-aansluiting.

Voor nadere informatie raadpleegt u "Een externe microfoon of extern geluidsapparaat aansluiten".

16.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zijaanzicht

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op de zijkant van het apparaat.

Hint

In deze beschrijving wordt verwezen naar de illustratie van het apparaat zonder bevestigd objectief.

Zwenk-/kantelvergrendeling
Hiermee vergrendelt u de zwenk-/kantelfunctie van het apparaat. Gebruik dit in de volgende gevallen.

Wanneer u het apparaat vervoert of verpakt.
Wanneer u een objectief bevestigt of verwijdert. Voor nadere informatie raadpleegt u "Een objectief bevestigen" of
"Een objectief verwijderen".
Wanneer u een objectief gebruikt dat zwenken en kantelen niet ondersteunt (zoals de Sony-objectieven
SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).
Verwijder altijd het objectief en stel de vergrendelingspositie in wanneer u het apparaat vervoert.

1.
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Verwant onderwerp

Een objectief bevestigen

Een objectief verwijderen

Geheugenkaarten plaatsen

De webapp openen vanuit een webbrowser
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Hint

De zwenk-/kantelfunctie kan worden vastgezet in de volgende hoeken.

Schuifvoet2.

Schroefgaten voor externe apparaten (4 posities)
Voor M3-schroeven tot 6 mm lang.

Opmerking

Gebruik geen schroeven langer dan 6 mm. Dit kan een storing tot gevolg hebben.

3.

Toegangsindicator A4.

Toegangsindicator B
De indicator brandt of knippert wanneer u een opnamemedium plaatst.

Voor nadere informatie raadpleegt u "Geheugenkaarten plaatsen".

5.

Kaartsleuf CFexpress Type A / SD (A)6.

Kaartsleuf CFexpress Type A / SD (B)
Gebruik deze om opslagmedia te plaatsen.

Voor nadere informatie raadpleegt u "Geheugenkaarten plaatsen".

7.

QR-code voor netwerkverbinding
Gebruik deze om de begininstellingen te configureren.

Voor nadere informatie raadpleegt u "De webapp openen vanuit een webbrowser".

8.

30



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bovenaanzicht

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op de bovenkant van het apparaat.

Hint

In deze beschrijving wordt verwezen naar de illustratie van het apparaat zonder bevestigd objectief.

5-041-957-73(1) Copyright 2022 Sony Corporation

Schroefgaten voor externe apparaten (2 posities)
Compatibel met 1/4-20 UNC-schroeven voor een statief.
Maximale lengte 6 mm.

1.

ɸ (beeldsensor-markering)
De beeldsensor-markering zit op dezelfde hoogte als de beeldsensor.
Gebruik deze markering als referentiepunt om de afstand tussen het apparaat en het onderwerp nauwkeurig te
meten.

2.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Onderaanzicht

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen op de onderkant van het apparaat.

Hint

In deze beschrijving wordt verwezen naar de illustratie van het apparaat zonder bevestigd objectief.

Schroefgaten voor de montage van de plafondbeugel (6 posities, 5,5 mm (7/32 inch) effectieve draaddiepte)
Wanneer u het apparaat hoog op een plafond of plank monteert, bevestigt u de behuizingsbeugel (optioneel) op de
onderkant van het apparaat met behulp van de zes behuizingsbeugel-bevestigingsschroeven in deze schroefgaten.

Voor nadere informatie over montage raadpleegt u "Rechtop monteren op een hoge vaste locatie" en "Montage
op een plafond".

1.

Montageschroeven voor statief (2 posities)
Deze gebruikt u om het apparaat op een camerastatief te bevestigen (optioneel, 1/4-20 UNC-schroeven tot 5,5 mm
(7/32 inch) lang).

2.
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Verwant onderwerp

Rechtop monteren op een hoge vaste locatie

Montage op een plafond
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Opmerking

Gebruik geen schroeven langer dan 5,5 mm (7/32 inch). Dit kan een storing tot gevolg hebben.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objectiefsteun

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen van de objectiefsteun van het apparaat.

Hint

In deze beschrijving wordt verwezen naar de illustratie van het apparaat zonder bevestigd objectief.

Objectiefsteunstaaf (2)
Ondersteunt het objectief.
Kan ook worden gebruikt om algemene staafhulpstukken Ø15 te bevestigen.

1.
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Objectiefsteuneenheid
De objectiefsteun kan naar voren en achteren worden geschoven, afhankelijk van het objectief, en dan vastgezet.

2.

Bevestigingsschroef objectiefsteunvoet
Bevestig deze op de objectiefsteunvoet. U kunt de schroef omhoog/omlaag verplaatsen zodat hij past bij de hoogte
van de objectiefsteunvoet.

3.

Objectiefsteun-penklemhendel (2 posities)
Zet de voorwaartse/achterwaartse positie van het objectief vast.

4.

Klemhendel bevestigingsschroef objectiefsteunvoet
Zet de verticale positie van de bevestigingsschroef van de objectiefsteunvoet vast.

Hint

Als de klemhendel in een stand staat waarbij hij moeilijk draaibaar is, maak dan de klemhendel los en draai hem naar een
stand die makkelijker te gebruiken is. Wanneer de gewenste stand is bereikt, sluit u de klemhendel.

A: klemhendel bevestigingsschroef objectiefsteunvoet
B: pen klemhendel objectiefsteun

Opmerking

Om te voorkomen dat de objectiefsteunvoet het zwenken/kantelen hindert, verplaatst u de objectiefsteuneenheid naar boven
tegen de camerakop wanneer u de objectiefsteuneenheid niet gebruikt en verplaatst u de bevestigingsschroef van de
objectiefsteunvoet naar de hoogste stand (dichtstbij het objectief).

5.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Locatie en functie van onderdelen van de infraroodafstandsbediening (meegeleverd)

In dit onderwerp worden de locatie en de functie beschreven van de onderdelen van de infraroodafstandsbediening
(meegeleverd).

Knop REC● (opname START/STOP)
Druk hierop om de opname te starten of te stoppen.

1.

Knop MENU
Druk hierop om het cameramenu weer te geven of te verbergen.

2.

GUI-bedieningsknoppen
Gebruik deze om handelingen uit te voeren in het cameramenu, in dialoogvensters met knoppen en andere
schermfuncties.

3.

Knop CANC./BACK4.
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Batterij infraroodafstandsbediening

Er gaan twee AA- (LR6) -batterijen in de infraroodafstandsbediening.
Plaats de batterijen in de infraroodafstandsbediening zoals weergegeven in de volgende afbeelding.

Druk hierop om een instelling te annuleren of om terug te keren naar het vorige scherm van het cameramenu van het
apparaat.
Kantel- en zwenkknoppen
Druk op de pijlknoppen om de camera te kantelen en te zwenken. Druk op de knop HOME om de camera terug te
brengen naar recht vooruit.

5.

Voorkeuzeknoppen voor posities
Houd de knop PRESET ingedrukt en druk op een van de knoppen 1 t/m 3 om de richtings-, zoom- en
scherpstelstatus van de camera op te slaan onder de ingedrukte cijfertoets.
Druk op een cijfertoets met opgeslagen instellingen om de opgeslagen status op te roepen.

6.

Bedieningsknoppen voor scherpstelling
Hiermee past u de scherpstelling aan.
Wilt u automatisch scherpstellen, druk dan op de knop AF.
Wilt u handmatig scherpstellen, druk dan op de knop MF en druk vervolgens op ofwel de knop F (Far, ver weg) om
scherp te stellen op ver verwijderde onderwerpen of op de knop N (Near, dichtbij) om scherp te stellen op
onderwerpen dichtbij.

7.

Toewijsbare knoppen 1 t/m 3
Voert de functies uit die zijn toegewezen aan de toewijsbare knoppen met het cameramenu.
Als u de functie [Direct Menu] toewijst aan een toewijsbare knop, kunt u belichting, witbalans en andere instellingen
aanpassen met de GUI-bedieningsknoppen.

Voor nadere informatie over het toewijzen met het cameramenu raadpleegt u "Toewijsbare knoppen".

Voor nadere informatie over het rechtstreekse menu raadpleegt u "Handelingen directmenu".

8.

 Aan-uitknop
Hiermee schakelt u het apparaat in of schakelt u de voeding naar stand-bystand.

9.

Knop THUMBNAIL
Geeft het pictogrammenscherm weer met de fragmenten die zijn opgenomen op de geheugenkaart van het apparaat.

Voor nadere informatie over het pictogrammenscherm raadpleegt u "Pictogrammenscherm".

U kunt clips selecteren en afspelen op het pictogrammenscherm met de GUI-bedieningsknoppen.

Voor nadere informatie over het selecteren van clips en afspelen raadpleegt u "Opgenomen clips afspelen" en
"Acties op opgenomen clips".

10.

Knop SLOT SEL (selectie geheugenkaartsleuf (A)/(B))
Wanneer u twee geheugenkaarten hebt geplaatst, drukt u op deze knop om het opnemen te schakelen tussen de
geheugenkaarten.
Druk op deze knop wanneer het pictogrammenscherm wordt weergegeven om te schakelen tussen de
geheugenkaarten die u wilt bekijken.

11.

Knop P/T RESET (zwenken/kantelen terugstellen)
Hiermee stelt u het zwenken/kantelen terug. Druk op de knop wanneer de lampjes POWER en NETWORK
tegelijkertijd knipperen of wanneer de knop [Execute Pan-Tilt Reset] wordt weergegeven in het kadrerings-
bedieningspaneel van de webapp.

12.

Zoom-bedieningsknoppen
Als u wilt inzoomen, drukt u op de toets T (Tele).
Als u wilt uitzoomen, drukt u op de toets W (Wide, breedbeeld).

13.
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Opmerking

Gebruik geen andere batterijen dan mangaan- of alkalinebatterijen omdat ze kunnen scheuren.

Voer batterijen af volgens de wet- en regelgeving van uw land of regio.

Verwant onderwerp

Toewijsbare knoppen

Handelingen directmenu

Pictogrammenscherm

Opgenomen clips afspelen

Acties op opgenomen clips

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Overzicht van het webapp-scherm

Wanneer u een tablet of computer aansluit, kunt u zwenken/kantelen, zoomen, opnemen, opgenomen video afspelen en
het apparaat configureren vanuit een webbrowser (in het vervolg wordt deze functie de "webapp" genoemd).

Voor nadere informatie over het starten van de webapp raadpleegt u "De webapp openen vanuit een webbrowser".

Opmerking

De webapp ondersteunt geen audio-uitvoer van de camera.

Wanneer de webapp start, verschijnt het volgende live-bedieningsscherm.

Live-bedieningsscherm

Voor informatie over het live-bedieningsscherm raadpleegt u "De structuur van het live-bedieningsscherm".
De knoppen en pictogrammen die overeenkomen tussen het live-bedieningsscherm en het afspeel-
bedieningsscherm worden bovenaan het venster weergegeven.

Voor nadere informatie over het gemeenschappelijke deel van het bedieningsscherm raadpleegt u "De structuur van
het gemeenschappelijke deel van de schermen".
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U kunt tussen de schermen schakelen door op de schermtabbladen te drukken in het gemeenschappelijke deel.

Afspeel-bedieningsscherm

Druk op het tabblad [Playback] om het afspeel-bedieningsscherm weer te geven.

Voor informatie over het afspeel-bedieningsscherm raadpleegt u "De structuur van het afspeel-bedieningsscherm".

Instellingenvenster

Druk op het tabblad [Settings] om het instellingenvenster weer te geven (dit wordt in het vervolg het "webmenu"
genoemd).
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Opmerking

In het webmenu worden instellingen pas toegepast als u op de knop [OK] drukt. Als u instellingen wijzigt op een pagina met een
knop [OK], vergeet dan niet op de knop [OK] te drukken.

Voor nadere informatie over het instellingenvenster raadpleegt u "De structuur van het instellingenvenster".
In deze Help-gids wordt het instellingenvenster van de webapp "webmenu" genoemd.

Verwant onderwerp
De webapp openen vanuit een webbrowser

De structuur van het live-bedieningsscherm

De structuur van het gemeenschappelijke deel van de schermen

De structuur van het afspeel-bedieningsscherm

De structuur van het instellingenvenster

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De structuur van het gemeenschappelijke deel van de schermen

In dit onderwerp wordt de structuur van het gemeenschappelijke deel van de schermen beschreven.

Cameranaam
Geeft de naam van de camera weer.
U kunt de naam wijzigen met [Network] > [Camera Name] in het webmenu.
De achtergrondkleur wijzigt in overeenstemming met het externe tallysignaal.

1.

Aan-uitschakelaar
Wanneer het apparaat is ingeschakeld, wordt [Power ON] weergegeven. U kunt op de schakelaar drukken en [Power
Standby] selecteren om de voeding van het apparaat in stand-bystand te zetten.
Wanneer [Power Standby] wordt weergegeven, kunt op de schakelaar drukken en [Power ON] selecteren om de
voeding van het apparaat in te schakelen.

2.

Schakeltabbladen van het bedieningsscherm
Druk op een tabblad om het bijbehorende bedieningsscherm weer te geven.
Tabblad [Live]: geeft het live-bedieningsscherm weer.
Tabblad [Playback]: geeft het afspeel-bedieningsscherm weer.
Tabblad [Settings]: geeft het instellingenvenster (webmenu) weer.

3.

Markering voor meldingen
Wanneer er een melding binnenkomt, verandert de markering zoals hieronder weergegeven.

 (Meldingen aan)
Voer de noodzakelijke handeling uit volgens de melding die wordt weergegeven in het camerabeeldpaneel.

Opmerking

Meldingen worden niet weergegeven als [Monitoring] > [Output Display] > [HDMI/Stream] is ingesteld op [Off] in het
webmenu. Stel dit in op [On] om de inhoud van meldingen te kunnen lezen.

4.

Knop  (Camerastatus)
Druk op deze knop om informatie over het opgeslagen camerabeeld / het beelduitvoersignaal, informatie over het
objectief en de status van de objectiefcontroller (optioneel) weer te geven in een apart venster.

5.
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Wanneer een melding verschijnt die te maken heeft met de objectiefcontroller (optioneel), wijzigt de indicatie als
hieronder weergegeven.

Schermvergrendelingsschakelaar
 (Bediening ontgrendeld): zet de schakelaar in de linkerpositie om acties in het live-bedieningsscherm en het

afspeel-bedieningsscherm uit te kunnen voeren.
 (Bediening vergrendeld): zet de schakelaar in de rechterpositie om acties in het live-bedieningsscherm en het

afspeel-bedieningsscherm te vergrendelen. Zo voorkomt u per ongeluk bedienen.

6.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De structuur van het live-bedieningsscherm

In dit onderwerp wordt de structuur van het live-bedieningsscherm beschreven.

Bedieningspaneel voor voorkeuzeposities
Geeft de vastgelegde positie van een voorkeuze aan door middel van een pictogram. Dubbeltik op het pictogram om
terug te keren naar de positie die in de voorkeuze is opgeslagen.

Voor nadere informatie over de voorkeuzepositie raadpleegt u "Zwenken/kantelen, zoompositie en
scherpstellingsinstelling opslaan/herstellen met de webapp".
Voor nadere informatie over PTZ-tracering raadpleegt u "Camera-kadreringshandelingen opnemen met de
webapp".

1.

Camerabeeldpaneel
Geeft het huidige camerabeeld en de status van het apparaat weer.
Dit geeft hetzelfde beeld weer als de HDMI-uitvoer.
De volgende status wordt boven het beeld weergegeven. Een rood of groen kader wordt bovendien rond het beeld
weergegeven, afhankelijk van het ontvangen externe tallysignaal.

2.
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Knop [Display]
Druk op deze knop als u cameragegevens wilt weergeven op het beeld.
Druk nogmaals terwijl de cameragegevens worden weergegeven om de cameragegevens te verbergen.

Naast markeringen worden enkele indicatoren en meldingen weergegeven over automatische scherpstelling,
afhankelijk van de status. Deze kunnen niet worden verborgen door op de knop [Display] te drukken.

Voor nadere informatie over de weergegeven cameragegevens raadpleegt u "Het cameraschermbeeld".

Knop Stop AF-volgen in echttijd
Druk op deze knop om te stoppen met het volgen van een onderwerp.

Nr. Weergave Beschrijving

2-
1

Indicator scherpstelmodus Zie "De indicator scherpstelmodus" in "Het cameraschermbeeld".

2-
2

Opnamemodus, sleuf A/B,
Interval Rec opname-
intervalindicator

Raadpleeg "Opnamemodus, sleuf A/B, Interval Rec opname-
intervalindicator" in "Het cameraschermbeeld".

2-
3

Indicator stream-status
Wordt weergegeven tijdens streamen (alleen wanneer [Stream Setting] is
ingesteld op [RTMP] of [SRT-Caller]).

2-
4

Statusindicator voor RAW-uitvoer Geeft de uitvoerstatus van het RAW-signaal weer. Voor nadere
informatie over RAW raadpleegt u "RAW video opnemen".

2-
5

Indicator resterende
mediacapaciteit

Zie "Indicator resterende mediumcapaciteit" in "Het
cameraschermbeeld".

2-
6

Indicator zoompositie

Zie "Indicator zoompositie" in "Het cameraschermbeeld".
Wanneer een objectiefcontroller (optioneel) is aangesloten, wordt 
weergegeven. Als er een fout optreedt in de objectiefcontroller
(optioneel), wordt  weergegeven.

2-
7

Indicator AE-modus/AE-niveau Zie "Indicator AE-modus/AE-niveau" in "Het cameraschermbeeld".
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Voor nadere informatie raadpleegt u "Een bepaald onderwerp volgen (AF-volgen in echttijd)".
Knop Record START/STOP
Druk op deze knop om de opname te starten. Tijdens de opname brandt de knop Record START/STOP rood.
Druk tijdens een opname om de opname te stoppen.
U kunt de schakelaar HOLD in de stand Hold zetten om per ongeluk bedienen van de knop Record START/STOP te
voorkomen.

3.

Deelvenster Basisconfiguratie van de camera
Hier vindt u instellingen voor basisfuncties die vereist zijn voor opnames op knoppen. Druk op een knop om het
bijbehorende instelscherm weer te geven voor de diverse functies in het aanpassingspaneel voor basisconfiguratie
van de camera hieronder (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Voor nadere informatie raadpleegt u de beschrijvingen van de diverse functies.

4.

Functie Verwijzing

FPS "Slow & Quick Motion"

ISO/Gain
"De basisgevoeligheid instellen", "De versterking automatisch aanpassen" en "De versterking
handmatig aanpassen" bij "De versterking aanpassen"

Exposure
Index

"De basisgevoeligheid instellen" en "De verdeling van donkere en lichte gebieden in het
opgenomen beeld wijzigen"

Shutter
"De sluitertijd automatisch aanpassen" en "De versterking handmatig aanpassen" bij "De
versterking aanpassen"

Iris
"Het diafragma automatisch aanpassen" en "Het diafragma handmatig aanpassen" bij "Het
diafragma aanpassen"

ND Filter "Het ND-filter" bij "Het lichtniveau aanpassen (ND-Filter)".

Scene File "Overzicht van uiterlijk" en andere onderwerpen bij "Filmen met het gewenste uiterlijk"

Base
Look/LUT

"Filmen met uiterlijkaanpassing in postproductie"
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Functie Verwijzing

White
Balance

"Scherm bij witbalansaanpassing"

Aanpasbare knoppen / aanpassingspaneel voor basisconfiguratie van de camera
Geeft toewijsbare knoppen weer tijdens normaal gebruik. Druk op de knoppen van het basisconfiguratiepaneel
(onderdeel 4) van de camera om de bijbehorende instellingen weer te geven. Druk op de knop [X] of druk nogmaals
op de knop Camera-instellingspaneel om terug te gaan naar de weergave van de toewijsbare knoppen.

Voor nadere informatie over toewijsbare knoppen raadpleegt u "Toewijsbare knoppen".
Voor nadere informatie over het aanpassingspaneel voor basisconfiguratie van de camera raadpleegt u de
beschrijvingen van de diverse functies.

5.

Kadrerings-bedieningspaneel / GUI-bedieningspaneel
Schakelt tussen het kadrerings-bedieningspaneel en het GUI-bedieningspaneel met de tabbladen bovenaan.
U kunt op de knop  (Sluiten) rechtsboven in het scherm drukken om het bedieningspaneel te verbergen en
onbedoelde bediening te voorkomen. Als het bedieningspaneel niet wordt weergegeven, druk dan op de knop 
(Openen) om het weer te geven.
Gebruik het kadrerings-bedieningspaneel om het kader aan te passen. Druk op het tabblad  (Zwenken-
kantelen-zoomen) om het kadrerings-bedieningspaneel weer te geven.

Voor nadere informatie over het gebruik raadpleegt u "De kadrering aanpassen".

Hint

Het joystickdeel van het kadrerings-bedieningspaneel wordt weergegeven zoals hieronder wanneer zwenken/kantelen is
uitgeschakeld en wanneer zwenken/kantelen moet worden geïnitialiseerd.

Wanneer zwenken/kantelen is vergrendeld met de zwenk-/kantelvergrendeling

6.
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Wanneer zwenken/kantelen niet is geïnitialiseerd

Wanneer zwenken/kantelen moet worden teruggesteld

Wanneer zwenken/kantelen is uitgeschakeld

Wanneer het gebruik van zwenken/kantelen niet is geïnitialiseerd of moet worden teruggesteld, kunt u snel naar de knop
 (Zwenken/kantelen terugstellen) gaan in het camerabedieningspaneel door op de melding te drukken die onder de

joystick wordt weergegeven.

Gebruik het GUI-bedieningspaneel om het cameramenu, het afspelen van clips en andere functies te bedienen. Druk
op het tabblad  (GUI camcorder) om het GUI-bedieningsblok weer te geven.

Voor nadere informatie over de bediening raadpleegt u "Het cameramenu gebruiken" en "Opgenomen clips
afspelen".

Camera-bedieningspaneel
Gebruik dit om functies te configureren die vereist zijn voor het bedienen van de camera.

7.
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Schakel tussen de vensters die u wilt weergeven met de tabbladen bovenaan.
U kunt op de knop  (Sluiten) rechtsboven in het scherm drukken om het bedieningspaneel te verbergen en
onbedoelde bediening te voorkomen. Als het bedieningspaneel niet wordt weergegeven, druk dan op de knop 
(Openen) om het weer te geven.

Voor nadere informatie raadpleegt u de beschrijvingen van de diverse functies.

Tabblad  (Main)
Geeft de instellingen weer voor vaak gebruikte functies.
De functies van de bovenste en onderste schuifbalk kunnen worden aangepast door op de knop [▼] te drukken en te
kiezen uit de lijst die wordt weergegeven. De volgende functies kunnen worden geselecteerd.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Tabblad  (Focus)
Geeft de instellingen weer rond scherpstelling.

 Wordt weergegeven afhankelijk van de menu-instellingen.*
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Tabblad  (Audio)

Geeft de instellingen weer rond audio.

Tabblad  (Stream)
Geeft de instellingen weer rond streaming.
De weergegeven onderdelen hangen af van de ingestelde indeling voor streamen.
Wanneer dit is ingesteld op [RTMP] of [SRT-Caller], kunt u het streamen starten en stoppen op dit scherm.

Voor nadere informatie raadpleegt u "Over streamen" en andere onderwerpen bij "Streamen configureren".
Wanneer er een verbindingsfout optreedt, wordt een foutmelding weergegeven. Voor nadere informatie over de
foutmelding raadpleegt u "Fout-/waarschuwingsmeldingen".

Tabblad  (Others)
Geeft de instellingen weer rond andere functies.
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Verwant onderwerp

Zwenken/kantelen, zoompositie en scherpstellingsinstelling opslaan/herstellen met de webapp

Camera-kadreringshandelingen opnemen met de webapp

Het cameraschermbeeld

RAW video opnemen

Een bepaald onderwerp volgen (AF-volgen in echttijd)

Slow & Quick Motion

De basisgevoeligheid instellen

De versterking automatisch aanpassen

De versterking handmatig aanpassen

De verdeling van donkere en lichte gebieden in het opgenomen beeld wijzigen

De sluitertijd automatisch aanpassen

De sluitertijd handmatig aanpassen

Het diafragma automatisch aanpassen

Het diafragma handmatig aanpassen

Het ND-filter

Overzicht van uiterlijk

Filmen met uiterlijkaanpassing in postproductie

Scherm bij witbalansaanpassing

Toewijsbare knoppen

Opgenomen clips afspelen

Het cameramenu gebruiken

Over streamen

Wanneer u op [Full Screen Display] drukt, verschijnt een nieuw tabblad in de webbrowser. Het beeld van het
camerabeeldpaneel wordt weergegeven op volledig scherm.
Alleen het beeld wordt weergegeven; AF door aanraken en andere functies zijn niet beschikbaar.

Opmerking

Het live-bedieningsscherm op het oorspronkelijke tabblad blijft functioneren. Wanneer u dit tabblad niet nodig hebt voor
bediening, kunt u het beste dit tabblad sluiten om het aantal gelijktijdige verbindingen te verminderen.

Druk op de knop  (Objectiefcontroller initialiseren) om de objectiefcontroller (derden-optie) te
initialiseren. Deze knop is alleen ingeschakeld als [Technical] > [Lens Controller] > [Zoom] > [Setting] is ingesteld op
[On] in het webmenu.
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Fout-/waarschuwingsmeldingen

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De structuur van het afspeel-bedieningsscherm

In dit onderwerp wordt de structuur van het afspeel-bedieningsscherm beschreven.

Camerabeeldpaneel
Geeft het afspeelbeeld en verwante gegevens weer. Wanneer het afspelen stopt, verschijnt het camerabeeldscherm.

1.
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1-1 Opnamedatum en -tijd
1-2 Indicator afspeelstatus
1-3 Indicator afspeelindeling (beeldgrootte)
1-4 Indicator afspeelindeling (codec)
1-5 Weergave clipnaam
1-6 Clipnummer / totaal aantal clips
1-7 Weergave LUT-naam
1-8 Indicator streamstatus
1-9 Indicator afspeelindeling (beeldsnelheid en scanmethode)
1-10 Indicator opname-uiterlijk

Afspeel-bedieningspaneel

Geeft de afspeelknoppen weer.

Knop [Display]
Druk hierop om te wisselen tussen de schermweergave op het beeld.
Knop [Thumbnail]
Hiermee geeft u de clips die zijn opgenomen op de geheugenkaart weer als pictogrammen in het
camerabeeldpaneel.

2.

Knop Functie

Knop  (Afspelen/pauze) Hiermee speelt u een clip af. Tijdens het afspelen pauzeert u hiermee de
clip.

Knop  (Snel vooruit), knop 
(Snel achteruit)

Speelt clips af op hoge snelheid. Wanneer u op deze knop drukt,
verandert de afspeelsnelheid in drie stappen.

Knop  (Volgende), knop 
(Vorige)

Springt naar het begin van de clip of de vorige/volgende clip.

Knop  (Stop) Hiermee stopt u het afspelen.
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Verwant onderwerp

Pictogrammenscherm

Toewijsbare knoppen

Opgenomen clips afspelen

5-041-957-73(1) Copyright 2022 Sony Corporation

Wanneer u op de knop [Thumbnail] drukt, sluit het pictogrammenscherm weer en gaat u terug naar het camerabeeld.

Voor nadere informatie over het pictogrammenscherm raadpleegt u "Pictogrammenscherm".

Knop [Slot Select]
Hiermee schakelt u tussen de doelafspeelmedia.

Toewijsbare knoppen
Hiermee geeft u de toewijsbare knoppen weer waaraan functies van het apparaat zijn toegewezen.

Voor nadere informatie over toewijsbare knoppen raadpleegt u "Toewijsbare knoppen".

3.

GUI-bedieningspaneel
Gebruik het GUI-bedieningspaneel om het cameramenu, het afspelen van clips en andere functies te bedienen.

Voor nadere informatie over de bediening raadpleegt u "Het cameramenu gebruiken" en "Opgenomen clips
afspelen".

4.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De structuur van het instellingenvenster

Gebruik het instellingenvenster om met het webmenu de verschillende instellingen van het apparaat te configureren,
zoals de begininstellingen, netwerkinstellingen en film-/afspeelinstellingen.

Opmerking

In het webmenu worden over het algemeen instellingen pas toegepast als u op de knop [OK] drukt. Als u instellingen wijzigt op
een pagina met een knop [OK], vergeet dan niet op de knop [OK] te drukken.

Voor nadere informatie over het instellingenvenster raadpleegt u "Het webmenu en gedetailleerde instellingen".

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Het cameramenu

Druk op de knop [Menu] in het GUI-bedieningspaneel van het live-bedieningsscherm of het afspeel-bedieningsscherm
om het cameramenu weer te geven in het camerabeeldpaneel.

U kunt de instellingen configureren die vereist zijn voor filmen en afspelen met het cameramenu.
Druk op de knop [Menu] terwijl het cameramenu wordt weergegeven om het cameramenu te verbergen.
U bedient het cameramenu met het GUI-bedieningspaneel.

Voor nadere informatie over het cameramenu raadpleegt u "Het cameramenu en gedetailleerde instellingen".

Opmerking

Wanneer [Monitoring] > [Output Display] > [HDMI/Stream] is ingesteld op Off in het webmenu (schakelt het weergeven van
informatie op de schermweergave uit), wordt het cameramenu niet meer weergegeven in het camerabeeldpaneel. Let er echter
op dat menu-acties in het GUI-bedieningspaneel nog steeds actief zijn. Om onbedoelde handelingen te voorkomen, let u erop dat
u geen menu-acties uitvoert met het GUI-bedieningspaneel wanneer [HDMI/Stream] is ingesteld op Off.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Het cameraschermbeeld

U kunt de status en instellingen van het apparaat weergeven bovenop het uitvoerbeeld van de camera. U kunt de
uitgangen waarvoor schermweergave wordt ingeschakeld instellen met [Monitoring] > [Output Display] in het webmenu.
U kunt de informatie weergeven/verbergen met de knop [Display]. Zelfs als het is verborgen, verschijnt deze bij het
uitvoeren van handelingen in het rechtstreekse menu.
U kunt onderdelen individueel weergeven/verbergen met [Monitoring] > [Display On/Off] in het cameramenu.

Informatie die wordt weergegeven op het scherm tijdens filmen

Indicator upload/resterende bestanden

Voor nadere informatie over het overdragen van bestanden raadpleegt u "Bestanden overbrengen" en andere
onderwerpen bij "Bestanden overdragen".

1.

Indicator scherpstellingsgebied
Geeft het scherpstellingsgebied voor automatische scherpstelling weer.

Voor nadere informatie over automatisch scherpstellen raadpleegt u "Automatisch aanpassen met de webapp" en
andere onderwerpen bij "De scherpstelling automatisch aanpassen (Autofocus)".

2.

Opnamemodus, sleuf A/B, Interval Rec opname-intervalindicator

Voor nadere informatie over intervalopname raadpleegt u "Intervalopname (Interval Rec)".

3.

Weergave Betekenis

●Rec Opnemen

Stby Opnemen stand-by

Indicator scherptediepte4.

58



Indicator scanmodus beeldsensor
De markering  (Verkeerde combinatie) wordt weergegeven als zich een verkeerde combinatie voordoet tussen de
beeldcirkelomvang van het objectief en de effectieve scanmodusinstelling van de beeldgrootte van de beeldsensor.
Als Imager Scan Mode is ingesteld op FF, wordt een "C"-markering weergegeven in modi met smallere hoek of
beeldweergave (bijgesneden).
Bijsnijden vindt plaats in de volgende modi.

Wanneer de opname-indeling 3840×2160 is en de beeldsnelheid voor S&Q Motion 100 fps of 120 fps is
Wanneer [Codec] is ingesteld op RAW of RAW & XAVC-I en de RAW-uitvoerindeling 3840×2160 is
Voor nadere informatie over de scanmodus van de beeldsensor raadpleegt u "De scanmodus van de beeldsensor
instellen" in "Basisbediening configureren".

5.

Statusindicator voor RAW-uitvoer
Geeft de uitvoerstatus van het RAW-signaal weer.

Voor nadere informatie over RAW raadpleegt u "RAW video opnemen".

6.

Beeldsnelheidindicator voor filmen met Slow & Quick Motion

Voor nadere informatie over Slow & Quick Motion raadpleegt u "Slow & Quick Motion".

7.

Indicator scherpstelpositie

Geeft het scherpstelpositie weer.

8.

Indicator scherpstelmodus

Gezichts-/ogendetectie AF

Voor nadere informatie over gezichts-/ogendetectie AF raadpleegt u "Volgen met behulp van
gezichts-/ogendetectie (Face/Eye Detection AF)".

9.

Weergave Betekenis

Focus Hold Focus Hold-modus

MF MF-modus

AF AF-modus

 (Modus AF-volgen in echttijd) Modus AF-volgen in echttijd

Weergave Betekenis

 (Gezichts-/ogendetectie AF) Geeft aan dat gezichts-/ogendetectie AF actief is

 (Alleen gezicht/ogen AF) Geeft aan dat alleen gezichts-/ogendetectie AF actief is

 (Opgeslagen gezicht voor volgen) Geeft aan dat een gezicht is opgeslagen voor volgen

 (AF gepauzeerd) Geeft aan dat AF is gepauzeerd*

Wordt weergegeven als er geen gezicht is opgeslagen voor volgen en er geen gezicht is gedetecteerd, of als er een gezicht is opgeslagen
voor volgen maar het gezicht voor volgen niet is gedetecteerd.

*

Indicator zoompositie
Geeft de zoompositie weer binnen het bereik van 0 (brede hoek) tot 99 (telefoto) (als er een objectief is bevestigd dat
weergave van de zoompositie ondersteunt).

10.
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U kunt de indicator ook wijzigen in een staafweergave of brandpuntsafstandweergave met de instelling [Technical] >
[Lens] > [Zoom Position Display] in het cameramenu.
De volgende onderdelen worden aan het display toegevoegd als Clear Image Zoom is ingeschakeld.

Voor nadere informatie over zoomen raadpleegt u "Het type zoom instellen" en andere onderwerpen bij "De Zoom
aanpassen".

Weergave Betekenis

 (Clear Image Zoom is ingeschakeld) Clear Image Zoom is ingeschakeld

Vergrotingswaarde Bij gebruik van Clear Image Zoom

Indicator beeldstabilisatiemodus11.

Indicator status opnameregeling SDI-uitvoer/HDMI-uitvoer
Geeft de uitvoerstatus van het REC besturingssignaal weer.

Voor nadere informatie raadpleegt u "Externe monitors en opname-apparaten aansluiten".

12.

Indicator scherpstelling

Voor nadere informatie raadpleegt u "Eenmalig automatische scherpstelling gebruiken (Push Auto Focus (AF-S))"
bij "De scherpstelling aanpassen".

13.

Indicator resterende mediacapaciteit
Het pictogram  (Beveiligd) verschijnt als de geheugenkaart tegen schrijven beveiligd is.

14.

Indicator witbalansmodus15.

Weergave Betekenis

 (ATW) Automodus

 (ATW Hold) Automodus gepauzeerd

W:P Voorkeuzemodus

W:A Modus geheugen A

Indicator externe vergrendeling tijdcode/weergave tijd en datum
Geeft "EXT-LK" aan bij vergrendeling aan de tijdcode van een extern apparaat.

Voor nadere informatie over tijdcodes raadpleegt u "Tijdgegevens instellen".

16.

Indicator ND filter

Voor nadere informatie over ND-filters raadpleegt u "Het lichtniveau aanpassen (ND-Filter)".
Voor nadere informatie over bokeh-regeling raadpleegt u "Bokeh aanpassen (functie Bokeh Control)".

17.

Weergave Betekenis

 (A) Automodus

 (B) Modus Bokeh-regeling

Indicator scenebestand18.
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Voor nadere informatie over scenebestanden raadpleegt u "Overzicht van uiterlijk" en andere onderwerpen bij
"Filmen met het gewenste uiterlijk".

Indicator diafragma
Geeft de diafragmapositie (F-waarde) weer (als er een objectief is bevestigd dat weergave van de diafragma-
instelling ondersteunt).

Voor nadere informatie over het diafragma raadpleegt u "Het diafragma automatisch aanpassen" en "Het
diafragma handmatig aanpassen".

19.

Indicator waarschuwing videoniveau20.

Versterkingsindicator
Geeft de EI-waarde weer in Cine EI- / Cine EI Quick-modus.

Voor nadere informatie over de versterking raadpleegt u "De versterking automatisch aanpassen" en "De
versterking handmatig aanpassen".
Voor nadere informatie over de modus Cine EI- / Cine EI Quick raadpleegt u "De opnamemodus instellen" in
"Basisbediening configureren".

21.

Weergave Betekenis

 (A) Automodus

L Preset L-modus

 (Tijdelijke aanpassingsmodus) Tijdelijke aanpassingsmodus

 (B) Modus Bokeh-regeling

Weergave clipnaam
Geeft de naam weer van de clip die wordt opgenomen of gaat worden opgenomen.
Als dit knippert, is er een verkeerde combinatie tussen de laatste clip op het opnamemedium en de instellingen voor
[Camera ID] of [Reel Number]. Voor nadere informatie raadpleegt u de beschrijving [Clip Name Format] > [Auto
Naming].

22.

Sluiterindicator

Voor nadere informatie over de sluitertijd raadpleegt u "De sluitertijd automatisch aanpassen" en "De sluitertijd
handmatig aanpassen".

23.

Indicator AE-modus/AE-niveau

Voor nadere informatie over automatische belichting (AE) raadpleegt u "Het doelniveau voor automatische
helderheidsaanpassing instellen".

24.

Waterpasindicator
Geeft het horizontale niveau weer in stappen van ±1° tot en met ±15°.

25.

Audioniveaumeter
Geeft het audioniveau van de diverse kanalen weer.

26.

Videosignaalmonitor
Geeft een golfvorm, vectorscoop en histogram weer.
De oranje lijn geeft de ingestelde waarde van de helderheidsniveaumarkering weer.
In logboek-opnamemodi wordt het monitor-doel-LUT-type boven de weergave weergegeven.

Voor nadere informatie raadpleegt u "Videosignaalmonitor".

27.
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Informatie die wordt weergegeven op het scherm tijdens afspelen

De volgende informatie wordt geprojecteerd op het afspeelbeeld.

Voor nadere informatie over de logboek-opnamemodi raadpleegt u "De opnamemodus instellen" in
"Basisbediening configureren".

Indicator Base Sensitivity / indicator Base ISO
In de modus Custom geeft dit de basisgevoeligheid weer die is ingesteld met de knop [ISO/Gain / Exposure Index] in
het paneel Basisconfiguratie van de camera of [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] in het cameramenu.
In logboek-opnamemodi geeft dit de Base ISO-gevoeligheid weer die is ingesteld met de knop [ISO/Gain / Exposure
Index] in het paneel Basisconfiguratie van de camera of [Shooting] > [ISO/Gain/EI] > [Base ISO] in het cameramenu.

Voor nadere informatie over de basisgevoeligheid raadpleegt u "De basisgevoeligheid selecteren".
Voor nadere informatie over de logboek-opnamemodi raadpleegt u "De opnamemodus instellen" in
"Basisbediening configureren".

28.

Indicator Monitoring-uiterlijk
In logboek-opnamemodi geeft dit de monitor-LUT-instelling weer.

Voor nadere informatie over de LUT-instelling raadpleegt u "Filmen met uiterlijkaanpassing in postproductie" en
aanverwante onderwerpen.
Voor nadere informatie over de logboek-opnamemodi raadpleegt u "De opnamemodus instellen" in
"Basisbediening configureren".

29.

Indicator Basisuiterlijk/opname-uiterlijk
Geeft de instelling voor basisuiterlijk weer.
In logboek-opnamemodi geeft dit het videosignaal weer dat wordt opgenomen op de geheugenkaarten.

Voor nadere informatie over het basisuiterlijk raadpleegt u "Overzicht van uiterlijk" bij "Filmen met het gewenste
uiterlijk".
Voor nadere informatie over de logboek-opnamemodi raadpleegt u "De opnamemodus instellen" in
"Basisbediening configureren".

30.

Indicator proxy-status31.

Indicator opname-indeling (codec)
Geeft de naam weer van de opname-indeling op de geheugenkaarten.
Stel de opname-indeling (codec) in met [Project] > [Rec Format] > [Codec] in het webmenu of het cameramenu.

32.

Indicator opname-indeling (beeldsnelheid en scanmethode)33.

Indicator opname-indeling (beeldgrootte)
Geeft de beeldgrootte weer voor opname op de geheugenkaarten.
Stel de opname-indeling (beeldgrootte) in met [Project] > [Rec Format] > [Codec] in het webmenu of het
cameramenu.

34.

Tally-indicator
Geeft een rood of groen kader weer rond het beeld, afhankelijk van het ontvangen externe tallysignaal.

35.
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Verwant onderwerp

Bestanden overbrengen

Automatisch aanpassen met de webapp

Intervalopname (Interval Rec)

Basisbediening configureren

RAW video opnemen

Slow & Quick Motion

Indicator upload/resterende bestanden1.

Clip-nummer2.

Indicator afspeelstatus3.

Indicator afspeelindeling (beeldsnelheid en scanmethode)4.

Indicator afspeelindeling (beeldgrootte)5.

Indicator afspeelindeling (codec)6.

Mediaindicator
Het pictogram  (Beveiligd) verschijnt als de geheugenkaart tegen schrijven beveiligd is.

7.

Weergave tijd/datum8.

Weergave clipnaam9.

Indicator gammaweergave-assistent10.

Audioniveaumeter
Geeft het audio-afspeelniveau weer.

11.

Indicator Basisuiterlijk/opname-uiterlijk12.

Tally-indicator13.
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Volgen met behulp van gezichts-/ogendetectie (Face/Eye Detection AF)

Het type zoom instellen

Externe monitors en opname-apparaten aansluiten

Eenmalig automatische scherpstelling gebruiken (Push Auto Focus (AF-S))

Tijdgegevens instellen

Overzicht van uiterlijk

Het diafragma automatisch aanpassen

Het diafragma handmatig aanpassen

De versterking automatisch aanpassen

De versterking handmatig aanpassen

De sluitertijd automatisch aanpassen

De sluitertijd handmatig aanpassen

Het doelniveau voor automatische helderheidsaanpassing instellen

Videosignaalmonitor

Filmen met uiterlijkaanpassing in postproductie

Clip Name Format

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rechtop monteren op een vaste locatie

In dit onderwerp wordt beschreven hoe u het apparaat op een bureau of statief monteert.

Opmerking over installatie
Om het objectief en het objectiefbevestigingsblok van het apparaat te beschermen, verwijdert u het kap en de dop
van het apparaat niet terwijl u het objectief bevestigt.
Om defecten van het objectief te voorkomen, houdt u onderdelen van het objectief niet vast tijdens het werken.
Om defecten van het apparaat te voorkomen, houdt u de camerakop niet vast tijdens het werken.

Controleer of er voldoende ruimte is voor de montage.

Bij montage op een bureau
Monteer dit apparaat op een vlak oppervlak en houd rekening met de vereiste ruimte om het objectief te kunnen
draaien en voor de bekabeling op de achterkant van het apparaat.

Opmerking

Monteer het op een stabiele plek die niet onderhevig is aan trillingen. Locaties met trillingen kunnen trilling in het beeld
veroorzaken.

Als u het apparaat op een schuin oppervlak moet monteren, blijf dan binnen ±15° van het horizontale vlak en tref
maatregelen om te voorkomen dat het apparaat valt.

Bij montage op een statief
Bevestig het statief op het statiefmontageschroefgat op de onderkant.
Gebruik een statiefmontageschroef met de volgende mate van uitsteken buiten het montageoppervlak en zet hem
vast met een handschroevendraaier.

A: statiefmontageschroeven 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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Bevestig vervolgens het objectief. Raadpleegt u "Een objectief bevestigen" waarbij u rekening houdt met de informatie bij
"Voorzorgen bij het bevestigen/verwijderen van een objectief", "De objectiefschakelaars controleren" en "Voorzorgen bij
gebruik van een zoomobjectief".

Verwant onderwerp

Voorzorgen bij het bevestigen/verwijderen van een objectief

De objectiefschakelaars controleren

Voorzorgen bij gebruik van een zoomobjectief

Een objectief bevestigen

5-041-957-73(1) Copyright 2022 Sony Corporation

B: uitstekend deel (4,5 mm tot 5,5 mm)

Gebruik geen statiefschroeven om het apparaat op een hoge plek te monteren.

Opmerking

Kies een statief dat niet kan vallen, zelfs niet als u het objectief draait.
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rechtop monteren op een hoge vaste locatie

In dit onderwerp wordt de werkwijze beschreven voor het rechtop monteren van het apparaat met de plafondbeugel
(CIB-PCM1, optioneel).

Wilt u het apparaat op een hoge plek monteren, laat dit dan door een professionele aannemer doen.
Bij het monteren op een hoge plek controleert u altijd of het montageoppervlak en het montagemateriaal (exclusief
accessoires) 200 kg (440 lb 15 oz) of meer kunnen dragen. Monteer het apparaat zoals beschreven in deze Help-
gids. Als de montage niet stevig genoeg is, kan het apparaat vallen en ernstig letsel veroorzaken.
Bevestig de meegeleverde valpreventiedraad om te voorkomen dat de plafondbeugel CIB-PCM1 (optioneel) van het
apparaat kan vallen.
Wanneer het apparaat op een hoge plek is gemonteerd, controleer dan eenmaal per jaar of de montage nog goed
vast zit. Verkort de controletermijn als de gebruiksomstandigheden dat vereisen.

Opmerking over installatie
Om het objectief en het objectiefbevestigingsblok van het apparaat te beschermen, verwijdert u het objectief en de
kap en dop van het apparaat niet totdat het objectief is bevestigd.
Om defecten van het objectief te voorkomen, houdt u onderdelen van het objectief niet vast tijdens het werken.
Om defecten van het apparaat te voorkomen, houdt u de camerakop niet vast tijdens het werken.

Controleer de accessoires voor hoge montage en de montageruimte.

Plafondbeugel CIB-PCM1 (optioneel)
Voordat u begint, controleert u of u de volgende onderdelen hebt.

Hoofdbeugel (1)
Plafondbeugel (1)
Dop voor objectiefvrijgaveknop (1)
Valpreventiedraad (1)
+Schroeven PSW M3×8 (9)
+Roestvrij stalen schroef PSW M4×8 voor valpreventiedraad (1)

1
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Opmerking

De valpreventiedraad is bedoeld om het apparaat te dragen wanneer dit wordt opgehangen. Hang niets anders eraan dan
het gewicht van het apparaat.

Montageruimte
Raadpleeg de volgende tekening bij het kiezen van de montageplek en -richting en houd rekening met de vereiste
ruimte om het objectief te kunnen draaien en voor de bekabeling op de achterkant van het apparaat.

A: bewegingsruimte van de camerakop (bijv. SEL70200GM2 (met SEL20TC bevestigd): Ø370)
B: Plafondbeugel (gat aan montageoppervlakzijde) (Ø150)
C: Montage-uitlijngat

Opmerking

Monteer het op een stabiele plek die niet onderhevig is aan trillingen. Locaties met trillingen kunnen trilling in het beeld
veroorzaken.

Als u het apparaat op een schuin oppervlak moet monteren, blijf dan binnen ±15° van het horizontale vlak en tref
maatregelen om te voorkomen dat het apparaat valt.

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

2
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Opmerking

Als de zwenk-/kantelfunctie van de camerakop niet is vergrendeld wanneer de grendel in de stand LOCK staat, beweeg de
camerakop dan met de hand totdat hij ingrendelt.

Bevestig de hoofdbeugel op de onderkant van het apparaat met behulp van de zes meegeleverde
schroeven (M3×8).

3
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Gebruik de meegeleverde schroeven. Gebruik van andere schroeven dan de meegeleverde kan schade aan het
binnenste van het apparaat veroorzaken.

Bevestig de valpreventiedraad aan de hoofdbeugel.4
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A: meegeleverde draad　
B: meegeleverde kruiskopschroef (M4×8)
C: metalen lus voor draad

Gebruik de meegeleverde schroef. Gebruik van andere schroeven dan de meegeleverde kan de effectiviteit van de
valpreventiedraad verminderen.

Bevestig de plafondbeugel op het oppervlak, zoals een plank, waar u het apparaat wilt monteren.5
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A: muur　
B: △-markering (markering voor voorkant camera)
C: gat voor verbindingskabels
D: plank of ander montageoppervlak

Bevestig de valpreventiedraad aan een punt vlakbij het montageoppervlak.

Gebruik een inbusschroef M5 (3/16 inch) (optioneel) en bevestig deze op een object dichtbij de plank of het
oppervlak waarop de plafondbeugel is gemonteerd.

6
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A: draad　
B: inbusschroef (M5, 3/16 inch)

Lijn het schroefgat 〇 voorop de hoofdbeugel uit op het gat ◇ van de plafondbeugel, steek het apparaat in
en zet de hoofdbeugel tijdelijk vast in de plafondbeugel door het apparaat rechtsom te draaien.

7
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A: gat 〇
B: gat ◇

Zet de hoofdbeugel en plafondbeugel vast met de drie meegeleverde draaivergrendelingsschroeven (M3×8).8
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Bevestig vervolgens het objectief. Raadpleegt u "Een objectief bevestigen" waarbij u rekening houdt met de informatie bij
"Voorzorgen bij het bevestigen/verwijderen van een objectief", "De objectiefschakelaars controleren" en "Voorzorgen bij
gebruik van een zoomobjectief".

Opmerking

Nadat u een objectief hebt bevestigd, controleert u of dit goed vastzit.
Het objectief is niet beschermd tegen vallen. Sony aanvaardt geen aansprakelijkheid als een objectief van het apparaat valt.

Verwant onderwerp

Voorzorgen bij het bevestigen/verwijderen van een objectief

De objectiefschakelaars controleren

Voorzorgen bij gebruik van een zoomobjectief

Een objectief bevestigen

Controleer de montage.

Controleer met name de volgende punten. 

De montageschroeven zitten correct vast.
De valpreventiedraad is correct bevestigd en niet gedraaid.
Het apparaat is horizontaal gemonteerd (niet gekanteld of wiebelend).
Het apparaat kan niet vrij ronddraaien.

9
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montage op een plafond

In dit onderwerp wordt de werkwijze beschreven voor het monteren van het apparaat op een plafond met de
plafondbeugel (CIB-PCM1, optioneel).

Wilt u het apparaat op een plafond monteren, laat dit dan door een professionele aannemer doen.
Bij het monteren op een plafond controleert u altijd of het montageoppervlak en het montagemateriaal (exclusief
accessoires) 200 kg (440 lb 15 oz) of meer kunnen dragen. Monteer het apparaat zoals beschreven in deze Help-
gids. Als de montage niet stevig genoeg is, kan het apparaat vallen en ernstig letsel veroorzaken.
Bevestig de meegeleverde valpreventiedraad om te voorkomen dat de plafondbeugel CIB-PCM1 (optioneel) van het
apparaat kan vallen.
Wanneer het apparaat op een plafond is gemonteerd, controleer dan eenmaal per jaar of de montage nog goed vast
zit. Verkort de controletermijn als de gebruiksomstandigheden dat vereisen.

Opmerking over installatie
Om het objectief en het objectiefbevestigingsblok van het apparaat te beschermen, verwijdert u het objectief en de
kap en dop van het apparaat niet totdat het objectief is bevestigd.
Om defecten van het objectief te voorkomen, houdt u onderdelen van het objectief niet vast tijdens het werken.
Om defecten van het apparaat te voorkomen, houdt u de camerakop niet vast tijdens het werken.

Controleer de plafondmontage-accessoires en de montageruimte.

Plafondbeugel CIB-PCM1 (optioneel)
Voordat u begint, controleert u of u de volgende onderdelen hebt.

Hoofdbeugel (1)
Plafondbeugel (1)
Dop voor objectiefvrijgaveknop (1)
Valpreventiedraad (1)
+Schroeven PSW M3×8 (9)
+Roestvrij stalen schroef PSW M4×8 voor valpreventiedraad (1)

1
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Opmerking

De valpreventiedraad is bedoeld om het apparaat te dragen wanneer dit wordt opgehangen. Hang niets anders eraan dan
het gewicht van het apparaat.

Montageruimte
Raadpleeg de volgende tekening bij het kiezen van de montageplek en -richting en houd rekening met de vereiste
ruimte om het objectief te kunnen draaien en voor de bekabeling op de achterkant van het apparaat.

A: bewegingsruimte van de camerakop (bijv. SEL70200GM2 (met SEL20TC bevestigd): Ø370)
B: Plafondbeugel (gat aan plafondzijde) (Ø150)
C: Montage-uitlijngat

Opmerking

Monteer op een plafond dat voldoende sterk is (zoals beton).

Wilt u het apparaat op een plafond monteren dat niet sterk genoeg is, zorg dan voor voldoende versterking.

Monteer het op een stabiele plek die niet onderhevig is aan trillingen. Locaties met trillingen kunnen trilling in het beeld
veroorzaken.

Als u het apparaat op een schuin oppervlak moet monteren, blijf dan binnen ±15° van het horizontale vlak en tref
maatregelen om te voorkomen dat het apparaat valt.

De kant tegenover de gat △ op de plafondbeugel is de richting van filmen (voorzijde van camera).

Schuif de zwenk-/kantelvergrendeling in de stand UNLOCK om het zwenken/kantelen te ontgrendelen en
draai de camerakop 180° in de kantelrichting.

2

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

3
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Camerakop 180° gedraaid

Opmerking

Als de zwenk-/kantelfunctie van de camerakop niet is vergrendeld wanneer de grendel in de stand LOCK staat, beweeg de
camerakop dan met de hand totdat hij ingrendelt.

Bevestig de hoofdbeugel op de onderkant van het apparaat met behulp van de zes meegeleverde
schroeven (M3×8).

4
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Gebruik de meegeleverde schroeven. Gebruik van andere schroeven dan de meegeleverde kan schade aan het
binnenste van het apparaat veroorzaken.

Bevestig de plafondbeugel op een montageplaat (optioneel) en bevestig dan de plaat op het plafond.5
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A: plafondbeugel
B: plafond
C: montageplaat
D: gat △
Bevestig de beugel volgens de richting van de plafondbeugel
Bij montage op een plafond moet de voorkant van de camera aan de tegenoverliggende kant van de plafondbeugel
zitten in vergelijking met normale montage rechtop. Zorg voor correcte montage aan de hand van het diagram met
de montagerichting.

A: voorzijde voor rechtop monteren (gatrichting △)
B: voorzijde voor plafondmontage

Opmerking

Het materiaal van het montageoppervlak is de verantwoordelijkheid van de klant.

Bevestig de valpreventiedraad aan het plafond.6
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A: plafondbeugel
B: inbusschroef (M5, 3/16 inch)
C: draad (meegeleverd)
D: montageplaat
E: plafond

Steek de valpreventiedraad door het gat in het midden van de plafondbeugel en bevestig hem aan de
hoofdbeugel.

Steek de valpreventiedraad door de metalen lus voor de draad van de hoofdbeugel en bevestig hem stevig aan de
beugel met de meegeleverde roestvrijstalen schroef (M4×8).

A: meegeleverde draad
B: meegeleverde kruiskopschroef (M4×8)
C: metalen lus voor draad

7
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Gebruik de meegeleverde schroef. Gebruik van andere schroeven dan de meegeleverde kan de effectiviteit van de
valpreventiedraad verminderen.

Opmerking

Het beste kan één persoon het apparaat vasthouden zoals te zien in de volgende afbeelding terwijl een tweede persoon het
apparaat monteert.

Houd de camerakop of objectiefsteun niet vast tijdens het monteren van het apparaat. Er kan schade of letsel ontstaan als
het apparaat valt.

Zorg ervoor dat de elektrische aansluitingen en kabels niet worden kortgesloten door de valpreventiedraad.

De montage kan een opgehangen massa van maximaal 8,8 kg (inclusief objectief) dragen. Om te voorkomen dat het
apparaat kan vallen, overschrijdt u het maximale verwachte gewicht niet.

Lijn het schroefgat (A) op de hoofdbeugel uit met het gat ◇ (B) op de plafondbeugel, steek het apparaat in
en draai het ongeveer 60 graden rechtsom totdat het schroefgat (A) en het schroefgat (C) tegenover elkaar
staan.

8
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A: schroefgat op de hoofdbeugel
B: schroefgat op de plafondbeugel (gat ◇)
C: schroefgat
D: plafond
E: montageplaat

Zet de hoofdbeugel en plafondbeugel vast met de drie meegeleverde draaivergrendelingsschroeven (M3×8).9
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Bevestig vervolgens het objectief. Raadpleegt u "Een objectief bevestigen" waarbij u rekening houdt met de informatie bij
"Voorzorgen bij het bevestigen/verwijderen van een objectief", "De objectiefschakelaars controleren" en "Voorzorgen bij
gebruik van een zoomobjectief".

Opmerking

Om goed te kunnen zwenken/kantelen wanneer het apparaat op een plafond is gemonteerd, stelt u [Pan-Tilt] > [Direction] >
[Ceiling] in op [On] in het webmenu.

Nadat u een objectief hebt bevestigd, controleert u of dit goed vastzit.
Het objectief is niet beschermd tegen vallen. Sony aanvaardt geen aansprakelijkheid als een objectief van het apparaat valt.

Verwant onderwerp
Voorzorgen bij het bevestigen/verwijderen van een objectief

Controleer de montage.

Controleer met name de volgende punten.

De montageschroeven zitten correct vast.
De valpreventiedraad is correct bevestigd en niet gedraaid.
Het apparaat is horizontaal gemonteerd (niet gekanteld of wiebelend).
Het apparaat kan niet vrij ronddraaien.

10
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De objectiefschakelaars controleren

Voorzorgen bij gebruik van een zoomobjectief

Een objectief bevestigen

5-041-957-73(1) Copyright 2022 Sony Corporation

86



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Voorzorgen bij het bevestigen/verwijderen van een objectief

Laat het objectief niet met de lens in de zon liggen. Direct zonlicht kan het objectief binnenvallen, een brandpunt vormen
in het apparaat en zo brand veroorzaken.

Opmerking

Bevestig/verwijder een objectief als het apparaat is uitgeschakeld.

Een objectief is een precisiecomponent. Plaats het objectief niet op een oppervlak met de objectiefbevestiging omlaag. Bevestig
de meegeleverde objectiefbevestigingsdop.

Hint

Voor nadere informatie over objectieven die door het apparaat worden ondersteund neemt u contact op met uw Sony
servicevertegenwoordiger.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De objectiefschakelaars controleren

De volgende controles en instellingen zijn vereist, afhankelijk van het type objectief.

Voor een objectief met een scherpstelmodusschakelaar

Zet de schakelaar op AF/MF of AF.
Als de schakelaar is ingesteld op MF of Full MF, kan de scherpstelling alleen worden aangepast met de objectiefring.

Opmerking

Bij gebruik van een objectief met A-bevestiging is handmatige aanpassing vanaf een afstandsbediening mogelijk niet
beschikbaar.

Voor een objectief met een zoomschakelaar

Zet de schakelaar op SERVO.
Als de schakelaar op MANUAL staat, kan de zoom alleen worden aangepast met de zoomring. Zoomen vanaf het
apparaat heeft geen effect.

Voor een objectief met een auto-diafragmaschakelaar

Zet de schakelaar op AUTO.
Als de schakelaar niet op AUTO staat, kan het diafragma alleen worden aangepast met de objectiefring. Bediening van
het diafragma vanaf het apparaat heeft geen effect.

Voor een objectief met een beeldstabilisatieschakelaar

Zet de schakelaar op OFF.
Als de schakelaar op ON staat, kan onverwacht gedrag optreden wanneer u zwenk-/kantelacties uitvoert.

SELP28135G

A: beweeg de scherpstelring naar de voorste stand (AF-/MF-modus).
B: zet de schakelaar ZOOM in de stand SERVO.
C: zet de objectiefring in de stand "A" en de schakelaar IRIS LOCK in de stand LOCK.
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D: zet de beeldstabilisatieschakelaar op OFF.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Voorzorgen bij gebruik van een zoomobjectief

Wanneer u een ander zoomobjectief gebruikt dan een power-zoomobjectief, kan de zoomstand variëren, afhankelijk van
de montageomgeving. Zet de zoomring vast op zijn plek met plakband, afhankelijk van het beoogde gebruik.

Plastic plakband: 471 BLA 50 of soortgelijk

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een objectief bevestigen

In dit onderwerp wordt beschreven hoe een objectief met E-bevestiging of A-bevestiging bevestigt.

Opmerking

Vervoer het apparaat niet met het objectief er nog op.

Bij gebruik van een objectief met A-bevestiging wordt het diafragma handmatig ingesteld en is de scherpstelling ingesteld op MF.

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

Opmerking

Als de zwenk-/kantelfunctie van de camerakop niet is vergrendeld wanneer de grendel in de stand LOCK staat, beweeg de
camerakop dan met de hand totdat hij ingrendelt.

1

Draai de klemhendel voor de bevestigingsschroef van de objectiefsteunvoet linksom om de vergrendeling
los te maken. Beweeg dan de bevestigingsschroef van de objectiefsteunvoet naar een stand die het
objectief niet hindert.

2
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A: goed
B: fout

Draai de camerakopgrendel in de richting van de pijl om de camerakop te ontgrendelen.

Opmerking

Totdat u de camerakop weer vergrendelt, kan de camerakop per ongeluk bewegen door zijn eigen gewicht. Ondersteun de
camerakop met uw hand terwijl u deze actie uitvoert.

3

Schuif de camerakop naar de voorste stand.4
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Draai de camerakopgrendel in de richting van de pijl om de camerakop te vergrendelen.

Opmerking

Zorg ervoor dat de vergrendelingsbeugel voor de camerakop niet in contact komt met andere onderdelen zodat het
kantelen niet wordt beïnvloed.

5

Verwijder de kap en de dop van het apparaat en het objectief.6

Lijn de objectiefmontagemarkering (wit) uit met het apparaat en schuif het objectief voorzichtig in de
camerakop. Draai dan het objectief rechtsom totdat het in de grendelpositie klikt.

A: montagemarkeringen (wit)

Opmerking

Om een objectief met A-bevestiging te gebruiken, bevestigt u een objectiefadapter (optioneel) op het apparaat en bevestigt
u vervolgens het objectief met A-bevestiging.

7

Draai de camerakopgrendel in de richting van de pijl om de camerakop te ontgrendelen.8
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Opmerking

Totdat u de camerakop weer vergrendelt, kan de camerakop per ongeluk bewegen door zijn eigen gewicht. Ondersteun de
camerakop met uw hand terwijl u deze actie uitvoert.

Houd de voorwaartse/achterwaartse balans van de camerakop goed zodat de schuifvoet horizontaal staat.

Als u een van de volgende objectieven gebruikt, kunt u het apparaat en objectief grofweg uitbalanceren met de
schaal op de schuifvoet.

9

Schaalpositie Naam objectief

0,5 SEL70200GM (met SEL20TC bevestigd)

1,7 SEL70200GM

2,0 SEL70200GM2 (met SEL20TC bevestigd)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Opmerking

Gebruik de schaal op de schuifvoet als referentie voor een grove balans.

Wanneer u het objectief bevestigt, past u de balans zo aan dat het apparaat niet heen en weer kan bewegen.

Pas de balans aan op een horizontaal oppervlak.

Verwijder de objectiefsteunvoet wanneer u de SELC1635G gebruikt.

Schaalpositie Naam objectief

5,0 of hoger SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Draai de camerakopgrendel in de richting van de pijl om de camerakop te vergrendelen.

Opmerking

Zorg ervoor dat de vergrendelingsbeugel voor de camerakop niet in contact komt met andere onderdelen zodat het
kantelen niet wordt beïnvloed.
Zo controleert u dit: schuif de zwenk-/kantelvergrendeling naar de stand UNLOCK, draai het camerablok met de hand zodat
het naar boven wijst en controleer visueel dat het geen contact maakt met andere onderdelen. Als er wel contact is, draai
dan de vergrendelingsbeugel voor de camerakop nogmaals in de richting van de pijl.

10

Draai de klemhendels voor de objectiefsteun linksom om de objectiefsteuneenheid los te maken.11
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A: objectiefsteun-penklemhendel (2 posities)
B: objectiefsteuneenheid

Verplaats de objectiefsteuneenheid zo dat de objectiefsteunvoet gelijk staat met de bevestigingsschroef
van de objectiefsteunvoet en draai dan de schroef rechtsom om de objectiefsteunvoet vast te zetten.

Opmerking

Zorg ervoor dat de objectiefsteunvoet loodrecht boven de bevestigingsschroef van de objectiefsteunvoet staat en zet hem
dan vast.

12

Draai de klemhendel voor de bevestigingsschroef van de objectiefsteunvoet rechtsom om de
bevestigingsschroef van de objectiefsteunvoet vast te zetten.

A: bevestigingsschroef objectiefsteunvoet
B: gat bevestigingsschroef
C: klemhendel bevestigingsschroef objectiefsteunvoet

Hint

Als de klemhendel in een stand staat waarbij hij moeilijk draaibaar is, maak dan de klemhendel los en draai hem naar een
stand die makkelijker te gebruiken is. Wanneer de gewenste stand is bereikt, sluit u de klemhendel.

13
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Verwant onderwerp

Een objectief met E-bevestiging kalibreren

5-041-957-73(1) Copyright 2022 Sony Corporation

A: klemhendel bevestigingsschroef objectiefsteunvoet
B: pen klemhendel objectiefsteun

Draai de twee penklemhendels voor de objectiefsteun rechtsom om de objectiefsteuneenheid vast te zetten.14

Controleer dat beide hendels vastzitten en niet los, dat het objectief correct is bevestigd en dat de
objectiefschakelaars correct zijn ingesteld.

Als een hendel los zit of als het objectief niet correct is bevestigd, kan het objectief vallen en beschadigd raken.
Wanneer u een power-zoomobjectief met E-bevestiging gebruikt, moet het objectief apart worden gekalibreerd
om de zoomposities die in de camera zijn opgeslagen als voorkeuzes correct te kunnen herstellen. Voor nadere
informatie raadpleegt u "Een objectief met E-bevestiging kalibreren".

15
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Een objectief verwijderen

Verwijder een objectief in omgekeerde volgorde van hoe u een objectief bevestigt.

Opmerking

Pak het objectief stevig vast, zodat het niet kan vallen.

Als er niet direct een ander objectief wordt bevestigd, bevestig dan altijd de bodydop.

Verwant onderwerp

Een objectief bevestigen

5-041-957-73(1) Copyright 2022 Sony Corporation

Controleer dat de zwenk-/kantelfunctie is vergrendeld.1

Draai de klemhendel voor de bevestigingsschroef van de objectiefsteunvoet linksom om de vergrendeling
los te maken.

2

Verwijder de bevestigingsschroef van de objectiefsteunvoet op de objectiefsteuneenheid en verplaats hem
naar een positie die het objectief niet hindert.

3

Ontgrendel de camerakop en schuif de camerakop naar de voorste stand.

Voor nadere informatie raadpleegt u de stappen 3 t/m 5 in "Een objectief bevestigen".

4

Houd de objectiefvrijgaveknop ingedrukt en draai het objectief naar links terwijl u het ondersteunt.5

Wanneer de montagemarkeringen (wit) van de camera en het objectief tegenover elkaar staan, trekt u het
objectief recht naar voren los.

6
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Kabels aansluiten

In dit onderwerp worden de kabelverbindingen beschreven.

5-041-957-73(1) Copyright 2022 Sony Corporation

Sluit de vereiste kabels aan op de aansluitingen op het achterpaneel.

Om te voorkomen dat de HDMI-kabel wordt losgetrokken, verwijdert u de bevestigingsschroef van de HDMI-
kabelbevestigingsplaat (M2.6×6, zwart) van het aansluitblok en bevestigt u de meegeleverde HDMI-
kabelbevestigingsplaat met de bevestigingsschroef. Zet de HDMI-kabel vast aan de HDMI-kabelbevestigingsplaat
met een in de handel verkrijgbare kabelbinder of -band.

A: bevestigingsschroef HDMI-kabelbevestigingsplaat(M2.6×6, zwart)
B: in de handel verkrijgbare kabelbinder of -band
C: HDMI-kabelbevestigingsplaat (meegeleverd)

1
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Het apparaat aansluiten op een netwerkapparaat via een kabel

In dit onderwerp wordt beschreven hoe u het apparaat aansluit op een netwerkapparaat via een kabel.

5-041-957-73(1) Copyright 2022 Sony Corporation

Sluit het apparaat aan op het netwerkapparaat (zoals een wifi-toegangspunt of switchhub) met behulp van
een LAN-kabel van categorie 5e of hoger.

1
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Netstroom gebruiken

In dit onderwerp wordt beschreven hoe u het apparaat van voeding voorziet vanaf het elektriciteitsnet.

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

1

Sluit de netadapter (meegeleverd) aan op de DC IN-aansluiting op het apparaat en sluit het netsnoer
(meegeleverd) aan op de netstroombron.

A: DC IN-aansluiting
B: netsnoer
C: netadapter

2

Zet de netadapterkabel vast met de kabelklem als u wilt voorkomen dat de kabel wordt losgetrokken.

Ontgrendel de kabelklem, leid de kabel door de klem zoals afgebeeld en vergrendel de klem.

3
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Opmerking

Gebruik geen andere netadapter of ander netsnoer dan die meegeleverd zijn met het apparaat. Het aansluiten van een andere
netadapter of ander netsnoer kan brand of een defect veroorzaken.

Sluit een netadapter niet aan of gebruik deze in een krappe ruimte, zoals tussen een muur en meubels.

Maak geen kortsluiting met de metalen onderdelen van de stekker van de netadapter. Dit kan een storing tot gevolg hebben.

A: kabelklem
B: kabelklemgrendel
C: netadapterkabel

Controleer dat het POWER-lampje op de voorkant van het apparaat wijzigt van groen knipperend naar
continu groen en dat het opstarten is voltooid.

Wanneer het apparaat normaal is opgestart en verbonden met het netwerk, gaat het NETWORK-lampje groen
branden.

Wanneer u een objectief gebruikt dat zwenken en kantelen niet ondersteunt, vergrendel dan de
zwenk-/kantelvergrendeling en sla de volgende stappen over. Voor nadere informatie over objectieven die
zwenken/kantelen ondersteunen neemt u contact op met uw leverancier of Sony servicevertegenwoordiger.

4

Schuif de zwenk-/kantelvergrendeling in de stand UNLOCK om zwenken/kantelen van de camerakop
ontgrendelen.

5

Stel de zwenk-/kantelfunctie terug.

Voor nadere informatie raadpleegt u "De zwenk-/kantelfunctie terugstellen".

6
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Steek de netadapter in het dichtstbijzijnde stopcontact. Als er zich tijdens het werken een probleem voordoet, trek dan
onmiddellijk het netsnoer uit het stopcontact.

Pak bij het loskoppelen van de netadapter de stekker rechtstreeks vast en trek deze recht uit het stopcontact. Trekken aan de
kabel kan een defect veroorzaken.

Verwant onderwerp

De zwenk-/kantelfunctie terugstellen

5-041-957-73(1) Copyright 2022 Sony Corporation
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PoE++-voeding gebruiken

Wanneer het apparaat is aangesloten op een voeding die compatibel is met PoE++, kan het apparaat zijn voeding krijgen
via een in de handel verkrijgbare netwerkkabel.
Met deze methode kunt u het apparaat van voeding voorzien zonder dat u een netsnoer nodig hebt op plekken waar
geen stopcontact in de buurt van de montagelocatie is.

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

1

Sluit het apparaat aan op een met PoE++-compatibele voedingsbron via een in de handel verkrijgbare
netwerkkabel.

A: netwerkkabel
B: met PoE++ compatibele voedingsbron

2

Controleer dat het POWER-lampje op de voorkant van het apparaat wijzigt van groen knipperend naar
continu groen en dat het opstarten is voltooid.

Wanneer het apparaat normaal is opgestart en verbonden met het netwerk, gaat het NETWORK-lampje groen
branden.

3
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Opmerking

Het apparaat voldoet aan IEEE802.3bt type 4 klasse 8. Voor nadere informatie over met PoE++ compatibele voedingsbronnen
neemt u contact op met uw leverancier of Sony servicevertegenwoordiger.

Het apparaat voldoet aan zachte verificatie (LLDP), maar het kan nodig zijn om netwerkapparaten te configureren (conform
IEEE802.3bt).

Sluit geen netadapter aan wanneer u PoE++-voeding gebruikt met zachte verificatie (LLDP) ingeschakeld.

Als een netadapter en PoE++-voeding tegelijkertijd worden aangesloten, komt de voeding van de netadapter.

Wanneer de voeding via PoE++ wordt verzorgd, gebruik dan een netwerkkabel van categorie 5e of hoger.

Wacht ongeveer 10 seconden nadat u het apparaat opnieuw hebt gestart wanneer u PoE++-voeding gebruikt.

Bij gebruik van PoE++-voeding verbindt u de aardaansluiting met de aarde.

Bij gebruik van PoE++-voeding mag u geen kabels door de open lucht laten lopen.

Verwant onderwerp

De zwenk-/kantelfunctie terugstellen

5-041-957-73(1) Copyright 2022 Sony Corporation

Opmerking

Wanneer de voeding wordt betrokken via PoE++ wordt een eerste verificatie uitgevoerd tijdens het opstarten.

Wanneer u een objectief gebruikt dat zwenken en kantelen niet ondersteunt, vergrendel dan de zwenk-/kantelvergrendeling
en sla de volgende stappen over. Voor nadere informatie over objectieven die zwenken/kantelen ondersteunen neemt u
contact op met uw leverancier of Sony servicevertegenwoordiger.

Schuif de zwenk-/kantelvergrendeling in de stand UNLOCK om zwenken/kantelen van de camerakop
ontgrendelen.

4

Stel de zwenk-/kantelfunctie terug.

Voor nadere informatie raadpleegt u "De zwenk-/kantelfunctie terugstellen".

5
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De zwenk-/kantelfunctie terugstellen

Op de volgende manier kunt u de zwenk-/kantelfunctie terugstellen, bijvoorbeeld wanneer u het objectief vervangt.

5-041-957-73(1) Copyright 2022 Sony Corporation

Schuif de zwenk-/kantelvergrendeling in de stand UNLOCK en controleer dat zwenken/kantelen van de
camerakop ontgrendeld is.

1

Voer de terugstelfunctie voor zwenken/kantelen uit.

De zwenk-/kantelfunctie kan worden teruggesteld vanaf de infraroodafstandsbediening, de webapp of de
afstandsbediening RM-IP500 (optioneel).

Met de infraroodafstandsbediening: druk op de knop P/T RESET.
Bediening met de webapp: druk op de knop  (Zwenken/kantelen terugstellen) op het tabblad 
(Others) in het camerabedieningspaneel in het live-bedieningsscherm.
Met de RM-IP500: raadpleeg de gebruiksaanwijzing bij de RM-IP500.

Opmerking

Bij het terugstellen van de zwenk-/kantelfunctie gaan camerakop en objectief draaien. Zorg ervoor dat het objectief niet
wordt gehinderd voordat u dit doet.

Het apparaat heeft een functie die het zwenk-/kantelbereik beperkt, maar deze functie is uitgeschakeld wanneer u het
apparaat inschakelt en wanneer u de zwenk-/kantelfunctie terugstelt.

Hint

Na het terugstellen van de zwenk-/kantelfunctie keert het apparaat terug naar de eerdere stand.

2
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De webapp openen vanuit een webbrowser

Door het apparaat aan te sluiten op een tablet of computer kunt u het bedienen en configureren vanuit een webbrowser.

Controleer of uw tablet of computer bediening met de webapp ondersteunt.

Opmerking

Als niet aan de vereisten is voldaan en afhankelijk van het gebruik van de tablet/computer kan videoweergave in de
webbrowser negatief worden beïnvloed.

De webapp van dit apparaat maakt gebruik van JavaScript. Als u antivirussoftware gebruikt op uw tablet/computer wordt de
webpagina misschien niet correct weergegeven.

1

Onderdeel Vereiste

Weergave
1080×810 pixels of hoger aanbevolen
Tablet-weergavegrootte: 10 inch of
groter aanbevolen

Ondersteund besturingssysteem en
webbrowser

Windows
Besturingssysteem Windows 10 of later

Webbrowser Google Chrome

Mac

Besturingssysteem macOS 10.15 of later

Webbrowser
Google Chrome
Safari

iPad

Besturingssysteem iPadOS 15 of later

Webbrowser
Google Chrome
Safari

Android
Besturingssysteem Android 12 of later

Webbrowser Google Chrome

Controleer dat het apparaat, de tablet of computer en randapparatuur zijn ingeschakeld.2

Controleer dat het apparaat en de tablet of computer zijn verbonden via wifi of bekabeld LAN.3

Maak verbinding met het apparaat vanuit de webbrowser van uw tablet of computer.

Verbinding maken met behulp van een QR-code
Scan de QR-code die op het mediumklepje van het apparaat aan de zijkant van het apparaat is afgedrukt met de
camera van de tablet.

4
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Opmerking

Als het HTTP-poortnummer is veranderd en niet langer 80 is, voer dan "http://IP-adres van het apparaat:poortnummer" in de
adresbalk in.

Wanneer u verbinding maakt met een QR-code of door het webadres in de adresbalk van een webbrowser in te voeren, gebruik

dan een apparaat dat mDNS* ondersteunt.

Hint

U kunt vervolgens het apparaat snel vinden met de bladwijzerfunctie van de webbrowser.

5-041-957-73(1) Copyright 2022 Sony Corporation

Open de weergegeven koppeling op de tablet.
De webbrowser op de tablet start en geeft het webapp-scherm van het apparaat weer.

Verbinding maken door een webadres in te voeren in de adresbalk van een webbrowser
Start een webbrowser op uw tablet of computer en voer het webadres in dat is afgedrukt op het mediumklepje aan
de zijkant van het apparaat.
De webbrowser geeft dan als het goed is het webappvenster van het apparaat weer.

Verbinding maken door het IP-adres van het apparaat in te voeren in de adresbalk van een webbrowser
Start een webbrowser op uw tablet of computer en voer "http://IP-adres van het apparaat" in de adresbalk in.
De webbrowser geeft dan als het goed is het webappvenster van het apparaat weer.

mDNS: een communicatieprotocol dat wordt gebruikt om het IP-adres van een hostnaam vast te stellen op een lokaal netwerk.*
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Het apparaat initialiseren

Zorg ervoor dat u het apparaat op de volgende manier configureert wanneer u het apparaat voor het eerst gebruikt.

Hint

Als de reservebatterij helemaal leegraakt, moet u de eerste installatie opnieuw uitvoeren.

Maak verbinding met het apparaat vanaf een tablet of computer en start de webapp.

Wanneer u het apparaat voor het eerst gebruikt, wordt u gevraagd om een gebruikersnaam en wachtwoord in te
voeren in de webbrowser. Voer de volgende instellingen in.

Gebruikersnaam: admin
Wachtwoord: (niets invullen)

Volg de instructies op het scherm om de eerste installatie te configureren.

1

Voer de gebruikersnaam en het wachtwoord van de beheerder (Administrator) in en druk op de knop [OK].

1: Voer de gebruikersnaam van de beheerder in.
2: Stel het beheerderswachtwoord in.
3: Voer ter bevestiging nogmaals hetzelfde wachtwoord in.

Opmerking

U kunt de volgende tekens gebruiken voor gebruikersnaam en wachtwoord. Het wachtwoord moet ten minste één
hoofdletter, één kleine letter en één cijfer bevatten en tussen 8 en 64 tekens lang zijn.

Alfanumerieke tekens

2
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Het live-scherm voor filmen verschijnt. Ga verder met de basisconfiguratie van het apparaat, afhankelijk van de
gebruiksmodus.

Hint

In sommige gevallen, bijvoorbeeld als u het apparaat samen met een tablet gebruikt, kan het eenvoudiger zijn om een vast IP-
adres voor het apparaat te gebruiken.

Symbolen (!$%`*+-./<=>?@[]^_{|}~)

De webbrowser start opnieuw en u wordt gevraagd om de gebruikersnaam en het wachtwoord in te voeren.

Voer de gebruikersnaam en het wachtwoord in die u in stap 2 hebt geconfigureerd.

Het instelvenster voor taal en klok verschijnt.

3

Geef de volgende onderdelen op en druk op de knop [OK].

[Language]
Selecteer de taal die u wilt gebruiken in de webapp en op het scherm van de camera. Wanneer u van taal
verandert, verandert de weergavetaal van de webapp.
[Date & Time Format]
Selecteer de weergave-indeling voor de datum en tijd uit de volgende opties.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
"yyyy" geeft het jaar aan, "mm" geeft de maand aan, "dd" geeft de dag aan, "hh" geeft het uur aan, "mm" geeft de
minuten aan en "ss" geeft de seconden aan.
[12 h/24 h]
Selecteer [12 h] (12-uursklok) of [24 h] (24-uursklok) voor de tijdweergave.
[Time Setting]
Selecteer de manier waarop u datum en tijd in wilt stellen.
[Synchronize with PC]: synchroniseer met de datum/tijd van de computer of tablet.
[Manual setting]: stel handmatig in. Kiest u deze methode, dan verschijnen er invoervelden voor de datum en tijd.
[Time Zone]
Selecteer de tijdzone.

4

110



Wilt u een IP-adres invoeren, schakel dan eerst [Network] > [Wired LAN] > [IPv4] > [DHCP] (schuifschakelaar in linker positie) uit
in het webmenu.

De instellingen voor een vast IP-adres verschijnen. Configureer de instellingen en druk dan op de knop [OK] op het scherm.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Basisbediening configureren

In dit onderwerp wordt beschreven hoe u het apparaat moet configureren voor basishandelingen.

De opnamemodus instellen

U kunt de opnamemodus van het apparaat selecteren die past bij de werkstroom.

Modus Custom: maak op flexibele manier beelden tijdens het opnemen.
Logboek-opnamemodi: neem S-Log-gegevens op.

Modus Flexible ISO: belichtingsinstellingen worden ingesteld door aanpassingen aan de ISO-waarde die passen
bij de scène die u filmt.
Modus Cine EI/Cine EI Quick: gebruik het apparaat als een filmcamera (creëer geen volledige beelden tijdens het
filmen) waarbij de opnamen worden ontwikkeld in postproductie.

In Cine EI Quick-modus wordt automatisch een basisgevoeligheid geselecteerd die geschikt is voor de Exposure Index-
instelling.
Schakel de opnamemodus met [Project] > [Base Setting] > [Shooting Mode] in het webmenu of het cameramenu.

Custom-modus
U kunt de videonorm selecteren.
Schakel met [Project] > [Base Setting] > [Target Display] in het webmenu of cameramenu.

[SDR(BT.709)]: filmen volgens de HD broadcast-norm
[HDR(HLG)]: filmen volgens de nieuwe generatie 4K broadcast-norm

Voor nadere informatie raadpleegt u "Overzicht van uiterlijk" en andere onderwerpen bij "Filmen met het gewenste
uiterlijk".

Logboek-opnamemodi
(Flexible ISO-modus / Cine EI-modus / Cine EI Quick-modus)
In logboek-opnamemodi selecteert u het basiskleurbereik voor opgenomen signaal en uitvoersignaal. Het hier
geselecteerde kleurbereik is het kleurbereik van de video-uitvoer als de instellingen [LUT On/Off] zijn ingesteld op [MLUT
Off].
U kunt het kleurbereik wijzigen met [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] in het cameramenu.

[S-Gamut3.Cine/SLog3]: makkelijk voor het aanpassen van kleurbereik voor digitale cinema (DCI-P3).
[S-Gamut3/SLog3]: breed Sony-kleurbereik dat het ITU-R BT.2020-kleurbereik afdekt.

Voor nadere informatie raadpleegt u "Filmen met uiterlijkaanpassing in postproductie".
 
De ondersteunde functies per opnamemodus worden weergegeven in de volgende tabel.
●: ondersteund, –: niet ondersteund

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –
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Hint

In Cine EI Quick-modus en Cine EI-modus filmt u met een basis-ISO-gevoeligheid zonder versterking om de prestaties van de
beeldsensor te maximaliseren. U past de helderheid aan met de belichting en het ND-filter om de hoeveelheid licht aan te passen
die de beeldsensor bereikt.

Het instellen van de systeemfrequentie

Schakel met [Project] > [Rec Format] > [Frequency] in het webmenu of cameramenu. Het apparaat kan mogelijk
automatisch herstarten na het schakelen, afhankelijk van de geselecteerde waarde.

Opmerking

U kunt de systeemfrequentie niet overschakelen tijdens opnemen of afspelen.

De scanmodus van de beeldsensor instellen

U kunt de effectieve beeldgrootte en resolutie van de beeldsensor instellen.
Schakel met [Project] > [Rec Format] > [Imager Scan Mode] in het webmenu of cameramenu.
[FF]: volledige kadergrootte.
[S35]: Super 35 mm-formaat.

Opmerking

De scanmodus van de beeldsensor kan niet worden omgeschakeld tijdens opnemen of afspelen.

Indien ingesteld op S35 is het videoformaat beperkt tot 1920×1080.

De codec instellen

U kunt de codec voor opnemen instellen.
Schakel met [Project] > [Rec Format] > [Codec] in het webmenu of cameramenu.

Opmerking

U kunt de codec niet omschakelen tijdens opnemen of afspelen.

De video-indeling instellen

U kunt de video-indeling voor opnemen en de indeling voor uitvoer vanaf de camera instellen.

Schakel de video-indeling met [Project] > [Rec Format] > [Video Format] in het webmenu of het cameramenu.

Custom Flexible ISO Cine EI Cine EI Quick

Base ISO – ● ● ● (gekoppeld aan EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(behalve Base Look)

● – – –
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Schakel de uitvoerindeling vanaf de aansluitingen SDI OUT en HDMI OUT met [Monitoring] > [Output Format] in het
webmenu of cameramenu.

Opmerking

U kunt de video-indeling niet omschakelen tijdens opnemen of afspelen.

Er kunnen beperkingen gelden voor het signaal van de aansluitingen SDI OUT en HDMI OUT, afhankelijk van de instelling voor
video-indeling.

Verwant onderwerp

Overzicht van uiterlijk

Filmen met uiterlijkaanpassing in postproductie

5-041-957-73(1) Copyright 2022 Sony Corporation
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Ondersteunde geheugenkaarten

Het apparaat neemt audio en video op CFexpress Type A geheugenkaarten (apart verkrijgbaar) op of op SDXC-
geheugenkaarten (apart verkrijgbaar) die in de kaartsleuven zijn geplaatst. De geheugenkaarten worden ook gebruikt
voor proxy-opname.

CFexpress Type A geheugenkaarten

Gebruik Sony CFexpress Type A geheugenkaarten* in het apparaat die zijn vermeld onder "Aanbevolen opnamemedia".
Raadpleeg voor details over werken met media van andere fabrikanten de gebruiksaanwijzing voor de media of de
informatie van de producent.

SDXC-geheugenkaarten

Gebruik SDXC-geheugenkaarten* in het apparaat die zijn vermeld onder "Aanbevolen opnamemedia".

Aanbevolen opnamemedia

De gegarandeerde functioneringscondities variëren afhankelijk van de opname-indeling en opname-instellingen.

CFexpress Type A
VPG400-compatibel
Ondersteund voor alle opname-indelingen van het apparaat.

SDXC
Ondersteund onder de voorwaarden die vermeld zijn in de volgende tabel. "●" geeft aan dat de werking is geverifieerd en
"–" dat de werking niet wordt gegarandeerd.

RAW Out & XAVC-I, 4096×2160 klasse 300, normale modus

RAW Out & XAVC-I, 3840×2160 klasse 300, normale modus

In deze Help-gids aangeduid als "CFexpress-kaarten".*

In deze Help-gids aangeduid als "SD-kaarten".*

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 klasse 300, S&Q (60 fps of minder)

RAW Out & XAVC-I, 3840×2160 klasse 300, S&Q (100 fps, 120 fps)
Geen beschikbare media geverifieerd.

XAVC-I, 4096×2160 klasse 300, normale modus

XAVC-I, 4096×2160 klasse 300, S&Q (60 fps of minder)

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 klasse 300, normale modus

XAVC-I, 3840×2160 klasse 300, S&Q (60 fps of minder)

XAVC-I, 3840×2160 klasse 300, S&Q (100 fps, 120 fps)
Geen beschikbare media geverifieerd.

XAVC-I, 1920×1080 klasse 100, normale modus

XAVC-I, 1920×1080 klasse 100, S&Q (60 fps of minder)

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 klasse 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 klasse 100, S&Q (150 fps, 180 fps)
Geen beschikbare media geverifieerd.

XAVC-I, 1920×1080 klasse 100, S&Q (200 fps, 240 fps)
Geen beschikbare media geverifieerd.

XAVC-L, 3840×2160 420, normale modus

XAVC-L, 3840×2160 420, S&Q (60 fps of minder)

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, normale modus

XAVC-L, 1920×1080 HD50, S&Q (60 fps of minder)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, normale modus

XAVC-L, 1920×1080 HD35, S&Q (60 fps of minder)

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-957-73(1) Copyright 2022 Sony Corporation

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systeemfrequentie Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Geheugenkaarten plaatsen

In dit hoofdstuk worden de voorzorgen beschreven bij het plaatsen van geheugenkaarten.

Open de mediaklep van het kaartsleufgedeelte.1

Plaats een geheugenkaart.

Bij CFexpress-kaarten wijst het etiket omhoog.

Opmerking

Wanneer het apparaat op een plafond is gemonteerd, wijst het etiket naar beneden.

Bij SD-kaarten wijst het etiket omlaag.

Opmerking

Wanneer het apparaat op een plafond is gemonteerd, wijst het etiket omhoog.

De toegangsindicator brand rood en gaat dan groen branden als de kaart bruikbaar is.

2
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Opmerking

De geheugenkaart, de geheugenkaartsleuf en beeldgegevens op de geheugenkaart kunnen beschadigd raken als de kaart
geforceerd verkeerdom in de sleuf wordt geplaatst.

Gebruik bij opnemen op media die zijn geplaatst in zowel CFexpress Type A-/SD-kaartsleuven A als B media die worden
geadviseerd voor gebruik met de gebruikte opname-indeling in beide sleuven.

5-041-957-73(1) Copyright 2022 Sony Corporation

Opmerking

Als de toegangsindicator doorlopend rood knippert en niet groen wordt, schakel het apparaat dan tijdelijk uit, verwijder de
geheugenkaart en plaats deze opnieuw.

Sluit de mediaklep.3
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een geheugenkaart uitwerpen

Open de mediaklep van het kaartgedeelte en druk de geheugenkaart voorzichtig een klein stukje naar binnen om de
kaart uit te werpen.

Opmerking

Als het apparaat wordt uitgeschakeld of als de geheugenkaart wordt verwijderd terwijl er gegevens worden uitgewisseld kan de
integriteit van de gegevens op de kaart niet worden gegarandeerd. Alle gegevens op de kaart kunnen verloren gaan. Controleer
altijd of de toegangsindicator groen is of niet brandt, voordat u het apparaat uitschakelt of de geheugenkaart verwijdert.

Als een geheugenkaart direct na beëindiging van een opname wordt verwijderd kan deze heet zijn, maar dit duidt niet op een
probleem.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Geheugenkaarten formatteren (initialiseren)

Als u een niet-geformatteerde geheugenkaart of een geheugenkaart plaatst die is geformatteerd met andere
specificaties, verschijnt in het camerabeeldpaneel de melding "Media Needs to be Formatted".
Formatteer de kaart met de volgende procedure.

Opmerking

Het formatteren van een geheugenkaart wist alle gegevens, inclusief opgenomen videogegevens en configuratiebestanden.

Er kunnen meldingen verschijnen tijdens de uitvoering, afhankelijk van de duur van het formatteringsproces.

Als het formatteren mislukt
Geheugenkaarten die niet worden ondersteund door het apparaat kunnen niet worden geformatteerd.
Er verschijnt een waarschuwingsmelding. Volg de instructies voor het vervangen van de kaart door een ondersteunde
geheugenkaart.

Een op het apparaat geformatteerde kaart gebruiken in de sleuf van een ander apparaat
Maak eerst een reservekopie van de kaart en formatteer vervolgens de kaart in het apparaat dat wordt gebruikt.

5-041-957-73(1) Copyright 2022 Sony Corporation

Selecteer [TC/Media] > [Format Media] in het cameramenu.1

Selecteer Media(A) (sleuf A) of Media(B) (sleuf B) en select vervolgens de formatteringsmethode (Full
Format of Quick Format).

Er verschijnt een bevestigingsmelding.
[Full Format]: initialiseert het medium volledig, inclusief het gegevensgebied en gegevensbeheerinformatie.
[Quick Format]: initialiseert alleen de gegevensbeheerinformatie van het medium.

2

Selecteer [Execute].

Er verschijnt een melding terwijl het formatteren bezig is en de toegangsindicator brandt rood.
Als het formatteren is voltooid, verschijnt een melding.

3
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De resterende opnametijd controleren

Bij het filmen (opnemen/stand-by) kunt u de resterende capaciteit van de geheugenkaart in de verschillende sleuven
volgen met de media-indicators voor resterende capaciteit in sleuf A/B in het camerabeeldpaneel.
De resterende opnametijd wordt berekend aan de hand van de resterende capaciteit van de media in de sleuven en de
huidige opname-indeling (opname-bitsnelheid); het resultaat wordt in minuten weergegeven.

Geheugenkaart vervangingstiming
Wanneer de totale resterende opnametijd op de twee geheugenkaarten minder dan 5 minuten wordt, verschijnt het
bericht "Media Near Full" en begint het opname-/tallylampje te knipperen om u te waarschuwen.
Vervangen door media met vrije ruimte.
Als u doorgaat met opnemen tot de totale resterende opnametijd nul bereikt, wordt wijzigt de melding in "Media Full" en
stopt de opname.

Opmerking

Op een geheugenkaart kunnen ongeveer 600 clips worden opgenomen.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Geheugenkaarten herstellen

Als er zich om bepaalde redenen een fout zou voordoen in een geheugenkaart, moet de kaart vóór gebruik worden
hersteld.
Als u een geheugenkaart plaatst die moet worden hersteld, verschijnt een melding in het camerabeeldpaneel of u de
kaart wilt herstellen.

Een kaart herstellen
Selecteer [Execute] met de pijlknoppen in het GUI-bedieningspaneel en druk op de knop [Set].
Er worden een melding en voortgangsstatus (%) weergegeven tijdens het formatteren en de toegangsindicator brandt
rood.
Als het herstellen is voltooid, verschijnt hiervan een melding.

Als herstellen mislukt
Geheugenkaarten waarop geheugenfouten hebben plaatsgevonden kunnen niet worden hersteld. Er verschijnt een
waarschuwingsmelding. Volg de instructies om de kaart te vervangen.
Geheugenkaarten waarop geheugenfouten hebben plaatsgevonden worden mogelijk onbruikbaar als ze worden
geformatteerd.
In sommige gevallen kunnen clips worden hersteld en andere niet. De herstelde clips kunnen normaal worden
afgespeeld.

Opmerking

Herstel media die zijn opgenomen met dit apparaat alleen met dit apparaat.

Media die zijn opgenomen met een ander apparaat dan dit apparaat of met een andere versie van dit apparaat (ook al is het
hetzelfde model) mogen niet met dit apparaat worden hersteld.

Clips die korter zijn dan 2 seconden kunnen niet worden hersteld.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Starten en stoppen met opnemen

In dit onderwerp wordt beschreven hoe u een opname start en stopt.

Bevestig de vereiste apparaten en controleer of er stroom beschikbaar is voor het apparaat en de
randapparatuur.

1

Plaats de geheugenkaart(en).2

Controleer de aan-uitstatus van het apparaat linksboven in het webapp-scherm.

Wanneer er voeding is
Wanneer het apparaat is ingeschakeld, verschijnt [Power ON] op de aan-uitschakelaar bovenin het webapp-
scherm.

Het POWER-lampje op de voorkant van het apparaat gaat branden en het camerabeeld verschijnt op het live-
bedieningsscherm van de webapp.

Opmerking

Als het beheerderswachtwoord niet is geconfigureerd, verschijnt een venster met de vraag om het wachtwoord te
configureren. Raadpleeg "Het apparaat initialiseren".

Wanneer de voeding in stand-by staat
Wanneer de voeding van het apparaat in stand-by staat, wordt [Power Standby] weergegeven op de aan-
uitschakelaar in de webapp.

In deze status druk u op de aan-uitschakelaar en selecteert u [Power ON]. Het apparaat schakelt in, het POWER-
lampje op de voorkant van het apparaat gaat groen branden en het camerabeeld verschijnt op het live-
bedieningsscherm van de webapp.

3
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De voeding van het apparaat in stand-bystand plaatsen
Druk op de aan-uitschakelaar in de webapp en selecteer [Power Standby] om de voeding van het apparaat in stand-
bystand te zetten.

Hint

U kunt u de voeding ook in stand-bystand zetten met de aan-uitknop op de meegeleverde infraroodafstandsbediening.

Hint

U kunt het apparaat ook aanzetten met de aan-uitknop op de meegeleverde infraroodafstandsbediening.

Druk op de opnameknop START/STOP.

De opname start en het opname-/tallylampje (2 plekken) gaat branden.
Tijdens de opname brandt de opnameknop START/STOP. Ook worden een pictogram voor het doelopnamemedium
en [●Rec] weergegeven.

4

Om het opnemen te stoppen drukt u weer op de knop START/STOP.

De opname stopt en het opname-/tallylampje (2 plekken) dooft.
Tijdens opname stand-bystand brandt de opnameknop START/STOP niet. Ook worden een pictogram voor het
doelopnamemedium en [Stby] weergegeven.

Hint

U kunt het opnemen ook starten en stoppen met de opnameknop START/STOP op de meegeleverde
infraroodafstandsbediening.

5
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Verwant onderwerp
Het apparaat initialiseren

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Overschakelen tussen geheugenkaarten

Wanneer er twee geheugenkaarten zijn geplaatst, kunt u op de knop [Slot Select] drukken in het afspeelpaneel van de
webapp om van geheugenkaart te wisselen.

Hint

U kunt ook op de knop SLOT SEL (selectie geheugenkaartsleuf (A)/(B)) op de meegeleverde infraroodafstandsbediening drukken
om van geheugenkaart te wisselen.

Over relay-opnemen

Tijdens opname schakelt het apparaat automatisch over naar de tweede geheugenkaart, vlak voordat de capaciteit van
de eerste kaart nul wordt (relay-opname). U kunt ononderbroken doorgaan met opnemen bij het overschakelen van
geheugenkaart door de volle geheugenkaart te verwisselen voor een nieuwe geheugenkaart.

Opmerking

Tijdens afspelen kan niet worden overgeschakeld tussen geheugenkaarten. Ook het ononderbroken afspelen van een clip
waarvan de media zich op twee geheugenkaarten bevinden is niet mogelijk.

Over opgenomen gegevens

Als u stopt met opnemen worden de video, de audio en bijbehorende gegevens van start tot eind van de opname
opgeslagen als één "clip" op een geheugenkaart.

Clipnaam van opgenomen gegevens

De naam van de clips die met het apparaat worden opgenomen, wordt automatisch toegewezen volgens [TC/Media] >
[Clip Name Format] in het cameramenu.

Maximale cliplengte

Maximaal 6 uur per clip.
De maximale duur van continue opname is hetzelfde als de maximale duur van een clip. Als de opnametijd de maximale
duur van een clip overschrijdt, wordt automatisch een nieuwe clip aangemaakt en gaat het opnemen door. De nieuwe
clip verschijnt als afzonderlijke clip op het pictogrammenscherm.
Meerdere clips worden achter elkaar opgenomen tijdens relay-opname, maar het opnemen stopt automatisch na
ongeveer 24 uur.

Opmerking

Verwijder geen geheugenkaart tijdens het opnemen als erop wordt opgenomen. Vervang tijdens het opnemen alleen
geheugenkaarten in sleuven waarvan de sleuftoegangsindicator niet brandt.

Als op de geheugenkaart waarop wordt opgenomen minder dan een minuut capaciteit resteert en een beschrijfbare
geheugenkaart in de andere sleuf is geplaatst, verschijnt het bericht "Will Switch Slots Soon". De melding verdwijnt nadat er is
gewisseld van geheugenkaartsleuf.

Relay-opname werkt mogelijk niet als het opnemen is gestart als de resterende capaciteit van de geheugenkaart minder dan een
minuut is. Controleer voor correcte relay-opname of de capaciteit van de geheugenkaart meer dan een minuut is, voordat het
opnemen wordt gestart.

Video die is gemaakt met de relay-functie van het apparaat kan niet naadloos worden afgespeeld op het apparaat.
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Om video te combineren die is gemaakt met de relay-functie gebruikt u de software "Catalyst Browse".

5-041-957-73(1) Copyright 2022 Sony Corporation
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Help-gids
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De audio controleren

Audio wordt uitgevoerd vanaf de aansluitingen SDI en HDMI van het apparaat. Selecteer de combinatie van
audiokanalen die worden uitgevoerd vanaf de HDMI-aansluiting met [Audio] > [Audio Output] > [HDMI/Stream Output
CH] in het cameramenu.
CH1/CH2: combinatie van CH1 en CH2
CH3/CH4: combinatie van CH3 en CH4
Wanneer u het geluid in de webapp controleert, gebruikt u de geluidsniveaumeter rechtsonder het camerabeeld.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Tijdgegevens instellen

In dit onderwerp wordt beschreven hoe u tijdgegevens instelt.

De tijdcode instellen

Stel de tijdcode voor opname in met [TC/Media] > [Timecode] in het cameramenu.

Userbits instellen

U kunt een 8-bits hexadecimaal getal aan het opgenomen beeld als userbits toevoegen. U kunt de userbits ook op de
huidige tijd instellen. Stel in met [TC/Media] > [Users Bit] in het cameramenu.

Tijdgegevens weergeven

Stel de tijdcode voor opname in met [TC/Media] > [TC Display] > [Display Select] in het cameramenu.
Wanneer u op een toewijsbare knop drukt waaraan [DURATION/TC/U-BIT] is toegewezen, schakelt de weergave
cyclisch om tussen tijdcode, userbits en tijdsduur.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een opname controleren (Rec Review)

U kunt de laatst opgenomen clip op het scherm controleren (recording review).

Opmerking

Rec Review wordt niet ondersteund als de video-indeling is gewijzigd na het opnemen van de clip.

De startpositie voor Rec Review instellen

U kunt de startpositie voor afspelen aan een van de volgende posities toewijzen met [Technical] > [Rec Review] in het
cameramenu.

Laatste 3 seconden van de clip
Laatste 10 seconden van de clip
Begin van de clip

Hint

Als u een specifieke clip wilt controleren na het opnemen van meerdere clips, druk dan op de knop [Thumbnail] om het
pictogrammenscherm weer te geven en selecteer de gewenste clip om deze af te spelen.

U kunt ook op de knop THUMBNAIL drukken van de meegeleverde infraroodafstandsbediening en zo het pictogrammenscherm
weergeven.

Methode voor Rec Review

Wijs van tevoren de functie Rec Review toe aan een van de toewijsbare knoppen in het aanpassingspaneel voor
basisconfiguratie.

Voor nadere informatie over het toewijzen raadpleegt u "Toewijsbare knoppen" onder "Handige functies".

Stop de opname en druk dan op een toewijsbare knop waaraan de functie Rec Review is toegewezen om de eerder
opgenomen clip af te spelen.
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De clip wordt tot het eind afgespeeld, Rec Review wordt beëindigd en het apparaat gaat terug naar de modus Stby
(stand-by).

Rec Review stoppen
Druk op een toewijsbare knop waaraan Rec Review is toegewezen of druk op de knop [Cancel/Back].
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Hint

U kunt ook op de knop [Cancel/Back] drukken van de meegeleverde infraroodafstandsbediening en zo de functie Rec Review
stoppen.

Verwant onderwerp

Toewijsbare knoppen

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het aanpassingsscherm voor kadrering

U past de kadrering aan met de volgende onderdelen van het live-bedieningsscherm.

Opmerking

Afhankelijk van de richting van de camera, de brandpuntsafstand van het objectief en de zoompositie kunnen delen van het
apparaat of de aangesloten kabels zichtbaar zijn. Controleer voordat u gaat filmen het zichtveld voor het objectief en de
brandpuntsafstand die u gebruikt. U kunt de het zwenk-/kantelbereik ook regelen met [Pan-Tilt] > [P/T Range Limit] in het
webmenu. Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik
genegeerd. Voor nadere informatie raadpleegt u [Pan-Tilt] > [P/T Range Limit] in het webmenu.

Hint

U kunt het kader ook regelen met de meegeleverde infraroodafstandsbediening.

5-041-957-73(1) Copyright 2022 Sony Corporation

Bedieningspaneel voor voorkeuzeposities1.

Tabblad  (Main) / tabblad  (Others)2.

Kadrering-bedieningspaneel3.
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De richting van filmen aanpassen met de webapp

Horizontale beweging van de camera wordt zwenken genoemd, verticale beweging van de camera heet kantelen.
U kunt de richting van filmen aanpassen met zwenk-/kantelacties.

Hint

Als [Execute Pan-Tilt Reset] wordt weergegeven onder de joystick, is er een ongelijkmatigheid opgetreden in de
zwenk-/kanteloorspronginformatie van het apparaat. Voer de terugstelfunctie voor zwenken/kantelen uit om de
oorspronginformatie bij te werken. Voor nadere informatie raadpleegt u "De zwenk-/kantelfunctie terugstellen".

De camera weer recht vooruit laten wijzen
Druk op de knop  (Zwenken/kantelen terug) op het tabblad  (Others) in het camerabedieningspaneel.

Opmerking

Afhankelijk van de richting van de camera, de brandpuntsafstand van het objectief en de zoompositie kunnen delen van het
apparaat of de aangesloten kabels zichtbaar zijn. Controleer voordat u gaat filmen het zichtveld voor het objectief en de
brandpuntsafstand die u gebruikt. U kunt de het zwenk-/kantelbereik ook regelen met [Pan-Tilt] > [P/T Range Limit] in het
webmenu. Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik
genegeerd. Voor nadere informatie raadpleegt u [Pan-Tilt] > [P/T Range Limit] in het webmenu.

Verwant onderwerp

De zwenk-/kantelfunctie terugstellen

Druk op het tabblad  (Zwenken/kantelen/zoomen) in het kadrerings-bedieningspaneel om de
joystick weer te geven.

1

Sleep het midden van de joystick in de richting waarin u wilt kijken terwijl u het camerabeeldpaneel in de
gaten houdt.

De richting en snelheid van de camera wijzigen naargelang de richting en het niveau waarmee u sleept.
U kunt de zwenk-/kantelfunctie exacter aanpassen door op een plek langs de rand van de joystick te drukken.

2
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De bedieningssnelheid voor zwenken/kantelen instellen

U kunt met de joystick de snelheid van de zwenk-/kantelacties wijzigen met de schuifbalk [Pan-Tilt Speed] in het
camerabedieningspaneel met de joystick in het kadrering-bedieningspaneel.

Opmerking

Als er een muur of obstakel is in het bewegingsbereik van de camera, let er dan op dat u de camera of het objectief niet laat
botsen tijdens het zwenken/kantelen.

De versnelling van het zwenken/kantelen hangt af van fysische karakteristieken, zoals de gewichtsbalans van het objectief. U
kunt de instelling voor de versnelling wijzigen met [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] in het webmenu of het
cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op het tabblad  (Main) in het camerabedieningspaneel.1

Selecteer de schuifbalk [Pan-Tilt Speed] in de lijst.

Als de schuifbalk [Pan-Tilt Speed] niet wordt weergegeven, selecteer dan een van de twee schuifbalkkeuzeknoppen
om de schuifbalk weer te geven.

2

Beweeg de schuifknop naar links of rechts.

Door de knop naar links te verplaatsen verlaagt u de bedieningssnelheid, door de knop naar rechts te verplaatsen
verhoogt u de bedieningssnelheid.

3
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De bedieningsversnelling voor zwenken/kantelen instellen

U kunt de versnelling instellen met [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] in het webmenu of het cameramenu.
Verhoog de waarde voor snellere wijzigingen in snelheid of verlaag de waarde voor geleidelijkere veranderingen van
snelheid.
Voor een snellere respons bij het zwenken/kantelen kiest u een waarde in het bereik 7 t/m 9.
Voor meer nauwkeurigheid van het begin/einde van de beweging naar een vooraf ingestelde positie, kunt u het beste
een waarde in het bereik 1 t/m 6 kiezen.

Voor nadere informatie over voorkeuzeposities raadpleegt u "De Zwenken/kantelen en zoominstelling
opslaan/herstellen".

Opmerking

Wanneer de waarde hoog is ingesteld, werkt de functie misschien niet goed als er een zwaar objectief is gemonteerd. Controleer
de werking voordat u het apparaat echt gaat gebruiken.

Relatie tussen de instelling [Ramp Curve] en zwenk-/kantelacties

Bij gebruik van zwenken/kantelen

Bij het oproepen van een voorkeuzepositie
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De richting van filmen aanpassen met de meegeleverde infraroodafstandsbediening

U kunt de richting van filmen aanpassen met de zwenk-/kantelknoppen van de meegeleverde
infraroodafstandsbediening.

De camera weer recht vooruit laten wijzen
Druk op de knop HOME.

Opmerking

Afhankelijk van de richting van de camera, de brandpuntsafstand van het objectief en de zoompositie kunnen delen van het
apparaat of de aangesloten kabels zichtbaar zijn. Controleer voordat u gaat filmen het zichtveld voor het objectief en de
brandpuntsafstand die u gebruikt. U kunt de het zwenk-/kantelbereik ook regelen met [Pan-Tilt] > [P/T Range Limit] in het
webmenu. Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik
genegeerd. Voor nadere informatie raadpleegt u [Pan-Tilt] > [P/T Range Limit] in het webmenu.
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Druk op de pijlknoppen om te zwenken en te kantelen.

Druk op de pijlknop in de richting waarin u wilt kijken terwijl u het cameradeelvenster in de gaten houdt.
Wilt u een korte afstand bewegen, druk dan kort op de pijlknop.
Wilt u een grotere afstand bewegen, houd dan de pijlknop ingedrukt.
Wilt u diagonaal bewegen, houd dan de knop  (pijl omhoog) of  (pijl omlaag) ingedrukt en druk op de knop 
(pijl links) of  (pijl rechts).

1
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Het type zoom instellen

Stel het zoomtype in met [Technical] > [Zoom] > [Zoom Type] in het cameramenu.
Het type zoom varieert afhankelijk van het type objectief dat is bevestigd.

Opmerking

Clear Image Zoom is niet beschikbaar in de volgende gevallen.

Wanneer [Shooting] > [S&Q Motion] > [Setting] is ingesteld op On en de instelling [Frame Rate] in het cameramenu hoger is
dan 60 fps
Wanneer [Project] > [Rec Format] > [Codec] in het cameramenu is ingesteld op [RAW] of een optie die RAW bevat

Het bedienen van de selectieschakelaar SERVO/MANUAL op een objectief reset de vergroting van Clear Image Zoom naar 1×.

AF-S wordt niet ondersteund tijdens Clear Image Zoom.

Clear Image Zoom

Het apparaat is uitgerust met een zoomfunctie die gebruik maakt van beeldsignaalverwerking met de naam Clear Image
Zoom. Als Clear Image Zoom is ingeschakeld wordt zoom ondersteund, zelfs voor objectieven met vaste scherpstelling.
Het kan ook worden gebruikt om het bereik te vergroten buiten het optische bereik op een powerzoom-objectief.
De maximale zoomverhouding bij gebruik van Clear Image Zoom varieert, afhankelijk van de opnameresolutie.

Voor QFHD/4K-opnameresolutie: 1,5×
Voor HD-opnameresolutie: 2×

5-041-957-73(1) Copyright 2022 Sony Corporation

Type bevestigd objectief
Instelling [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objectief met vaste scherpstelling /
handmatig zoomobjectief

Gebruik van zoom wordt niet
ondersteund.

Clear Image Zoom wordt ondersteund.

Power-zoomobjectief
Alleen optische zoom wordt
ondersteund.

Optische zoom en Clear Image Zoom
worden ondersteund.
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De zoom aanpassen met de webapp

U kunt de zoom van het apparaat aanpassen met optische zoom of met Clear Image Zoom. In dit onderwerp wordt
beschreven hoe u aanpassingen doet met de webapp. Voor nadere informatie over Clear Image Zoom raadpleegt u "Het
type zoom instellen".

Opmerking

Afhankelijk van de richting van de camera, de brandpuntsafstand van het objectief en de zoompositie kunnen delen van het
apparaat of de aangesloten kabels zichtbaar zijn. Controleer voordat u gaat filmen het zichtveld voor het objectief en de
brandpuntsafstand die u gebruikt. U kunt de het zwenk-/kantelbereik ook regelen met [Pan-Tilt] > [P/T Range Limit] in het
webmenu. Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik
genegeerd. Voor nadere informatie raadpleegt u [Pan-Tilt] > [P/T Range Limit] in het webmenu.

De werkelijke zoomsnelheid en -nauwkeurigheid hangen af van het objectief. Controleer de werking voordat u het apparaat echt
gaat gebruiken.

Hint

U kunt de zoom van een handmatig zoomobjectief regelen met een objectiefcontroller (optioneel) die past bij dit apparaat. Voor
nadere informatie raadpleegt u "Een objectiefcontroller aansluiten" en "De zoom aanpassen met een objectiefcontroller".

Verwant onderwerp

Het type zoom instellen

Een objectiefcontroller aansluiten

De zoom aanpassen met een objectiefcontroller

Druk op het tabblad  (Zwenken/kantelen/zoomen) in het kadrerings-bedieningspaneel om het
zwenk-/kantelbedieningspaneel weer te geven.

1

Schuif de schuifknop [Zoom] in de richting [T] (Tele) of in de richting [W] (Wide, breedbeeld) om de zoom
aan te passen.

De zoomsnelheid varieert met de beweging van de schuifbalk.

2

146



5-041-957-73(1) Copyright 2022 Sony Corporation

147



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De bedieningssnelheid voor zoom instellen

U kunt de snelheid van de zoom wijzigen met de schuifbalk [Zoom] in het kadrering-bedieningspaneel met de schuifbalk
[Zoom Speed] in het camerabedieningspaneel.

Opmerking

De werkelijke zoomsnelheid en -nauwkeurigheid hangen af van het objectief. Controleer de werking voordat u het apparaat echt
gaat gebruiken.
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Druk op het tabblad  (Main) in het camerabedieningspaneel.1

Selecteer de schuifbalk [Zoom Speed] in de lijst.

Als de schuifbalk [Zoom Speed] niet wordt weergegeven, selecteer dan een van de twee schuifbalkkeuzeknoppen
om de schuifbalk weer te geven.

 

2

Beweeg de schuifknop [Zoom Speed] naar links of rechts.

Door de knop naar links te verplaatsen verlaagt u de bedieningssnelheid, door de knop naar rechts te verplaatsen
verhoogt u de bedieningssnelheid.

3

148



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De zoom aanpassen met de meegeleverde infraroodafstandsbediening

U kunt de zoom van het apparaat aanpassen met optische zoom of met Clear Image Zoom. In dit onderwerp wordt
beschreven hoe u aanpassingen doet met de meegeleverde infraroodafstandsbediening. Voor nadere informatie over
Clear Image Zoom raadpleegt u "Het type zoom instellen".

Opmerking

Afhankelijk van de richting van de camera, de brandpuntsafstand van het objectief en de zoompositie kunnen delen van het
apparaat of de aangesloten kabels zichtbaar zijn. Controleer voordat u gaat filmen het zichtveld voor het objectief en de
brandpuntsafstand die u gebruikt. U kunt de het zwenk-/kantelbereik ook regelen met [Pan-Tilt] > [P/T Range Limit] in het
webmenu. Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik
genegeerd. Voor nadere informatie raadpleegt u [Pan-Tilt] > [P/T Range Limit] in het webmenu.

Hint

U kunt de zoom van een handmatig zoomobjectief regelen met een objectiefcontroller (optioneel) die past bij dit apparaat. Voor
nadere informatie raadpleegt u "Een objectiefcontroller aansluiten" en "De zoom aanpassen met een objectiefcontroller".

Verwant onderwerp
Het type zoom instellen

Een objectiefcontroller aansluiten

De zoom aanpassen met een objectiefcontroller

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de zoomknop om de zoom aan te passen.

Druk op de knop T (Tele) of W (Wide, breedbeeld) om de zoom aan te passen terwijl u het scherm in de gaten
houdt.
Als u wilt inzoomen, drukt u op de knop T.
Als u wilt uitzoomen, drukt u op de knop W.

1
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Een objectief met E-bevestiging kalibreren

Kalibratie corrigeert voor verschillen in zoompositie vanwege verschillen in individuele objectieven wanneer u een power-
zoomobjectief met E-bevestiging gebruikt.
Opdat de zoompositie correct kan worden berekend, kalibreert u op de volgende manier het objectief voor individuele
verschillen in het objectief.

Kalibratiegegevens
Er kunnen kalibratiegegevens voor maximaal vijf objectieven worden opgeslagen in het apparaat. De oudste
gegevens worden overschreven als u een 6e of verder objectief kalibreert.
U kunt controleren of er kalibratiegegevens beschikbaar zijn voor het bevestigde objectief door te drukken op de knop

 (Camerastatus) in het gemeenschappelijke deel van het webapp-scherm en [Lens] > [Calibration Data] te
selecteren.

5-041-957-73(1) Copyright 2022 Sony Corporation

Als het objectief een schakelaar SERVO/MANUAL heeft, zet die dan in de stand SERVO.

Opmerking

Het objectief kan geen zoomopdrachten ontvangen van het apparaat als de schakelaar op MANUAL staat.

1

Voer de kalibratie uit met [Technical] > [Lens] > [Lens Calibration] in het cameramenu.

Tijdens de kalibratie beweegt het zoomobjectief automatisch en wordt het gemeten.

2
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Zwenken/kantelen, zoompositie en scherpstellingsinstelling opslaan/herstellen met
de webapp

U kunt instellingen voor zwenken/kantelen, zoompositie en scherpstelling opslaan en desgewenst terugroepen met de
webapp (voorkeurspositie-functie).

Voor nadere informatie over de onderdelen die u kunt opslaan/herstellen raadpleegt u "Opgeslagen onderdelen in
voorkeuzes".

Opmerking

Een voorkeurspositie kan niet worden opgeslagen als de Clear Image Zoom-verhouding groter is dan 1×.

Als de instelling [Pan-Tilt] > [P/T Direction] [Ceiling] in het webmenu wordt gewijzigd, worden alle opgeslagen voorkeursposities
verwijderd.

Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Bepaal de positie die u wilt opslaan met zwenk-/kantel- en zoomacties.2

Druk op de knop [+] in het bedieningspaneel voor voorkeursposities.

Het beeld met de opgeslagen positie wordt weergegeven in het bedieningspaneel voor voorkeuzeposities.

Hint

Als het bedieningspaneel voor voorkeuzeposities niet wordt weergegeven, druk dan op de knop  (Openen) om het weer
te geven.

Posities worden op volgorde opgeslagen vanaf [Preset1].

3

151



Het herstellen van een voorkeurspositie annuleren
Druk op de knop  (Herstellen annuleren) die wordt weergegeven op het bedieningspaneel voor voorkeursposities
tijdens het herstellen van de voorkeurspositie als u het herstellen wilt annuleren. Gebruik de joystick en de schuifbalk
[Zoom] om het kader aan te passen.

Als er ongebruikte voorkeuzes zijn in een reeks voorkeuzes, worden de posities opgeslagen in de voorkeuzes die nog niet
in gebruik zijn. Als er bijvoorbeeld voorkeursposities zijn opgeslagen in [Preset1] en [Preset3] maar niet in [Preset2], dan
worden de volgende voorkeursposities opgeslagen in [Preset2] en vervolgens in [Preset4].

U kunt maximaal 100 voorkeursposities opslaan.

U kunt voorkeursposities een andere naam geven. Voor nadere informatie raadpleegt "Voorkeursposities hernoemen met
de webapp".

Herstel een opgeslagen positie.

Druk dubbel op het pictogram van de positie die u wilt herstellen in het bedieningspaneel voor voorkeuzeposities
om de bijbehorende positie te roepen.

Hint

U kunt een positie ook terugroepen door op het beeld te drukken, op de knop  (Voorkeurspositiemenu) te drukken die
verschijnt en [Recall] te selecteren.

De overgangssnelheid naar een opgeslagen positie wordt bepaald door de instelling [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] >
[Pan-Tilt Speed for Common] in het webmenu toen de positie werd opgeslagen. U kunt de overgangssnelheid ook wijzigen
na het opslaan. Voor nadere informatie raadpleegt u "De overgangssnelheid wijzigen
(zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie".

De mate van wijziging van de zwenk-/kantel-positie bij het bewegen naar een voorkeuze kan worden aangepast met de
instellingen voor overgangssnelheid en [Ramp Curve]. Voor nadere informatie raadpleegt u "De overgangssnelheid wijzigen
(zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeursposities" en "De bedieningsversnelling voor
zwenken/kantelen instellen".

Wanneer u een andere voorkeuze terugroept tijdens het afspelen, stopt de werking van de eerste teruggeroepen voorkeuze
en start de werking van de daarna teruggeroepen voorkeuze.

Opmerking

Als de temperatuur van de omgeving sterk is gewijzigd tussen het opslaan van een voorkeuze en het afspelen ervan,
kunnen er afwijkingen optreden in de kadrering.

Terwijl een voorkeurspositie wordt opgeslagen kunt u geen andere handelingen uitvoeren behalve het herstellen of
annuleren van de voorkeurspositie.

4
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Verwant onderwerp

Opgeslagen onderdelen in voorkeuzes

Voorkeursposities hernoemen met de webapp

De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie

De bedieningsversnelling voor zwenken/kantelen instellen
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153



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Voorkeursposities hernoemen met de webapp

U kunt opgeslagen voorkeursposities een andere naam geven.
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Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Druk op de voorkeurspositie die u wilt hernoemen.

De knop  (Voorkeurspositiemenu) verschijnt rechtsboven het beeld.

2

Druk op de knop  (Voorkeurspositiemenu) en selecteer [Rename] in het menu dat verschijnt.3

Voer een nieuwe naam voor de voorkeuze in.4
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Een opgeslagen voorkeurspositie vervangen door een nieuwe positie met de webapp

U kunt een opgeslagen voorkeurspositie vervangen door een nieuwe positie.
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Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Bepaal de positie die u wilt opslaan met zwenk-/kantel- en zoomacties.2

Druk op het beeld van de positie die u wilt vervangen in het bedieningspaneel voor voorkeuzeposities.

De knop  (Voorkeurspositiemenu) verschijnt rechtsboven het beeld.

3

Druk op de knop  (Voorkeurspositiemenu) en selecteer [Replace] in het menu dat verschijnt.

De nieuwe positie vervangt de huidige instelling.

4
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Een opgeslagen voorkeurspositie wissen met de webapp

U kunt opgeslagen voorkeursposities wissen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Druk op het beeld van de positie die u wilt verwijderen in het bedieningspaneel voor voorkeuzeposities.

De knop  (Voorkeurspositiemenu) verschijnt rechtsboven het beeld.

2

Druk op de knop  (Voorkeurspositiemenu) en selecteer [Delete] in het menu dat verschijnt.

De opgeslagen positie is verwijderd.

3
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Zwenken/kantelen en zoomen/scherpstellen synchroniseren bij het herstellen van een
voorkeurspositie

U kunt het zwenken/kantelen en het zoomen synchroniseren wanneer u een opgeslagen voorkeurspositie herstelt om het
kadreren soepeler te laten verlopen.

Hint

U kunt van tevoren de instellingen opgeven die worden gebruikt voor het vastleggen van een voorkeurspositie. Stel [Pan-Tilt] >
[P/T Preset] > [Default] > [Zoom Sync] in op [On] in het webmenu.

Wanneer [Pan-Tilt] > [P/T Preset] > [Speed Select] is ingesteld op [Common] worden alle posities hersteld met de snelheid die is
ingesteld met [Pan-Tilt] > [P/T Preset] > [Common Speed].

Wanneer het zoomen is voltooid, beweegt de camera naar de opgeslagen scherpstelpositie.

Nadat de beweging is voltooid, keert [AF Transition Speed] terug naar de oorspronkelijke instelling.

Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Druk op het beeld van de voorkeurspositie waarvoor u de overgangssnelheid wilt wijzigen.

De knop  (Voorkeurspositiemenu) verschijnt rechtsboven het beeld.

2

Druk op de knop  (Voorkeurspositiemenu) en selecteer [Edit…] in het menu dat verschijnt.

Het instelscherm voor de geselecteerde voorkeurspositie verschijnt.

3

Schuif de schakelaar [Zoom Sync] naar rechts om de functie in te schakelen en druk op de knop [OK].

De volgende keer dat een opgeslagen positie wordt hersteld, beweegt de camera met de geconfigureerde snelheid.

4
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De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het
herstellen van een voorkeurspositie

U kunt de overgangssnelheid wijzigen (zwenken/kantelen, zoomen, scherpstellen) wanneer u een opgeslagen vooraf
ingestelde positie herstelt.

Hint

Wanneer [Pan-Tilt] > [P/T Preset] > [Speed Select] is ingesteld op [Common] worden alle posities hersteld met de snelheid die is
ingesteld met [Pan-Tilt] > [P/T Preset] > [Common Speed].

Wanneer het zoomen is voltooid, beweegt de camera naar de opgeslagen scherpstelpositie.

Nadat de beweging is voltooid, keert [AF Transition Speed] terug naar de oorspronkelijke instelling.

Stel [Pan-Tilt] > [P/T Preset] > [Speed Select] in op [Separate] in het webmenu.1

Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

2

Druk op het beeld van de voorkeurspositie waarvoor u de overgangssnelheid wilt wijzigen.

De knop  (Voorkeurspositiemenu) verschijnt rechtsboven het beeld.

3

Druk op de knop  (Voorkeurspositiemenu) en selecteer [Edit…] in het menu dat verschijnt.

Het instelscherm voor de geselecteerde voorkeurspositie verschijnt.

4

Stel de overgangssnelheden (Zwenken/kantelen, zoomen, scherpstellen) in die u wilt wijzigen met de
schuifbalken of voer de waarden rechtstreeks in en druk op de knop [OK].

De volgende keer dat een opgeslagen positie wordt hersteld, beweegt de camera met de geconfigureerde snelheid.

5
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Zwenken/kantelen en zoompositie opslaan/herstellen met de meegeleverde
infraroodafstandsbediening

U kunt zwenken/kantelen en zoompositie opslaan en desgewenst terugroepen met de meegeleverde
infraroodafstandsbediening.

Verwant onderwerp
De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie

Pas zwenken/kantelen en zoom van de camera aan.1

Stel de PTZ-hulpmodus in op [Pos.] in de keuzelijst bovenaan het bedieningspaneel voor voorkeursposities
in de webapp.

2

Houd de knop PRESET ingedrukt en druk op een van de knoppen 1 t/m 3.

De positie is opgeslagen.

3

Herstel een opgeslagen positie.

Druk op een van de knoppen 1 - 3 om de betreffende voorkeurspositie te herstellen.

Hint

De overgangssnelheid bij het herstellen van een voorkeurspositie wordt bepaald door de opgeslagen waarde onder [Pan-
Tilt] > [P/T Preset] > [Pan-Tilt Speed] in het webmenu. U kunt de overgangssnelheid wijzigen na het opslaan van een
waarde. Voor nadere informatie raadpleegt u "De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij
het herstellen van een voorkeurspositie".

4
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Camera-kadreringshandelingen opnemen met de webapp

U kunt camera-kadreringshandelingen opnemen met de webapp.

Pas de startpositie van de camera aan.1

Stel de PTZ-hulpmodus in op [Trace] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

2

Druk op de knop [+] in het bedieningspaneel voor voorkeursposities.

Er wordt een pictogram toegevoegd en de camera schakelt naar opname-wachtstand.

Hint

3
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Hint

Tijdens de opnamen wordt de resterende opnametijd weergegeven bovenaan het camerabeeldpaneel.

Opmerking

De opgenomen kadreringshandelingen worden verwijderd als u naar plafondmontage overschakelt

Wisselen van systeemfrequentie kan leiden tot verwijderen van de opgenomen kadreringshandelingen.

Zoomen wordt niet opgenomen wanneer een objectiefcontroller is aangesloten.

De maximale tijdsduur voor het opnemen van één kadreringshandeling is 3 minuten. De opname stopt automatisch als de
opnameduur de 3 minuten bereikt.

Het opnemen van een kadreringshandeling kan niet worden gestart als de Clear Image Zoom-verhouding groter is dan 1×.

Als de camera wordt bediend vanaf een ander apparaat tijdens het opnemen van een kadreringshandeling, worden de
handelingen vanaf het andere apparaat ook opgenomen. Voor nadere informatie over het opnemen met een afstandsbediening
van een derde neemt u contact op met de betreffende fabrikant.

Scherpstellings- en beeldkwaliteitsinstellingen worden door deze functie niet opgenomen.

U kunt op de knop  (Sluiten) drukken op het pictogram om de opname-wachtstand te verlaten en terug te keren naar
normaal gebruik.

Start de kadreringshandeling met de joystick en de schuifbalk [Zoom].

De opname start vanaf het moment dat de kadreringshandeling begint.

4

Druk op de knop  (Opname stoppen) op het pictogram om de opname te stoppen.5
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De opgenomen zwenk-/kantel-/zoomhandelingen tijdens het opnemen van een kadreringshandeling kunnen bij het afspelen niet
exact worden gereproduceerd.

Als u na het opnemen van een kadreringshandeling de zwenk-/kantelbereiklimiet met [Pan-Tilt] > [P/T Range Limit] in het
webmenu instelt, wordt de zwenk-/kantelbereiklimiet niet toegepast tijdens het afspelen van de kadrering. Als u een
kadreringshandeling en de zwenk-/kantellimietfunctie tegelijkertijd wilt gebruiken, stel dan de zwenk-/kantelbereiklimiet in voordat
u de kadreringshandeling opneemt.

Opgenomen kadreringshandelingen kunnen niet worden afgespeeld als RAW-video-uitvoer is geselecteerd.

Opgenomen kadreringshandelingen kunnen niet worden afgespeeld als het videosignaal niet wordt uitgevoerd vanaf de SDI-
uitgang.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Camera-kadreringshandelingen afspelen met de webapp

U kunt camera-kadreringshandelingen afspelen met de webapp.

Stel de PTZ-hulpmodus in op [Trace] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Selecteer een pictogram met de kadreringshandeling die u wilt afspelen.

De knop  (Voorbereiden) verschijnt op het pictogram.

2

Druk op de knop  (Voorbereiden).

De camera beweegt naar de startpositie van de kadreringshandeling en schakelt naar afspelen-wachtstand.

3

Druk op de knop  (Afspelen) op het pictogram.4
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Hint

In afspelen-wachtstand en tijdens het afspelen kunt u het afspelen annuleren en terugkeren naar normaal gebruik door een van
de volgende handelingen uit te voeren.

Druk op de knop  (Stop) op het pictogram of in het bedieningspaneel voor voorkeursposities.
Gebruik de joystick.
Gebruik de schuifbalk [Zoom].

Tijdens de opnamen wordt de afspeeltijd die is verlopen weergegeven bovenaan het camerabeeldpaneel.

Opmerking

Onverwacht gedrag kan optreden als de Clear Image Zoom-instelling bij opname en afspelen van de kadreringshandeling
verschillend is.

Zoomen afspelen wordt niet ondersteund wanneer een objectiefcontroller is aangesloten. Gebruik van de zoom stopt het afspelen
van de kadreringshandeling.

Tijdens het afspelen van de kadreringshandeling heeft het wijzigen van de zwenk-/kantelbereiklimiet met [Pan-Tilt] > [P/T Range
Limit] in het webmenu geen effect. Stel dan de zwenk-/kantelbereiklimiet in voordat u de kadreringshandeling opneemt.

5-041-957-73(1) Copyright 2022 Sony Corporation

De kadreringshandeling wordt afgespeeld.
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Opgenomen camera-kadreringshandelingen verwijderen met de webapp

U kunt opgenomen camera-kadreringshandelingen verwijderen met de webapp.

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel de PTZ-hulpmodus in op [Trace] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

1

Selecteer een pictogram met de kadreringshandeling die u wilt verwijderen.

De knop  (Menu Volgen) verschijnt op het pictogram.

2

Druk op de knop  (Menu Volgen).

Het menu verschijnt.

3

Selecteer [Delete] in het weergegeven menu.

De geselecteerde kadreringshandeling wordt verwijderd.

4
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Camera-kadreringshandelingen opnemen met de meegeleverde
infraroodafstandsbediening

U kunt camera-kadreringshandelingen opnemen met de meegeleverde infraroodafstandsbediening.

Voor nadere informatie over het afspelen van een opgenomen kadreringshandeling raadpleegt u "Camera-
kadreringshandelingen afspelen met de meegeleverde infraroodafstandsbediening".

Opmerking

De maximale tijdsduur voor het opnemen van één kadreringshandeling is 3 minuten. De opname stopt automatisch als de
opnameduur de 3 minuten bereikt.

Als de camera wordt bediend vanaf een ander apparaat tijdens het opnemen van een kadreringshandeling, worden de
handelingen vanaf het andere apparaat ook opgenomen als onderdeel van de kadreringshandeling.

Als u de beeldkwaliteit aanpast tijdens het opnemen van een kadreringshandeling, wordt die wijziging niet opgenomen.

Verwant onderwerp

Camera-kadreringshandelingen afspelen met de meegeleverde infraroodafstandsbediening

5-041-957-73(1) Copyright 2022 Sony Corporation

Open het live-bedieningsscherm van de webapp.1

Stel de PTZ-hulpmodus in op [Trace] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

2

Pas de startpositie van de camera aan met de infraroodafstandsbediening.3

Houd de knop PRESET ingedrukt en druk op een van de knoppen POSITION1 t/m 3.

De camera schakelt naar opname-wachtstand.

4

Voer de kadreringshandeling uit die u wilt opnemen.5

Om de opname te stoppen houdt u de knop PRESET ingedrukt en drukt u op de POSITION-knop die u bij
stap 4 had geselecteerd.

6
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Camera-kadreringshandelingen afspelen met de meegeleverde
infraroodafstandsbediening

U kunt opgenomen camera-kadreringshandelingen afspelen met de meegeleverde infraroodafstandsbediening.

Opmerking

Door de camera te zwenken/kantelen/zoomen stopt u het afspelen.

Verwant onderwerp

Camera-kadreringshandelingen opnemen met de meegeleverde infraroodafstandsbediening
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Open het live-bedieningsscherm van de webapp.1

Stel de PTZ-hulpmodus in op [Trace] in de keuzelijst bovenaan het bedieningspaneel voor
voorkeursposities.

2

Selecteer en druk op een van de knoppen POSITION1 t/m 3 waarvoor u een kadreringshandeling hebt
opgenomen.

De zwenk-/kantel-/zoomposities van de camera bewegen naar de startpositie voor afspelen.

3

Nadat de camera naar de startpositie voor afspelen is gegaan, drukt u nogmaals op dezelfde POSITION-
knop.

Het afspelen start.

4
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Het aanpassingsscherm voor scherpstelling

U past de scherpstelling aan met de volgende onderdelen van het live-bedieningsscherm.

5-041-957-73(1) Copyright 2022 Sony Corporation

Camerabeeldpaneel
U kunt de scherpstelling aanpassen door het camerabeeld aan te raken. U kunt aanraakbediening uitschakelen in de
webapp met de schakelaar [Touch Focus] op het tabblad  (Focus) in het camerabedieningspaneel.

1.

Camerabedieningspaneel – Tabblad  (Focus)2.

GUI-bedieningspaneel3.

171



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Handmatig aanpassen met de webapp

U kunt de scherpstelling handmatig aanpassen, in bijvoorbeeld de volgende gevallen.

Onderwerpen die deels zijn verborgen door waterdruppels
Onderwerpen met weinig contrast tegen een achtergrond
Onderwerpen die zich verder weg bevinden dan de onderwerpen op de voorgrond

Opmerking

Handmatig scherpstellen kan niet worden geregeld vanuit de webapp als u aan het zoomen bent.

Hint

U kunt automatische scherpstelling ook gebruiken als handmatige aanpassing de hoofdmethode voor bediening is. Voor nadere
informatie raadpleegt u "Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp".

Verwant onderwerp

De objectiefschakelaars controleren

Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp
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Als het objectief is uitgerust met een focus-keuzeschakelaar, zet de schakelaar dan op de stand "AF/MF" of
"AF".

Opmerking

Als de schakelaar is ingesteld op de stand "Full MF" of "MF", kan het scherpstellen van het objectief niet worden bediend
vanaf het apparaat. Raadpleeg "Voor een objectief met een scherpstelmodusschakelaar" onder "De objectiefschakelaars
controleren".

1

Schuif de schakelaar [Auto Focus] naar links in het bedieningspaneel om automatische scherpstelling uit te
schakelen.

De handmatige scherpstelmodus is ingeschakeld.

 (MF)

2

Pas aan met de schuifbalk onderaan het tabblad  (Focus).3
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Handmatig aanpassen met de meegeleverde infraroodafstandsbediening

U kunt de scherpstelling handmatig aanpassen met de meegeleverde infraroodafstandsbediening.

Hint

U kunt automatische scherpstelling ook gebruiken als handmatige aanpassing de hoofdmethode voor bediening is. Voor
nadereinformatie raadpleegt u "Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde
infraroodafstandsbediening".

Verwant onderwerp

Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde infraroodafstandsbediening
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Druk op de knop MF op de infraroodafstandsbediening.1

Pas de scherpstelling handmatig aan met de knoppen F (Far, ver weg) en N (Near, nabij).

Wilt u scherpstellen op een ver verwijderd onderwerp, druk dan op de knop F.
Wilt u scherpstellen op een onderwerp dichtbij, druk dan op de knop N.

2
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Scherpstellen door een scherpstelpositie op te geven ("Spot Focus")

In handmatige scherpstelmodus kunt u de plek aangeven waarop u wilt scherpstellen in het camerabeeldpaneel.

Opmerking

De functie Spot Focus werkt niet als het objectief is ingesteld op handmatige scherpstelling.

Hint

In de modus Spot Focus kunt u drukken op een toewijsbare knop waaraan [Push AF/MF] is toegewezen om tijdelijk Spot Focus te
stoppen en automatisch scherpstellen in te schakelen voor zolang als u de knop ingedrukt houdt. De scherpstelling gaat terug
naar handmatige scherpstelling als u de knop loslaat.
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Stel [Shooting] > [Focus] > [Touch Function in MF] in op [Spot Focus] in het webmenu of cameramenu.1

Schuif de schakelaar [Touch Focus] op het tabblad  (Focus) naar rechts om dit in te schakelen.2

Schuif de schakelaar [Auto Focus] op het tabblad  (Focus) naar links om dit uit te schakelen.3

Geeft het scherpstelpositie aan.

De scherpstellingsmarkering verschijnt en het beeld wordt zo aangepast dat die plek is scherpgesteld.

Voorbeeld van positie aangeven door aanraken

4
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Automatische scherpstelling tijdelijk gebruiken (Push Auto Focus (AF))

In handmatige scherpstelmodus kunt u de scherpstelling tijdelijk aanpassen met automatische scherpstelling door te
drukken op de knop [Push AF/MF].
Dit is nuttig als u de scherpstelling langzaam van het ene naar het andere onderwerp wilt verplaatsen tijdens handmatige
scherpstelling.

Opmerking

De functie scherpstelling door knop indrukken werkt niet als het objectief is ingesteld op handmatige scherpstelling.

Hint

Dezelfde handeling wordt ondersteund bij het gebruik van een toewijsbare knop die is toegewezen aan [Push AF/MF].
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Stel [Shooting] > [Focus] > [Push AF Mode] in op [AF] in het cameramenu.1

Schuif de schakelaar [Auto Focus] op het tabblad  (Focus) naar links om dit uit te schakelen.2

Druk op de knop [Push AF/MF].

Automatische scherpstelling is actief zolang de knop wordt ingedrukt.

De scherpstelling door knop indrukken gaat terug naar handmatige scherpstelling als u de knop loslaat.

3
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Eenmalig automatische scherpstelling gebruiken (Push Auto Focus (AF-S))

Druk in de modus handmatige scherpstelling op de knop [Push AF/MF] om automatisch met hoge snelheid scherp te
stellen.
Deze functie is handig wanneer u op een onderwerp scherpstelt voordat u begint met filmen.

Opmerking

De functie scherpstelling door knop indrukken werkt niet als het objectief is ingesteld op handmatige scherpstelling.

Het scherpstelkader is niet verborgen als de knop [Display] wordt gebruikt.

Stel [Shooting] > [Focus] > [Push AF Mode] in op [Single-shot AF(AF-S)] in het webmenu of cameramenu.1

Geef de positie aan waarvoor u de scherpstelling wilt aanpassen met [Shooting] > [Focus] > [Focus Area
(AF-S)] in het cameramenu.

Hint

U kunt deze positie wijzigen door op een toewijsbare knop te drukken waaraan [Focus Setting] is toegewezen; er verschijnt
een oranje kader rond het scherpstellingsgebied en u kunt een positie selecteren door aanraken.

2

Schuif de schakelaar [Auto Focus] op het tabblad  (Focus) naar links om dit uit te schakelen.3

Druk op de knop [Push AF/MF].

Als u de knop loslaat voordat het scherpstellen voltooid is, stopt het automatisch scherpstellen door knop indrukken.

Tijdens scherpstellen door knop indrukken wordt de scherpstellingsstatus weergegeven door de
scherpstellingsindicator.
Aan: de scherpstelling is gefixeerd op de scherpstellingspositie.
Knippert: onscherp. Omdat het apparaat niet automatisch scherpstelt, wijzigt u de compositie en
scherpstellingsinstellingen om scherpstelling te bereiken.
De scherpstelling gaat terug naar handmatige scherpstelling als u de knop loslaat.

4
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Tijdens Clear Image Zoom kunt u de kaderpositie voor [Focus Area (AF-S)] niet instellen. Tijdens scherpstellen door knop
indrukken geeft AF bovendien voorrang aan het gebied midden in het scherm.

Hint

Dezelfde handeling wordt ondersteund bij het gebruik van een toewijsbare knop die is toegewezen aan [Push AF/MF].

U kunt ook [Push AF Mode] aan een toewijsbare knop toewijzen.

U kunt ook [Focus Area (AF-S)] aan een toewijsbare knop toewijzen.

U kunt het scherpstellingsgebied weergeven of verbergen met [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] in het
cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Automatisch aanpassen met de webapp

Het apparaat gebruikt fasedetectie-AF voor scherpstelling op hoge snelheid en contrast-AF voor scherpstelling met hoge
nauwkeurigheid.
De combinatie van deze twee AF-methodes zorgt voor automatische scherpstelling met hoge snelheid en hoge
nauwkeurigheid.

Opmerking

Een objectief dat automatische scherpstelling ondersteunt is vereist.

Nauwkeurigheid kan mogelijk niet worden bereikt, afhankelijk van de condities waarin wordt gefilmd.

De scherpstelling kan niet automatisch worden aangepast op een objectief met A-bevestiging.

Hint

Tijdens automatische scherpstelmodus kunt u de scherpstelling aanpassen met de schuifbalk Focus in het
camerabedieningspaneel. Voor nadere informatie raadpleegt u "Het onderwerp voor automatische scherpstelling handmatig
instellen (AF assist) met de webapp".

Verwant onderwerp
De objectiefschakelaars controleren

Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp

5-041-957-73(1) Copyright 2022 Sony Corporation

Als het objectief is uitgerust met een focus-keuzeschakelaar, zet de schakelaar dan op de stand "AF/MF" of
"AF".

Opmerking

Als de schakelaar is ingesteld op de stand "Full MF" of "MF", kan het scherpstellen van het objectief niet worden bediend
vanaf het apparaat. Raadpleeg "Voor een objectief met een scherpstelmodusschakelaar" onder "De objectiefschakelaars
controleren".

1

Schuif de schakelaar [Auto Focus] naar rechts in het camerabedieningspaneel om dit in te schakelen.

De automatische scherpstelmodus is ingeschakeld.

 (AF)

2

178



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatisch aanpassen met de meegeleverde infraroodafstandsbediening

U kunt de scherpstelling automatisch aanpassen met de meegeleverde infraroodafstandsbediening.

Opmerking

U kunt automatische scherpstelling ook gebruiken als handmatige aanpassing de hoofdmethode voor bediening is. Voor
nadereinformatie raadpleegt u "Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde
infraroodafstandsbediening".

Verwant onderwerp

Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde infraroodafstandsbediening

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de knop AF op de infraroodafstandsbediening.

De scherpstelling van het onderwerp wordt automatisch aangepast.

1
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Het gebied of de positie van automatische scherpstelling instellen (Focus Area)

U kunt het doelgebied voor automatische scherpstelling instellen en de scherpstelling aanpassen voor dat gebied.

Druk op de knop [Menu] in het GUI-bedieningspaneel om het cameramenu te openen.1

Stel het doelgebied voor automatische scherpstelling in met [Shooting] > [Focus] > [Focus Area] in het
cameramenu.

[Wide]:
Zoekt bij scherpstellen naar een onderwerp in een brede hoek in het beeld. Er wordt geen kader weergegeven.

[Zone]:
Zoekt automatisch een scherpstellingspositie binnen de opgegeven zone.
Na het selecteren geeft u de positie op met de pijlknoppen in het GUI-bedieningspaneel.

U kunt terugkeren naar de middenpositie door de schakelaar [Set] ingedrukt te houden.
[Flexible Spot]:
Richt zich op een specifieke positie op het beeld.

2
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Opmerking

Het scherpstelkader is niet verborgen als de knop [Display] in het camerabeeldpaneel wordt gebruikt.

Tijdens Clear Image Zoom wordt het scherpstellingsgebied ingesteld op [Wide] (vast).

Hint

U kunt het scherpstellingsgebied weergeven of verbergen met [Monitoring] > [Display On/Off] > [Focus Area Indicator] in het
cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation

Na het selecteren geeft u de positie op met de pijlknoppen in het GUI-bedieningspaneel.

U kunt terugkeren naar de middenpositie door de schakelaar [Set] ingedrukt te houden.
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Het scherpstellingsgebied snel wijzigen (Focus Setting)

U kunt de positie en de grootte van het automatische scherpstellingsgebied snel wijzigen tijdens het filmen door [Focus
Setting] aan een toewijsbare knop toe te wijzen.

Voor nadere informatie over toewijsbare knoppen raadpleegt u "Toewijsbare knoppen".

De werking varieert afhankelijk van de instelling voor het scherpstellingsgebied.

Wanneer [Shooting] > [Focus] > [Focus Area] is ingesteld op [Flexible Spot] of [Zone] in het
cameramenu

U kunt de positie van het scherpstellingsgebied wijzigen door op een toewijsbare knop te drukken waaraan [Focus
Setting] is toegewezen en aanpassen met de pijlknoppen in het GUI-bedieningspaneel. U kunt de positie van het
scherpstellingsgebied naar het midden terugbrengen tijdens het aanpassen van de positie door op de knop [Set] te
drukken.
U kunt de grootte van het scherpstellingsgebied wijzigen door een toewijsbare knop ingedrukt te houden waaraan
[Focus Setting] is toegewezen. Na het wijzigen van de grootte kunt u de positie van het scherpstellingsgebied
wijzigen door op de knop [Set] te drukken. Druk als u klaar bent op de toewijsbare knop waaraan [Focus Setting] is
toegewezen om naar het oorspronkelijke scherm terug te keren.

Wanneer [Shooting] > [Focus] > [Focus Area] is ingesteld op [Wide] in het cameramenu

U kunt alleen de grootte van het scherpstellingsgebied wijzigen door een toewijsbare knop ingedrukt te houden waaraan
[Focus Setting] is toegewezen. De positie kan ook worden gewijzigd door eerst het type te veranderen naar [Flexible
Spot] of [Zone].

Hint

Wanneer zowel [Shooting] > [Focus] > [Push AF Mode] is ingesteld op [Single-shot AF(AF-S)] in het cameramenu en de
schakelaar [Auto Focus] in de uit-stand staat (handmatige scherpstelmodus), kunt u het scherpstellingsgebied [Focus Area (AF-
S)] wijzigen.

Het scherpstellingskader wordt oranje weergegeven als de positie van het scherpstellingsgebied kan worden gewijzigd.

Verwant onderwerp
Toewijsbare knoppen

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het scherpstelkader verplaatsen met aanraakbediening (scherpstellingsgebied)

U kunt de positie van het scherpstellingsgebied wijzigen door op een toewijsbare knop te drukken [Focus Setting] is
toegewezen om de weergave van het scherpstellingsgebied te wijzigen in oranje en vervolgens het scherpstellingskader
te verplaatsen met aanraakbediening in het camerabeeldpaneel.
Tip op het scherm om het scherpstellingsgebied te verplaatsen met de scherpstelling gecentreerd op de aangetikte
positie. Sleep over het scherm om het scherpstellingsgebied te verplaatsen naar de positie die uw vinger volgt.

Hint

U kunt het scherpstellingsgebied in- of uitschakelen op het opnamescherm met een toewijsbare knop waaraan [Focus Setting] is
toegewezen.

Tik op een willekeurige plaats.

De plaats waar u tikt, wordt het midden van het scherpstellingsgebied.

1

Sleep om het scherpstellingsgebied te verplaatsen, waarbij het uw vingerpositie volgt.2
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Opmerking

Als u op een plaats tikt of het scherpstellingsgebied naar een positie sleept die buiten het instelbereik ligt, wordt het
scherpstellingsgebied ingesteld op de boven-/onder-/linker of rechterkant van het instelbereik.

Deze functie is niet beschikbaar in de volgende gevallen.

Wanneer de schakelaar [Touch Focus] uitgeschakeld is in het bedieningspaneel
Wanneer het scherpstellingsgebied grijs wordt weergegeven of helemaal niet wordt weergegeven

5-041-957-73(1) Copyright 2022 Sony Corporation
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De automatische scherpstelactie aanpassen (AF-overgangssnelheid, AF-gevoeligheid
onderwerpverplaatsing)

U kunt de werking van de automatische scherpstelling aanpassen door de overgangssnelheid en de gevoeligheid voor
onderwerpverplaatsing te wijzigen.

De AF-overgangssnelheid instellen

U kunt de snelheid van de scherpstelmotor voor als het onderwerp verandert instellen met de knop [AF Transition Speed]
in het bedieningspaneel.

Selecteer de snelheid binnen het bereik [Speed 1] (Langzaam) tot [Speed 7] (Snel) in stappen van 1. Druk op de knop <
om de waarde te verlagen (langzamer) of op de knop > om de waarde te verhogen (sneller).
Als dit is ingesteld op lage snelheid, verandert de scherpstelling langzaam als het scherp te stellen onderwerp wijzigt,
waardoor indrukwekkende beelden kunnen worden gemaakt.
Als dit is ingesteld op hoge snelheid wisselt de scherpstelling tussen onderwerpen snel. In onderstaand voorbeeld wijzigt
de scherpstelling snel van het gebouw op de achtergrond naar de wandelende persoon op de voorgrond. Er wordt
onmiddellijk scherpgesteld op het onderwerp dat het frame binnenkomt, waardoor dit ideaal is voor het filmen van
documentaires, waarbij snel scherpstellen vereist is.

AF-gevoeligheid voor objectverplaatsing

U kunt de gevoeligheid voor het overschakelen tussen onderwerpen instellen met de knop [AF Subj. Shift Sens.] in het
camerabedieningspaneel.
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Selecteer de gevoeligheid binnen het bereik [Sens 1] (Vergrendeld) tot [Sens 5] (Snel reagerend) in stappen van 1. Druk
op de knop < om de waarde te verlagen (langzaam wijzigen) of op de knop > om de waarde te verhogen (snel wijzigen).
Ingesteld op een lage gevoeligheid verandert de scherpte niet direct, zelfs als er een ander onderwerp vóór het
scherpgestelde onderwerp komt.

Ingesteld op een hoge gevoeligheid reageert de scherpstelling direct op het onderwerp dat naar de voorgrond gaat.

Hint

Als [AF Speed/Sens.] is toegewezen aan een toewijsbare knop, worden de niveausegmenten voor instellen van waarden in het
camerabeeldpaneel in de volgende volgorde weergegeven, elke keer als de knop wordt ingedrukt. Hiermee kunt u de instellingen
voor AF-overgangssnelheid en AF-gevoeligheid voor objectverplaatsing wijzigen.
AF-overgangssnelheid →-AF-gevoeligheid voor objectverplaatsing → Geen weergave …

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met
de webapp

Als u de scherpstelling handmatig hebt verplaatst en aangepast, kunt u de scherpstelregeling overdragen aan de
automatische scherpstelling voor nadere aanpassing van de scherpstelling.

Opmerking

In de modus AF Assist is het verplaatsen van de scherpstelling lastig, ongeacht de instelling [Shooting] > [Focus] > [AF Subj. Shift
Sens.] in het cameramenu.

De AF assistentiestaat wordt geannuleerd door het volgende.

Als het onderwerp waarop u met de schuifbalk [Focus] hebt scherpgesteld niet langer zichtbaar is
Bij het overschakelen naar handmatige scherpstelling
Wanneer AF-volgen in echttijd is gestart

Hint

Stel [Shooting] > [Focus] > [AF Assist] in op [On] in het cameramenu.1

Stel [Shooting] > [Focus] > [AF Assist Control] in op [On] in het webmenu.2

Schuif de schakelaar [Auto Focus] naar rechts in het camerabedieningspaneel om dit in te schakelen.

De automatische scherpstelmodus is ingeschakeld.

3

Stel het doelgebied voor scherpstelling in met de schuifbalk [Focus] in het camerabedieningspaneel.

[Near]: scherpgesteld op een onderwerp dichterbij.
[Far]: scherpgesteld op een onderwerp verder weg.

In de modus AF Assist wordt automatisch scherpgesteld op een onderwerp op de afstand die is ingesteld met de
schuifbalk [Focus].

4
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De modus AF Assist kan snel worden geannuleerd door een toewijsbare knop te gebruiken waaraan [Push AF/MF] is
toegewezen.

AF volgen in echttijd stopt wanneer u de schuifbalk [Focus] gebruikt.

In de modus Face/Eye Only AF stelt de automatische scherpstelling scherp op het gezicht dat zich het dichtst bij de
scherpstelpositie van de schuifbalk [Focus] bevindt.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Handmatig scherpstellen tijdens automatische scherpstelmodus met de
meegeleverde infraroodafstandsbediening

Wanneer [Shooting] > [Focus] > [AF Assist] is ingesteld op [On] in het cameramenu, kunt u de knoppen F (Veraf) en N
(Dichtbij) gebruiken op de meegeleverde infraroodafstandsbediening om zelfs tijdens automatische scherpstelmodus de
scherpstelling op een onderwerp aan te passen.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Handmatige scherpstelling tijdelijk gebruiken tijdens automatische scherpstelmodus
(Push Manual Focus)

Druk op de knop [Push AF/MF] tijdens automatische scherpstelmodus als u handmatig wilt scherpstellen terwijl de knop
is ingedrukt. De scherpstelling gaat terug naar automatische scherpstelling als u de knop loslaat.
Hiermee kunt u tijdelijk automatische scherpstelling stoppen en handmatig scherpstellen als er iets anders dan het
onderwerp van het filmen voor het onderwerp passeert.

Hint

Dezelfde handeling wordt ondersteund bij het gebruik van een toewijsbare knop die is toegewezen aan [Push AF/MF].

5-041-957-73(1) Copyright 2022 Sony Corporation
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Volgen met behulp van gezichts-/ogendetectie (Face/Eye Detection AF)

Het apparaat kan gezichten en ogen van mensen detecteren als volgobject en vervolgens de scherpstelling aanpassen
op de gezichten en ogen binnen het scherpstellingsgebied.
Als er gezichten worden gedetecteerd, worden grijze gezichts-/ogendetectiekaders weergegeven. Als automatisch
scherpstellen mogelijk is, worden de kaders wit en start het volgen. Als er ogen worden gedetecteerd en de
scherpstelling wordt aangepast, wordt het gezichts-/ogendetectiekader weergegeven op de ogen. Als er meerdere
personen worden gedetecteerd, wordt het hoofdonderwerp automatisch bepaald.
Deze functie is alleen beschikbaar als de AF-modus als scherpstellingsmodus wordt gebruikt of tijdens scherpstelling
door knop indrukken.

Hint

Als het scherpstellingsgebied is ingesteld op [Zone] of [Flexible Spot] en gezichten of ogen overlappen in het specifieke
scherpstellingsgebied, worden de gezichts-/ogendetectiekaders wit en stelt het apparaat automatisch scherp op deze
gezichten/ogen.

Als scherpstelling door knop indrukken (AF-S) wordt gebruikt, worden de gezichts-/ogendetectiekaders groen voor de gezichten
en ogen waarop is scherpgesteld.

Stel het doelgebied voor scherpstelling in met de knop [Face/Eye Detection AF] in het
camerabedieningspaneel

Druk op de knop [Face/Eye Detection AF] en stel de gezichts-/ogendetectie-AF-functie in.

[Face/Eye Only AF]: de camera detecteert de gezichten/ogen van onderwerpen (mensen) en volgt en stelt scherp op
alleen hun gezichten/ogen. Als er geen gezicht of oog wordt gedetecteerd, wordt AF tijdelijk gestopt en wordt het
pictogram  (Modus Face/Eye Only AF voor automatische scherpstelling gepauzeerd) weergegeven. Deze modus is
effectief als u alleen wilt volgen en scherpstellen op gezichten/ogen.
[Face/Eye Priority AF]: de camera detecteert de gezichten/ogen van onderwerpen (mensen) en geeft voorrang aan het
volgen/scherpstellen op de gezichten/ogen. Als er geen gezicht of oog wordt gedetecteerd, vindt scherpstellen plaats in
AF-modus (standaardinstelling).
[AF]: de functie gezichts-/ogendetectie AF is uitgeschakeld.

Opmerking

Tijdens werking van scherpstellen door knop indrukken wordt [Face/Eye Priority AF] ingeschakeld, zelfs als [Face/Eye Only AF]
momenteel is geselecteerd.
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Als de schakelaar [Auto Focus] in de uit-stand staat, is gezichts-/ogendetectie AF uitgeschakeld (behalve tijdens automatisch
scherpstellen door knop indrukken).

Als u de camcorder uitschakelt terwijl [Face/Eye Only AF] is geselecteerd, schakelt de modus automatisch over naar [Face/Eye
Priority AF] als de camcorder de volgende keer weer wordt ingeschakeld.

Hint

U kunt de functie gezichts-/ogendetectie AF instellen met [Shooting] > [Focus] > [Face/Eye Detection AF] in het cameramenu.

De gezichts-/ogendetectiekaders verbergen
U kunt gezichts-/ogendetectiekaders weergeven of verbergen met [Monitoring] > [Display On/Off] > [Face/Eye Detection
Frame] in het cameramenu.

Opmerking

Groene gezichts-/ogendetectiekaders worden weergegeven voor gezichten en ogen die zijn scherpgesteld met scherpstellen
door knop indrukken (AF-S) en worden niet verborgen met de knop [Display] of als [Face/Eye Detection Frame] is ingesteld op
[Off].

De functie gezichts-/ogendetectie AF in- of uitschakelen met een toewijsbare knop
Wijs [Face/Eye Detection AF] toe aan een toewijsbare knop. U kunt dan met elke druk op de knop de werking van
gezichts-/ogendetectie AF omschakelen in de volgorde [Face/Eye Priority AF], [Face/Eye Only AF] en [AF].

Instellen in het hoofdmenu

U kunt de functie gezichts-/ogendetectie AF ook instellen in het hoofdmenu.

Voor nadere informatie over het rechtstreekse menu raadpleegt u "Handelingen directmenu".

Verwant onderwerp
Handelingen directmenu

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een bepaald onderwerp volgen (AF-volgen in echttijd)

U kunt blijven scherpstellen op een onderwerp door het onderwerp op te geven door aanraken of door een kader voor
gezichtsherkenning te selecteren in het bedieningspaneel.
Wanneer een onderwerp is geselecteerd, wordt een wit kader weergegeven en start het volgen.

Hint

Het volgen gebeurt over het hele beeldgebied, ongeacht de instelling voor automatisch scherpstellen.

Wanneer [Shooting] > [Focus] > [Touch Function in MF] is ingesteld op [Tracking AF] in het webmenu of cameramenu, wordt AF-
volgen in echttijd ondersteund, zelfs als de scherpstelmodus MF is.

De volgende handelingen worden uitgevoerd op het volgobject, afhankelijk van de modus voor AF met
gezichts-/ogendetectie.

[Face/Eye Only AF] of [Face/Eye Priority AF]: het opgegeven onderwerp wordt gevolgd en er wordt op scherpgesteld.
Als het volgobject een persoon is en een gezicht of ogen worden gedetecteerd, stelt de camera scherp op dat gezicht /
die ogen.
Wanneer een gezicht/ogen voor volgen wordt gedetecteerd, wordt het gezicht voor volgen opgeslagen. Eenmaal
opgeslagen, wordt  (pictogram opgeslagen gezicht voor volgen) weergegeven.

Opmerking

Als u AF-volgen start tijdens handmatig scherpstellen, wordt het gezicht voor volgen niet opgeslagen.

[AF]: gebruik dit om op een bepaald onderwerp scherp te stellen en dit te volgen. Gezicht/ogen worden niet
gedetecteerd, zelfs niet als het volgobject een persoon is.

Opmerking

De functie AF-volgen in echttijd werkt niet als het objectief is ingesteld op handmatige scherpstelling.

AF-volgen in echttijd starten

Wanneer u een bepaald onderwerp hebt aangegeven als volgobject, start het volgen van dat onderwerp.
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Opgeven door aanraken
Zet de schakelaar [Touch Focus] op het tabblad  (Focus) in het camerabedieningspaneel naar rechts om dit in te
schakelen en tik dan op het doelonderwerp om dit te volgen in een van de volgende statussen.

Tijdens handmatig scherpstellen of tijdens handmatig scherpstellen door indrukken, en wanneer [Shooting] >
[Focus] > [Touch Function in MF] is ingesteld op [Tracking AF] in het webmenu of cameramenu
Tijdens automatische scherpstelling of tijdens automatisch scherpstellen door knop indrukken (AF)

Opgeven door selectie van een kader voor gezichtsherkenning
Verplaats de gezichtsselectiecursor (oranje onderstreept) naar het volgobject met de pijlknoppen in het GUI-
bedieningspaneel en druk op de knop [Set].

A: gezichtsdetectiekaders (grijs)
B: volgkader
C: gezichtsselectiekader (oranje)

Opmerking

Tijdens handmatig scherpstellen kunt u het volgen niet starten door een kader voor gezichtsherkenning te selecteren.

Hint

U kunt het volgobject ook wijzigen om dit te volgen tijdens AF-volgen in echttijd.

AF-volgen in echttijd stoppen

Druk op de knop  (Stop AF-volgen in echttijd).

Hint

AF-volgen in echttijd stopt in de volgende gevallen:

Wanneer u de schakelaar [Auto Focus] of de knop AUTO/ MANUAL op het objectief gebruikt
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Wanneer u de scherpstelmodus wijzigt
Wanneer u AF Assist uitvoert
Wanneer u de instelling voor het scherpstellingsgebied of de handeling voor gezichts-/ogendetectie met AF wijzigt
Wanneer u een toewijsbare knop indrukt die is toegewezen aan [Push AF/MF]
Wanneer het volgobject zich niet binnen het opnamevenster bevindt of wanneer het onderwerp meerdere seconden lang
onscherp is

Wanneer u een gezicht voor volgen opslaat (wanneer het pictogram  (Opgeslagen gezicht voor volgen) wordt weergegeven),
gaat AF-volgen in echttijd weer verder wanneer het opgeslagen gezicht voor volgen weer in beeld komt. U wist het gezicht voor
volgen door AF-volgen in echttijd te stoppen, zoals hierboven is beschreven.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het aanpassingsscherm voor helderheid

U kunt de helderheid aanpassen door het diafragma, de versterking en de sluitertijd in te stellen en door het lichtniveau
met ND-filters aan te passen in de volgende bedieningspanelen van het live-bedieningsscherm in de webapp. U kunt de
helderheid ook automatisch aanpassen.

Opmerking

De versterking kan niet worden aangepast wanneer [Shooting Mode] is ingesteld op [Cine EI Quick] of [Cine EI]. De helderheid
kan dus niet automatisch met de sluitertijd worden aangepast wanneer ingesteld op [Cine EI Quick] of [Cine EI]. Automatische
helderheidsaanpassing met het diafragma en ND-Filter wordt ondersteund.

Hint

Camerabedieningspaneel – Tabblad  (Main)1.

Deelvenster Basisconfiguratie van de camera
Hier vindt u instelstatus van basisfuncties die vereist zijn voor filmen op knoppen. Druk op een knop om het
bijbehorende instelscherm weer te geven voor de diverse functies in het aanpassingspaneel voor basisconfiguratie
van de camera hieronder.

2.

Deelvenster voor aanpassing van de basisconfiguratie van de camera
Geeft het aanpassingspaneel voor het instelonderwerp weer dat is geselecteerd in het basisconfiguratiepaneel van
de camera.

3.
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Cine EI is een modus voor filmen met een basisgevoeligheid zonder versterking om de prestaties van de beeldsensor te
maximaliseren. U past de helderheid aan met de belichting en het ND-filter om de hoeveelheid licht aan te passen die de
beeldsensor bereikt. Voor nadere informatie over Exposure Index (EI) raadpleegt u "De verdeling van donkere en lichte gebieden
in het opgenomen beeld wijzigen".

Verwant onderwerp

De verdeling van donkere en lichte gebieden in het opgenomen beeld wijzigen

5-041-957-73(1) Copyright 2022 Sony Corporation
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De basisgevoeligheid instellen

U kunt de basisgevoeligheid instellen voordat u met filmen start om de helderheid aan te passen.

Als [Shooting Mode] is ingesteld op [Custom]

Druk op de knop [ISO/Gain] in het basisconfiguratiepaneel van de camera en stel [Base Sensitivity] in het
aanpassingspaneel voor ISO/versterking in op [High] of [Low].
Selecteer [Low] bij normale lichtomstandigheden en selecteer [High] bij weinig licht.
Scherm wanneer [AGC] is uitgeschakeld

Scherm wanneer [AGC] is ingeschakeld

Als [Shooting Mode] is ingesteld op [Flexible ISO] of [Cine EI]

Druk op de knop [Base ISO/Exposure Index] in het basisconfiguratiepaneel van de camera en stel [Base ISO] in het
aanpassingspaneel Base ISO/Exposure Index in op [ISO 12800] of [ISO 800].
Selecteer [ISO 800] bij normale lichtomstandigheden en selecteer [ISO 12800] bij weinig licht.

Hint
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U kunt dit ook instellen op het tabblad  (Main) in het camerabedieningspaneel.

U kunt dit ook instellen met [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] of [Base ISO] in het cameramenu.

U kunt ook [Base ISO/Sensitivity] aan een toewijsbare knop toewijzen.

In de opnamemodus [Cine EI Quick] wordt de basisgevoeligheid automatisch ingesteld op basis van de Exposure Index-instelling.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het doelniveau voor automatische helderheidsaanpassing instellen

Het doelniveau voor automatische helderheidsaanpassing wordt ingesteld met de schuifbalk [AE Level] in het
camerabedieningspaneel.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op het tabblad  (Main) in het camerabedieningspaneel.

Als de schuifbalk [AE Level] niet wordt weergegeven, selecteer dan een van de twee schuifbalkkeuzeknoppen en
selecteer de schuifbalk [AE Level] in de lijst.

De schuifbalk [AE Level] verschijnt.

1

Stel het doelniveau in met de schuifbalk.

Beweeg de schuifknop naar links om het beeld donkerder te maken. Beweeg de schuifknop naar rechts om het
beeld helderder te maken.

Hint

U kunt dit ook instellen met [Shooting] > [Auto Exposure] > [Level] in het cameramenu.

2
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Het diafragma automatisch aanpassen

U kunt de helderheid automatisch aanpassen aan de hand van het onderwerp. Een compatibel objectief is vereist.

Opmerking

Het diafragma kan niet automatisch worden aangepast op een objectief met A-bevestiging.

Hint

U kunt ook [Auto Iris] aan een toewijsbare knop toewijzen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Als er een objectief is bevestigd met een Auto Iris-schakelaar, zet de schakelaar dan op AUTO.1

Druk op de knop [Iris] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Iris] krijgt een oranje kleur.

Het aanpassingspaneel Iris verschijnt.

2

Schuif de schakelaar [Auto] naar rechts om dit in te schakelen.

Het diafragma schakelt over naar automatische aanpassingsmodus. De automatisch aangepaste diafragmawaarde
wordt rechts van de schakelaar weergegeven.

3
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Het diafragma handmatig aanpassen

U kunt de helderheid handmatig aanpassen.

Het diafragma tijdelijk automatisch aanpassen
U kunt ook op de knop [Push Auto] drukken in het aanpassingspaneel Iris om het diafragma automatisch aan te passen
zolang de knop wordt ingedrukt.

Als er een objectief is bevestigd met een Auto Iris-schakelaar, zet de schakelaar dan op AUTO.

Opmerking

Als de schakelaar Auto Iris van het objectief is ingesteld op MANUAL, hebben de functies [Auto Iris] en [Push Auto Iris] van
het apparaat geen effect. Handmatige aanpassingen van het diafragma op het apparaat hebben ook geen effect.

1

Druk op de knop [Iris] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Iris] krijgt een oranje kleur.

Het aanpassingspaneel Iris verschijnt.

2

Schuif de schakelaar [Auto] naar links om dit uit te schakelen.

Het diafragma schakelt over naar handmatige aanpassingsmodus.

3

Pas het diafragma aan met de schuifbalk [Iris] of met de aanpassingsknoppen [Iris].

Hint

De schuifbalk en de aanpassingsknoppen zijn gekoppeld.

U kunt het diafragma ook toewijzen aan de schuifbalk op het tabblad  (Main) in het camerabedieningspaneel.

4
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Hint

Druk op een toewijsbare knop waaraan de functie [Push Auto Iris] is toegewezen om de diafragma automatisch aan te passen
zolang de knop wordt ingedrukt.
Het diafragma gaat terug naar handmatige modus als u de knop loslaat.

5-041-957-73(1) Copyright 2022 Sony Corporation
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De versterking automatisch aanpassen

U kunt de helderheid automatisch aanpassen met de versterkingsinstelling wanneer [Shooting Mode] is ingesteld op
[Custom] of [Flexible ISO].

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel [Project] > [Shooting Mode] in op [Custom] in het webmenu of cameramenu.1

Druk op de knop [ISO/Gain] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [ISO/Gain] krijgt een oranje kleur.

Het aanpassingspaneel ISO/Gain verschijnt.

2

Schuif de schakelaar [AGC] naar rechts om dit in te schakelen.

De versterking schakelt over naar automatische aanpassingsmodus. De automatisch aangepaste
versterkingswaarde wordt rechts van de schakelaar weergegeven.

Hint

U kunt dezelfde handeling uitvoeren door [Shooting] > [Auto Exposure] > [AGC] in te stellen op [On] in het cameramenu.

U kunt ook [AGC] aan een toewijsbare knop toewijzen.

3
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De versterking handmatig aanpassen

U kunt de helderheid handmatig aanpassen met de versterkingsinstelling wanneer [Shooting Mode] is ingesteld op
[Custom] of [Flexible ISO].
U kunt de versterking regelen als u de belichting wilt aanpassen bij gebruik van een vaste diafragma-instelling of als u
extra versterking wilt voorkomen als gevolg van AGC.

De versterking tijdelijk automatisch aanpassen
U kunt de versterking ook tijdelijk aanpassen door [ISO/Gain] toe te wijzen aan een schuifbalk-keuzeknop op het tabblad

 (Main) in het camerabedieningspaneel en de schuifbalk te gebruiken.
Dit is nuttig als u de belichting met een stap wilt aanpassen zonder de scherptediepte te wijzigen.
Het resultaat van de aanpassing keert terug naar de voorkeuzewaarde die is geconfigureerd met [ISO/Gain<L>] nadat u
een van de volgende handelingen hebt uitgevoerd.

Stel [Project] > [Shooting Mode] in op [Custom] in het webmenu of cameramenu.1

Druk op de knop [ISO/Gain] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [ISO/Gain] krijgt een oranje kleur.

Het aanpassingspaneel ISO/Gain verschijnt.

2

Schuif de schakelaar [AGC] naar links om dit uit te schakelen.

De versterking schakelt over naar handmatige aanpassingsmodus.

3

Pas de versterking aan met de schuifbalk [ISO/Gain] of met de aanpassingsknoppen [ISO/Gain].

Hint

De schuifbalk en de aanpassingsknoppen zijn gekoppeld.

4
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Aanpassingsonderdelen voor ISO/Gain wijzigen
De basisgevoeligheid wijzigen
De AGC-schakelaar in de stand On zetten
De voeding van het apparaat in stand-bystand plaatsen

De versterking tijdelijk automatisch aanpassen met een toewijsbare knop
Druk op een toewijsbare knop waaraan de functie [Push AGC] is toegewezen om de versterking automatisch aan te
passen zolang de knop wordt ingedrukt.
De versterking gaat terug naar handmatige modus als u de knop loslaat.
Het resultaat van de aanpassing keert terug naar de voorkeuzewaarde die is geconfigureerd met [ISO/Gain<L>] nadat u
een van de volgende handelingen hebt uitgevoerd.

Aanpassingsonderdelen voor ISO/Gain wijzigen
De basisgevoeligheid wijzigen
De AGC-schakelaar in de stand On zetten
De voeding van het apparaat in stand-bystand plaatsen

Opmerking

Deze functie kan niet worden uitgevoerd wanneer [Shooting] > [Iris] > [Bokeh Control] is ingesteld op [On] in het cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation
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De sluitertijd automatisch aanpassen

U kunt de sluitertijd automatisch aanpassen naargelang de helderheid van het beeld.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de knop [Shutter] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Shutter] krijgt een oranje kleur.

Het aanpassingspaneel Shutter verschijnt.

1

Druk op de knop [Shutter Type] en selecteer [Auto] in de lijst.

Hint

U kunt dezelfde handeling uitvoeren door [Shooting] > [Auto Exposure] > [Auto Shutter] in te stellen op [On] in het
cameramenu.

U kunt ook [Auto Shutter] aan een toewijsbare knop toewijzen.

2
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De sluitertijd handmatig aanpassen

U kunt de sluitertijd handmatig aanpassen.

Druk op de knop [Shutter] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Shutter] krijgt een oranje kleur.

Het aanpassingspaneel Shutter verschijnt.

1

Druk op de knop [Shutter Type] en selecteer [Speed] in de lijst.2

Pas de sluiter aan met de schuifbalk [Speed] of met de aanpassingsknoppen [Speed].

Wilt u de belichtingstijd aanpassen aan het frame-interval, selecteer dan [Off] in stap 2. U kunt ook een vaste
waarde instellen met [ECS] (Frequentie) of deze automatisch aanpassen met [Auto].
Voorbeeld: instellen met [ECS] (Frequentie)

Hint

De schuifbalk en de aanpassingsknoppen zijn gekoppeld.

Wilt u [Angle] gebruiken in plaats van [Speed] of [Off], stel dan [Shooting] > [Shutter] > [Mode] in op [Angle] in het
cameramenu.

3
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Het ND-filter

Onder condities waarin het licht te helder is, kunt u de juiste helderheid instellen door wijziging van het ND-filter.
Bij het filmen van een helder verlicht onderwerp kan het te ver dichtdraaien van het diafragma diffractievervaging
veroorzaken, wat een beeld produceert dat onscherp begint te worden (een typisch verschijnsel in camera's). U kunt dit
effect onderdrukken voor betere videoresultaten met behulp van het ND-filter.
Het apparaat heeft de volgende ND-filter-modi.
Voorkeuzemodus

Raadpleeg "Aanpassen in voorkeuzemodus".

Variabele modus (automatische aanpassing)

Raadpleeg "Automatisch aanpassen in variabele modus".

Variabele modus (handmatige aanpassing)

Raadpleeg "Handmatig aanpassen in variabele modus".

Verwant onderwerp

Aanpassen in voorkeuzemodus

Automatisch aanpassen in variabele modus

Handmatig aanpassen in variabele modus

5-041-957-73(1) Copyright 2022 Sony Corporation
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Aanpassen in voorkeuzemodus

U kunt op voorhand drie ND-filter-doorlaatwaarden selecteren en tijdens het filmen snel hiertussen wisselen.

Hint

Wanneer u drukt op een toewijsbare knop waaraan [ND Filter Position] is toegewezen, wijzigt het ND-filter in de volgorde
[Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel [Shooting] > [ND Filter] > [Mode] in op [Preset] in het cameramenu.1

Druk op de knop [ND Filter] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [ND Filter] krijgt een oranje kleur.

Het aanpassingspaneel ND Filter verschijnt.

2

Druk op de knop [ND Filter] en selecteer een van de volgende opties in de lijst.

[Clear]: geen ND-filter.
[Preset1]: lichtdoorlatendheid ingesteld door [Shooting] > [ND Filter] > [Preset1] in het cameramenu.
[Preset2]: lichtdoorlatendheid ingesteld door [Shooting] > [ND Filter] > [Preset2] in het cameramenu.
[Preset3]: lichtdoorlatendheid ingesteld door [Shooting] > [ND Filter] > [Preset3] in het cameramenu.

Wanneer een van de opties [Preset1] t/m [Preset3] is geselecteerd voor het ND-filter, wordt de lichtdoorlaatwaarde
weergegeven naast de naam van het ND-filter.

3
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Automatisch aanpassen in variabele modus

U kunt automatische belichtingsaanpassing met het ND-filter inschakelen.

Opmerking

Als het ND-filter wordt overgeschakeld van of naar [Clear] tijdens het filmen, wordt het ND-filterkader weergegeven in het beeld
en wordt een bedieningsgeluid weergegeven.

Hint

U kunt ook [Auto ND Filter] toewijzen aan een toewijsbare knop en de knop indrukken om te schakelen tussen [Auto] en [Manual].

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel [Shooting] > [ND Filter] > [Mode] in op [Variable] in het cameramenu.1

Druk op de knop [ND Filter] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [ND Filter] krijgt een oranje kleur.

Het aanpassingspaneel ND Filter verschijnt.

2

Druk op de knop [ND Filter] en selecteer [Auto] in de lijst.

De automatisch aangepaste lichtdoorlaatwaarde voor het ND-filter wordt weergegeven naast de knop [ND Filter].

3
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Handmatig aanpassen in variabele modus

U kunt handmatige belichtingsaanpassing met het ND-filter inschakelen.

Tijdelijk automatisch aanpassen
U kunt [Push Auto ND] aan een toewijsbare knop toewijzen en tijdelijk Auto ND Filter inschakelen terwijl de knop is
ingedrukt. Door de knop los te laten schakelt u Auto ND Filter weer uit.
Stel het ND-filter in op [Manual].

Opmerking

Als het ND-filter wordt overgeschakeld van of naar [Clear] tijdens het filmen, wordt het ND-filterkader weergegeven in het beeld
en wordt een bedieningsgeluid weergegeven.

Stel [Shooting] > [ND Filter] > [Mode] in op [Variable] in het cameramenu.1

Druk op de knop [ND Filter] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [ND Filter] krijgt een oranje kleur.

Het aanpassingspaneel ND Filter verschijnt.

2

Druk op de knop [ND Filter] en selecteer [Manual] in de lijst.3

Pas de lichtdoorlatendheid van het ND-filter aan met de schuifbalk [ND Filter] of de aanpassingsknoppen
[ND Filter].

Hint

De schuifbalk en de aanpassingsknoppen zijn gekoppeld.

U kunt het ND-filter ook aanpassen op het tabblad  (Main) in het camerabedieningspaneel.

4
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Hint

U kunt ook [ND Filter Position] toewijzen aan een toewijsbare knop en de knop indrukken om te schakelen tussen [Manual] en
[Clear].

U kunt ook op de knop [Push Auto] drukken in het aanpassingspaneel ND Filter om het automatische ND-filter aan te passen
zolang de knop wordt ingedrukt.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Scherm bij witbalansaanpassing

U kunt de witbalans aanpassen met het live-bedieningsscherm van de webapp om een witbalans te creëren waardoor
het beeld natuurlijker lijkt.

5-041-957-73(1) Copyright 2022 Sony Corporation

Deelvenster Basisconfiguratie van de camera1.

Deelvenster voor aanpassing van de basisconfiguratie van de camera
Geeft het aanpassingspaneel voor het instelonderwerp weer dat is geselecteerd in het basisconfiguratiepaneel van
de camera.

2.
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De witbalans automatisch aanpassen

U kunt altijd een geschikte witbalans krijgen met de functie ATW (Auto Tracking White Balance, witbalans automatisch
volgen).
Wanneer ATW is ingeschakeld, wordt de witbalans automatisch aangepast als de kleurtemperatuur van de lichtbron
wijzigt.

Opmerking

ATW kan niet worden gebruikt wanneer [Shooting Mode] is ingesteld op [Cine EI] of [Cine EI Quick].

De juiste kleur kan mogelijk niet worden aangepast met ATW, afhankelijk van de condities van het licht en het onderwerp.
Voorbeelden:

Als het onderwerp wordt gedomineerd door één kleur, zoals lucht, zee, aarde of bloemen.
Als de kleurtemperatuur extreem hoog of extreem laag is.

Als de ATW-volgsnelheid laag is of het goede effect kan niet worden bereikt, druk dan op de knop [WB SET] om de witbalans
automatisch in te stellen.

Hint

U kunt de reactiesnelheid in ATW-modus selecteren in vijf stappen (1, 2, 3, 4, 5) met [Shooting] > [White Setting] > [ATW Speed]
in het cameramenu. Hoe lager het getal, hoe sneller de reactiesnelheid.

U kunt de huidige witbalansinstelling bevriezen door de functie [ATW Hold] toe te wijzen aan een toewijsbare knop en de
toewijsbare knop in te drukken om de ATW-modus tijdelijk te pauzeren.
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Druk op de knop [White Balance] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [White Balance] krijgt een oranje kleur.

Het aanpassingspaneel White Balance verschijnt.

1

Druk op de knop [White Mode] en selecteer [ATW] in de lijst.2
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De witbalans handmatig aanpassen

U kunt de witbalans handmatig aanpassen.

Druk op de knop [White Balance] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [White Balance] krijgt een oranje kleur.

Het aanpassingspaneel White Balance verschijnt.

1

Druk op de knop [White Mode] en selecteer een van de volgende opties in de lijst.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Pas de witbalans aan met de schuifbalken of aanpassingsknoppen.

Hint

De schuifbalk en de aanpassingsknoppen zijn gekoppeld.

Het verschil tussen [Memory A(T/T)] en [Memory A(R/B)] is dat de as van de aanpassing verschillend is, maar de resultaten
van de aanpassing zijn gekoppeld.

Voor [Memory A(T/T)]
Bij deze modus wordt de witbalans aangepast die is opgeslagen in geheugen A door de kleurtemperatuur (Temp)
en Tint aan te passen.

3
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U kunt de kleurtemperatuur instellen in stappen van 20 K binnen het bereik van 2000 K tot 5600 K. Waarden boven
5600 K kunnen worden ingesteld in intervallen die overeenkomen met de hoeveelheid kleurwijziging (Mired) van
5580 K tot 5600 K.
Door op de knop [Reset] rechts van [Temp] of [Tint] te drukken herstelt u de overeenkomende instelling naar de
standaardwaarde.
Voor [Memory A(R/B)]
Bij deze modus wordt de witbalans aangepast die is opgeslagen in geheugen A door R Gain en B Gain aan te
passen.
Door op de knop [Reset] te drukken, stelt u de betreffende versterkingsinstelling terug naar de standaardwaarde.
Voor [Preset]
Bij deze modus wordt de kleurtemperatuur aangepast aan een voorkeuzewaarde.
U kunt de waarde instellen in stappen van 100 K.
In voorkeuzemodus kunt u ook [Preset White Select] aan een toewijsbare knop toewijzen en de knop indrukken om
te wijzigen naar een vooraf ingestelde voorkeuzewaarde.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Automatische witbalans uitvoeren

In de modus Geheugen A wordt de witbalans die wordt opgeslagen automatisch aangepast.

Druk op de knop [White Balance] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [White Balance] krijgt een oranje kleur.

Het aanpassingspaneel White Balance verschijnt.

1

Druk op de knop [White Mode] en selecteer [Memory A(T/T)] of [Memory A(R/B)] in de lijst.

[Memory A(T/T)]

[Memory A(R/B)]

2

Plaats een wit papier (of object) op een plaats met dezelfde lichtbron en condities als het onderwerp en
zoom vervolgens in op het papier om wit op het scherm weer te geven.

3

Pas de helderheid aan.

Pas het diafragma aan volgens de procedure in "Het diafragma handmatig aanpassen".

4

Druk op de knop [WB SET] in het aanpassingspaneel voor de witbalans.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Opmerking

Als de aanpassing niet is gelukt, verschijnt gedurende ongeveer 3 seconden een foutmelding op het scherm. Als de foutmelding
aanhoudt na herhaalde pogingen voor het instellen van de witbalans, neem dan contact op met uw Sony
servicevertegenwoordiger.

Hint

U kunt dit ook uitvoeren in ATW-modus. U kunt dit gebruiken als u snel de witbalans wilt aanpassen tijdens ATW-gebruik. Na de
aanpassing keert de modus terug naar normale ATW.

Verwant onderwerp

Het diafragma handmatig aanpassen
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Als automatische witbalans wordt uitgevoerd in geheugenmodus wordt het resultaat van de automatische
aanpassing opgeslagen in geheugen A.
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Het audioconfiguratiescherm

U kunt het geluidsniveau dat u wilt opnemen met het apparaat aanpassen op het live-bedieningsscherm van de webapp.
Configureer de schakelaars op het aansluitblok van het apparaat en configureer het geluid in het cameramenu of het
webmenu.

5-041-957-73(1) Copyright 2022 Sony Corporation

Camerabedieningspaneel – Tabblad  (Audio)1.
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Het audio-invoerapparaat selecteren

Stel de volgende schakelaars in aan de hand van het apparaat dat u hebt aangesloten op de AUDIO IN-aansluiting.

Opmerking

Audio wordt niet opgenomen in de modi Interval Rec mode of Slow & Quick Motion.

5-041-957-73(1) Copyright 2022 Sony Corporation

Wanneer u een microfoon hebt aangesloten, stel dan schakelaar SETUP 2 op het aansluitblok op de
achterkant van het apparaat in.

De instellingen voor CH-1 en CH-2 zijn gelijk.

1

Instelling Beschrijving

OFF
(standaard)

Selecteer dit wanneer u een dynamische microfoon gebruikt of een microfoon met een batterij.
De +48 V-phantomvoeding wordt uitgeschakeld en LINE of MIC wordt ingesteld als CH-1- en CH-
2-invoergeluidsbron.

ON
Selecteer dit wanneer u een microfoon gebruikt die compatibel is met +48 V-phantomvoeding. De
+48 V-phantomvoeding wordt ingeschakeld en de met phantomvoeding compatibele microfoon
wordt ingesteld als CH-1- en CH-2-invoergeluidsbron.

Stel het type aangesloten apparaat in met [Audio] > [Audio Input] > [AUDIO IN Select] in het cameramenu.2

Selecteer de audio-invoer met [Audio] > [Audio Input] > [CH1 Input Select] t/m [CH4 Input Select] in het
webmenu of cameramenu.

3
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Het audio-opnameniveau automatisch aanpassen

Stel het kanaal in waarvoor u het audio-opnameniveau automatisch wilt instellen met [Auto] op de pagina [Audio] van het
webmenu of met [Audio] > [Audio Input] > [CH1 Level Control] t/m [CH4 Level Control] in het cameramenu.
De kanalen die u hebt opgegeven voor automatische aanpassing worden aangegeven met een pictogram  (Auto)
naast het betreffende kanaal op het tabblad  (Audio) van het live-bedieningsscherm.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het audio-opnameniveau handmatig aanpassen

U kunt het audio-opnameniveau handmatig aanpassen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel het kanaal in waarvoor u het audio-opnameniveau handmatig wilt instellen met [Manual] op de pagina
[Audio] van het webmenu of met [Audio] > [Audio Input] > [CH1 Level Control] t/m [CH4 Level Control] in
het cameramenu.

1

Druk op het tabblad  (Audio) in het camerabedieningspaneel.2

In het venster [Audio] van het camerabedieningspaneel stelt u het audio-opnameniveau in met de
schuifbalk of de aanpassingsknoppen voor het kanaal waarvoor u het audio-opnameniveau handmatig wilt
instellen.

Opmerking

Kanalen waarbij het pictogram  (Auto) wordt weergegeven, worden automatisch aangepast. Wijzigingen in waarden met
de schuifbalk of de aanpassingsknoppen worden niet toegepast op het opgenomen geluid.

Hint

De schuifbalk en de aanpassingsknoppen zijn per rij gekoppeld.

U kunt het audio-opnameniveau in echttijd volgen met de geluidsniveaumeter op het filmscherm.

3
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Handelingen directmenu

U kunt de status en instellingen van het apparaat controleren. Deze worden over het camerabeeld geprojecteerd. U kunt
de instellingen wijzigen met de GUI-bedieningsknoppen op de infraroodafstandsbediening.
De volgende onderdelen kunnen worden geconfigureerd.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-waarde
[Auto Iris]
[Iris]-waarde
[AGC]
[Gain]-waarde
[ISO]-waarde
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-waarde
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] en [Frame Rate]

Hint

U kunt dezelfde handeling uitvoeren met een toewijsbare knop en het GUI-bedieningspaneel van de webapp.

Druk op een toewijsbare knop waaraan [Direct Menu] is toegewezen op de infraroodafstandsbediening.

De knop [Direct Menu] is standaard toegewezen aan toewijsbare knop 1.
Alleen de onderdelen op het scherm die kunnen worden geconfigureerd met het directmenu kunnen worden
geselecteerd met de oranje cursor.

1

Verplaats de cursor naar het onderdeel dat u wilt instellen met de pijlknoppen in het GUI-bedieningspaneel
en druk op de knop [Set].

Er wordt een menu weergegeven of het onderdeel wordt weergegeven op een witte achtergrond.

2

Selecteer een instelling met de pijlknoppen en druk op de knop [Set].

Het menu of de witte achtergrond verdwijnt en de nieuwe instelling wordt weergegeven met een oranje cursor.
Druk nogmaals op een toewijsbare knop waaraan het [Direct Menu] is toegewezen of wacht 3 seconden zonder een
handeling uit te voeren om het directmenu te verlaten.

3
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Toewijsbare knoppen

Er zitten tien toewijsbare knoppen in de webapp van het apparaat waar u functies aan kunt toewijzen.
De toewijsbare knoppen worden weergegeven op het live-bedieningsscherm en op het afspeel-bedieningsscherm.

Opmerking

De lijst met toewijsbare knoppen wordt niet weergegeven tijdens het configureren van instellingen in het basisbedieningspaneel
van de camera van het live-bedieningsscherm. Om de handeling af te sluiten drukt u op de knop [X] rechtsboven van het
aanpassingspaneel.

De volgende functies zijn standaard toegewezen aan de toetsen.
Knop 1: [Direct Menu]
Knop 2: [Focus Setting]
Knop 3: [Rec Review]

De knoppen 1 t/m 3 komen overeen met dezelfde knoppen op de meegeleverde infraroodafstandsbediening.

Knop 4: [Push Auto ND]
Knop 5: [Crop Select]
Knop 6: [Marker]
Knop 7: [Video Signal Monitor]
Knop 8: [Clip Flag OK]
Knop 9: [Color Bars]
Knop Focus Hold: [Focus Hold]

De knop Focus Hold komt overeen met de knop Focus Hold op objectieven met E-bevestiging.

De functie van een knop wijzigen
Gebruik [Project] > [Assignable Button] in het cameramenu.
Wanneer u een toewijzing wijzigt, verandert de weergave van de toewijsbare knoppen.
Voor nadere informatie over toewijsbare functies raadpleegt u "Assignable Button" bij "Het cameramenu en
gedetailleerde instellingen".

Verwant onderwerp
Assignable Button
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Slow & Quick Motion

Als de opname-indeling is ingesteld op de volgende waarden, kunt u verschillende waarden opgeven voor de
beeldsnelheid waarmee wordt gefilmd en de beeldsnelheid waarmee wordt afgespeeld.
In de volgende tabel vindt u de configureerbare beeldsnelheden.

Systeemfrequentie: 59.94/50/29.97/25/23.98, beeldsensor-scanmodus: FF

Systeemfrequentie: 59.94/50/29.97/25/23.98, beeldsensor-scanmodus: S35

Systeemfrequentie: 24, beeldsensor-scanmodus: FF

Opmerking

Slow & Quick Motion kan niet worden ingesteld tijdens opname, afspelen of als het pictogrammenscherm wordt weergegeven.

Audio opname wordt niet ondersteund in de modus Slow & Quick Motion.

De functies automatisch diafragma en automatische sluitertijd worden in de modus Slow & Quick Motion uitgeschakeld.

Automatisch scherpstellen heeft de volgende beperkingen in de modus Slow & Quick Motion.

Beperkingen vanwege het model objectief, de systeemfrequentie en de opnamebeeldsnelheid

Codec Video-indeling Configureerbare beeldsnelheden

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Video-indeling Configureerbare beeldsnelheden

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Video-indeling Configureerbare beeldsnelheden

XAVC-I 4096×2160P 1–60

229



De functie automatische scherpstelling wordt tijdelijk uitgeschakeld als het diafragma wordt ingesteld op F18 of hoger.

Voor nadere informatie over het gebruik van RAW raadpleegt u "RAW video opnemen".

Verwant onderwerp

RAW video opnemen

5-041-957-73(1) Copyright 2022 Sony Corporation

Sony-objectief Systeemfrequentie Beschikbaarheid van AF

Alles behalve SEL16F28 – 7 fps of hoger ondersteund

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps ondersteund

50,00/25,00 25, 50, 100, 200 fps ondersteund

24,00 Niet ondersteund
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Intervalopname (Interval Rec)

Met de functie Interval Rec kunt u intervalvideo vastleggen in het interne geheugen van het apparaat. Dit is een
effectieve manier om langzaam bewegende onderwerpen te filmen.
Als u de opname start, neemt het apparaat automatisch een vastgesteld aantal frames (Number of Frames) binnen een
specifiek tijdsinterval (Interval Time) op.

A: filminterval (Interval Time)
B: aantal frames in één take (Number of Frames)

Opmerking

Er kan slechts één speciale opnamefunctie, zoals Interval Rec, tegelijk worden gebruikt.

Als er een andere speciale opnamemodus actief wordt terwijl Interval Rec in gebruik is, wordt Interval Rec automatisch
uitgeschakeld.

De modus Interval Rec wordt automatisch uitgeschakeld na het wijzigen van systeeminstellingen, zoals de video-indeling.

De instellingen voor Interval Rec kunnen niet worden gewijzigd tijdens opnemen of afspelen, of als het pictogrammenscherm
wordt weergegeven.

Beperkingen tijdens opname
Audio wordt niet opgenomen.
Een opname controleren (Rec Review) is niet mogelijk.

Als het apparaat wordt uitgeschakeld tijdens de opname
Als de voeding van het apparaat in stand-by wordt gezet, wordt het medium gedurende enkele seconden gebruikt om
de beelden op te slaan die tot dat moment in het geheugen zijn opgeslagen, waarna het apparaat automatisch in
stand-by wordt geschakeld.
Als de gelijkstroomkabel wordt losgekoppeld, de voeding naar de netadapter wordt uitgeschakeld of de PoE++-
voeding wordt onderbroken, kunnen de tot dan opgenomen opnames mogelijk verloren gaan (maximaal 10
seconden). Pas dus goed op.

Het aantal frames en het interval tussen opnames instellen
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Stel [Project] > [Interval Rec] > [Setting] in op [On] in het webmenu en stel [Number of Frames] en [Interval Time] in.
Het apparaat sluit de modus Interval Rec af als het wordt uitgeschakeld, maar de instellingen [Number of Frames] en
[Interval Time] blijven behouden. De volgende keer als u gaat opnemen in de modus Interval Rec hoeft u deze niet meer
in te stellen.

Hint

U kunt dit ook instellen met [Project] > [Interval Rec] in het cameramenu.

Starten met filmen

Druk op de knop START/STOP om te starten met opnemen. "Int●Rec" en "Int●Stby" verschijnen afwisselend.

Stoppen met filmen

Stop het filmen.
Als het filmen wordt gestopt worden de in het geheugen opgeslagen videogegevens tot dat punt opgeslagen op de
media.
U verlaat de modus Interval Rec op een van de volgende manieren.

Plaats de voeding van het apparaat in wachtstand.
In de modus Opname stand-by stelt u [Project] > [Interval Rec] > [Setting] in op [Off].

De modus Interval Rec wordt ook automatisch uitgeschakeld als het apparaat opnieuw wordt opgestart.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Beelden in cache opnemen (Picture Cache Rec)

Met de functie Picture Cache Rec kunt u video achteraf vastleggen wanneer u een opname start door een intern
cachegeheugen bij te houden met een bepaalde duur.

De cachegrootte instellen

Stel [Project] > [Picture Cache Rec] > [Setting] in op [On] in het webmenu en stel de cachegrootte in met [Cache Size] in.

Opmerking

U kunt Picture Cache Rec niet gebruiken in combinatie met Interval Rec, simultane opnamefunctie met 2 kaartsleuven of proxy-
opname. Wanneer Picture Cache Rec is ingesteld op On, worden deze andere speciale opnamemodi geforceerd ingesteld op Off.

De modus Picture Cache Rec kan niet worden geselecteerd tijdens het opnemen of wanneer Rec Review bezig is.

Wanneer Picture Cache Rec is ingesteld op On, wordt de tijdcode vastgelegd in de modus [Free Run], zelfs als dit is ingesteld op
[Regen] of [Rec Run].

De instelling [Output Format] kan misschien niet worden geconfigureerd tijdens de modus Picture Cache Rec. Als dat gebeurt,
schakel dan Picture Cache Rec tijdelijk in op Off en wijzig vervolgens de instelling.

Hint

De cachetijd kan korter zijn, afhankelijk van de opname-indeling. Controleer de tijd die wordt weergegeven bij [Project] > [Picture
Cache Rec] > [Cache Rec Time] in het webmenu.

U kunt dit ook instellen met [Project] > [Picture Cache Rec] in het cameramenu.

U kunt ook [Picture Cache Rec] schakelen tussen On en Off met een toewijsbare knop.

Picture Cache Rec starten

Wanneer [Picture Cache Rec] is ingesteld op On, verschijnt "●Cache" (● is groen).
Wanneer u op de knop START/STOP drukt, start de opname en wordt video naar de geheugenkaarten geschreven, te
beginnen met de video die in het cachegeheugen is opgeslagen.

Opmerking

Door de opname-indeling of het basisuiterlijk te wijzigen, wist u de video die tot dan toe in het cachegeheugen is opgeslagen.
Vervolgens wordt nieuwe video naar de cache geschreven. Daardoor is het opnemen in de beeldcache van beelden van voor het
wijzigen van de indeling niet mogelijk, ook niet als u onmiddellijk met opnemen begint nadat u de indeling hebt gewijzigd.

Als u onmiddellijk nadat u een geheugenkaart hebt geplaatst Picture Cache Rec instelt op On of Off, worden cachegegevens
misschien niet op de kaart opgenomen.

Instelling [Cache Size] Cache-tijd (ongeveer)

[Short] 5 seconden

[Medium] 10 seconden

[Long] 20 seconden

[Max] Maximale waarde van de betreffende opname-indeling
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Video wordt in het cachegeheugen opgeslagen als de functie Picture Cache Rec is ingesteld op On. Video van voor u de functie
instelde op On wordt niet in de cache opgenomen.

Video wordt niet in het cachegeheugen opgeslagen wanneer een geheugenkaart bezet is, zoals bij afspelen, Rec Review of
weergave van het pictogrammenscherm. Op die momenten is opnemen naar de beeldcache van video niet mogelijk.

Picture Cache Rec annuleren

Stel [Project] > [Picture Cache Rec] > [Setting] in op [Off] in het webmenu of druk op een toewijsbare knop waaraan de
functie [Picture Cache Rec] is toegewezen.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Opnemen op geheugenkaart A en B tegelijkertijd (2-slot Simul Rec)

U kunt opnemen op zowel geheugenkaart A als geheugenkaart B tegelijkertijd door [Project] > [Simul Rec] > [Setting] in
te stellen op [On] in het webmenu of cameramenu.

Afzonderlijk naar geheugenkaart A en geheugenkaart B opnemen

U kunt het opnemen naar de verschillende geheugenkaarten onafhankelijk in- en uitschakelen met de opnameknop
START/STOP of de knop [2nd Rec START/STOP] op het tabblad  (Others).
Standaard zijn beide knoppen ingesteld op gelijktijdig starten en stoppen met opnemen naar beide geheugenkaarten A
en B.
Wanneer de knoppen zijn ingesteld voor opnemen naar verschillende geheugenkaarten, volgt de opnamestart-
stopregeling van de [SDI/HDMI Rec Control] de opnamestatus van sleuf A.

De instelling wijzigen

Stel het volgende in met [Project] > [Simul Rec] > [Rec Button Set] in het cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation

Instelling [Rec
Button Set] Knoppen en geheugenkaarten

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Start en stopt gelijktijdig opnemen naar de geheugenkaarten A en B door middel van beide
knoppen.

Rec Button:<Slot A>
2nd Rec Button:
<Slot B>

De opnameknop START/STOP start-stopt het opnemen naar geheugenkaart A, en de knop
[2nd Rec START/STOP] op het tabblad  (Others) start-stopt het opnemen naar
geheugenkaart B.

Rec Button:<Slot B>
2nd Rec Button:
<Slot A>

De opnameknop START/STOP start-stopt het opnemen naar geheugenkaart B, en de knop
[2nd Rec START/STOP] op het tabblad  (Others) start-stopt het opnemen naar
geheugenkaart A.
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Videosignaalmonitor

U kunt het type videosignaal instellen dat in het camerabeeldpaneel wordt weergegeven als golfvorm, vectorscoop of
histogram met [Monitoring] > [Video Signal Monitor] > [Setting] in het cameramenu.
De oranje lijn geeft de ingestelde waarden van [Level Marker 1] en [Level Marker 2] weer.
U kunt ook de functie [Video Signal Monitor] aan een toewijsbare knop toewijzen.

Doelweergave voor monitoring
In logboek-opnamemodi wordt de informatie voor kleurbereikinstelling of monitor-LUT-instelling rechtsboven op de
videosignaalmonitor weergegeven om het monitor-doel aan te geven.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Clipvlaggen

U kunt een [OK]-vlag aan een clip toevoegen door op een toewijsbare knop te drukken waaraan de functie [Clip Flag OK]
is toegewezen en [Add OK] te selecteren.
U kunt een [OK]-clipvlag verwijderen door twee keer op de knop te drukken en [Delete Clip Flag] te selecteren.

Hint

U kunt ook een clipvlag toevoegen met [Thumbnail] > [Set Clip Flag] in het cameramenu.

Het pictogrammenscherm kan worden weergegeven, gesorteerd op clipvlagtype (gefilterd clip-pictogrammenscherm). Voor
nadere informatie raadpleegt u "Acties op opgenomen clips" in "Pictogrammenscherm".

Verwant onderwerp

Acties op opgenomen clips

5-041-957-73(1) Copyright 2022 Sony Corporation
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Ademcompensatie

U kunt kiezen of ademcompensatie wordt toegepast voor het objectief met [Technical] > [Lens] > [Breathing
Compensation] in het cameramenu.
Deze functie corrigeert voor het fenomeen waarbij de kijkhoek verandert wanneer de scherpstelpositie verandert.
Wanneer ademcompensatie wordt toegepast, wordt een deel van het beeld elektronisch afgesneden zodat een
constante beeldhoek wordt aangehouden zodat het ademfenomeen niet optreedt.

Opmerking

Wanneer ademcompensatie is ingeschakeld, kunnen de kijkhoek en beeldkwaliteit enigszins afwijken.

Afhankelijk van het objectief kan het zijn dat u de verandering in kijkhoek niet kunt corrigeren wanneer ademcompensatie is
ingeschakeld.

Compensatie is niet mogelijk wanneer u een objectief hebt gemonteerd dat ademcompensatie niet ondersteunt.

Deze functie is in de volgende gevallen ingesteld op Off (vast).

Wanneer [Technical] > [Lens] > [Distortion Comp.] is ingesteld op [Off] in het cameramenu
Wanneer [Shooting] > [S&Q Motion] > [Setting] is ingesteld op [On] in het webmenu of cameramenu
Wanneer [Project] > [Rec Format] > [Codec] is ingesteld op [RAW] of [RAW & XAVC-I] in het webmenu of cameramenu

5-041-957-73(1) Copyright 2022 Sony Corporation
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Overzicht van proxy-opname

Met deze functie kunt u tegelijkertijd proxydata op lage resolutie opnemen, samen met originele videodata op hoge
resolutie.

Voor nadere informatie over ondersteunde geheugenkaarten, het formatteren van geheugenkaarten en het
controleren van de resterende capaciteit raadpleegt u "Ondersteunde geheugenkaarten" bij "Geheugenkaarten
voorbereiden".

Over het opgenomen bestand
De bestandsnaamextensie is ".mp4".
De tijdcode wordt tegelijkertijd opgenomen.

Opslagbestemming van het opgenomen bestand
Het opgenomen bestand wordt opgeslagen in de volgende map.

Over de bestandsnaam
De bestandsnaam bestaat uit de clipnaam die is opgenomen op de geheugenkaart en een "S03"-achtervoegsel.
Voor clipnamen raadpleegt u [TC/Media] > [Clip Name Format] in het cameramenu.

Verwant onderwerp
Ondersteunde geheugenkaarten
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Opnamemedia Map naar pad

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Een proxy opnemen

U kunt beginnen met opnemen wanneer u proxy-opname hebt ingeschakeld.

Stoppen met filmen
Stop het filmen.

Het audiokanaal voor proxy-opname instellen
Stel het audiokanaal voor proxy-opname in met [Project] > [Proxy Rec] > [Audio Channel] in het cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel [Project] > [Proxy Rec] > [Setting] in op [On] in het webmenu of cameramenu.1

Plaats een geheugenkaart in een CFexpress Type A- / SD-kaartsleuf.

Bij CFexpress-kaarten plaatst u het etiket omhoog.
Bij SD-kaarten plaatst u het etiket omlaag.

Opmerking

Proxy Rec kan niet tegelijk worden ingesteld op On met S&Q Motion of Interval Rec. Als Proxy Rec is ingesteld op On,
worden deze andere opnamemodi geforceerd ingesteld op Off.

2

Druk op de opnameknop START/STOP.

De proxy-opname start.

Opmerking

Als het apparaat wordt uitgeschakeld of als de geheugenkaart wordt verwijderd terwijl er gegevens worden uitgewisseld kan
de integriteit van de gegevens op de kaart niet worden gegarandeerd.
Alle gegevens op de geheugenkaart kunnen verloren gaan. Controleer altijd dat de toegangsindicator van de
geheugenkaart niet brandt voordat u het apparaat uitschakelt of de geheugenkaart verwijdert.

Zorg dat de geheugenkaart er niet uitspringt bij het plaatsen of verwijderen.

3
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Overzicht van uiterlijk

Als het apparaat zich in de modus Custom bevindt, kunt u wijzigingen aanbrengen in de parameters Zwart, Matrix en
andere om een "uiterlijk" te creëren op basis van het basisuiterlijk.

U kunt ook snel een ander uiterlijk selecteren door verschillende combinaties van instellingen in scene-bestanden op te
slaan.
Het apparaat biedt in een totaal zeven voorkeuzes voor uiterlijk.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een uiterlijk selecteren

In dit onderwerp wordt beschreven hoe u een uiterlijk selecteert.

Controleer dat [Project] > [Base Setting] > [Shooting Mode] is ingesteld op [Custom] in het webmenu of
cameramenu.

Hint

In de modus [Custom] worden de knoppen [ISO/Gain] en [Scene File] weergegeven in het basisconfiguratiepaneel van de
camera.

1

Druk op de knop [Scene File] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Scene File] krijgt een oranje kleur.

Het aanpassingspaneel Scene File verschijnt.

2

Druk op de knop [Scene File] in het aanpassingspaneel en selecteer een scenebestand met het gewenste
uiterlijk in de lijst.

De volgende presets zijn standaard vanuit de fabriek geconfigureerd.

Hint

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scenebestand 1 [S-Cinetone] [HLG Live]

Scenebestand 2 [Standard] [HLG Natural]

Scenebestand 3 [Still] (Niet geregistreerd)

Scenebestand 4 [ITU709] (Niet geregistreerd)

Scenebestand 5 [709tone] (Niet geregistreerd)

Scenebestanden 6 t/m 16 (Niet geregistreerd) (Niet geregistreerd)
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U kunt ook een uiterlijk selecteren met [Paint/Look] > [Scene File] > [Recall] in het cameramenu. U kunt ook een voorkeuze-
uiterlijk oproepen met [Scene File] > [Preset Recall].

Opmerking

Vanaf softwareversie 2.0 is het voorkeuze scenebestand 5 ingesteld op [709tone]. Het wordt weergegeven wanneer u
[Maintenance]> [Reset] > [Factory Default] in het webmenu uitvoert.
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Een gewenst basisuiterlijk importeren

U kunt een 3D LUT-bestand, dat op een computer of een ander apparaat is gemaakt, importeren als basisuiterlijk. Er
kunnen maximaal 16 bestanden worden geïmporteerd.
Bestandsindeling: CUBE bestand (*.cube) voor een 17-raster of 33-raster 3D LUT gemaakt met Catalyst Browse, RAW
Viewer, of DaVinci Resolve* (van Blackmagic Design Pty. Ltd.).

Invoerkleurbereik/gamma: [S-Gamut3.Cine/S-Log3] of [S-Gamut3/S-Log3]

Aanpassen voor onderbelichting

Gecontroleerd met Resolve V9.0, V10.0 en V11.0.*

Sla het 3D LUT-bestand op het apparaat op waarop u de webapp gebruikt.1

Open [Paint/Look] > [Base Look] in het webmenu.

Een lijst met geregistreerde basisuiterlijken verschijnt.

2

Druk op de knop [Import] in de rij waar u het bestand wilt importeren.

Het dialoogvenster voor bestandskeuze verschijnt.

3

Selecteer het voorbereide 3D LUT-bestand.

Het geïmporteerde 3D LUT-bestand wordt het basisuiterlijk van het apparaat.

4

Selecteer het geïmporteerde 3D LUT-bestand met [Paint/Look] > [Base Look] > [Select] in het cameramenu.5

Configureer [Paint/Look] > [Base Look] > [Input] en [Output] in het cameramenu zodat dit past bij de
kenmerken van het geïmporteerde 3D LUT-bestand.

6
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Als er een tendens voor onderbelichting is als automatische belichting is geselecteerd bij gebruik van het geïmporteerde
basisuiterlijk, pas dan [Paint/Look] > [Base Look] > [AE Level Offset] in het webmenu aan.

Opmerking

Het zojuist geïmporteerde 3D LUT-bestand verandert het beeld niet. Laad het geïmporteerde 3D LUT-bestand met [Paint/Look] >
[Base Look] > [Select] in het cameramenu.

Als [Input] niet correct is ingesteld, wordt het juiste uiterlijk niet bereikt.

De instellingen van de menu-onderdelen [Input], [Output] en [AE Level Offset] worden toegepast op het basisuiterlijk dat is
geselecteerd met [Select]. Als er meerdere 3D LUT-bestanden zijn geïmporteerd, selecteer dan de verschillende 3D LUT-
bestanden met [Select] en configureer [Input], [Output] en [AE Level Offset] voor elk bestand afzonderlijk.

De geconfigureerde instellingen voor [Input], [Output] en [AE Level Offset] worden voor elk 3D LUT-bestand opgeslagen.

De basisuiterlijk-/LUT-selectie-opties voor geïmporteerde 3D LUT-bestanden zijn gemeenschappelijk voor de opnamemodi
[SDR(BT.709)], [HDR(HLG)] en logboek-opnamemodi, maar kleurbereik- en gammaconversie worden niet volgens deze modi
uitgevoerd.

3D LUT-bestanden worden niet gewist als [Maintenance] > [Reset] > [All Reset (except for Network Settings)] wordt uitgevoerd in
het webmenu.

Als  (3D LUT-bestandsbijlagefout) voor de [Base Look Name] wordt weergegeven, betekent dit dat 3D LUT-bestanden niet
kunnen worden toegevoegd aan clips die zijn opgenomen in een logboek-opnamemodus. Importeer het 3D LUT-bestand
nogmaals.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een uiterlijk aanpassen

U kunt het uiterlijk aanpassen gebaseerd op het basisuiterlijk met de schuifbalken [Master Black], [R Black] en [B Black]
in het aanpassingspaneel Scene File in het basisconfiguratiepaneel van de camera en [Paint/Look] > [Matrix] en andere
instelonderdelen in het cameramenu.
Sluit het apparaat aan op een tv of monitor en pas de beeldkwaliteit aan terwijl u het beeld bekijkt op de tv of het
monitorscherm.

1: schuifbalk/aanpassingsknoppen [R Black]
2: schuifbalk/aanpassingsknoppen [B Black]
3: schuifbalk/aanpassingsknoppen [Master Black]

Opmerking

Als u een 3D LUT-bestand importeert en op het beeld toepast, wordt het gewenste uiterlijk dat in het 3D LUT-bestand is
gedefinieerd niet bereikt als [Paint/Look] > [Matrix] en andere instellingen dan die van het basisuiterlijk in het cameramenu zijn
gewijzigd.

U kunt alle aangepaste instellingen terugstellen met [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] in het
cameramenu.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een uiterlijk opslaan

U kunt het huidige uiterlijk opslaan als een scene-bestand in het interne geheugen met [Paint/Look] > [Scene File] >
[Store] in het cameramenu.
U kunt een opgeslagen uiterlijk snel terugroepen met het aanpassingspaneel Scene File of met acties in het directmenu.

Opmerking

Als u een ander uiterlijk selecteert zonder het huidige uiterlijk op te slaan, wordt het huidige uiterlijk verworpen.

Hint

U kunt de preset scene-bestanden overschrijven. Om een voorkeuzescenebestand te herstellen, laadt u het uiterlijk dat u wilt
herstellen met [Paint/Look] > [Scene File] > [Preset Recall] in het cameramenu en slaat u het scenebestand vervolgens op met
[Scene File] > [Store].

Een opgeslagen uiterlijk verwijderen
U kunt een scenebestand dat is opgeslagen in het interne geheugen verwijderen met [Paint/Look] > [Scene File] >
[Delete] in het cameramenu.

Hint

Na het wissen wordt het niet langer weergegeven in het aanpassingspaneel Scene File of het directmenu.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een basisuiterlijk verwijderen

U kunt geïmporteerde 3D LUT-bestanden afzonderlijk verwijderen met [Paint/Look] > [Base Look] > [Delete] in het
cameramenu.
U kunt alle geïmporteerde 3D LUT-bestand verwijderen met [Paint/Look] > [Base Look] > [Delete All] in het cameramenu.

Opmerking

Controleer voor het verwijderen of het basisuiterlijk niet wordt gebruikt in een scene-bestand. Als een basisuiterlijk wordt
verwijderd dat in gebruik is, wordt het uiterlijk van de betreffende scene-bestanden incorrect.

Geïmporteerde 3D LUT-bestanden worden niet gewist als [Maintenance] > [Reset] > [All Reset (except for Network Settings)]
wordt uitgevoerd in het webmenu.

Een verwijderd basisuiterlijk kan niet langer als een LUT in logboek-opnamemodi worden gebruikt.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Filmen met uiterlijkaanpassing in postproductie

Door het apparaat in een logboek-opnamemodus*1 te gebruiken en gradaties gelijkmatig op te nemen van donkere
gebieden naar lichte gebieden, kunt u fijnaanpassingen maken, zoals het lokaal herstellen van de gradaties van donkere
gebieden en lichte gebieden, in postproductie.
Echter, bij het bekijken van de opgenomen beelden op een conventionele monitor is het algehele contrast laag, waardoor
scherpstellings- en belichtingsaanpassingen moeilijk worden.
U kunt een LUT toepassen op een monitordoel op het apparaat om te helpen bij verschillende aanpassingen tijdens het
filmen. U kunt de gebruikte LUT ook toepassen tijdens het automatisch filmen bij het afspelen om snel het uiteindelijke
resultaat te controleren.
LUTs worden toegepast door de volgende systemen. Maar er kan slechts één LUT worden toegepast.

SDI-uitvoer
HDMI-uitvoer en streamen
Proxy-clip opgenomen op opnamemedium
Clip in hoge resolutie (hoofd) opgenomen op opnamemedium

5-041-957-73(1) Copyright 2022 Sony Corporation

Generieke term voor Flexible ISO-modus / Cine EI-modus / Cine EI Quick-modus*1
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Een LUT toepassen op HDMI-uitvoer en streamen

U kunt een LUT toepassen op HDMI-uitvoer en streamen.

Opmerking

Het beeld in het camerabeeldpaneel van de webapp wordt ook meegenomen in het streambeeld.

Hint

U kunt dit ook instellen met [Shooting] > [LUT On/Off] > [HDMI/Stream] in het cameramenu.

SDI-uitvoer kan op dezelfde manier worden ingesteld.

Voor video op opnamemedia kunt u dit instellen met [Shooting] > [LUT On/Off] > [Internal Rec] en [Proxy] in het cameramenu.

Als  (3D LUT-bestandsbijlagefout) voor de [Base Look/LUT] wordt weergegeven, betekent dit dat 3D LUT-bestanden niet
kunnen worden toegevoegd aan clips die zijn opgenomen in een logboek-opnamemodus. Importeer het 3D LUT-bestand
nogmaals.
Dit pictogram verschijnt ook als het toevoegen van bijlagen mislukt vanwege een tijdelijke opstopping bij de verwerking.

Controleer dat [Project] > [Base Setting] > [Shooting Mode] is ingesteld op [Flexible ISO], [Cine EI] of [Cine
EI Quick] in het webmenu of cameramenu.

Hint

In logboek-opnamemodi worden de knoppen [Base ISO/Exposure Index] en de knop [Base Look/LUT] weergegeven in het
basisconfiguratiepaneel van de camera.

1

Druk op de knop [Base Look/LUT] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Base Look/LUT] krijgt een oranje kleur.

Het aanpassingspaneel Base Look/LUT verschijnt.

2

Selecteer [HDMI/Stream] > [MLUT].3
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Een LUT wijzigen

U kunt de LUT aanpassen die u wilt toepassen.

Hint

Het apparaat biedt [s709], [709(800%)] en [S-Log3] als vooraf ingestelde LUT's.

U kunt ook een 3D LUT-bestand importeren en toepassen. Voor nadere informatie raadpleegt u "Een gewenst basisuiterlijk
importeren" en "Een basisuiterlijk verwijderen".

U kunt dit ook instellen met [Paint/Look] > [Base Look] > [Select] in het cameramenu.

Verwant onderwerp
Een gewenst basisuiterlijk importeren

Een basisuiterlijk verwijderen

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de knop [Base Look/LUT] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Base Look/LUT] krijgt een oranje kleur.

Het aanpassingspaneel Base Look/LUT verschijnt.

1

Druk op de knop [Base Look/LUT] en selecteer het basisuiterlijk dat u wilt toepassen.2

252



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De verdeling van donkere en lichte gebieden in het opgenomen beeld wijzigen

In de opnamemodi Cine EI en Cine EI Quick kunt u de verdeling van donkere gebieden en lichte gebieden wijzigen,
bijvoorbeeld als u prioriteit wilt geven aan de toon van donkere gebieden boven lichte gebieden, door Exposure Index te
wijzigen ten opzichte van de basisgevoeligheid.

Druk op de knop [Base Look/LUT] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Base Look/LUT] krijgt een oranje kleur.

Het aanpassingspaneel Base Look/LUT verschijnt.

1

Selecteer [HDMI/Stream] > [MLUT].

Een LUT wordt toegepast op de HDMI-uitvoer en streamen.

2

Druk op de knop [Base ISO/Exposure Index] in het basisconfiguratiepaneel van de camera.

Het kader van de knop [Base ISO/Exposure Index] krijgt een oranje kleur.

Het aanpassingspaneel Base ISO/Exposure Index verschijnt.

3

Pas de belichtingsindex aan volgens de gewenste verdeling van donkere en lichte gebieden met de
schuifbalk [Exposure Index] of de aanpassingsknoppen [Exposure Index].

Voor [Cine EI]

Voor [Cine EI Quick]
De basisgevoeligheid wordt automatisch ingesteld op basis van de opgegeven belichtingsindex.

4
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Hint

U kunt dit ook instellen met [Shooting] > [ISO/Gain/EI] > [Exposure Index] in het cameramenu.

SDI-uitvoer kan op dezelfde manier worden gebruikt.

De tweede numerieke waarde van de instelling geeft aan hoeveel stappen helderheidinformatie zijn toegewezen voor lichte
gebieden (helderheid hoger dan 18% grijs). Gebieden die lichter zijn dan dat, zijn overbelicht.
Voorbeeld: In "400EI/5.0E" zijn 5,0 stappen toegewezen aan de lichte zijde.

U kunt dit ook als een leidraad gebruiken om de toon van donkere en lichte gebieden tijdens het filmen te controleren. Vergeet
niet terug te gaan naar de oorspronkelijke EI-waarde na het controleren van de belichting. Pas in Cine EI Quick-modus ook op
dat u de basisgevoeligheid niet verkeerd beïnvloedt.

5-041-957-73(1) Copyright 2022 Sony Corporation

Pas de belichting en/of het ND-filter aan zodat de camerabeelduitvoer van [HDMI/Stream] de juiste
belichting heeft.

5
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RAW video opnemen

U kunt het RAW video uitgangssignaal van de SDI OUT-aansluiting van het apparaat naar een externe recorder die
wordt ondersteund.
De ondersteunde RAW uitvoerindelingen worden hieronder weergegeven.

Systeemfrequentie [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Sluit een externe RAW-recorder aan op de SDI OUT-aansluiting van het apparaat.1

Stel [Project] > [Base Setting] > [Shooting Mode] in op [Cine EI], [Cine EI Quick] of [Flexible ISO] in het
webmenu of cameramenu.

2

Stel de beeldhoek (alleen FF) in met [Project] > [Rec Format] > [Imager Scan Mode] in het webmenu of het
cameramenu.

3

Stel [Project] > [Rec Format] > [Codec] in op [RAW] in het webmenu of cameramenu.

Als u [RAW & XAVC-I] selecteert, wordt video tegelijkertijd naar de externe RAW-recorder opgenomen en naar de
geheugenkaarten in het apparaat.

4

Set de resolutie in met [Project] > [Rec Format] > [RAW Output Format] in het webmenu of het cameramenu.5

Controleer of de externe recorder is ingeschakeld en druk dan op de opnameknop START/STOP op het live-
bedieningsscherm.

De opnamestatus voor RAW-video wordt aangegeven door een pictogram in het camerabeeldpaneel.

6

255



Opmerking

Als de opname wordt gestart op de externe recorder zonder gebruik te maken van de opnameknop START/STOP op de live-
bedieningsscherm, worden de clips mogelijk niet goed opgenomen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Opmerking

Het opnameregelsignaal wordt verzonden via de SDI OUT-aansluiting van het apparaat, maar het is niet mogelijk om de
status van de externe recorder op te vragen. Als gevolg hiervan kan het apparaat aangeven dat RAW-video-opname loopt
als de externe recorder eigenlijk niet opneemt. Controleer de indicator op de externe recorder voor de correcte
functioneringsstatus.

256



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

RAW-video opnemen in de modus Slow & Quick Motion

U kunt RAW-video opnemen in de modus Slow & Quick Motion.

Voor meer informatie over de ondersteunde beeldsnelheden raadpleegt u "Slow & Quick Motion".

Verwant onderwerp

Slow & Quick Motion

5-041-957-73(1) Copyright 2022 Sony Corporation
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De functie Bokeh Control in-uitschakelen

U kunt het bokeh-niveau gemakkelijk aanpassen door het ND-filter en de versterking te koppelen aan de bediening van
het diafragma.

De functie Bokeh Control in-uitschakelen

Deze functie kan alleen worden ingeschakeld als u de belichting handmatig aanpast. Stel het ND-filter in op variabele
modus, stel dan het diafragma, de versterking, de sluiter en het ND-filter in op handmatige bediening.
U kunt de bokeh-regelfunctie in- en uitschakelen met [Shooting] > [Iris] > [Bokeh Control] in het cameramenu.
Wanneer de bokeh-regelfunctie is ingesteld op On, verschijnt het pictogram   (B) op het ND-filter en de
versterkingsindicatoren.

Opmerking

Deze functie is alleen ingeschakeld op objectieven met E-bevestiging die kunnen communiceren met het apparaat.

Het maximale effect van deze functie wordt bereikt door een objectief met E-bevestiging van Sony te gebruiken.

De bokeh-regelfunctie wordt ingesteld op Off als u een van de volgende handelingen uitvoert.

Wanneer u het apparaat uitschakelt
Wanneer diafragma, versterking, sluiter of ND-filter is ingesteld op Auto
Wanneer u de opnamemodus wijzigt
Wanneer het ND-filter is ingesteld op wissen of een presetmodus
Wanneer u het objectief verwijdert
Wanneer het apparaat opnieuw opstart, bijvoorbeeld na een wijziging in frequentie

Hint

U kunt de functie [Bokeh Control] ook toewijzen aan een toewijsbare knop en de bokeh-regelfunctie schakelen tussen On en Off
met de knop.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het bokeh-niveau aanpassen

Pas de instellingen bij de stappen 2 t/m 4 aan zoals gewenst.

Opmerking

Hoe dit eruit ziet, hangt af van de gebruikssnelheid, objectief, opname-instellingen en het onderwerp; ook de helderheid kan
veranderen. U kunt het beste eerst een cameratest uitvoeren voor u gaat opnemen.

De helderheid kan veranderen wanneer de richting van het diafragmagebruik wijzigt, bijvoorbeeld wanneer u het diafragma opent
nadat u het eerder had gesloten of wanneer u het diafragma sluit na het te openen. In dat geval past u iets verder aan dan nodig
en neemt u vervolgens iets terug. Controleer de helderheid en begin dan met opnemen. Als u bijvoorbeeld het diafragma wilt
openen naar F8 en de achtergrond wilt vervagen, open dan het diafragma eerst verder dan F8 en neem vervolgens terug tot F8.
Controleer vervolgens de helderheid en begin met opnemen.

Voer bedieningsfuncties aan de bokeh langzaam uit. Als u sneller wilt werken, probeer dan geleidelijk aan te passen terwijl u de
wijzigingen in het beeld in de gaten houdt.

Hint

Wanneer de bokeh-regelfunctie is ingesteld op On, werken het ND-filter en de versterking samen en compenseren ze wijzigingen
in de belichting door aanpassing van het diafragma. Zo kunt u het bokeh-niveau aanpassen.

De Bokeh Control wordt eerst gekoppeld aan het ND-filter in reactie op het gebruik van het diafragma. Wanneer het ND-filter niet
meer gewijzigd kan worden, wordt de versterking gekoppeld.

In MF-modus kunt u het beste eerst het diafragma openen en vervolgens scherpstellen.

Wanneer u het automatische ND-filter gebruikt in plaats van de functie Bokeh Control, volgt het ND-filter de wijzigingen in
helderheid van het onderwerp.

Weergave tijdens koppelen van versterking
Wanneer de bokeh-regelfunctie is ingesteld op On, kan de versterking wijzigen als het diafragma wordt aangepast.
Wanneer de versterking is gekoppeld en deze wijzigt, verschijnt er een melding bovenin het scherm en knippert het
pictogram   (B) op de versterkingsindicator.

Stel de bokeh-regelfunctie in op On.1

Open het diafragma volledig.2

Stel het ND-filter in op 1/128.3

Stel de versterking in op 0 dB en gebruik verlichting om de juiste belichting te krijgen.4

Past de scherpstelling aan.5

Pas het diafragma aan.

Het bokeh-niveau verandert.

6
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Overzicht van configuratiegegevens opslaan en laden

U kunt de instellingen van het apparaat opslaan als configuratiegegevens met de webapp. Zo kunt u snel een geschikte
set menu-instellingen voor de huidige situatie oproepen.
Met dit apparaat kunt u bijna alle instellingen die te maken hebben met camerafuncties opslaan in een ALL-bestand
(bestand met alle instellingen), behalve de volgende.

Opmerking

Netwerkfunctie-instellingen en verificatiegegevens worden niet opgeslagen. Voor nadere informatie over opgeslagen raadpleegt u
"Lijst met menu-onderdelen".

Verwant onderwerp

Lijst met menu-onderdelen

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een ALL-bestand opslaan

In dit onderwerp wordt beschreven hoe u een ALL-bestand opslaat.

5-041-957-73(1) Copyright 2022 Sony Corporation

Open [Project] > [All File] in het webmenu.1

Druk op de knop [Save All File] > [Save].

De webbrowser downloadt tijdelijk een bestand met de naam all-file.ALL.

2

Geef een locatie en bestandsnaam op voor het gedownloade all-file.ALL-bestand en sla het bestand op.

Voor nadere informatie over bestandsacties raadpleegt u de gebruiksaanwijzing van uw apparaat.

3
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Een ALL-bestand laden

In dit onderwerp wordt beschreven hoe u een ALL-bestand laadt.

Opmerking

Het apparaat start automatisch opnieuw na het laden van de configuratiegegevens. Na de herstart laadt u de pagina in de
webbrowser opnieuw.

5-041-957-73(1) Copyright 2022 Sony Corporation

Open [Project] > [All File] in het webmenu.1

Druk op de knop [Load All File] > [Load].

Het bestandsdialoogvenster verschijnt op het apparaat waarop u de webapp gebruikt.

2

Open het bestand dat u wilt laden.

Voor nadere informatie over bestandsacties raadpleegt u de gebruiksaanwijzing van uw apparaat.

3

Wanneer het meldingenscherm voor de bestandsnaam verschijnt, drukt u op de knop [OK].4

Wanneer het bevestigingsscherm verschijnt, drukt u op de knop [OK].5

Wacht tot het apparaat opnieuw is opgestart en maak opnieuw verbinding met de webapp.6
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Bestanden overbrengen

U kunt een proxy-bestand of een origineel bestand dat is opgenomen op het apparaat uploaden naar een server op het
internet of op een lokaal netwerk.

Opmerking

Wanneer de voeding in de status Stand-by wordt geplaatst, worden bestandsoverdrachten onderbroken, ook al heeft het
apparaat nog steeds stroom.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een doel voor bestandsoverdracht registreren

U kunt een doelserver voor overdracht registreren voordat u een bestandsoverdracht start.

Selecteer [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (of [Server Settings2],
[Server Settings3]) in het webmenu.

Hint

De naam van de geselecteerde optie verandert in overeenstemming met de [Display Name] die u in de volgende stap
configureert.

1

Configureer de volgende onderdelen voor [Network] > [FTP Server 1] t/m [FTP Server 3] in het webmenu.

[Display Name]
Voer de naam van de server in die moet worden weergegeven in de lijst met overdrachtsdoelen wanneer u een
doelserver voor overdracht selecteert.
[Service]
Geeft het servertype weer.
[FTP]: FTP-server
[Host Name]
Voer het adres of de hostnaam van de server in.
[Port]
Voer het poortnummer van de server in waarmee verbinding moet worden gemaakt.
[User Name]
Voer de gebruikersnaam in.
[Password]
Voer het wachtwoord in.
[Passive Mode]
Schakel passieve modus in of uit.
[Destination Directory]
Voer de naam van de map op de bestemmingsserver in.

Opmerking

Als er tekens worden ingevoerd die ongeldig zijn op de doelserver die is opgegeven bij [Destination Directory], worden
bestanden verzonden naar de hoofdmap van de gebruiker. Welke tekens ongeldig zijn verschilt, afhankelijk van de server.

[Using Secure Protocol]
Stel in of veilige FTP-overdracht moet worden gebruikt.
[Root Certificate]
Laad/wis een certificaat.
[Load]: laad een CA-certificaat. Laadt certificaten in PEM-indeling.
[Clear]: wis het CA-certificaat.
[None]: laad of wis geen certificaat.

Opmerking

Stel de klok van het apparaat in op de juiste tijd voordat u een CA-certificaat laadt.

Bij opnemen in XAVC-I 4096×2160P/3840×2160P 59.94/50P kan [Load] niet worden geselecteerd.

2
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[Root Certificate Status]: geeft de laadstatus van het certificaat weer.
[Reset]: stelt de Server Settings terug naar de standaardwaarden.
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Proxy-bestanden op een geheugenkaart vanaf het pictogrammenscherm uploaden

U kunt proxy-bestand op een geheugenkaart afzonderlijk vanaf het pictogrammenscherm uploaden.

Opmerking

Er kunnen maximaal 200 overdrachtstaken worden geregistreerd.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de knop [Thumbnail] op het live-bedieningsscherm van de webapp.

De weergave schakelt over van het camerabeeld naar het pictogrammenscherm.

1

Selecteer [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] in het cameramenu.

Wilt u alle proxy-bestanden tegelijkertijd overbrengen, selecteer dan [Transfer Clip (Proxy)] > [All Clips].
Clips kunnen worden verzonden vanuit het pictogrammenscherm of het pictogrammenscherm met gefilterde clips.

2

Selecteer de clip die u wilt overbrengen met de knop [Set] en druk op de knop [Menu].

Er verschijn een bevestigingsscherm voor de overdracht.

3

Selecteer [Execute].

Het proxy-bestand dat overeenkomt met de geselecteerde clip wordt geregistreerd als een overdrachtstaak en het
uploaden begint.
Als de overdrachtsopdracht succesvol is geregistreerd verschijnt het resultaatscherm voor de overdracht.

4

Druk op de knop [OK].5
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Originele bestanden op een geheugenkaart vanaf het pictogrammenscherm uploaden

U kunt een origineel bestand op een geheugenkaart vanaf het pictogrammenscherm uploaden.

Opmerking

Er kunnen maximaal 200 overdrachtstaken worden geregistreerd.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de knop [Thumbnail] op het live-bedieningsscherm van de webapp.

De weergave schakelt over van het camerabeeld naar het pictogrammenscherm.

1

Selecteer [Thumbnail] > [Transfer Clip] > [Select Clip] in het cameramenu.

Wilt u alle originele bestanden tegelijkertijd overbrengen, selecteer dan [Transfer Clip] > [All Clips].
Clips kunnen worden verzonden vanuit het pictogrammenscherm of het pictogrammenscherm met gefilterde clips.

2

Selecteer de clip die u wilt overbrengen met de knop [Set] en druk op de knop [Menu].

Er verschijn een bevestigingsscherm voor de overdracht.

3

Selecteer [Execute].

Het originele bestand dat overeenkomt met de geselecteerde clip wordt geregistreerd als een overdrachtstaak en
het uploaden begint.
Als de overdrachtsopdracht succesvol is geregistreerd verschijnt het resultaatscherm voor de overdracht.

4

Druk op de knop [OK].5
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De status van de bestandsoverdracht controleren

U kunt de status van de bestandsoverdracht controleren door [Network] > [File Transfer] > [View Job List] te selecteren in
het cameramenu.

Opmerking

Er kunnen maximaal 200 overdrachtstaken worden geregistreerd.

De overdrachtstaken worden behouden wanneer het apparaat naar stand-by wordt geschakeld, maar maximaal 10 minuten van
de voortgangsinformatie kan verloren gaan als de voeding op een andere manier wordt onderbroken.

Als er een fout optreedt tijdens de bestandsoverdracht, wordt de overdracht van een clip met dezelfde naam als een
overgedragen clip mogelijk niet hervat, afhankelijk van de instellingen en status van de bestemmingsserver voor overdracht.
Controleer in dit geval de instelling en status van de transmissiebestemmingsserver.

Hint

Als [Network] > [File Transfer] > [Auto Upload (Proxy)] is ingesteld op [On] in het cameramenu en er een netwerkverbinding
bestaat, worden proxy-bestanden automatisch ge-upload naar de server die is opgegeven bij [Default Upload Server] als de
opname wordt beëindigd.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Uploaden met veilige FTP

U kunt bestanden uploaden met versleuteling met behulp van FTPS in Explicit mode (FTPES) voor de verbinding met de
bestemmingsbestandsserver.
Voor veilige FTP-overdracht stelt u [Using Secure Protocol] bij de instellingen van de bestemmingsbestandsserver in op
[On] en laadt u een certificaat.

Voor nadere informatie over de configuratie raadpleegt u "Een doel voor bestandsoverdracht registreren".

Verwant onderwerp

Een doel voor bestandsoverdracht registreren

5-041-957-73(1) Copyright 2022 Sony Corporation
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Over streamen

Het apparaat kan tegelijkertijd de video en audio streamen die wordt uitgevoerd vanaf de HDMI-aansluiting.

Opmerking

Wilt u streamen gebruiken als hoofdvideo, stel dan [Monitoring] > [Output Display] > [SDI] in op [On] en [HDMI/Stream] op [Off] in
het webmenu en volg de camerastatus op een SDI-monitor.

Als u een HDMI-monitor hebt aangesloten die de HDMI-uitvoerindeling niet ondersteunt die is geconfigureerd in het menu
[Monitoring] in het webmenu of cameramenu, wordt het camerabeeld niet uitgevoerd naar de webapp. Streamende video kan dan
ook niet worden uitgevoerd.

De resolutie voor streamen kan niet hoger worden ingesteld dan de resolutie van het HDMI-uitvoersignaal.

Wanneer er meerdere gebruikers kijken, kan het beeld vervormd raken, afhankelijk van de codec-instellingen.

Het apparaat ondersteunt de volgende methoden voor streamen. De beschikbare video-codecs worden tussen haakjes
weergegeven.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configureer de instelling voor de streamindeling, video-codec-instelling en audio-codec-instelling, in die volgorde.

●: ingeschakeld, –: uitgeschakeld

Hint

Het beeld in het camerabeeldpaneel van de webapp is tegelijkertijd een streamingsysteem.

Streamindeling
Codec-instelling

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Webapp – – ● –

RTMP kan worden geselecteerd wanneer [Stream] > [Audio Stream] is ingesteld op [On] in het webmenu.*1

Wanneer de systeemfrequentie 59,94 of 50 is en de HDMI-uitvoerindeling is 3840×2160 of hoger, is video 2-uitvoer niet beschikbaar.*2
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De streamindeling instellen

Stel de streamindeling in met [Stream] > [Stream] > [Stream Setting] > [Setting] in het cameramenu.

Als [Setting] is ingesteld op [RTSP]

Bij RTSP-streamen kan het beeld van één camera tegelijkertijd worden bekeken door vijf gebruikers.
U kunt twee video-codecmodi instellen.
[Port Number]
Hiermee stelt u het poortnummer in dat voor RTSP-streamen wordt gebruikt. De standaardwaarde is 554.
Wanneer u deze waarde wijzigt, start de RTSP-server opnieuw op.
[Time Out]
Geeft de maximale tijd op van de Keep-Alive-opdracht voor RTSP-streamen. De maximale tijd kan worden ingesteld van
0 seconden tot 600 seconden. De standaardinstelling is 60 seconden.
Wanneer u de instelling 0 seconden kiest, is de Keep-Alive-opdracht niet werkzaam.
[Authentication]
Geeft aan of verificatie vereist is.
[Video Port Number 1], [Video Port Number 2]
Geeft het poortnummer voor beeldgegevenscommunicatie aan dat wordt gebruikt voor RTSP-unicast-streamen. De
standaardwaarde voor Video Port Number 1 is 51000. De standaardwaarde voor Video Port Number 2 is 53000. Voer
een viercijferig nummer in het bereik van 1024 t/m 65534 in. De waarde die u hier instelt en het daarop volgende oneven
nummer dat u verkrijgt door 1 erbij op te tellen, worden de twee poortnummers die worden gebruikt voor
beeldgegevenscommunicatie en -regeling.
[Video Port Number 1] en [Video Port Number 2] komen overeen met [Stream] > [Video Stream] > [Video Stream 1] en
[Video Stream 2].
[Audio Port Number]
Geeft het poortnummer op voor geluidsgegevenscommunicatie dat wordt gebruikt voor RTSP-unicast-streamen. De
standaardwaarde is 57000. Voer een viercijferig nummer in het bereik van 1024 t/m 65534 in. De waarde die u hier
instelt en het daarop volgende oneven nummer dat u verkrijgt door 1 erbij op te tellen, worden de twee poortnummers die
worden gebruikt voor geluidsgegevenscommunicatie en -regeling.

Als [Setting] is ingesteld op [RTMP]

De video-codecmodus die kan worden gebruikt voor RTMP is alleen H.264. Wilt u RTMP gebruiken, dan moet [Stream] >
[Audio Stream] worden ingesteld op [On] in het webmenu.
[Server URL]
Hiermee stelt u het doeladres voor het uploaden in. Geef een tekenreeks op die begint met "rtmp://" of "rtmps://".
[Stream Key]
Voer de streamsleutel in die u hebt gekregen van de website die u gebruikt. Wanneer u op de knop [Clear] drukt, wist u
de invoer.

Opmerking

Wees voorzichtig met het gebruik van de streamsleutel. Als een derde de streamsleutel kent, kan deze de stream nabootsen.

[Root Certificate]
Hiermee importeert u het basiscertificaat voor streamen met het RTMPS-protocol. Druk op de knop [Load] en selecteer
een basiscertificaat om het basiscertificaat te importeren. Druk op de knop [OK] in het dialoogvenster voor
bestandskeuze om het geselecteerde bestand naar het apparaat te importeren. Als er een geïmporteerd basiscertificaat
in het apparaat bestaat, wordt het basiscertificaat bijgewerkt. Wilt u een geïmporteerd basiscertificaat verwijderen, druk
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dan op de knop [Delete] in het instelscherm. De status van het basiscertificaat wordt weergegeven bij [Root Certificate
Status].

Opmerking

Importeer het basiscertificaat dat vereist is door de streamingdienst.

Als [Setting] is ingesteld op [SRT-Caller] of [SRT-Listener]

De video-codecmodus is alleen H.264.
[Destination]
Wordt weergegeven wanneer de streammodus is ingesteld op [SRT-Caller]. Hiermee stelt u het doeladres van de
verbinding in.
[Port Number]
Wordt weergegeven wanneer de streammodus is ingesteld op [SRT-Listener]. Hiermee stelt u het poortnummer in
waarop wordt geluisterd. De standaardwaarde is 4201.
[Latency]
Stelt de vertragingstijd in tussen 20 ms en 8000 ms. De standaardwaarde is 120.
[TTL]
Hiermee stelt u de TTL-waarde in tussen 1 en 255. De standaardwaarde is 64.
[Encryption]
Hiermee selecteert u de versleutelingsmethode. Selecteer Off, AES128 of AES256. De standaardwaarde is Off.
[Passphrase]
Stelt het wachtwoord in voor de versleuteling. Wanneer u op de knop [Clear] drukt, stelt u het geconfigureerde
wachtwoord terug.
[ARC]
Wilt u de functie Adaptive Rate Control inschakelen, stel dit dan in op On.
Wanneer de functie Adaptive Rate Control is ingeschakeld, kunnen onderbrekingen in het beeld door opstopping in de
communicatielijn worden verminderd.

Als [Setting] is ingesteld op [NDI|HX]

Het apparaat voldoet aan NDI|HX versie 2 van NewTek.
Wilt u NDI|HX gebruiken, dan moet u een licentie kopen.
Een licentie kopen
Koop een licentie op het volgende adres van NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Opmerking

Download het nieuwste NDI|HX-stuurprogramma en installeer dit in een product van NewTek.

Voor nadere informatie over het registreren van en werken met NDI|HX raadpleegt u de gebruiksaanwijzing bij het product van
NewTek.

[License]
Geeft de licentiegegevens weer wanneer een licentie is ingeschakeld.
[Source Name]
Geeft de bronnaam weer.
[Group]
Wilt u de groeperingsfunctie voor NDI inschakelen, stel dit dan in op On.
[Group Name]: stelt de NDI groepsnaam in. U kunt meerdere instellingen configureren, gescheiden door een komma.
[Discovery Server 1], [Discovery Server 2]
Stelt NDI-ontdekkingsserver 1 en NDI-ontdekkingsserver 2 in.
[Reliable UDP Mode]
Wilt u de modus Reliable UDP inschakelen, stel dit dan in op On.
[Multicast Mode]
Wilt u multicast-streamen inschakelen, stel dit dan in op On.
[Multicast Prefix]: stelt het voorvoegsel in voor multicast-streamen.
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[Multicast Netmask]: stelt het netmasker in dat het adresbereik voor multicast bepaalt.
[Multicast TTL]: hiermee stelt u de TTL-waarde voor multicast-streamen in tussen 1 en 256. De standaardwaarde is 3.
[Multi-TCP Mode]
Wilt u de modus Multi-TCP inschakelen, stel dit dan in op On.
[Unicast UDP Mode]
Wilt u de modus Unicast UDP inschakelen, stel dit dan in op On.

Over diensten en software van derden
Er kunnen verschillende gebruiksvoorwaarden van toepassing zijn.

De levering van diensten en software-updates kan zonder aankondiging worden onderbroken of beëindigd.
De beschrijving van diensten en software kan zonder voorafgaande kennisgeving worden gewijzigd.
Apart registreren en abonneren kan vereist zijn.

Sony is niet aansprakelijk voor aanspraken door gebruikers of derden in verband met diensten en software van andere
bedrijven.

5-041-957-73(1) Copyright 2022 Sony Corporation
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De video-codec voor streamen instellen

Stel de video-codec in met [Stream] > [Video Stream] in het webmenu.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
U kunt drie beeld-codecmodi instellen. Configureer de volgende instellingen apart voor elke beeldmodus.
[Video Stream 3] wordt gebruikt voor het camerabeeldpaneel van de webapp.

Opmerking

Wanneer [Stream] > [Stream Setting] > [Setting] is ingesteld op [RTMP], [SRT-Caller] of [SRT-Listener], hebben sommige van de
instellingen [Video Stream 1], [Video Stream 2] en [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])
de standaardwaarden.

[Codec 1], [Codec 2], [Codec 3]
Selecteer [H.264], [H.265] of [Off]. Merk op dat u [Codec 1] niet kunt instellen op [Off]. Bovendien is [Codec 3] ingesteld
op [JPEG] (vast).

Opmerking

De volgende symptomen kunnen optreden, afhankelijk van de combinatie van verschillende instellingen, zoals beeldgrootte,
beeldsnelheid en bitsnelheid van [Codec 1], [Codec 2] en [Codec 3].

Langere video-vertragingstijd.
Overslaan van frames tijdens het afspelen van video.
Hakkelend geluid.
Langzame reactie van de camera op verschillende opdrachten.
Langzame reactie van de camera op handelingen op een afstandsbediening.
Langzame weergave op de monitor en langzame configuratiehandelingen.

Als u deze symptomen hebt, verlaag dan de waarden van de parameters voor beeldgrootte, beeldsnelheid en bitsnelheid of wijzig
de waarden van andere instellingsparameters om het probleem op te lossen.

Wanneer [Stream] > [Stream Setting] > [Setting] is ingesteld op [RTMP], [SRT-Caller] of [SRT-Listener], [Codec 1] is ingesteld op
[H.264] (vast). [Codec 2] is ingesteld op [Off] (vast).

Wanneer de beeldgrootte of systeemfrequentie van de HDMI-uitvoer verandert, wordt [Codec 2] ingesteld op [Off].

[Size 1], [Size 2], [Size 3]
Hiermee selecteert u de beeldgrootte die vanaf de camera wordt gestreamd.
De beschikbare opties voor beeldgrootte hangen af van de beeldgrootte van de HDMI-uitvoer.

Opmerking

Wanneer de beeldgrootte of systeemfrequentie van de HDMI-uitvoer verandert, wordt de maximale beeldgrootte geselecteerd.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Hiermee stelt u de beeldsnelheid van het beeld in.
"fps" geeft het aantal frames aan dat per seconde wordt gestreamd.
De beschikbare opties voor beeldsnelheid hangen af van de beeldgrootte van de HDMI-uitvoer.

Opmerking
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Wanneer de beeldgrootte of systeemfrequentie van de HDMI-uitvoer verandert, wordt de maximale beeldsnelheid geselecteerd.

[I-Picture Mode 1], [I-Picture Mode 2]
Hiermee stelt u de methode waarmee het insteekinterval voor I-picture wordt opgegeven voor H.264 en H.265 in op
[Time] of [Frame].
Kan niet worden ingesteld voor [Codec 3].
[Time]: stelt het insteekinterval voor I-picture in als tijd.
[Frame]: stelt het insteekinterval voor I-picture in als aantal frames.
[I-Picture Interval 1], [I-Picture Interval 2]
Stelt het insteekinterval voor I-picture in seconden in. Stelt een waarde in tussen 1 seconde en 5 seconden. De
standaardinstelling is 1 seconde.
Kan niet worden ingesteld voor [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Stelt een insteekinterval in voor H.264 en H.265 als aantal frames tussen 15 en 300. De standaardinstelling is 300
frames.
Kan niet worden ingesteld voor [Codec 3].
[Profile 1], [Profile 2]
Stelt het beeld-codecprofiel in voor H.264 of H.265.
[H.264]: selecteer het profiel [high], [main] of [baseline].
[H.265]: selecteer het profiel [main] of [main10]. Wanneer u twee videocodecs inschakelt, is alleen de profielselectie-optie
[main] beschikbaar.
Het beeldcompressierendement wordt hoger in de volgorde [high], [main] en [baseline]. Selecteer een profiel dat wordt
ondersteund door uw systeem.
Wanneer [H.265] is ingesteld op [main10], wordt [main10] gebruikt wanneer de HDMI-uitvoer YCrCb is of [main] wanneer
de HDMI-uitvoer RGB is.
Kan niet worden ingesteld voor [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Selecteer [CBR] of [VBR].
Wilt u een constante bitsnelheid behouden, selecteer dan [CBR]. Wilt u beeldkwaliteit behouden, selecteer dan [VBR].
Kan niet worden ingesteld voor [Codec 3].

Opmerking

De werkelijk gestreamde beeldsnelheid en bitsnelheid kunnen afwijken van de ingestelde waarden, afhankelijk van de
beeldgrootte, opnamescene, netwerkomgeving en andere factoren.

Wanneer [Stream] > [Stream Setting] > [Setting] is ingesteld op [RTMP], [SRT-Caller] of [SRT-Listener], [Bit Rate Compression
Mode 1] is ingesteld op [CBR] (vast).

[Bit Rate 1], [Bit Rate 2]
U kunt de bitsnelheid per videostream instellen wanneer [Bit Rate Compression Mode] is ingesteld op [CBR]. Door een
hoge bitsnelheid in te stellen, kunt u in hoge beeldkwaliteit streamen.
Kan niet worden ingesteld voor [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Hiermee stelt u de beeldkwaliteit in tussen 1 en 10. De waarde 10 staat voor de hoogste beeldkwaliteit. De
standaardwaarde is 6.
Voor [Quality 1] en [Quality 2] kunt u de beeldkwaliteit voor H.264 instellen door [Bit Rate Compression Mode] in te
stellen op [VBR] en [Codec] in te stellen op [H.264]. U kunt de beeldkwaliteit van H.265 instellen door [Bit Rate
Compression Mode] in te stellen op [VBR] en [Codec] op [H.265].

5-041-957-73(1) Copyright 2022 Sony Corporation
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De audio-codec voor streamen instellen

Stel de audio-codec in met [Stream] > [Audio Stream] in het webmenu.
[Setting]
Wilt u audio streamen inschakelen, stel dit dan in op On.

Opmerking

Wilt u RTMP gebruiken, selecteer dan altijd eerst On.

[Codec]
Hiermee selecteert u het type codec dat voor het streamen van audio wordt gebruikt.
[AAC (256kbps)]: selecteer dit om prioriteit te geven aan de geluidskwaliteit.
[AAC (128kbps)]: selecteer dit om prioriteit te geven aan de gegevenscapaciteit.
Deze instelling heeft geen effect op de clip die wordt opgenomen door het apparaat of op het audiosignaal dat is ingebed
in het HDMI-/SDI-signaal.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Starten en stoppen met streamen

Voor [RTSP], [SRT-Listener] en [NDI|HX]

Het apparaat wacht op een verzoek tot levering van een stream.
Start een client-toepassing voor het bekijken van de stream en open het webadres dat u in de volgende tabel vindt.
Voer de waarden voor gebruikersnaam en wachtwoord in die zijn geconfigureerd op het apparaat.

<camera_adres>: IP-adres van het apparaat
<Poort>: luisterpoort die is geconfigureerd met [Port Number]

Opmerking

Het afspelen in alle toepassingen of op alle apparaten wordt niet gegarandeerd.

Voor [RTMP] en [SRT-Caller]

Druk op de knop [Stream now] op het tabblad  (Stream) van het live-bedieningsscherm om het streamen te starten.
De knop wijzigt in [Stop stream] en het pictogram [Stream] verschijnt boven het camerabeeldpaneel.
Druk tijdens het streamen op de knop [Stop stream] om het streamen te stoppen. De knop wijzigt weer in [Stream now]
en het pictogram [Stream] boven het camerabeeldpaneel verdwijnt.

Opmerking

Het afspelen in alle toepassingen of op alle apparaten wordt niet gegarandeerd.

5-041-957-73(1) Copyright 2022 Sony Corporation

Streamindeling Webadres

RTSP
Video Stream 1 rtsp://<camera_adres>:<Poort>/video1

Video Stream 2 rtsp://<camera_adres>:<Poort>/video2

SRT-Listener srt://<camera_adres>:<Poort>

NDI|HX Raadpleeg de gebruiksaanwijzing bij het client-apparaat dat compatibel is met NDI|HX.
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Pictogrammenscherm

Wanneer u op de knop [Thumbnail] drukt op het afspeel-bedieningsscherm of op de knop THUMBNAIL op de
infraroodafstandsbediening, worden de clips die zijn opgenomen op de geheugenkaart weergegeven in het
camerabeeldpaneel. Deze weergave in het camerabeeldpaneel wordt het pictogrammenscherm genoemd.
U kunt een clip op het pictogrammenscherm selecteren en het afspelen van die clip starten.
Wanneer u tijdens weergave van het pictogrammenscherm op de knop [Thumbnail] drukt, sluit het pictogrammenscherm
weer en gaat u terug naar het camerabeeld.

Opmerking

Alleen de clips die zijn opgenomen in de momenteel geselecteerde opname-indeling worden weergegeven op het
pictogrammenscherm. Als een verwachte opgenomen clip niet wordt weergegeven, controleer dan de opname-indeling. Let hier
speciaal op vóór het formatteren (initialiseren) van media.

Schermindeling

Het pictogram van een geselecteerde clip wordt weergegeven met een oranje achtergrond.
Informatie over de geselecteerde clip wordt weergegeven aan de onderkant van het scherm.
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Geselecteerde geheugenkaart
Er verschijnt rechts een grendelpictogram als de geheugenkaart schrijfbeveiligd is.

1.

Clipnummer/totaal aantal clips2.

Pictogram (indexafbeelding)
Geeft de indexafbeelding van de clip weer. Als een clip wordt opgenomen, wordt het eerste frame automatisch
ingesteld als indexafbeelding.
Clip/frame-informatie wordt weergegeven onder het pictogram. U kunt de weergegeven informatie wijzigen met
[Thumbnail] > [Customize View] > [Thumbnail Caption] in het cameramenu.

3.

Clipnaam
Geeft de naam van de geselecteerde clip weer.

4.

Opname-indeling
Geeft de bestandindeling van de geselecteerde clip weer.

5.

Speciale opname-informatie
Geeft de opname-indeling alleen weer als de clip is opgenomen in een speciale opnamemodus.
Voor Slow & Quick Motion-clips wordt de beeldsnelheid aan de rechterkant weergegeven.

6.

Clipduur7.

Aanmaakdatum8.
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Opgenomen clips afspelen

U kunt opgenomen clips afspelen als het apparaat in stand-bymodus (Stby) staat.
In dit onderwerp wordt beschreven hoe u opgenomen clips afspeelt met het GUI-bedieningspaneel.

Plaats de geheugenkaart om af te spelen.1

Druk op de knop [Thumbnail].

De clippictogrammen verschijnen.

2

Gebruik de pijlknoppen in het GUI-bedieningspaneel om de cursor te verplaatsen naar het pictogram voor
de clip die u wilt afspelen.

3
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Opmerking

Er kan zich een tijdelijke onderbreking van het beeld of stilstaand beeld voordoen bij de overgang tussen clips. U kunt het
apparaat in deze tijd niet gebruiken.

Opmerking

U kunt clips niet selecteren door aanraken.

Druk op de knop [Set] in het GUI-bedieningspaneel.

Afspelen begint vanaf het begin van de geselecteerde clip.

4

Gebruik het afspeel-bedieningspaneel naar behoefte.

Hint

U kunt ook handelingen verrichten met het GUI-bedieningspaneel.

Afspelen: druk op de knop [Set].
Afspelen pauzeren: druk op de knop [Set] terwijl er wordt afgespeeld. Druk nogmaals in om terug te gaan naar normaal
afspelen.
Springen naar het begin van de clip / begin van de volgende clip: druk op de knop links of rechts.
Snel vooruit/achteruit spoelen: houd de knop links/rechts ingedrukt. Het afspelen gaat terug naar normale snelheid als u
de knop loslaat.
Afspelen stoppen: druk op de knop [Cancel/Back].

5

Knop Functie

Knop  (Afspelen/pauze)
Hiermee speelt u een clip af. Tijdens het afspelen pauzeert u hiermee de
clip.

Knop  (Snel vooruit), knop 
(Snel achteruit)

Speelt clips af op hoge snelheid. Wanneer u op deze knop drukt,
verandert de afspeelsnelheid in drie stappen.

Knop  (Vorige), knop 
(Volgende)

Springt naar het begin van de clip of de vorige/volgende clip.

Knop  (Stop) Stopt het afspelen en schakelt over naar het opnamescherm.
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Als u een clip in het pictogrammenscherm selecteert en afspelen start, kan er zich een tijdelijke vervorming van het beeld
voordoen bij de start van de clip. Om het begin van de clip zonder vervorming te bekijken, pauzeert u en drukt u op de knop 
(Vorige) om naar het begin van de clip terug te gaan. Start daarna het afspelen opnieuw.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Acties op opgenomen clips

In het pictogrammenscherm kunt u de clips bedienen of clipeigenschappen controleren met het menu [Thumbnail] in het
cameramenu.
Druk op de knop [Menu] in het afspeel-bedieningsscherm om het cameramenu weer te geven in het camerabeeldpaneel.
U kunt de volgende handelingen uitvoeren in het menu [Thumbnail] in het cameramenu.
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Hint

U kunt ook op de knop [Menu] drukken in het live-bedieningsscherm om het cameramenu weer te geven.

Acties met het menu [Thumbnail] in het cameramenu
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Selecteer een functie met de pijlknoppen in het GUI-bedieningspaneel en druk op de knop [Set].
Druk op de knop [Cancel/Back] om naar het vorige scherm te gaan.

Opmerking

Sommige onderdelen kunnen niet worden geselecteerd, afhankelijk van de staat waarin het menu werd weergegeven.

Menu-onderdelen voor clipacties

Het menu [Thumbnail] in het cameramenu heeft de volgende menu-onderdelen voor acties op clips.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Voor nadere informatie over deze menu-onderdelen raadpleegt u "Het menu [Thumbnail]".

Het scherm voor clipeigenschappen weergeven
Selecteer [Thumbnail] > [Display Clip Properties] in het cameramenu om het scherm met clipeigenschappen weer te
geven.
Druk op de knop  (Vorige) of  (Volgende) om naar de vorige/volgende clip te springen.

Clipvlaggen toevoegen
U kunt clipvlaggen (OK-, NG- of KP-markeringen) aan clips toevoegen om de weergave te filteren op clips die zijn
gebaseerd op de clipvlaggen.
Selecteer het pictogram voor de clip waar u een vlag aan wilt toevoegen en selecteer vervolgens de clipvlag met
[Thumbnail] > [Set Clip Flag] in het cameramenu.

Hint

U kunt ook een toewijsbare knop gebruiken waaraan de clipvlagfunctie is toegewezen om clipvlaggen toe te voegen.

Het gefilterde clip-pictogrammenscherm weergeven
Selecteer [Thumbnail] > [Filter Clips] in het cameramenu en selecteer een type clipvlag om alleen de clips met die
specifieke vlag weer te geven.
Selecteer [All] om alle clips weer te geven.
U kunt ook op de knop [Display] drukken om de pictogrammen op vlag te sorteren.

Clips verwijderen
U kunt clips van een geheugenkaart verwijderen.
Selecteer [Thumbnail] > [Delete Clip] > [Select Clip] of [All Clips] in het cameramenu.
[Select Clip]: verwijdert de geselecteerde clip. Er kunnen meerdere clips tegelijk worden geselecteerd.
[All Clips]: verwijdert alle weergegeven clips.

Instelling Toegevoegde clipvlag

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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De op het pictogrammenscherm weergegeven informatie aanpassen
U kunt de weergegeven clip/frame-informatie onder het pictogram wijzigen.
Selecteer [Thumbnail] > [Customize View] > [Thumbnail Caption] in het cameramenu en selecteer de informatie die u wilt
weergeven.
[Date Time]: geeft de datum en de tijd weer waarop de clip is gemaakt en het laatst is gewijzigd.
[Time Code]: geeft de tijdcode weer.
[Duration]: geeft de duur van de clip weer.
[Sequential Number]: geeft een opeenvolgend getal weer voor elk pictogram.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Het cameramenu configureren

Wanneer u op de knop [Menu] in het GUI-bedieningspaneel of op de knop MENU op de infraroodafstandsbediening
drukt, wordt het cameramenu weergegeven in het camerabeeldpaneel. Hier kunt u de verschillende vereiste instellingen
voor filmen en afspelen instellen.

Het menu bestaat uit de volgende submenu's.

Menuconfiguratie

Menu [User]
Bevat menu-onderdelen die zijn geconfigureerd door de gebruiker.
Kan worden bewerkt met [Edit User Menu].
Menu [Edit User]
Bevat menu-onderdelen om het menu [User] te bewerken.
Menu [Shooting]
Bevat instellingen met betrekking tot filmen.
Menu [Project]
Bevat basisinstellingen voor projecten.
Menu [Paint/Look]
Bevat instellingen met betrekking tot beeldkwaliteit.
Menu [Pan-Tilt]
Bevat instellingen met betrekking tot zwenken en kantelen.
Menu [TC/Media]
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Bevat instellingen met betrekking tot tijdcodes en opnamemedia.
Menu [Monitoring]
Bevat instellingen met betrekking tot video-uitvoer en het weergavevenster.
Menu [Audio]
Bevat instellingen met betrekking tot audio.
Menu [Thumbnail]
Bevat instellingen met betrekking tot weergave van pictogrammen.
Menu [Technical]
Bevat instellingen voor technische onderdelen.
Menu [Network]
Bevat instellingen met betrekking tot netwerken.
Menu [Maintenance]
Bevat apparaatinstellingen, zoals de klok en taal.

Configuratie en hiërarchie van het cameramenu

Niveau 1 Niveau 2

User
(Fabrieksinstellingen)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Niveau 1 Niveau 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Niveau 1 Niveau 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Niveau 1 Niveau 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Het cameramenu gebruiken

Wanneer u op de knop [Menu] in het GUI-bedieningspaneel of op de knop MENU op de infraroodafstandsbediening
drukt, wordt het cameramenu weergegeven in het camerabeeldpaneel. Hier kunt u de verschillende vereiste instellingen
voor filmen en afspelen instellen.
U bedient het menu met knoppen in het GUI-bedieningspaneel.

Knop [Menu]: druk hierop om het cameramenu weer te geven. Druk nogmaals in als het cameramenu wordt
weergegeven om het menu te verbergen.
Pijlknoppen: druk op de pijlknoppen om de cursor omhoog/omlaag/naar links/naar rechts te verplaatsen om menu-
onderdelen of instellingen in het cameramenu te selecteren.
Knop [Set]: druk hierop om het geselecteerde onderdeel toe te passen.
Knop [Cancel/Back]: druk hierop om naar het vorige menu terug te gaan. Een wijziging die niet compleet is wordt
geannuleerd.

Opmerking

Sommige onderdelen kunnen niet worden geselecteerd, afhankelijk van de staat waarin het menu werd weergegeven.

Menu-onderdelen instellen

Verplaats de cursor naar het onderdeel dat u wilt instellen met de pijlknoppen in het GUI-bedieningspaneel en druk op de
knop [Set] om de instellingen toe te passen.

Het selectiegebied voor menu-onderdelen geeft maximaal acht regels weer. Als alle beschikbare opties voor een
onderdeel niet tegelijkertijd kunnen worden weergegeven, verschuif dan het display door de cursor omhoog en
omlaag te verplaatsen.
Voor de subonderdelen met een groot instelbereik (bijvoorbeeld −99 tot +99) wordt het instelgebied niet
weergegeven. De huidige instelling wordt gemarkeerd om aan te geven dat de waarde kan worden gewijzigd.
Door [Execute] te selecteren voor een functie wordt de betreffende functie uitgevoerd.
Een onderdeel selecteren dat moet worden bevestigd vóór uitvoering, verbergt het menu tijdelijk en geeft een
bevestigingsmelding weer. Controleer de melding en kies of de functie moet worden uitgevoerd of niet.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Een reeks tekens invoeren

Als u een onderdeel selecteert waarvoor tekens moeten worden ingevoerd, zoals een bestandsnaam, verschijnt het
tekeninvoerscherm.

5-041-957-73(1) Copyright 2022 Sony Corporation

Druk op de pijlknoppen in het GUI-bedieningspaneel om het teken te selecteren en pas de instelling toe.

[ABC]: hoofdletters
[abc]: kleine letters
[123]: cijfers
[!#$]: speciale tekens

1

Selecteer een teken en druk op de knop [Set] om de instelling toe te passen.

De cursor gaat naar het volgende veld.
[Space]: voert een spatie in op de cursorpositie.
[←] [→]: verplaatst de positie van de cursor.
[BS]: verwijdert het teken links van de cursor (backspace).

2

Als u klaar bent, drukt u op de knop [Done] om de instelling toe te passen.

De tekenreeks is bevestigd en het tekeninvoerscherm verdwijnt.

3
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User

In dit onderwerp worden de functies en instellingen van de diverse menu-onderdelen besproken.

Opmerking

U kunt menu-onderdelen toevoegen en verwijderen in het [User] met behulp van het menu [Edit User]. U kunt maximaal 20
onderdelen configureren.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Beschrijving

Base Setting Onderdeel Project > Base Setting

Focus Onderdeel Shooting > Focus

S&Q Motion Onderdeel Shooting > S&Q Motion

LUT On/Off Onderdeel Shooting > LUT On/Off

Simul Rec Onderdeel Project > Simul Rec

Proxy Rec Onderdeel Project > Proxy Rec

Interval Rec Onderdeel Project > Interval Rec

Picture Cache Rec Onderdeel Project > Picture Cache Rec

Assignable Button Onderdeel Project > Assignable Button

Scene File Onderdeel Project > Scene File

Base Look Onderdeel Paint/Look > Base Look

P/T Acceleration Onderdeel Pan-Tilt > P/T Acceleration

Clip Name Format Onderdeel TC/Media > Clip Name Format

Format Media Onderdeel TC/Media > Format Media

Video Signal Monitor Onderdeel Monitoring > Video Signal Monitor

Marker Onderdeel Monitoring > Marker

Zoom Onderdeel Technical > Zoom

Lens Onderdeel Technical > Lens

Edit User Menu Geeft het menu Edit User weer.
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Edit User

Het menu [Edit User] wordt weergegeven als bovenste niveau als [Edit User Menu] is geselecteerd in het [User].
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Add Item
Een onderdeel aan het
menu [User] toevoegen

– –
Voegt een menu-onderdeel van het 2e
niveau toe aan het menu [User].

Customize Reset
De onderdelen in het menu
[User] terugstellen

– –
Herstelt de menu-onderdelen die zijn
geregistreerd in het menu [User] naar de
fabrieksinstellingen.

Het tijdens bewerking
geselecteerde menu-
onderdeel van niveau 2

Delete –
Wist het geregistreerde menu-onderdeel
van het 2e niveau uit het menu [User].

Move –
Herschikt de geregistreerde menu-
onderdelen binnen het menu [User].

Edit Sub Item –
Bewerkt (registreert/wist) het
geregistreerde menu-subonderdeel van het
3e niveau in het menu [User].
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ISO/Gain/EI

Versterkingsinstellingen maken.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Mode ISO/dB dB
Selecteert de instellingsmodus
voor versterking.

ISO/Gain<L>

Voor nadere informatie over
instellingen raadpleegt u
"ISO/Gain-instellingen en -
standaardwaarden".

–
Stelt de presetwaarde voor <L>
gain in.

Exposure
Index<L>

Wanneer Base ISO is ingesteld
op ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Wanneer Base ISO is ingesteld
op ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Wanneer Base ISO is
ingesteld op ISO 800:
800EI / 6.0E
Wanneer Base ISO is
ingesteld op ISO 12800:
12800EI / 6.0E

Stelt de waarde Exposure
Index<L> in.

Shockless
Gain

On / Off Off
Schakelt de functie naadloze
versterkingsomschakeling in of
uit.

Base
Sensitivity

High / Low Low Stelt de basisgevoeligheid in
voor de modus Custom.
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Verwant onderwerp
ISO/Gain-instellingen en -standaardwaarden
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Base ISO ISO 12800 / ISO 800 ISO 800
Stelt de ISO basisgevoeligheid
in voor de modus Cine EI /
Flexible ISO.
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ND Filter

Stelt de presetwaarden in voor het ND-filter.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Mode Preset / Variable Variable Selecteert de ND-filtermodus.

Preset1
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/4
Stelt de preset 1-waarde in voor het ND-
filter.

Preset2
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/16
Stelt de preset 2-waarde in voor het ND-
filter.

Preset3
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/64
Stelt de preset 3-waarde in voor het ND-
filter.
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Shutter

Stelt de elektronische sluiter in.
Wordt gebruikt voor het duidelijk filmen van snel bewegende objecten.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Mode Speed / Angle Speed

Selecteert de modus voor
instelling van de sluitertijd in
seconden (Speed) of als een
sluiterhoek (Angle).

Shutter
Speed
On/Off

On / Off Off

Stelt in of de belichtingstijd bij
actieve modus Speed de
[Shutter Speed] volgt of is
ingesteld op volledige
belichting.

Shutter
Speed

64F t/m 1/8000
De beschikbare instellingen variëren
afhankelijk van de beeldsnelheid van de
geselecteerde video-indeling.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 /
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P: 1/24

Stelt de sluitertijd in als de
modus Speed is ingesteld.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Stelt de sluiterhoek in als de
modus Angle is ingesteld.

ECS On/Off On / Off Off
Schakelt de functie Clear Scan
function in of uit.

301



5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

ECS
Frequency

23.99 t/m 8000
De beschikbare instellingen variëren
afhankelijk van de beeldsnelheid van de
geselecteerde opname-indeling.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Stelt de ECS-frequentie in als
Mode is ingesteld op ECS.
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Iris

Configureert de instellingen voor diafragma.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Bokeh Control On / Off Off Schakelt de functie Bokeh Control in en uit.
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Auto Exposure

Regelt de instellingen voor automatische belichtingsaanpassingen.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 /
+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /
+0.5 / +0.25 / ±0 / −0.25 / −0.5 / −0.75
/ −1.0 / −1.25 / −1.5 / −1.75 / −2.0 /
−2.25 / −2.5 / −2.75 / −3.0

±0
Stelt het helderheidniveau in voor de
automatische gedetecteerde
belichting.

Mode Backlight / Standard / Spotlight Standard

Stelt de werkmodus in van de auto-
belichtingsaanpassing.
Backlight: tegenlichtmodus (modus
voor minder donker worden van een
onderwerp als het onderwerp met
tegenlicht wordt gefilmd)
Standard: standaardmodus
Spotlight: spotmodus (modus voor
minder overbelichting als het
onderwerp wordt verlicht door
spotlampen)

Speed −99 t/m +99 ±0
Stelt de aanpassingssnelheid in van
auto-belichtingsaanpassing.

AGC On / Off Off
Schakelt de functie AGC (auto gain
control) in of uit.

AGC Limit

Voor nadere informatie over
instellingen raadpleegt u "AGC
Limit-instellingen en -
standaardwaarden".

–
Stelt de maximale versterking van de
functie AGC in.

AGC Point F2.8 / F4 / F5.6 F2.8
Stelt de F-stopwaarde van het
diafragma in waar AGC-werking begint
als de functie AGC is ingesteld op On.

Auto Shutter On / Off Off
Schakelt de automatische
sluiterfunctie in of uit.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Stelt de snelste sluitertijd in voor de
automatische sluiterfunctie.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Stelt de F-stopwaarde van het
diafragma in waar de werking van de
automatische sluiterfunctie begint.
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AGC Limit-instellingen en -standaardwaarden
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Clip High
light

On / Off Off

Schakelt de functie in of uit die de
meest heldere gebieden negeert voor
een vlakkere respons bij hoge
helderheid.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6/ Custom 1

Stelt het lichtmetingsbereik voor
automatische belichtingsaanpassing in
op basis van de helderheid van het
onderwerp. (Niet beschikbaar als de
belichting handmatig wordt ingesteld)

Detect
Window
Indication

On / Off Off
Schakelt de indicatie van de
lichtmeting in of uit.

Custom
Width

40 t/m 999 500
Stelt de breedte van het
lichtmetingsbereik in.

Custom
Height

70 t/m 999 500
Stelt de hoogte van het
lichtmetingsbereik in.

Custom H
Position

−479 t/m +479 ±0
Stelt de horizontale positie van het
lichtmetingsbereik in.

Custom V
Position

−464 t/m +464 ±0
Stelt de verticale positie van het
lichtmetingsbereik in.
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White

Regelt de witbalansinstelling.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Preset
White

2000K t/m
15000K

3200K Stelt de presetwaarde van de witbalans in.

Color Temp
<A>

2000K t/m
15000K

3200K

Stelt de kleurtemperatuur van de witbalans in, die wordt
opgeslagen in geheugen A.

Opmerking

Omdat Color Temp wordt beperkt tot 2000K en 15000K
tijdens het gebruik van R Gain /B Gain, kan de correcte
waarde voor Color Tempmogelijk niet worden weergegeven
voor de R Gain-/B Gain-waarde.

Tint<A> −99 t/m +99 ±0

Stelt de tint van de witbalans in die wordt opgeslagen in
witgeheugen A.

Opmerking

Omdat Tint wordt beperkt tot ±99 tijdens R Gain-/B Gain-
werking, kan de correcte waarde voor tint mogelijk niet
worden weergegeven voor de R Gain-/B Gain-waarde.

R Gain <A> −99.0 t/m +99.0 ±0.0
Stelt de witbalans R-versterkingswaarde in die wordt
opgeslagen in geheugen A.

B Gain <A> −99.0 t/m +99.0 ±0.0
Stelt de witbalans B-versterkingswaarde in die wordt
opgeslagen in geheugen A.
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White Setting

Past de witbalansinstelling aan.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Shockless
White

Off / 1 / 2 / 3 2

Stelt de reactiesnelheid in van de witbalans als wordt
overgeschakeld van witbalansmodus.
Off: schakelt onmiddellijk.
1 t/m 3: hogere nummers schakelen langzamer.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Stelt de reactiesnelheid van de ATW-modus in.
De snelste reactietijd is 1 en de langzaamste reactietijd
is 5.
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Offset White

Regelt de offsetinstelling voor witbalans.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Offset White
<A>

On / Off Off
Selecteert of er wel (On) of niet (Off) een offsetwaarde
aan de witbalans in geheugen A moet worden
toegevoegd.

Offset Color
Temp<A>

−99 t/m +99 ±0
Stelt de verplaatsingswaarde van de kleurtemperatuur
in die moet worden opgeteld bij de witbalans in
geheugen A als [Offset White <A>] is ingesteld op On.

Offset Tint<A> −99 t/m +99 ±0
Stelt de verplaatsingswaarde voor tint in die moet
worden opgeteld bij de witbalans in geheugen A als
[Offset White <A>] is ingesteld op On.

Offset
White<ATW>

On / Off On
Selecteert of er wel (On) of niet (Off) een offsetwaarde
aan de ATW-witbalans moet worden toegevoegd.

Offset Color
Temp<ATW>

−99 t/m +99 ±0
Stelt de verplaatsingswaarde van de kleurtemperatuur
in die moet worden opgeteld bij de ATW-witbalans als
[Offset White<ATW>] is ingesteld op On.

Offset
Tint<ATW>

−99 t/m +99 ±0
Stelt de verplaatsingswaarde voor de tint in die moet
worden opgeteld bij de ATW-witbalans als [Offset
White<ATW>] is ingesteld op On.
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Focus

Regelt de scherpstelling.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

AF
Transition
Speed

1(Slow) / 2 / 3 /
4 / 5 / 6 / 7(Fast)

5
Stelt de snelheid in van de scherpstellingsaandrijving als
het onderwerp verandert tijdens automatische
scherpstelling.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Stelt de gevoeligheid in voor wijziging van
onderwerpscherpstelling tijdens automatische
scherpstelling.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Stelt het gebied in voor automatische scherpstelling en
automatische scherpstelling door knop indrukken (AF).

Raadpleeg "De scherpstelling automatisch aanpassen
(Autofocus)" en "Het gebied of de positie van
automatische scherpstelling instellen (Focus Area)".

Wide: zoekt bij scherpstellen naar een onderwerp in een
brede hoek in het beeld.
Zone: zoekt automatisch naar een scherpstellingspunt
binnen de opgegeven zone.
Flexible Spot: richt zich op een specifieke positie op het
beeld.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Stelt het doelgebied in voor scherpstelling door knop
indrukken (AF-S).

Face/Eye
Detection
AF

Face/Eye Only
AF /
Face/Eye Priority
AF / Off

Face/Eye Priority AF

Schakelt gezichtsherkenning voor AF in of uit.

Raadpleeg "Volgen met behulp van
gezichts-/ogendetectie (Face/Eye Detection AF)".

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Stelt de modus scherpstelling door knop indrukken in.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Stelt de handeling in wanneer u het camerascherm
aanraakt in MF-modus op het live-bedieningsscherm van
de webapp.

AF Assist On / Off On

Als dit is ingesteld op On kunt u tijdelijk automatische
scherpstelling opheffen en handmatig scherpstellen.

Raadpleeg "Het onderwerp voor automatische
scherpstelling handmatig instellen (AF assist) met de
webapp" en "Handmatig scherpstellen tijdens
automatische scherpstelmodus met de meegeleverde
infraroodafstandsbediening".
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Verwant onderwerp
Het gebied of de positie van automatische scherpstelling instellen (Focus Area)

Volgen met behulp van gezichts-/ogendetectie (Face/Eye Detection AF)

Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp

Handmatig scherpstellen tijdens automatische scherpstelmodus met de meegeleverde infraroodafstandsbediening
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S&Q Motion

Hiermee configureert de instellingen voor de modus Slow & Quick Motion (raadpleeg "Slow & Quick Motion").

Verwant onderwerp
Slow & Quick Motion
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt de Slow & Quick motion-modus in of uit.

Frame
Rate

1fps t/m 60fps / 100fps /
120fps / 150fps / 180fps /
200fps / 240fps

–

Stelt de beeldsnelheid in voor het filmen met
Slow & Quick Motion.

Opmerking

De beschikbare instellingen kunnen variëren
afhankelijk van de geselecteerde
systeemfrequentie, codec en video-indeling.
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LUT On/Off

Regelt LUT-instellingen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

SDI MLUT On / MLUT Off MLUT Off
Selecteert of de monitor-LUT op de SDI-
uitvoervideo moet worden toegepast.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Selecteert of de monitor-LUT op de HDMI- en
stream-uitvoervideo moet worden toegepast.

Proxy MLUT On / MLUT Off MLUT Off
Selecteert of de monitor-LUT op de
opgenomen proxy-video moet worden
toegepast.

Internal Rec MLUT On / MLUT Off MLUT Off
Selecteert of de monitor-LUT op de
opgenomen hoofdvideo moet worden
toegepast.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
en HDMI/Stream

HDMI/Stream
Stelt de doeluitvoer in die wordt bediend door
een toewijsbare knop waaraan LUT On/Off is
toegewezen.
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Noise Suppression

Regelt de ruisonderdrukkingsinstellingen.

Hint

De instellingen [Setting(Custom)] en [Level(Custom)] worden weerspiegeld in de instelling [Target Display].
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting(Custom) On / Off On
Schakelt de functie Ruisonderdrukking in of uit
in de modus Custom.

Level(Custom) Low / Mid / High Mid
Stelt de ruisonderdrukking in de modus Custom
in.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Schakelt de functie ruisonderdrukking in of uit in
de logboek-opnamemodi.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Stelt het niveau voor ruisonderdrukking in de
logboek-opnamemodi in.
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Flicker Reduce

Regelt de instellingen voor flikkercorrectie.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Mode Auto / On / Off Off Stelt de flikkercorrectiemodus is.

Frequency 50 Hz / 60 Hz 60Hz
Stelt de frequentie van de stroombron van de verlichting in
die het flikkeren veroorzaakt.
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SteadyShot

Regelt de beeldstabilisatie-instellingen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting
Active / Standard /
Off

Off

Stelt de functie beeldstabilisatie in.

Opmerking

Ingeschakeld als er een compatibel objectief is bevestigd.

Als dit is ingesteld op Active of Standard kan onverwacht
gedrag optreden wanneer u zwenk-/kantelacties uitvoert.
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Base Setting

Regelt basisinstellingen.

Verwant onderwerp

Basisbediening configureren
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Stelt de opnamemodus in.

Raadpleeg "De opnamemodus instellen" in
"Basisbediening configureren".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Stelt het kleurbereik van de opname/uitvoer in
de modus Custom in.
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Rec Format

Regelt de instellingen voor opname-indeling.

Instellingen [RAW Output Format]

De standaardwaarden zijn vet weergegeven.
De omstandigheden waarbij [RAW Output Format] niet kan worden ingesteld, zijn weggelaten.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Selecteert de systeemfrequentie.

Imager Scan
Mode

FF / S35 FF Selecteert het beeldsensorformaat.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Stelt de clip-opname-/-
afspeelmoduscodec in.

Opmerking

Wanneer [Imager Scan Mode] is
ingesteld op [S35], kunnen [RAW] en
[RAW & XAVC-I] niet worden
geselecteerd.

RAW Output
Format

De beschikbare instellingen
kunnen variëren, afhankelijk van
de instelling [Frequency].

Raadpleeg "Instellingen voor
[RAW Output Format]"
hieronder.

–

Stelt de grootte van het RAW-beeld in dat
wordt uitgevoerd naar een externe RAW-
recorder.

Opmerking

Wanneer [Codec] is ingesteld op [RAW
& XAVC-II], schakelt de instelling voor
[Video Format] synchroon over met de
instelling voor [RAW Output Format].

Video
Format

De beschikbare instellingen
kunnen variëren, afhankelijk van
de instellingen [Frequency],
[Imager Scan Mode] en [Codec].

Raadpleeg "Instellingen voor
[Video Format]" hieronder.

– Stelt de beeldgrootte en bitsnelheid in.

Frequency Imager Scan Mode Codec Instelling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Instellingen [Video Format]

De standaardwaarden zijn vet weergegeven.
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Frequency Imager Scan Mode Codec Instelling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Hiermee stelt u de instellingen voor de logboek-opnamemodi in (raadpleeg "De opnamemodus instellen" in
"Basisbediening configureren").

Verwant onderwerp

Basisbediening configureren
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Color Gamut
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Stelt het kleurbereik in voor logboek-
opnamemodi ([Flexible ISO], [Cine EI Quick],
[Cine EI]).

Embed LUT
File

On / Off On
Schakelt het opnemen van metagegevens
voor een 3D LUT-bestand (CUBE-bestand) in
en uit.
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Simul Rec

Hiermee configureert u instellingen voor het opnemen naar 2 kaartsleuven tegelijkertijd (raadpleeg "Opnemen op
geheugenkaart A en B tegelijkertijd (2-slot Simul Rec)").
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off
Schakelt de opnamemodus
voor 2 kaartsleuven
tegelijkertijd in of uit.

Rec Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:
<Slot A> 2nd Rec Button:<Slot B> / Rec
Button:<Slot B> 2nd Rec Button:<Slot
A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot A>
<Slot B>

Wijst de opnameknoppen in
waarmee de verschillende
opnamemedia worden
bediend.
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Proxy Rec

Hiermee configureert u instellingen voor de proxy-opnamemodus (raadpleeg "Proxy-opname").
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt proxy-opname in of uit.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Selecteert het audiokanaal dat naar proxydata moet
opnemen.
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Interval Rec

Hiermee configureert u instellingen voor de intervalopnamemodus (raadpleeg "Intervalopname (Interval Rec)").
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off

Schakelt intervalopname in of uit.
(Als deze modus op On wordt
ingesteld, worden alle andere
speciale modi ingesteld op Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (uur)

1

Stelt het interval in tussen
opnames in de modus Interval
Rec (als Interval Rec op On is
ingesteld).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
De beschikbare instellingen variëren
afhankelijk van de beeldsnelheid van
de geselecteerde video-indeling.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Stelt het aantal frames in dat per
take moet worden opgenomen in
de modus Interval Rec (als
Interval Rec op On is ingesteld).
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Picture Cache Rec

Hiermee configureert u instellingen voor de beeldcache-opnamemodus (raadpleeg "Beelden in cache opnemen (Picture
Cache Rec)").

Verwant onderwerp

Beelden in cache opnemen (Picture Cache Rec)
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt de beeldcachefunctie in of uit.

Cache Size
Short / Medium /
Long / Max

Max
Stelt de tijd in voor het verzamelen van beelden in het
beeld-cachegeheugen (opnametijd voor beeld-cache).

Cache Rec
Time – –

Geeft de tijd weer voor het verzamelen van beelden in
het beeld-cachegeheugen (opnametijd voor beeld-
cache).

323



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SDI/HDMI Rec Control

Regelt de bedieningsinstellingen voor SDI/HDMI-opname.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Stelt start/stop-bediening in van een verbonden extern
apparaat via het SDI-/HDMI-uitgangssignaal.
Off: gebruik de afstandsbediening niet.
SDI/HDMI Remote I/F: bediening van stop-start vanaf een
verbonden extern apparaat als er geen medium in het
apparaat is geplaatst. Niet gesynchroniseerd met frame-
nauwkeurigheid met media in het apparaat.
Parallel Rec: bediening van stop-start van een verbonden
extern apparaat als er een medium in het apparaat is
geplaatst. Gesynchroniseerd met frame-nauwkeurigheid
met media in het apparaat.

Opmerking

Wilt u regelen met het HDMI-uitvoersignaal, stel dan
[TC/Media] > [HDMI TC Out] > [Setting] in op [On] in het
cameramenu.
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Assignable Button

Hiermee stelt u in welke functies worden toegewezen aan de toewijsbare knoppen (<1> t/m <9>) en [Focus Hold Button].
De volgende functies kunnen worden toegewezen.
[Off]: geen functie toegewezen.
[Base ISO/Sensitivity]: schakelt de basisgevoeligheid van de beeldsensor om.
[AGC]: schakelt de AGC-functie in of uit.
[Push AGC]: schakelt de functie AGC in zolang de knop wordt ingedrukt.
[ND Filter]

In variabele modus: past de lichtdoorlatendheid van het ND-filter aan. Houd de knop ingedrukt om te schakelen
tussen Clear/Manual/Auto.
In voorkeuzemodus: houd ingedrukt om te schakelen tussen voorkeuzes.

[ND Filter Position]: schakelt ND-filters om.
[Auto ND Filter]: schakelt de automatische ND-filterfunctie in en uit.
[Push Auto ND]: schakelt de automatische ND-filterfunctie in zolang de knop wordt ingedrukt.
[Auto Iris]: schakelt de diafragmafunctie in of uit.
[Push Auto Iris]: schakelt de automatische diafragmafunctie in zolang de knop wordt ingedrukt.
[Bokeh Control]: schakelt de bokeh-regelfunctie in en uit.
[Auto Shutter]: schakelt de automatische sluiterfunctie in of uit.
[AE Level/Mode]: past het AE-niveau aan. Houd de knop ingedrukt om de AE-modus te schakelen.
[Backlight]: schakelt tussen Backlight en Standard.
[Spotlight]: schakelt tussen Spotlight en Standard.
[Preset White Select]: schakelt de voorkeuzemodus van de witbalanswaarde om.
[ATW]: schakelt de ATW-functie in of uit.
[ATW Hold]: pauzeert werking van de functie ATW.
[AF Speed/Sens.]: schakelt de AF-overgangssnelheid en de gevoeligheid van de AF-onderwerpverplaatsing om.
[Focus Setting]: stelt het scherpstellingsgebied in.
[Face/Eye Detection AF]: schakelt de AF-instellingen voor gezichts-/ogendetectie om.
[Push AF Mode]: schakelt de modusinstelling om voor automatische scherpstelling door knop indrukken.
[Push AF/MF]: activeert AF in de modus MF-scherpstelling zolang de knop wordt ingedrukt. Activeert MF in de modus
AF-scherpstelling zolang de knop wordt ingedrukt.
[Focus Hold]: in de modus AF-scherpstelling wordt de scherpstelling vastgezet zolang deze knop is ingedrukt.
[S&Q Motion]: schakelt de functie Slow & Quick motion in of uit. Stelt de opnamebeeldsnelheid in bij indrukken en
vasthouden.
[LUT On/Off]: schakelt de LUT-functie in of uit. Het schakeldoel wordt ingesteld met [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: schakelt tussen Active, Standard en Off.
[Crop Select]: schakelt de Imager Scan Mode. Schakelen is mogelijk binnen het bereik zonder dat de opname-indeling
wordt gewijzigd.
[Rec]: start of stopt de opname.
[Picture Cache Rec]: schakelt de opnamemodus Picture Cache in of uit.
[Rec Review]: schakelt de functie Rec Review in of uit.
[Clip Flag OK]: voert Add OK uit. Druk tweemaal om Delete Clip Flag uit te voeren.
[Clip Flag NG]: voert Add NG uit. Druk tweemaal om Delete Clip Flag uit te voeren.
[Clip Flag Keep]: voert Add KEEP uit. Druk tweemaal om Delete Clip Flag uit te voeren.
[Slot Select]: schakelt tussen de geheugensleuven (A) en (B).
[Color Bars]: schakelt de kleurbalken in of uit.
[DURATION/TC/U-BIT]: schakelt tussen Time Code, Users Bit en Duration.
[Display]: schakelt de schermindicatoren in of uit.
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[Lens Info]: schakelt de scherptediepte-indicator om.
[Video Signal Monitor]: schakelt de videosignaalmonitor om (bijvoorbeeld een golfvormmonitor).
[Marker]: schakelt de markeerfunctie in of uit.
[Thumbnail]: opent of sluit het pictogrammenscherm.
[Auto Upload (Proxy)]: schakelt automatische overdracht van proxy-bestanden in of uit.
[Direct Menu]: opent of sluit het directmenu.
[User Menu]: opent of sluit het menu User.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Scene File

Hier configureert u instellingen die te maken hebben met scene-bestanden (raadpleeg "Filmen met het gewenste
uiterlijk").
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Recall – –

Laadt een scene-bestand dat is
opgeslagen in het interne geheugen en
past de instellingen toe als de huidige
beeldkwaliteitsinstellingen.

Store – –
Slaat de huidige staat van de beeldkwaliteit
op als een scene-bestand in het interne
geheugen.

Delete – –
Verwijdert een scene-bestand dat is
opgeslagen in het interne geheugen.

Preset
Recall

Wanneer Shooting Mode is
ingesteld op Custom en Target
Display is ingesteld op
SDR(BT.709): S-Cinetone /
Standard / Still / ITU709/ 709tone
Wanneer Shooting Mode is
ingesteld op Custom en Target
Display is ingesteld op
HDR(HLG): HLG Live / HLG
Natural

–
Past voorkeuze-beeldkwaliteitsinstellingen
(niet overschrijfbaar) toe als de huidige
beeldkwaliteitsinstellingen.
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Base Look

Regelt instellingen voor het basisuiterlijk.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Select

Wanneer Shooting Mode is
ingesteld op Custom en Target
Display is ingesteld op
SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone /
User1 t/m User16
Wanneer Shooting Mode is
ingesteld op Custom en Target
Display is ingesteld op
HDR(HLG): HLG Live / HLG
Natural / User1 t/m User16
Wanneer Shooting Mode is
ingesteld op logboek-
opnamemodi: s709 / 709(800) / S-
Log3 / User1 t/m User16

Wanneer Shooting Mode
ingesteld op Custom en
Target Display is ingesteld
op SDR(BT.709): S-Cinetone
Wanneer Shooting Mode
iingesteld op Custom en
Target Display is ingesteld
op HDR(HLG): HLG Live
Wanneer Shooting Mode is
ingesteld op logboek-
opnamemodi: s709

Selecteert een basisuiterlijk.

Delete – –
Verwijdert het geselecteerde
basisuiterlijk.

Delete All – – Verwijdert alle basisuiterlijken.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Stelt het invoerkleurbereik voor
het geselecteerde basisuiterlijk in
met [Select].

Output BT.709 / HLG BT.709
Stelt het uitvoerkleurbereik voor
het geselecteerde basisuiterlijk in
met [Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV
Stelt belichtingsreferentiewaarde
voor het geselecteerde
basisuiterlijk in met [Select].
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Reset Paint Settings

Herstelt de instellingen voor het menu [Paint/Look], met uitzondering van het basisuiterlijk.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Reset without
Base Look

Execute / Cancel –
Herstelt de instellingen voor het menu [Paint/Look],
met uitzondering van het basisuiterlijk.
Execute: voer de functie uit.
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Black

Regelt de zwartinstellingen.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Master Black −99.0 t/m +99.0 ±0.0 Stelt het masterniveau zwart in.

R Black −99.0 t/m +99.0 ±0.0 Stelt het zwartniveau voor R-signalen in.

B Black −99.0 t/m +99.0 ±0.0 Stelt het zwartniveau voor B-signalen in.
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Knee

Regelt kniecorrectie-instellingen.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting

Wanneer Target Display
is ingesteld op
SDR(BT.709): On / Off / ---
Wanneer Target Display
is ingesteld op
HDR(HLG): On / Off / ---

Wanneer Target Display is
ingesteld op SDR(BT.709):
Off
Wanneer Target Display is
ingesteld op HDR(HLG): Off

Schakelt de kniecorrectiefunctie in of uit.

Opmerking

Alleen ingeschakeld als [Base Look] >
[Select] is ingesteld op [Standard],
[ITU709], [709tone], [HLG Live] of [HLG
Natural].

Auto Knee

Wanneer Target Display
is ingesteld op
SDR(BT.709): On / Off / ---
Wanneer Target Display
is ingesteld op
HDR(HLG): On / Off / ---

Wanneer Target Display is
ingesteld op SDR(BT.709):
On
Wanneer Target Display is
ingesteld op HDR(HLG): Off

Schakelt de functie auto knee in of uit.

Opmerking

Alleen ingeschakeld als [Base Look] >
[Select] is ingesteld op [Standard],
[ITU709] of [709tone].

Point 75% t/m 109% 90% Stelt het kniepunt in.

Slope −99 t/m +99 ±0 Stelt de compressieverhouding in.
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Detail

Regelt instellingen voor detailaanpassingen.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off On Schakelt de detailfunctie in of uit.

Level −7 t/m +7 ±0 Stelt het detailniveau in.

Manual
Setting

On / Off / --- Off
Schakelt de functie handmatige detailaanpassing in of
uit.

H/V Ratio −2 t/m +2 ±0

Stelt de balans in tussen horizontaal (H) detail en
verticaal (V) detail voor handmatige detailaanpassing.

Opmerking

Dit onderdeel varieert afhankelijk van de

softwareversie.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Stelt de balans in tussen zwart (B) detail voor gebieden
met lage helderheid en wit (W) detail voor gebieden met
hoge helderheid voor handmatige detailaanpassingen.

Limit 0 t/m 7 7
Stelt het limietniveau in voor het detail voor handmatige
detailaanpassingen.

Crispening 0 t/m 7 0
Stelt het niveau in voor aanscherpen voor handmatige
detailaanpassingen.

High Light
Detail

0 t/m 4 0
Stelt het detailniveau in van heldere gebieden voor
handmatige detailaanpassingen.

In softwareversie 1.00 heet dit menu-onderdeel [V/H Balance]. In softwareversie 1.10 of later heet dit menu-onderdeel [H/V Ratio]. Het
instelbereik is ongewijzigd: van -2 via 0 tot +2. Het effect op de beeldkwaliteit is echter verschillend.
Softwareversie 1.00: hoe hoger de ingestelde waarde, hoe meer horizontaal (H) detail.
Softwareversie 1.10 of later: hoe hoger de ingestelde waarde, hoe meer verticaal (V) detail.
Bij het bijwerken van softwareversie 1.00 naar 1.10 of later worden [All File], [Scene File] en andere instellingen overgenomen, maar met
omgekeerde polariteit (de beeldkwaliteit blijft behouden).
Als u het menu-onderdeel [V/H Balance] hebt geregistreerd in het menu [User], wordt het automatisch vervangen door het menu-onderdeel [H/V
Ratio] in het menu [User] nadat de software is bijgewerkt.

*1
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Matrix

Regelt matrix correctie-instellingen.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

User Matrix On / Off Off Schakelt de functie user matrix-correctie in of uit.

User Matrix
Level

−99 t/m +99 ±0 Past de kleurverzadiging van het totale beeld aan.

User Matrix
Phase

−99 t/m +99 ±0 Past de kleurtoon (fase) van het totale beeld aan.

User Matrix R-G −99 t/m +99 ±0 Stelt een door de gebruiker aangepaste R-G user
matrix in.

User Matrix R-B −99 t/m +99 ±0
Stelt een door de gebruiker aangepaste R-B user
matrix in.

User Matrix G-R −99 t/m +99 ±0
Stelt een door de gebruiker aangepaste G-R user
matrix in.

User Matrix G-B −99 t/m +99 ±0
Stelt een door de gebruiker aangepaste G-B user
matrix in.

User Matrix B-R −99 t/m +99 ±0 Stelt een door de gebruiker aangepaste B-R user
matrix in.

User Matrix B-G −99 t/m +99 ±0
Stelt een door de gebruiker aangepaste B-G user
matrix in.
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Multi Matrix

Regelt multi matrix-correctie-instellingen.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off
Schakelt de functie multi matrix-
correctie in of uit.

Reset Execute / Cancel –
Reset de tint en verzadiging van alle
askleuren naar de standaardwaarden.

Axis
B / B+ / MG− / MG / MG+ / R / R+ /
YL− / YL / YL+ / G− / G / G+ / CY /
CY+ / B−

B Seleteert de as.

Hue −99 t/m +99 ±0
Stelt de tint in van de voor multi matrix-
correctie gebruikte kleur.

Saturation −99 t/m +99 ±0
Stelt de verzadiging in van de voor multi
matrix-correctie gebruikte kleur.
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P/T Acceleration

Hiermee configureert u instellingen met betrekking tot de versnelling voor zwenk-/kantelacties.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Ramp
Curve

1 t/m 9 8
Selecteert de versnelling/vertraging voor
zwenk-/kantelacties. Hoe groter de waarde, hoe groter de
versnelling.
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Timecode

Regelt tijdcode-instellingen.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Mode
Preset / Regen /
Clock

Preset

Stelt de uitvoermodus voor de tijdcode in.
Preset: begint met uitvoeren vanaf een
voorkeuzewaarde.
Regen: begint met uitvoeren vanaf de tijdcode van het
eind van de vorige clip.
Clock: gebruikt de interne klok als tijdcode.

Run Rec Run / Free Run Rec Run
Rec Run: loopt alleen tijdens opname.
Free Run: loopt altijd, onafhankelijk de opnamefunctie.

Setting – –
Stelt de tijdcode in op een willekeurige waarde.
Set: stelt de waarde in.

Reset Execute / Cancel –
Reset de tijdcode naar 00:00:00:00.
Execute: voer de functie uit.

TC Format DF / NDF DF
Stelt de tijdcode-indeling in.
DF: Drop Frame
NDF: Non-Drop Frame
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TC Display

Regelt de instellingen voor weergave van de tijdgegevens.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Display Select Timecode / Users Bit / Duration Timecode Schakelt de weergave van tijdgegevens om.
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Users Bit

Regelt instellingen met betrekking tot user bits.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Mode Fix / Time Fix

Stelt de modus voor user bits in.
Fix: gebruikt een willekeurige vaste waarde in
gebruikersbits.
Time: gebruikt de huidige uren, minuten en seconden in
gebruikersbits.

Setting – – Stelt de user bits in op een willekeurige waarde.
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HDMI TC Out

Regelt instellingen met betrekking tot tijdcode-uitvoer bij gebruik van HDMI.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off
Regelt of er tijdcode naar apparaten voor andere
doeleinden moet worden verzonden met HDMI.
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Clip Name Format

Regelt instellingen met betrekking tot naamgeving en verwijdering van clips.
Wanneer [Auto Naming] is ingesteld op [Cam ID + Reel#] worden de eerste vier tekens van de clipnaam bepaald per
opnamemedium. Wanneer het nieuwe opnamemedium is geplaatst of als de laatste clip op het opnamemedium niet
overeenkomt met de instellingen [Camera ID] of [Reel Number] knippert de clipnaam om u te waarschuwen.
Wanneer [Auto Naming] is ingesteld op [Title] kunt u een willekeurige tekenreeks gebruiken als eerste deel van de
clipnaam.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Auto
Naming

Cam ID + Reel# / Title

Hiermee selecteert u de naamindeling voor de clip.
Cam ID + Reel#: Camera ID + spoelnummer +
opnamenummer + datum + willekeurige tekenreeks
Title: willekeurige tekenreeks, opgegeven met [Title
Prefix] + clipnummer

Camera ID A tot Z A

Stelt de camera-id in die wordt gegenereerd voor clip-
naamgeving.

Opmerking

Alleen configureerbaar als [Auto Naming] is
ingesteld op [Cam ID + Reel#].

Reel
Number

001 t/m 999 001

Stelt het spoelnummer-deel in dat wordt gebruikt om
clipnamen te generen.

Opmerking

Alleen configureerbaar als [Auto Naming] is
ingesteld op [Cam ID + Reel#].

Camera
Position

C / L / R C

Stelt het eerste teken in van het opnamenummer dat
wordt gebruikt voor clip-naamgeving.

Opmerking

Alleen configureerbaar als [Auto Naming] is
ingesteld op [Cam ID + Reel#].
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[Title Prefix] instellen

Verwant onderwerp

Een reeks tekens invoeren
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Title Prefix

nnn_(nnn is de laatste
3 cijfers van het
serienummer)
(Max. 7-cijferige
weergave)

nnn

Stelt het titelgedeelte (4 - 46 tekens) voor de
clipnaam in.
Opent een invoerscherm voor tekenreeksen.

Voor nadere informatie over het instellen van titels
en het tekeninvoerscherm raadpleegt u "Zo voert
u de titel in" hieronder en "Een reeks tekens
invoeren".

Opmerking

Alleen configureerbaar als [Auto Naming] is
ingesteld op [Title].

Number Set 0001 t/m 9999 0001

Stelt het 4-cijferige achtervoegsel van de clipnaam in.

Opmerking

Alleen configureerbaar als [Auto Naming] is
ingesteld op [Title].

Selecteer het teken dat u wilt invoeren op de plaats van de cursor in het gedeelte [Title Prefix] in het
tekenselectiegebied met de pijlknoppen in het GUI-bedieningspaneel (het teken wordt gemarkeerd) en druk
op de knop [Set] in het GUI-bedieningspaneel.

Het geselecteerde teken wordt ingevoerd en de cursor beweegt naar rechts.

1

Herhaal stap 1 om de titel in te stellen.

Gebruik [BS] indien nodig.

2

Druk na het invoeren van de titel op de knop [Done] om het tekeninvoerscherm te sluiten.

Voor nadere informatie over het tekeninvoerscherm raadpleegt u "Een reeks tekens invoeren".

De volgende tekens kunnen worden geselecteerd.
!#$%()+,-.;=@[ ]^_~ spatie
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Hiermee werkt u het beheerbestand op geheugenkaarten bij (raadpleeg "Geheugenkaarten herstellen").

Verwant onderwerp

Geheugenkaarten herstellen
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Media(A) Execute / Cancel –
Werkt het beheerbestand bij op de geheugenkaart in
sleuf A.
Execute: voer de functie uit.

Media(B) Execute / Cancel –
Werkt het beheerbestand bij op de geheugenkaart in
sleuf B.
Execute: voer de functie uit.
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Format Media

Hiermee formatteert (initialiseert) u een geheugenkaart (zie "Geheugenkaarten formatteren (initialiseren)").

Verwant onderwerp
Geheugenkaarten formatteren (initialiseren)
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Media(A) Full Format / Quick Format / Cancel – Formatteert de geheugenkaart in sleuf A.

Media(B) Full Format / Quick Format / Cancel – Formatteert de geheugenkaart in sleuf B.
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Media Life

Geeft de resterende levensduur van de geheugenkaarten weer.

Opmerking

Hiervoor zijn geheugenkaarten noodzakelijk die het weergeven van de resterende levensduur ondersteunen.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Media(A) – –
Geeft de resterende levensduur weer van de
geheugenkaart in sleuf A.

Media(B) – –
Geeft de resterende levensduur weer van de
geheugenkaart in sleuf B.
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Output Format

Regelt de uitvoerindeling.

Verwant onderwerp
Uitvoerindelingen en beperkingen
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

SDI Voor nadere informatie over instellingen
raadpleegt u "Uitvoerindelingen en beperkingen".

– Regelt de uitvoerresolutie
voor SDI en HDMI.HDMI –

345



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Regelt instellingen voor weergave-onderdelen.
Wilt u een onderdeel weergeven, selecteer dan On. Wilt u een onderdeel verbergen, selecteer dan Off.

Onderdeel Instelling subonderdeel Standaardinstelling

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Onderdeel Instelling subonderdeel Standaardinstelling

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Hiermee configureert u instellingen voor de videosignaalmonitor.
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting
Off / Waveform / Vector /
Histogram

Off Stelt het type videosignaalmonitor in.

Level Marker
1

0% t/m 109% 70%
Stelt het niveau in van de
helderheidsniveaumarkering 1.

Level Marker
2

0% t/m 109% 100%
Stelt het niveau in van de
helderheidsniveaumarkering 2.
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Marker

Regelt instellingen voor markerweergave.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off On
Schakelt de weergave van alle markers in of
uit.

Color
White / Yellow / Cyan /
Green / Magenta / Red / Blue

White Selecteert de kleur van het markerssignaal.

Center
Marker

1 / 2 / 3 / 4 / Off Off Selecteert de centrale marker.

Safety Zone On / Off Off Schakelt de veiligheidszonemarker in of uit.

Safety Area 80% / 90% / 92.5% / 95% 90%
Selecteert de grootte van de
veiligheidszonemarker (als een percentage
van de totale schermgrootte).

Aspect
Marker

Line / Mask / Off Off Selecteert het type beeldindelingsmarkering.

Aspect Mask 0 t/m 15 12
Stelt het niveau van het videosignaal buiten de
markering in.

Aspect
Safety Zone

On / Off Off Schakelt de veiligheidsmarkering voor
beeldindeling in of uit.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Selecteert de grootte van de
veiligheidsmarkering voor beeldindeling (als
een percentage van de totale schermgrootte).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Stelt de modus in bij weergave van de
beeldindelingsmarkering.

Custom
Aspect Ratio

Voer een willekeurige waarde
in.

01.00:01.00

Stelt de beeldindelingsverhouding in op een
willekeurige waarde.

Opmerking

Ingeschakeld als [Aspect Select] is ingesteld
op [Custom].

Guide Frame On / Off Off
Schakelt de weergave van het hulpkader in of
uit.

100%
Marker

On / Off Off Schakelt de 100%-marker in of uit.
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User Box On / Off Off
Schakelt de weergave van de
indelingsmarkering in of uit.

User Box
Width

3 t/m 479 240
Stelt de breedte in van de indelingsmarkering
(afstand van het midden tot de linker en
rechter randen).

User Box
Height

3 t/m 269 135
Stelt de hoogte in van de indelingsmarkering
(afstand van het midden tot de bovenste en
onderste randen).

User Box H
Position

−476 t/m +476 0
Stelt de horizontale positie van het midden
van de beeldindelingsmarkering in.

User Box V
Position

−266 t/m +266 0
Stelt de verticale positie van het midden van
de beeldindelingsmarkering in.
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Audio Input

Regelt instellingen voor audio-invoer.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

AUDIO IN
Select

MIC / LINE MIC
Selecteert het type apparaat dat is aangesloten op de
AUDIO IN-aansluiting.

Phantom
Power +48V

On / Off Off Geeft de status weer van de +48 V-phantomvoeding.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1
Geeft de ingangsbron weer voor opname op
kanaal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Schakelt de ingangsbron om voor opname op kanaal
2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1
Schakelt de ingangsbron om voor opname op kanaal
3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Schakelt de ingangsbron om voor opname op kanaal
4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Stelt het referentie-opnameniveau in voor XLR-
microfooninvoer van AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Stelt het referentie-opnameniveau in voor XLR-
microfooninvoer van AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Stelt het referentie-ingangsniveau in wanneer
[AUDIO IN Select] is ingesteld op LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Selecteert het opnameniveau van de 1 kHz
referentietoon.

CH1 Wind
Filter

On / Off Off
Schakelt het windreductiefilter voor opname via
kanaal 1 in of uit.

CH2 Wind
Filter

On / Off Off
Schakelt het windreductiefilter voor opname via
kanaal 2 in of uit.

CH3 Wind
Filter

On / Off Off
Schakelt het windreductiefilter voor opname via
kanaal 3 in of uit.

CH4 Wind
Filter

On / Off Off Schakelt het windreductiefilter voor opname via
kanaal 4 in of uit.

351



Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

CH1 Level
Control

Auto / Manual Auto
Selecteert automatische aanpassing van
ingangsniveau of handmatige aanpassing voor
opname op kanaal 1.

CH2 Level
Control

Auto / Manual Auto
Selecteert automatische aanpassing van
ingangsniveau of handmatige aanpassing voor
opname op kanaal 2.

CH3 Level
Control

Auto / Manual Auto
Selecteert automatische aanpassing van
ingangsniveau of handmatige aanpassing voor
opname op kanaal 3.

CH4 Level
Control

Auto / Manual Auto
Selecteert automatische aanpassing van
ingangsniveau of handmatige aanpassing voor
opname op kanaal 4.

CH1 Input
Level

0 t/m 99 49
Stelt het ingangsniveau in voor opname van kanaal
1.

CH2 Input
Level

0 t/m 99 49 Stelt het ingangsniveau in voor opname van kanaal
2.

CH3 Input
Level

0 t/m 99 49
Stelt het ingangsniveau in voor opname van kanaal
3.

CH4 Input
Level

0 t/m 99 49
Stelt het ingangsniveau in voor opname van kanaal
4.

Master Input
Level

0 t/m 99 99 Stelt het master-ingangsniveau voor audio in.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Selecteert de limiterkarakteristiek voor hoge
ingangsignalen als het audio-ingangsniveau
handmatig wordt ingesteld.

CH1&2 AGC
Mode

Mono / Stereo Stereo

Stelt de modus in voor automatische niveau-
aanpassing voor opname van kanaal 1 en kanaal 2.
Wanneer dit is ingesteld op Stereo, is de AGC tussen
de kanalen gekoppeld.

CH3&4 AGC
Mode

Mono / Stereo Stereo

Stelt de modus in voor automatische niveau-
aanpassing voor opname van kanaal 3 en kanaal 4.
Wanneer dit is ingesteld op Stereo, is de AGC tussen
de kanalen gekoppeld.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Selecteert de AGC-karakteristiek.

1kHz Tone on
Color Bars

On / Off Off

Schakelt de 1 kHz-referentietoon in of uit bij het
weergeven van kleurbalken.

Opmerking

Als dit is ingesteld op [On] wordt de 1 kHz-
referentietoon ingesteld voor opname op kanaal 3
en kanaal 4, zelfs als [CH3 Input Select] en [CH4
Input Select] zijn ingesteld op [Off].

352



5-041-957-73(1) Copyright 2022 Sony Corporation

353



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Regelt instellingen voor audio-uitvoer.
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HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Stelt de combinatie van audiokanalen in voor de
HDMI-/stream-uitvoer.
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Display Clip Properties

Geeft het scherm weer voor clipeigenschappen.
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Display Clip
Properties

– –
Geeft het scherm weer voor
clipeigenschappen.
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Set Clip Flag

Regelt instellingen voor clipvlag.
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Add OK – – Voegt een OK-vlag toe.

Add NG – – Voegt een NG-vlag toe.

Add KEEP – – Voegt een KEEP-vlag toe.

Delete Clip Flag – – Verwijdert alle vlaggen.
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Lock/Unlock Clip

Regelt instellingen voor clipbescherming.
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Select Clip – – Selecteert en vergrendelt/ontgrendelt een clip.

Lock All Clips – – Vergrendelt alle clips.

Unlock All Clips – – Ontgrendelt alle clips.

357



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Verwijdert clips.
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Select Clip – – Verwijdert de geselecteerde clip.

All Clips – – Verwijdert alle clips.
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Transfer Clip

Verzendt clips.
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Select Clip – – Verzendt geselecteerde clips.

All Clips – –

Verzendt alle clips.

Opmerking

Er kunnen maximaal 200 overdrachtstaken worden
geregistreerd.
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Transfer Clip (Proxy)

Verzendt proxy-clips.
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Select Clip – –
Verzendt proxy-clips corresponderend met de
geselecteerde clips.

All Clips – –

Verzendt proxy-clips corresponderend met alle clips.

Opmerking

Er kunnen maximaal 200 overdrachtstaken worden
geregistreerd.
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Filter Clips

Regelt instellingen voor weer te geven clips.
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OK – – Geeft alleen clips weer die een OK-vlag hebben.

NG – – Geeft alleen clips weer die een NG-vlag hebben.

KEEP – – Geeft alleen clips weer die een KEEP-vlag hebben.

None – – Geeft alleen clips weer die geen vlag hebben.

All – – Geeft alle clips weer, ongeacht of er een vlag is.
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Customize View

Schakelt het pictogrammenscherm om.
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Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Schakelt de onder de pictogrammen
weergegeven informatie om.
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Color Bars

Regelt instellingen voor kleurbalk.
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Setting On / Off Off Schakelt de kleurbalken in of uit.

Type ARIB / 100% / 75% / SMPTE ARIB Selecteert het type kleurbalk.
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Genlock

Hiermee configureert u de weergave van de Genlock-status (raadpleeg "De fase van het videosignaal synchroniseren
(Genlock)").

Verwant onderwerp

De fase van het videosignaal synchroniseren (Genlock)
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Reference
Internal / External(HD) /
External(SD)

–
Geeft het type Genlock-referentiesignaal
weer.
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Tally

Hiermee configureert u instellingen voor het opname-/tallylampje (raadpleeg "Een tallysignaal aansluiten").

Verwant onderwerp
Een tallysignaal aansluiten
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Tally Lamp
Brightness

High / Low / Off High Stelt de helderheid van het opname-/tallylampje in.

G Tally Lamp Enable / Disable Enable Schakelt het G-tallylampje in of uit.

Tally Control External / Internal Internal

Selecteert het doel voor aanname van de
regelgegevens van het opname-/tallylampje van het
apparaat.
External: tallyregeling van buiten de camera.
Internal: regeling via de camera-opname.
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Rec Review

Hiermee configureert u instellingen voor opnamecontrole (raadpleeg "Een opname controleren (Rec Review))".

Verwant onderwerp

Een opname controleren (Rec Review)
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Setting 3s / 10s / Clip 3s
Stelt de afspeeltijd in van clips die zojuist zijn
opgenomen voor opnamecontrole.
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Zoom

Hiermee configureert u de zoominstellingen (raadpleeg "De zoom aanpassen").
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Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Stelt het zoomtype in.
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Lens

Regelt instellingen met betrekking tot lenzen.

Verwant onderwerp

Ademcompensatie
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Lens Calibration Execute / Cancel –

Voert de functie uit die corrigeert voor verschillen in
zoompositie vanwege verschillen in individuele
objectieven wanneer u een power-zoomobjectief
gebruikt.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Stelt de richting in van de zoomringbediening.

Opmerking

Alleen inschakelen bij gebruik van een objectief
met E-bevestiging die overschakeling van
zoomringrichting ondersteunt.

Shading
Compensation

Auto / Off Auto Stelt de automatische schaduwcompensatie in.

Chroma
Aberration
Comp.

Auto / Off Auto Stelt de automatische chromatische aberratie in.

Distortion Comp. Auto / Off Auto Stelt de automatische vervormingscompensatie in.

Breathing
Compensation

Auto / Off Off
Stelt de ademcompensatie voor het objectief in.

Raadpleeg "Ademcompensatie".

Distance Display Meter / Feet Meter
Stelt de weergave-eenheid in voor
objectiefinformatie en scherpstellingspositie.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Stelt de weergave-indeling voor de zoompositie in.
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APR

Voert APR uit.
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APR Execute / Cancel –

Voert APR (Automatic Pixel Restoration) uit voor
automatische aanpassing van de beeldsensor.
Execute: voer de functie uit.

Opmerking

Bevestig altijd de objectiefdop voordat APR wordt
uitgevoerd.
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Wired LAN

Regelt instellingen met betrekking tot bekabelde LAN-verbindingen.
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HTTP Port – 80 Geeft de HTTP-toegangspoort weer.

Detail
Settings

– –
Geeft de eigenschappen van de bekabelde LAN-
verbinding weer.

DHCP
On / Off

On
Geeft aan of DHCP is ingeschakeld (On) of
uitgeschakeld (Off).

IP Address – Geeft het IP-adres weer van het apparaat als [DHCP]
is ingesteld op [Off].

Subnet Mask –
Geeft het subnetmasker weer van het apparaat als
[DHCP] is ingesteld op [Off].

Gateway –
Geeft de standaard-gateway weer als [DHCP] is
ingesteld op [Off].

DNS Auto
On / Off

On
Geeft de instelling voor automatisch verkrijgen van
DNS weer.
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File Transfer

Hiermee configureert u instellingen die te maken hebben met bestandsoverdracht (raadpleeg "Bestanden overbrengen").

Verwant onderwerp
Bestanden overbrengen
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Auto Upload
(Proxy)

On / Off Off
Schakelt automatisch uploaden van proxy-bestanden in
of uit.

Default
Upload
Server

Server Settings1
t/m 3 > Display
Name

–

Selecteert de uploadserver voor bestanden. De hier
geselecteerde server wordt de automatische
uploadbestemming voor proxy-bestanden en de
uploadbestemming voor bestanden van het
pictogrammenscherm.
Geeft de instellingen voor [Display Name] weer die zijn
geconfigureerd bij [Server Settings1 t/m 3].

Clear
Completed
Jobs

Execute / Cancel –
Verwijdert voltooide overdrachtstaken uit de lijst.
Execute: voer de functie uit.

Clear All
Jobs

Execute / Cancel –
Verwijdert alle overdrachtstaken uit de lijst.
Execute: voer de functie uit.

View Job
List

– – Geeft de lijst met overdrachtstaken weer.
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Language

Stelt de weergavetaal in.
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Select – –
Stelt de weergavetaal in.
Set: stelt de waarde in.
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Clock Set

Regelt instellingen voor de interne klok.

Opmerking

Wanneer u deze instelling hebt gewijzigd vanuit het cameramenu, schakelt u de stroomtoevoer naar het apparaat uit en start u
het apparaat opnieuw op. Wanneer u stand-by inschakelt met de infraroodafstandsbediening of de webapp, kan onverwacht
gedrag optreden.
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Time Zone
UTC − 12:00 tot UTC
+ 14:00 –

Stelt het tijdsverschil met UTC in eenheden van
30 minuten in.

Date Mode
YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Selecteert de weergave-indeling voor datums.
YYMMDD: jaar, maand, dag
MMDDYY: maand, dag, jaar
DDMMYY: dag, maand, jaar

12H/24H 12H / 24H 24H
Selecteert de weergave-indeling voor de klok.
12H: 12-uursmodus
24H: 24-uursmodus

Date – –
Stelt de huidige datum in.
Set: stelt de waarde in.

Time – –
Stelt de huidige tijd in.
Set: stelt de waarde in.
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Hours Meter

Geeft de geaccumuleerde looptijd weer.
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Hours(System) – –
Geeft de geaccumuleerde gebruiksuren weer (kan
niet worden gereset).

Hours(Reset) – –
Geeft de geaccumuleerde gebruiksuren weer (kan
worden gereset).

Reset Execute / Cancel –
Stelt de verlopen gebruikstijd terug op 0.
Execute: voer de functie uit.
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ISO/Gain-instellingen en -standaardwaarden

Het bereik van de instellingen en standaardwaarden voor [ISO/Gain<L>] varieert afhankelijk van de instellingen [Mode],
[Base Look] > [Select] en [Base Sensitivity].
De standaardwaarden zijn vet weergegeven in de tabellen.

Als [Mode] is ingesteld op [ISO]

Als [Base Look] > [Select] is ingesteld op [S-Cinetone], [Standard], [ITU709], [709tone] of [Still]

Als [Base Look] > [Select] is ingesteld op [HLG Live] of [HLG Natural]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Als [Base Look] > [Select] is ingesteld op [User1] t/m [User16]

Als [Mode] is ingesteld op [dB]

U kunt een waarde configureren binnen het bereik −3dB t/m +30dB in stappen van 1dB.
De standaardwaarde is 0dB.
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Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit-instellingen en -standaardwaarden

Het bereik van de menu-instellingen en standaardwaarden voor [AGC Limit] varieert, afhankelijk van de instellingen
[Mode], [Base Look] > [Select] en [Base Sensitivity].
De standaardwaarden zijn vet weergegeven in de tabellen.

Als [Mode] is ingesteld op [ISO]

Als [Base Look] > [Select] is ingesteld op [S-Cinetone], [Standard], [ITU709], [709tone] of [Still]

Als [Base Look] > [Select] is ingesteld op [HLG Live] of [HLG Natural]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

377



Als [Base Look] > [Select] is ingesteld op [User1] t/m [User16]

Als [Mode] is ingesteld op [dB]

Kies uit 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
De standaardwaarde is 15 dB.
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Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[Low]

Als [ISO/Gain/EI] > [Base Sensitivity] is ingesteld op
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Beeldkwaliteitsinstellingen opgeslagen voor elke opnamemodus

De huidige status van configuratie-onderdelen met betrekking tot beeldkwaliteit wordt opgeslagen voor elk van de
volgende opnamemodi. Als u de opnamemodus wijzigt, worden de corresponderende instellingen die zijn opgeslagen
toegepast voor de doelopnamemodus.

Custom-modus SDR(BT.709) doelweergave
Custom-modus HDR(HLG) doelweergave
Logboekopname (Cine EI, Cine EI Quick, Flexible ISO)

De configuratie-onderdelen met betrekking tot beeldkwaliteit die worden opgeslagen voor elk van de opnamemodi
worden in de volgende tabellen weergegeven.
"Ja" geeft aan dat de instelling wordt opgeslagen, "Nee" geeft een instelling aan die niet wordt opgeslagen. Wanneer "Ja"
over meerdere kolommen wordt weergegeven, betreft het gemeenschappelijke instellingen.

Onderdeel

Opnamemodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Shooting

ISO/Gain/EI

ISO/Gain Ja1) Ja Nee

Exposure Index Nee Nee Ja Ja

Base Sensitivity Ja Nee

Base ISO Nee Ja4) Nee3) Ja4)

White

Preset White Ja Ja

Anders dan
bovenstaand

Ja

White Setting Ja

Offset White Ja Nee

LUT On/Off Nee Ja

Noise
Suppression

Setting(Custom) Ja Ja Nee

Level(Custom) Ja Ja Nee

Setting (Cine
EI/Flex. ISO)

Nee Ja

Level (Cine EI/Flex.
ISO)

Nee Ja
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Onderdeel

Opnamemodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE Level Offset2) Ja

Black Ja Ja Nee

Knee

Auto Knee Ja Nee Nee

Anders dan
bovenstaand

Ja Ja Nee

Detail Ja Ja Nee

Matrix Ja Ja Nee

Multi Matrix Ja Ja Nee

 Afzonderlijke ISO-gevoeligheidsinstellingen worden opgeslagen voor zowel de Custom-modus SDR(BT.709) als HDR(HLG).1)

 Instellingen worden opgeslagen voor elk basisuiterlijk en zijn niet afhankelijk van de opnamemodus.2)

 De basis-ISO-gevoeligheid wijzigt in samenhang met de belichtingsindex.3)

 Gemeenschappelijke instelwaarde in de opnamemodi Flexible ISO en Cine EI.4)
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Configuratie van het webmenu

Druk op het tabblad voor bedieningsscherm schakelen [Settings] om het instellingenvenster weer te geven.
Gebruik het instellingenvenster om met het webmenu de verschillende instellingen van het apparaat te configureren,
zoals de begininstellingen, netwerkinstellingen en film-/afspeelinstellingen.

Het menu bestaat uit de volgende submenu's.

Configuratie en hiërarchie van het menu

Niveau 1 Beschrijving van niveau 1 Niveau 2

Shooting Bevat instellingen met betrekking tot filmen. Focus
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Niveau 1 Beschrijving van niveau 1 Niveau 2

Project Bevat basisinstellingen voor projecten.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Bevat instellingen met betrekking tot beeldkwaliteit. Base Look

Pan-Tilt Bevat instellingen met betrekking tot zwenken en kantelen.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Bevat instellingen met betrekking tot video-uitvoer en het
weergavevenster.

Output Format

Output Display

Audio Bevat instellingen met betrekking tot audio. Audio

Technical Bevat instellingen voor technische onderdelen.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Bevat instellingen met betrekking tot netwerken.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Opmerking

[Accessibility] is alleen beschikbaar op modellen voor Noord-Amerika.

5-041-957-73(1) Copyright 2022 Sony Corporation

Niveau 1 Beschrijving van niveau 1 Niveau 2

Stream Bevat instellingen met betrekking tot streamen.

Stream

Video Stream

Audio Stream

Maintenance Bevat apparaatinstellingen, zoals de klok en taal.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Bediening van het webmenu

Druk op het tabblad voor bedieningsscherm schakelen [Settings] om het instellingenvenster weer te geven. Hier kunt u
met het webmenu de verschillende instellingen van het apparaat configureren, zoals de begininstellingen,
netwerkinstellingen en film-/afspeelinstellingen.
Configureer instellingen in het webmenu op een tablet door aanraken of op een computer met een muis.
Druk op het menu voor de onderdelen die u wilt configureren om de instelonderdelen met hun instellingen weer te geven
in dat menu.

Configuratiemethode

Een waarde kiezen

Menu (niveau 1)1.

Menu (niveau 2)2.

Instellingen3.
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Druk op het keuzerondje voor een onderdeel. Het keuzerondje van een geselecteerd onderdeel wordt oranje
weergegeven.

Onderdeel aan-uit

Druk op de schakelaar om het onderdeel in of uit te schakelen. De schakelaar is oranje als het onderdeel is ingeschakeld
en wit als het is uitgeschakeld.

Een waarde kiezen uit een lijst

Druk op de keuzelijst en selecteer een onderdeel uit de lijst die wordt weergegeven.

Een numerieke waarde kiezen

Druk op < of > om de numerieke waarde te wijzigen. Als de numerieke waarde is onderstreept, dan kunt u de numerieke
waarde ook rechtstreeks invoeren.

Een teken/cijfer invoeren

Configuratie in een apart venster
Druk op de knop om instelhandelingen in een apart venster te doen.

Help-melding

Hier wordt informatie weergegeven die helpt bij het configureren van sommige instellingen en meldingen die aandacht
vragen voor het apparaat.

Een instelling opslaan

Als u klaar bent met een instelling drukt u op de knop [OK] om de instelling op te slaan.
Druk op de knop [Cancel] om de wijzigingen in de instelling te verwerpen en naar de vorige instelling terug te gaan.
Druk op de knop [Reload] om de schermweergave bij te werken.

Opmerking

Als u op de knop [Reload] drukt voordat u de instelling hebt opgeslagen, gaan de wijzigingen in de instelling verloren.
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Als u naar een andere pagina gaat voordat u de instelling hebt opgeslagen, gaan de wijzigingen in de instelling verloren.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Focus

Regelt de scherpstelling.

Verwant onderwerp

Het onderwerp voor automatische scherpstelling handmatig instellen (AF assist) met de webapp

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Stelt de modus scherpstelling door knop indrukken in.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Stelt de handeling in wanneer u het camerascherm
aanraakt in MF-modus.

AF Assist
Control

On / Off On

Wanneer dit is ingesteld op [On] kunt u de
scherpstellingsschuifbalk in de webapp gebruiken tijdens
automatische scherpstelling om de scherpstelpositie aan
te passen.

Voor nadere informatie raadpleegt u "Het onderwerp
voor automatische scherpstelling handmatig instellen
(AF assist) met de webapp".

Opmerking

Dit onderdeel is alleen actief als [AF Assist] is ingesteld op
[On] in het cameramenu.
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Base Setting

Regelt basisinstellingen.

Verwant onderwerp

Basisbediening configureren
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Stelt de opnamemodus in.

Raadpleeg "Opnamemodus" in
"Basisbediening configureren".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Stelt het kleurbereik van de opname/uitvoer
in de modus Custom in.
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Rec Format

Regelt de instellingen voor opname-indeling.

Instellingen [RAW Output Format]

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Selecteert de systeemfrequentie.

Opmerking

Als de frequentie wordt gewijzigd, start
de camera opnieuw. Na de herstart
laadt u de pagina in de webbrowser
opnieuw.

Imager Scan
Mode

FF / S35 FF Selecteert het beeldsensorformaat.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Stelt de clip-opname-/-
afspeelmoduscodec in.

Opmerking

Wanneer [Imager Scan Mode] is
ingesteld op [S35], kunnen [RAW] en
[RAW & XAVC-I] niet worden
geselecteerd.

RAW Output
Format

De beschikbare instellingen
kunnen variëren, afhankelijk van
de instelling [Frequency].

Raadpleeg "Instellingen voor
[RAW Output Format]"
hieronder.

–

Stelt de grootte van het RAW-beeld in dat
wordt uitgevoerd naar een externe RAW-
recorder.

Opmerking

Wanneer [Codec] is ingesteld op [RAW
& XAVC-II], schakelt de instelling voor
[Video Format] synchroon over met de
instelling voor [RAW Output Format].

Video
Format

De beschikbare instellingen
kunnen variëren, afhankelijk van
de instellingen [Frequency],
[Imager Scan Mode] en [Codec].

Raadpleeg "Instellingen voor
[Video Format]" hieronder.

– Stelt het beeldformaat in.
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De standaardwaarden zijn vet weergegeven.
De omstandigheden waarbij [RAW Output Format] niet kan worden ingesteld, zijn weggelaten.

Instellingen [Video Format]

De standaardwaarden zijn vet weergegeven.

5-041-957-73(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Instelling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Instelling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Hiermee configureert u instellingen voor het opnemen naar 2 kaartsleuven tegelijkertijd (raadpleeg "Opnemen op
geheugenkaart A en B tegelijkertijd (2-slot Simul Rec)").

Verwant onderwerp

Opnemen op geheugenkaart A en B tegelijkertijd (2-slot Simul Rec)
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off
Schakelt de functie simultane opname in of uit en stelt
de doelmedia voor opnamen in.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Geeft de toewijzing van de opnameknoppen weer voor
de verschillende opnamemedia.
Stel [Project] > [Simul Rec] > [Rec Button Set] in het
cameramenu in.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Hiermee configureert u instellingen voor de proxy-opnamemodus (raadpleeg "Proxy-opname").
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt proxy-opname in of uit.
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Interval Rec

Hiermee configureert u instellingen voor de intervalopnamemodus (raadpleeg "Intervalopname (Interval Rec)").

Verwant onderwerp
Intervalopname (Interval Rec)
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off

Schakelt intervalopname in of uit.
(Als deze modus op On wordt
ingesteld, worden alle andere
speciale modi ingesteld op Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (uur)

1

Stelt het interval in tussen
opnames in de modus Interval
Rec (als Interval Rec op On is
ingesteld).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
De beschikbare instellingen variëren
afhankelijk van de beeldsnelheid van
de geselecteerde video-indeling.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Stelt het aantal frames in dat per
take moet worden opgenomen in
de modus Interval Rec (als
Interval Rec op On is ingesteld).
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Picture Cache Rec

Hiermee configureert u instellingen voor de beeldcache-opnamemodus (raadpleeg "Beelden in cache opnemen (Picture
Cache Rec)").

Verwant onderwerp

Beelden in cache opnemen (Picture Cache Rec)
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt de beeldcachefunctie in of uit.

Cache Size
Short / Medium /
Long / Max

Max
Stelt de tijd in voor het verzamelen van beelden in het
beeld-cachegeheugen (opnametijd voor beeld-cache).

Cache Rec
Time – –

Geeft de tijd weer voor het verzamelen van beelden in
het beeld-cachegeheugen (opnametijd voor beeld-
cache).
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All File

Hiermee voert u acties met ALL-bestanden uit (raadpleeg "Configuratiegegevens opslaan en laden").
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Load All
File

– –

Laad een ALL-bestand in het apparaat vanaf het apparaat
op waarop de webapp is gestart.

Opmerking

Wanneer een ALL-bestand wordt geladen, start het
apparaat opnieuw op. Na de herstart laadt u de pagina in
de webbrowser opnieuw.

Save All
File

– –
Slaat de instellingen van het apparaat op naar het apparaat
waarop de webapp is gestart als een ALL-bestand.
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Base Look

U kunt een basisuiterlijk in het apparaat laden.
Een lijst met beschikbare uiterlijken wordt weergegeven op het scherm. Het momenteel toegepaste basisuiterlijk wordt
aangegeven door de markering ● links van het basisuiterlijknummer.

[No.]: nummer van het basisuiterlijk
[Base Look Name]: naam van het basisuiterlijk
[Input]: invoersignaal van het basisuiterlijk
[Output]: uitvoersignaal van het basisuiterlijk
[AE Level Offset]: verschuivingswaarde van de belichtingsreferentie- van het basisuiterlijk

Een basisuiterlijk toevoegen
Druk op de knop [Import] om een nieuw basisuiterlijk te importeren. Volg de instructies op het scherm.
Na de import stelt u geschikte waarden in voor [Input], [Output] en [AE Level Offset]. Voor nadere informatie raadpleegt u
"Een gewenst basisuiterlijk importeren".

Verwant onderwerp
Een gewenst basisuiterlijk importeren

5-041-957-73(1) Copyright 2022 Sony Corporation
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P/T Speed

Hiermee configureert u instellingen met betrekking tot de zwenk-/kantelsnelheid.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Speed
Step

Normal /
Extended

Extended

Stelt het aantal snelheidsstappen in voor de
zwenk-/kantelmotor.
Normal: de snelheid kan worden opgegeven in 24 stappen.
Gebruik deze instelling voor compatibiliteit met bestaande
externe camera's van Sony.
Extended: de snelheid kan worden opgegeven in 50
stappen.

Speed
Mode

Normal / Slow Normal

Stelt de snelheid in voor de zwenk-/kantelmotor.
Alleen ingeschakeld als [Speed Step] is ingesteld op
[Normal].
Normal: werkt in het normale snelheidsbereik (minimum
naar maximum (60 graden/seconde)).
Slow: werkt in het lage snelheidsbereik (minimum naar
maximum (40 graden/seconde)).
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P/T Acceleration

Hiermee configureert u instellingen met betrekking tot de zwenk-/kantelsnelheid.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Acceleration 1 t/m 9 8
Selecteert de versnelling/vertraging voor
zwenk-/kantelacties. Hoe groter de waarde, hoe groter de
versnelling.
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P/T Range Limit

Hiermee configureert u instellingen met betrekking tot het bereik van zwenk-/kantelacties.
Stel de bereiklimieten voor zwenken/kantelen in met het volgende scherm.

Opmerking

Wanneer het apparaat wordt ingeschakeld of wanneer u zwenkt of kantelt, wordt de instelling voor dit bereik genegeerd. Deze
functie kan niet worden gebruikt om obstakels in de buurt van het apparaat te ontwijken.

Zet de schakelaar [Setting] in de stand On.

De functie voor het beperken van zwenk-/kantelacties wordt ingeschakeld.

1

Controleer het beeld met de zwenk-/kantelknoppen van de camera.2

Wilt u de positie instellen tot waar het bereik wordt beperkt, druk dan op de knoppen [Left], [Right], [Up],
[Down] > [Set Current Value] op de betreffende positie.

[Left]: linkerkant van de camera
[Right]: rechterkant van de camera
[Up]: bovenkant van de camera

3
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Opmerking

Camerastanden buiten deze bereiken kunnen niet worden ingesteld als voorkeuze.

Als de instelling [Pan-Tilt] > [P/T Direction] > [Ceiling] wordt gewijzigd, worden de geconfigureerde bereiken teruggesteld naar de
standaardwaarden.

De instelling kan niet worden gewijzigd tijdens afspelen, wanneer de pictogrammen worden weergegeven, wanneer een
zwenk-/kantelfout optreedt, wanneer zwenken/kantelen niet is geconfigureerd en wanneer zwenken/kantelen is vergrendeld.

5-041-957-73(1) Copyright 2022 Sony Corporation

[Down]: onderkant van de camera

De limietposities worden ingesteld en worden weergegeven als numerieke waarden (hoeken).
Wilt u een limiet wissen, druk dan op de knop [Reset] voor de betreffende positie.

Druk op de knop [OK].

Zwenken/kantelen wordt beperkt tot de geconfigureerde bereiken.

4

400



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Direction

Hiermee stelt u instellingen in met betrekking tot de zwenk-/kantelrichting.

Opmerking

Wanneer een gewijzigde instelling voor [Ceiling] wordt toegepast, worden alle voorkeuzeposities gewist, omdat de
zwenk-/kantelcoördinaten verkeerd om zouden zijn.

Het bereik van de zwenk-/kantelmotor wijzigt zoals weergegeven in het volgende schema, afhankelijk van de instelling
[Ceiling].

A: als [Ceiling] is ingesteld op [Off]
B: als [Ceiling] is ingesteld op [On]

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Ceiling On / Off Off

Wanneer het apparaat op een bureaublad is gemonteerd, stel
dit dan in op [Off]. Wanneer het apparaat op een plafond is
gemonteerd, stel dit dan in op [On]. Wanneer [Ceiling] is
ingesteld op [On], wordt [Pan Direction] automatisch
ingesteld op [Opposite].

Pan
Direction

Normal /
Opposite

Normal Stelt de richting van de zwenkmotor in. Wanneer de instelling
wordt gewijzigd, keert de richting van de motor om.

Tilt
Direction

Normal /
Opposite

Normal
Stelt de richting van de kantelmotor in. Wanneer de instelling
wordt gewijzigd, keert de richting van de motor om.
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P/T Preset

Hiermee configureert u instellingen voor cameravoorkeuzes.

Pan-Tilt
Stelt de snelheid voor voorkeuzes in.

Default
Stelt de standaardwaarden in die worden geconfigureerd wanneer u een voorkeurspositie opslaat.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Stelt in of voorkeuzesnelheden apart worden
geconfigureerd of dat ze gezamenlijk worden ingesteld.

Pan-Tilt Speed
for Common

1 t/m 50 50

Stelt de gemeenschappelijke snelheid in voor
voorkeuzes.

Opmerking

Een maximale motorsnelheid van 24 wordt gebruikt als
u een waarde van 25 of hoger instelt wanneer [Pan-
Tilt] > [P/T Speed] > [Speed Step] is ingesteld op
[Normal].

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Pan-Tilt Speed
for Separate

1 t/m 50 50
Stelt de snelheid voor voorkeuzes in wanneer de
selectiemethode voor voorkeuzesnelheid is ingesteld
op [Separate].

Zoom Sync On / Off On
Stelt in of gebruik van zwenken/kantelen en van
zoomen worden gesynchroniseerd bij het herstellen
van een voorkeurspositie.

Zoom Speed 0 t/m 32767 32767 Stelt de zoomsnelheid in.

Focus Recall On / Off On Stelt in of scherpstellings-instellingen worden hersteld.

MF Speed 0 t/m 32767 32767
Stelt de scherpstellingssnelheid in voor handmatig
scherpstellen.
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Output Format

Regelt de uitvoerindeling.

Verwant onderwerp
Uitvoerindelingen en beperkingen

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

SDI Voor nadere informatie over instellingen
raadpleegt u "Uitvoerindelingen en beperkingen".

– Regelt de uitvoerresolutie
voor SDI en HDMI.HDMI –
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Output Display

Hiermee configureert u instellingen die te maken hebben met het uitvoersignaal.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

SDI On / Off Off
Stelt in of het menu en de status wordt opgenomen in het
SDI-uitgangssignaal.

HDMI/Stream On / Off On

Stelt in of het menu en de status wordt opgenomen in het
HDMI-uitvoersignaal.

Opmerking

Deze instelling wordt ook toegepast op het HDMI-
uitvoersignaalbeeld, het streamuitvoerbeeld en het beeld
in het camerabeeldpaneel van de webapp.
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Audio Input

Hiermee configureert u instellingen met betrekking tot audio-invoer op CH1 t/m CH4.

Stelt het master-ingangsniveau voor audio in. Het masterniveau voor audio wordt gebruikt voor alle kanalen 1 t/m 4.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Level
Control

Auto / Manual Auto
Selecteert automatische aanpassing van
ingangsniveau of handmatige aanpassing.

Level 0 t/m 99 49 Stelt het-ingangsniveau in.

Input Select
AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 en CH3: AUDIO IN
CH1
CH2 en CH4: AUDIO IN
CH2

Stelt de audio-invoerbron in.

Opmerking

CH1 is ingesteld op [AUDIO IN CH1] (vast).

Wind Filter On / Off Off Schakelt het windruisreductiefilter in of uit.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Master 0 t/m 99 99 Stelt het master-ingangsniveau in.
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Audio Output

Hiermee configureert u instellingen die te maken hebben met audio-uitvoer.

Opmerking

Deze instelling wordt ook toegepast op streamuitvoergeluid.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Stelt de combinatie van audiokanalen in voor de
HDMI-/stream-uitvoer.
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Tracking Data Output

Hiermee configureert u instellingen die te maken hebben met volginformatie-uitvoer (compatibel met free-d-protocol).
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Transfer
Mode

Off / Always / On
Demand

Off Selecteert de uitvoermethode voor volginformatie.

Camera ID 0 t/m 255 255 Stelt de id van het apparaat in.

Destination
Address

IPv4-adres –
Wanneer [Transfer Mode] is ingesteld op [Always], stelt
dit het IP-adres van het doel voor de volginformatie in.

Destination
Port

1024 t/m 65534 40000
Wanneer [Transfer Mode] is ingesteld op [Always], stelt
dit het poortnummer van het doel voor de volginformatie
in.

Listen Port 1024 t/m 65534 40000
Wanneer [Transfer Mode] is ingesteld op [On Demand],
stelt dit het poortnummer in op het apparaat om naar
aanvragen van clients te luisteren.
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Tally

Hiermee configureert u instellingen voor het opname-/tallylampje (raadpleeg "Een tallysignaal aansluiten").

Verwant onderwerp

Een tallysignaal aansluiten

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Tally Lamp
Brightness

High / Low / Off High Stelt de helderheid van het opname-/tallylampje in.

G Tally Lamp Enable / Disable Enable Schakelt het G-tallylampje in of uit.

Tally Control External / Internal Internal
Selecteert het doel voor aanname van de
regelgegevens van het opname-/tallylampje van het
apparaat.
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IR Remote

Hiermee configureert u instellingen die te maken hebben met de infraroodafstandsbediening.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off On
Schakelt bediening van het apparaat vanaf de
infraroodafstandsbediening in of uit.
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RCP/MSU

Hiermee configureert u instellingen wanneer een RCP/MSU (optioneel) is aangesloten.
Voor nadere informatie raadpleegt u "Een RCP/MSU (optioneel) aansluiten".

Opmerking

Configureer de instellingen op de RCP/MSU zoals gewenst.

Voor een multi-camerasysteem is een MSU vereist.

Wanneer u meerdere MSU-apparaten aansluit, stelt u één MSU-apparaat in als hoofdapparaat en alle andere MSU-apparaten als
clients.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

CNS Mode
Off / Bridge / MCS /
PC Control

Off Stelt de verbindingsmodus in voor de RCP/MSU.

Master IP
Address

IPv4-adres 0.0.0.0
Stel het IP-adres in van het hoofdapparaat wanneer u
een multi-camerasysteem opbouwt op basis van een
LAN.

Camera No.
Camera No. (1 t/m
96)

1
Stelt een uniek cameranummer in binnen het systeem
wanneer u een multi-camerasysteem opbouwt op basis
van een LAN.
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Lens Controller

Configureert instellingen voor een aangesloten objectiefcontroller (optioneel).
Voor nadere informatie raadpleegt u "Een objectiefcontroller aansluiten".

Opmerking

Wanneer [Setting] wordt gewijzigd, start het apparaat opnieuw op. Laad de pagina in de webbrowser opnieuw.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Stelt in of u de objectiefcontroller (optioneel) gaat gebruiken.

Mode 0 t/m 15 0

Stelt de werkmodus in van de objectiefcontroller (optioneel).
Er zijn waarden van 0 t/m 15 beschikbaar, maar de werkelijke
waarden die kunnen worden geselecteerd hangen af van de
objectiefcontroller (optioneel). Raadpleeg voor nadere
informatie de gebruiksaanwijzing van de objectiefcontroller.

Reverse On / Off Off
Keert de draairichting van de objectiefcontroller (optioneel)
om.

Initialize – – Initialiseert de objectiefcontroller(optioneel).
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Camera Name

Hiermee configureert u instellingen met betrekking tot de naam van de camera (apparaatnaam).

U kunt maximaal acht (0 t/m 8) van de volgende tekens invoeren voor Camera Name.
Alfanumerieke tekens
Symbolen (spatie !#$`*+-./;<=>?@[\]^_`{|})
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Camera Name – FR7 Stelt de cameranaam in.
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User

Hiermee configureert u instellingen die te maken hebben met de toegang voor gebruikers van het apparaat.

Instellingen die te maken hebben met beheerders (Administrator) (vereist)

Instellingen die te maken hebben met algemene gebruikers (User 1 t/m User 9) (optioneel)
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

User Name – admin Stelt de gebruikersnaam in.

Current
Password

– –
Wanneer u het wachtwoord wilt wijzigen, voert u het
huidige wachtwoord in.

New Password – – Voer het nieuwe wachtwoord in.

Re-Type
Password

– –
Voer ter bevestiging nogmaals het nieuwe
wachtwoord in.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

User Name – – Stelt de gebruikersnaam in.

Current
Password

– –
Wanneer u het wachtwoord wilt wijzigen, voert u het
huidige wachtwoord in.

New Password – – Voer het nieuwe wachtwoord in.

Re-Type
Password – –

Voer ter bevestiging nogmaals het nieuwe
wachtwoord in.
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Wired LAN

Status
Geeft de netwerkstatus weer.

IPv4
Configureert instellingen voor het IPv4-netwerk.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Host Name – – Geeft de hostnaam weer.

MAC Address – – Geeft het MAC-adres van het apparaat weer.

Ethernet Status – – Geeft de huidige communicatiesnelheid weer.

IP Address – – Geeft het IP-adres van het apparaat weer.

Subnet Mask – – Geeft het subnetmasker van het apparaat weer.

Gateway – –
Geeft de IPv4-standaardgateway van het
apparaat weer.

Primary DNS
Server

– –
Geeft de primaire DNS-server van het apparaat
weer.

Secondary DNS
Server

– –
Geeft de secundaire DNS-server van het
apparaat weer.

IPv6 Address 1 – – Geeft IPv6-adres 1 van het apparaat weer.

IPv6 Address 2 – – Geeft IPv6-adres 2 van het apparaat weer.

IPv6 Gateway – –
Geeft de IPv6-standaardgateway van het
apparaat weer.

Link-local IPv6
Address

– –
Geeft het lokale IPv6-koppelingadres van het
apparaat weer.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

DHCP On / Off On Schakelt de functie [DHCP] in of uit.

IP Address – – Stelt het IPv4-adres in als [DHCP] is ingesteld op Off.

Subnet
Mask – –

Stelt het subnetmasker in als [DHCP] is ingesteld op
Off.

Gateway – –
Stelt de IPv4-standaardgateway in als [DHCP] is
ingesteld op Off.
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IPv6
Configureert instellingen voor het IPv6-netwerk.

Common
Configureert instellingen die gemeenschappelijk zijn voor IPv4- en IPv6-netwerken.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Obtain an IP Address
Automatically

On / Off On
Schakelt het automatisch verkrijgen van een
IPv6 in of uit.

IP Address – –
Stelt het IPv6-adres in als [Obtain an IP Address
Automatically] is ingesteld op Off.

Prefix Length – –
Stelt het voorvoegsel in als [Obtain an IP
Address Automatically] is ingesteld op Off.

Gateway – –
Stelt de IPv6-standaardgateway in als [Obtain an
IP Address Automatically] is ingesteld op Off.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

HTTP Port 80, 1024 t/m 65534 80 Stelt het HTTP-poortnummer in.

DNS Auto On / Off On
Stelt in of er DNS-adressen van de DHCP-server
worden opgehaald.

Primary DNS
Server

IPv4-/IPv6-adres –
Stelt de primaire DNS-server in als [DNS Auto] is
ingesteld op Off.

Secondary DNS
Server IPv4-/IPv6-adres –

Stelt de secundaire DNS-server in als [DNS
Auto] is ingesteld op Off.
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File Transfer

Regelt instellingen met betrekking tot de bestandsoverdracht.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Auto Upload
(Proxy)

On / Off Off
Schakelt automatisch uploaden van proxy-bestanden in
of uit.

Default
Upload
Server

Server Settings1
t/m 3 > Display
Name

Server Settings1

Selecteert de uploadserver voor bestanden. De hier
geselecteerde server wordt de automatische
uploadbestemming voor proxy-bestanden en de
uploadbestemming voor bestanden van het
pictogrammenscherm.
Geeft de instellingen voor [Display Name] weer die zijn
geconfigureerd bij [Server Settings1 t/m 3].
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FTP Server 1 t/m 3

Hiermee configureert u instellingen met betrekking tot FTP-bestandsoverdracht.
Deze instellingen zijn gemeenschappelijk voor FTP Server 1 t/m 3.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Display Name – –
Stelt de weergavenaam in die in het configuratiemenu
voor overdrachtsbestemming wordt weergegeven.

Service – – Geeft het type server weer.

Host Name – –
Stelt de hostnaam van de
transmissiebestemmingsserver in.

Port
21, 990, 1024 t/m
65534

21
Stelt het poortnummer in van de
transmissiebestemmingsserver.

User Name – –
Stelt de gebruikersnaam in voor verificatie van de
verbinding met de transmissiebestemmingsserver.

Password – –
Stelt het verificatiewachtwoord in voor de verbinding met
de transmissiebestemmingsserver.

Passive Mode On / Off Off Schakelt passieve modus in of uit.

Destination
Directory

– – Stelt de naam in van de overdrachtsdoelmap.

Using Secure
Protocol

On / Off Off
Stelt in of veilige FTP-overdracht wel (On) of niet (Off)
moet worden gebruikt.

Root
Certificate

– –

Laadt het basiscertificaat voor veilige FTP-overdracht.
Druk op de knop [Load] en selecteer een basiscertificaat
in het venster dat verschijnt.
Druk op de knop [Delete] om het geladen
basiscertificaat te wissen.

Root
Certificate
Status

– – Geeft de laadstatus van het basiscertificaat weer.

Reset – – Stelt [Server Settings] terug naar de standaardwaarden.
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SSL

Hiermee configureert u instellingen met betrekking tot SSL.

SSL
Schakelt de SSL-functie in of uit.

SSL Server Authentication
Configureert instellingen voor SSL-serververificatie.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Function
Disable / Enable / Enable (Allow HTTP connection
for some clients)

Disable
Schakelt de SSL-functie in
of uit.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external
certificate

–
Stelt de installatiemethode in voor het SSL-
servercertificaat.

Status – –

Geeft de geldigheid van het SSL-
servercertificaat weer wanneer [Certificate
Options] is ingesteld op [Use a self-signed
certificate (For test use)].

Issuer DN – –

Geeft de DN-naam van de uitgever van het
SSL-servercertificaat weer wanneer [Certificate
Options] is ingesteld op [Use a self-signed
certificate (For test use)].

Subject DN – –

Geeft de DN-naam van het onderwerp van het
SSL-servercertificaat weer wanneer [Certificate
Options] is ingesteld op [Use a self-signed
certificate (For test use)].

Available
Period

– –

Geeft de geldigheidsduur van het SSL-
servercertificaat weer wanneer [Certificate
Options] is ingesteld op [Use a self-signed
certificate (For test use)].

Extended Key
Usage

– –

Geeft de methode voor uitgebreide-
sleutelgebruik weer wanneer [Certificate
Options] is ingesteld op [Use a self-signed
certificate (For test use)].
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Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Delete – –

Deze knop wordt weergegeven wanneer
[Certificate Options] is ingesteld op [Use a self-
signed certificate (For test use)].
Verwijdert een geïnstalleerd SSL-
servercertificaat.

Import – –
Installeert een extern SSL-servercertificaat uit
een lijst wanneer [Certificate Options] is
ingesteld op [Use an external certificate].

Private Key
Password

– –

Stelt het wachtwoord in voor de persoonlijke
sleutel van het SSL-servercertificaat wanneer
[Certificate Options] is ingesteld op [Use an
external certificate].

Reset – –
Met deze knop wist u het wachtwoord voor de
persoonlijke sleutel zodat u een nieuw
wachtwoord kunt invoeren.

Self-Signed
Certificate
Generation

– –

Druk op de knop [Generate] om een zelf-
ondertekend certificaat te genereren wanneer
[Certificate Options] is ingesteld op [Use a self-
signed certificate (For test use)].
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Referer Check

Hiermee configureert u instellingen voor verwijzercontroles.

Exception List
Configureert instellingen voor de uitzonderingslijst van de verwijzercontrole.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off On Schakelt de functie Referer Check in of uit.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

No. 1 t/m 10 – Stelt het uitzonderingsnummer uit de lijst in.

Host Name – – Stelt de hostnaam van de uitzondering in.

Port
Number

– – Stelt het poortnummer van de uitzondering in.

Set – –
Druk hier om de geconfigureerde uitzondering te registreren
in de uitzonderingslijst.

Delete – –
Selecteer een uitzondering die u wilt verwijderen en druk op
de knop om de geregistreerde uitzondering te verwijderen
uit de uitzonderingslijst.
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Brute Force Attack Protection

Hiermee configureert u instellingen die te maken hebben met het voorkomen van beveiligingsaanvallen.

Wanneer een aanvaller wordt gedetecteerd, wordt de lijst met aanvallerinformatie weergegeven.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Setting On / Off On Schakelt de functie [Brute Force Attack Protection] in of uit.

Count 3 t/m 100 8
Stelt het aantal pogingen in dat wordt beschouwd als een
aanval.
Ingeschakeld als [Setting] is ingesteld op On.

Release
Mode

Always / Timer Timer

Stelt de vrijgavevoorwaarde in.
Ingeschakeld als [Setting] is ingesteld op On.
Always: verwijder dit niet uit de lijst met aanvallers.
Timer: verwijder dit uit de lijst met aanvallers na de
vrijgavetijd is verlopen die is ingesteld met [Release Time].

Release
Time

30 tot 86400 s 60

Stelt de vrijgavetijd in.
Ingeschakeld als [Setting] is ingesteld op On.
Wanneer Release Mode is ingesteld op [Timer] worden
vermeldingen verwijderd uit de lijst met aanvallers nadat de
vrijgavetijd is verlopen.

423



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Hiermee configureert u instellingen voor streamen (raadpleeg "Over streamen").

Stream Setting
Configureert instellingen met betrekking tot het streamprotocol.

Opmerking

Wilt u RTMP gebruiken, stel dan [Stream] > [Audio Stream] > [Setting] van tevoren in op [On].

RTSP
De volgende onderdelen worden weergegeven wanneer [Stream Setting] is ingesteld op [RTSP].
Configureert instellingen met betrekking tot RTSP-streamen.

RTMP
De volgende onderdelen worden weergegeven wanneer [Stream Setting] is ingesteld op [RTMP].
Configureert instellingen met betrekking tot RTMP-streamen.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
Selecteer het
streamprotocol.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Port Number
554, 1024 t/m
65534

554 Stelt het RTSP-poortnummer in.

Time Out 0 t/m 600 60
Stelt de maximale tijd in van de Keep Alive-opdracht
voor RTSP-streamen.

Authentication On / Off On Schakelt de RTSP-verificatiefunctie in of uit.

Video Port
Number 1

1024 t/m 65534 51000
Stelt het poortnummer in voor het verzenden van
video 1 voor RTSP-unicast-streamen.

Video Port
Number 2

1024 t/m 65534 53000
Stelt het poortnummer in voor het verzenden van
video 2 voor RTSP-unicast-streamen.

Audio Port
Number

1024 t/m 65534 57000
Stelt het poortnummer in voor het verzenden van
audio voor RTSP-unicast-streamen.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Server URL – –
Hiermee stelt u het doeladres van de RTMP- of
RTMPS-verbinding in.
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SRT
De volgende onderdelen worden weergegeven wanneer [Stream Setting] is ingesteld op [SRT-Caller] of [SRT-Listener].
Configureert instellingen met betrekking tot SRT-streamen.

NDI|HX
De volgende onderdelen worden weergegeven wanneer [Stream Setting] is ingesteld op [NDI|HX].
Configureert instellingen voor NDI|HX.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Stream Key – –
Stelt de streamsleutel in die u van de RTMP-server
hebt gekregen.

Root
Certificate

– –

Laadt het basiscertificaat dat voor de verbinding met de
RTMP-server vereist is.
Druk op de knop [Load] en selecteer een
basiscertificaat in het venster dat verschijnt.
Druk op de knop [Delete] om het geladen
basiscertificaat te wissen.
De status wordt weergegeven bij [Root Certificate
Status].

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Destination – –
Stelt het verbindings-doeladres in wanneer het
apparaat functioneert als oproeper.

Port
Number

1024 t/m 65534 4201
Stelt het poortnummer in wanneer het apparaat
functioneert als luisteraar.

Latency 20 t/m 8000 ms 120 Stelt de vertragingstijd in.

TTL 1 t/m 255 64 Stelt de TTL-waarde in.

Encryption Off / AES128 / AES256 Off
Schakelt versleuteling in of uit en stelt de
versleutelingsmethode in.

Passphrase
0 of een reeks met 10 tot
79 tekens

0
Stelt het wachtwoord in voor de versleuteling.
Druk op Reset om het ingevoerde wachtwoord te
wissen.

ARC On / Off On Schakelt de functie Adaptive Rate Control in of uit.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

License – –
Geeft de installatiestatus weer van de NDI-
licentiesleutel.

Source Name – – Geeft de NDI-bronnaam weer.

Group On / Off Off Schakelt de NDI-groeperingsfunctie in of uit.
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Verwant onderwerp

Over streamen
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Group Name – –
Wordt weergegeven als de NDI-groeperingsfunctie
is ingesteld op On.
Stelt de groepsnaam in.

Discovery
Server 1

– – Stelt NDI-ontdekkingsserver 1 in.

Discovery
Server 2

– – Stelt NDI-ontdekkingsserver 2 in.

Multicast Mode On / Off Off Schakelt multicast-streamen in of uit.

Multicast Prefix 239.255.0.0 239.255.0.0
Wordt weergegeven als [Multicast Mode] is
ingesteld op On.
Stelt het voorvoegsel in voor multicast-streamen.

Multicast
Netmask

255.255.0.0 255.255.0.0

Wordt weergegeven als [Multicast Mode] is
ingesteld op On.
Stelt het netmasker in dat het adresbereik voor
multicast bepaalt.

Multicast TTL 1 t/m 256 3
Wordt weergegeven als [Multicast Mode] is
ingesteld op On.
Stelt de TTL-waarde voor multicast-streamen.

Multi-TCP Mode On / Off Off Schakelt de Multi-TCP-modus in of uit.

Unicast UDP
Mode

On / Off On Schakelt de Unicast UDP-modus in of uit.
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Video Stream

Hiermee configureert u instellingen met betrekking tot de video-codecs voor streamen.

Video Stream 1
Configureert instelling die te maken hebben met video-codec 1.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Codec 1 H.264 / H.265 H.264 Stelt de codec voor beeld 1 in.

Size 1
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 / 1280×720 /
640×360

1920×1080
Stelt de beeldgrootte voor beeld 1
in.

Frame Rate 1

Voor nadere informatie over
ondersteunde beeldsnelheden
raadpleegt u "De video-codec
voor streamen instellen".

–
Hiermee stelt u de beeldsnelheid
van beeld 1 in.

I-Picture Mode
1

Time / Frame Time
Stelt het insteekinterval voor IDR-
frames in voor beeld 1 als een tijd
of als aantal frames.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 s 1

Wordt weergegeven als [I-Picture
Mode 1] is ingesteld op Time.
Stelt het insteekinterval voor IDR-
frames in voor H.264 en H.265 als
een tijd.

I-Picture Ratio 1 15 tot 300 frames 30

Wordt weergegeven als [I-Picture
Mode 1] is ingesteld op Frame.
Stelt het insteekinterval voor IDR-
frames in voor H.264 en H.265 als
een aantal frames.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Stelt het H.264- of H.265-profiel in.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Stelt de bitcompressiemodus van
beeld 1 in.

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 /
4000 / 5000 / 6000 / 7000 / 8000 /
16000 / 24000 / 32000 / 50000 /
64000 / 80000 kbps

16000

Wordt weergegeven als [Bit Rate
Compression Mode 1] is ingesteld
op On.
Stelt de doelwaarde voor
bitsnelheid in wanneer de
bitsnelheid-compressiemodus is
ingesteld op CBR.
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Video Stream 2
Configureert instelling die te maken hebben met video-codec 2.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Stelt de H.264- of H.265-kwaliteit
in.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Codec 2 H.264 / H.265 / Off Off Stelt de codec voor beeld 2 in.

Size 2
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360 / 512×270

1920×1080 Stelt de beeldgrootte voor beeld 2 in.

Frame Rate 2

Voor nadere informatie over
ondersteunde beeldsnelheden
raadpleegt u "De video-codec
voor streamen instellen".

–

Wordt weergegeven als [Codec 2] niet
is ingesteld op Off.
Hiermee stelt u de beeldsnelheid van
beeld 2 in.

I-Picture Mode
2

Time / Frame Time

Wordt weergegeven als [Codec 2] niet
is ingesteld op Off.
Stelt het insteekinterval voor IDR-
frames in voor beeld 2 als een tijd of
als aantal frames.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 s 1

Wordt weergegeven wanneer
tegelijkertijd [Codec 2] niet is ingesteld
op Off en [I-Picture Mode 2] is
ingesteld op [Time].
Stelt het insteekinterval voor IDR-
frames in voor H.264 en H.265 als
een tijd.

I-Picture Ratio
2 15 tot 300 frames 30

Wordt weergegeven wanneer
tegelijkertijd [Codec 2] niet is ingesteld
op Off en [I-Picture Mode 2] is
ingesteld op [Frame].
Stelt het insteekinterval voor IDR-
frames in voor H.264 en H.265 als
een aantal frames.

Profile 2
H.264: high / main / baseline
H.265: main

– Stelt het H.264- of H.265-profiel in.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Wordt weergegeven als [Codec 2] niet
is ingesteld op Off.
Stelt de bitcompressiemodus van
beeld 2 in.
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Video Stream 3
Configureert instelling die te maken hebben met video-codec 3.

Verwant onderwerp
De video-codec voor streamen instellen

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 /
4000 / 5000 / 6000 / 7000 / 8000 /
16000 / 24000 / 32000 / 50000 /
64000 / 80000 kbps

8000

Wordt weergegeven wanneer
tegelijkertijd [Codec 2] niet is ingesteld
op Off en [Bit Rate Compression
Mode 2] is ingesteld op [On].
Stelt de doelwaarde voor bitsnelheid
in wanneer de bitsnelheid-
compressiemodus is ingesteld op
CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Wordt weergegeven wanneer
tegelijkertijd [Codec 2] is ingesteld op
H.264 en [Bit Rate Compression
Mode 2] is ingesteld op Off.
Stelt de H.264- of H.265-kwaliteit in.

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Codec 3 JPEG JPEG
Stelt de codec voor
beeld 3 in.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Stelt de beeldgrootte
voor beeld 3 in.

Frame Rate
3

Voor nadere informatie over ondersteunde
beeldsnelheden raadpleegt u "De video-codec
voor streamen instellen".

–
Hiermee stelt u de
beeldsnelheid van
beeld 3 in.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Stelt de kwaliteit in.
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Audio Stream

Hiermee configureert u instellingen met betrekking tot de audio-codec voor streamen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Setting On / Off Off Schakelt audio-streamuitvoer in of uit.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Wordt weergegeven als [Setting] is ingesteld op
On.
Stelt de audio-codec voor streamen in.
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Language

Stelt de weergavetaal in.

Opmerking

De beschikbare talen kunnen verschillen, afhankelijk van het land of de regio.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Language – – Stelt de weergavetaal in.
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Accessibility

Hiermee configureert u instellingen met betrekking tot audio uitspreken (tekst naar spraak).

Opmerking

Deze functie is alleen beschikbaar op modellen verkocht in Noord-Amerika. De schermlezerfunctie kan alleen worden gebruikt als
de taal is ingesteld op Engels (per datum van introductie).

Schakel de schermlezerfunctie van de webbrowser in op het apparaat waarop u de webapp gebruikt.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Screen
Reader

On / Off Off 
Schakelt de schermlezerfunctie in het
camerabeeldpaneel van de webapp in of uit.

Speech Rate
Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal

Stelt de snelheid in van de
schermlezerfunctie.
Een voorbeeldpassage wordt hardop
voorgelezen met de geconfigureerde
snelheid.

Speech
Volume

1 t/m 15 7

Stelt het volume in van de schermlezerfunctie
van de webapp.
Een voorbeeldpassage wordt hardop
voorgelezen met het geconfigureerde volume.
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Clock Set

Regelt instellingen voor de interne klok.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Current Date
& Time

– –
Geeft de huidige tijd weer die is
geconfigureerd op het apparaat.

PC Clock – –
Geeft de huidige tijd weer van de tablet of de
computer die wordt gebruikt voor de
configuratie.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-
dd-yyyy hh:mm:ss / dd-mm-
yyyy hh:mm:ss

yyyy-mm-dd Stelt de indeling voor de datum en tijd in.

12 h / 24 h 12 h / 24 h 24 h Stelt de tijd in op 12-uurs- of 24-uursnotatie.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

–
Stelt de configuratiemethode in voor de
datum en tijd.

yy-mm-dd
hh:mm:ss

yy: 19 tot 37
mm: 01 tot 12
dd: 01 tot 31
hh: 00 tot 23
mm: 00 tot 59
ss: 00 tot 59 (seconden)

–
Wordt weergegeven als [Time Setting] is
ingesteld op Manual setting.
Hiermee stelt u datum en tijd handmatig in.

NTP Auto On / Off Off

Wordt weergegeven als [Time Setting] is
ingesteld op Synchronize with NTP.
Stelt in of het IP-adres van de NTP-server
van de DHCP-server wordt opgehaald.

NTP Server IPv4-/IPv6-adres of hostnaam –

Wordt weergegeven wanneer tegelijkertijd
[Time Setting] is ingesteld op [Synchronize
with NTP] en [NTP Auto] is ingesteld Off.
Geeft de NTP-server op die wordt gebruikt
voor tijdsynchronisatie.

Time Zone UTC − 12:00 tot UTC + 14:00 – Selecteert de tijdzone.
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Reset

Hiermee initialiseert u het apparaat.

Reboot
Start het apparaat opnieuw op.

Reset
Stelt de instellingen van het apparaat terug.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Reboot Execute –

Start het apparaat opnieuw op.
Execute: voer de functie uit.

Opmerking

Na de herstart laadt u de pagina in de webbrowser
opnieuw.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

All Reset (except
for Network
Settings)

Execute –

Stelt de instellingen van het apparaat terug
(behalve de netwerkinstellingen).
Execute: voer de functie uit.

Opmerking

Geïmporteerde basisuiterlijken en LUT-bestanden
worden niet verwijderd.

Network Reset Execute –

Stelt de netwerkinstellingen van het apparaat terug.
Execute: voer de functie uit.

Opmerking

Nadat Network Reset is uitgevoerd, start het
apparaat opnieuw op. Na de herstart laadt u de
pagina in de webbrowser opnieuw.
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Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Factory Default Execute –

Stelt de instellingen van het apparaat terug naar de
fabrieksinstellingen.
Execute: voer de functie uit.

Opmerking

Nadat Factory Default is uitgevoerd, start het
apparaat opnieuw op. Na de herstart laadt u de
pagina in de webbrowser opnieuw.
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Information

Hiermee geeft u informatie over de camera en het objectief weer. U kunt hier ook software bijwerken.

Camera
Geeft cameragegevens weer en werkt software bij.

Lens
Geeft gegevens over het objectief weer en werkt software bij.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Model Name – – Geeft de modelnaam van de camera weer.

Serial
Number

– – Geeft het serienummer van de camera weer.

Version
Number

– – Geeft de software-versie van de camera weer.

Version Up – –

Druk op de knop [Choose File] en volg de instructies op
het scherm om de camerasoftware bij te werken.

Opmerking

Na het bijwerken start het apparaat opnieuw op. Na de
herstart laadt u de pagina in de webbrowser opnieuw.

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Model Name – – Geeft de modelnaam van het objectief weer.

Serial
Number

– – Geeft het serienummer van het objectief weer.

Version
Number

– – Geeft de software-versie van het objectief weer.
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Verwant onderwerp
De software van een objectief met E-bevestiging bijwerken

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

Version Up – –

Druk op de knop [Choose File] en volg de instructies op
het scherm om de objectiefsoftware bij te werken.

Voor nadere informatie raadpleegt u "De software van
een objectief met E-bevestiging bijwerken".

Opmerking

Na het bijwerken van het objectief start het apparaat
opnieuw op. Na de herstart laadt u de pagina in de
webbrowser opnieuw.
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System Log

Hiermee configureert u instellingen met betrekking tot het systeemlogboek.

Dit levert een logboek op zoals hieronder weergegeven.

Verwant onderwerp

De software van een objectief met E-bevestiging bijwerken

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Stelt het niveau in waarvoor een vermelding
wordt toegevoegd aan het systeemlogboek.

Log Size 200 t/m 1024 1024
Bepaalt de grootte van de vermelding die in het
systeemlogboek wordt opgeslagen.

Download as
File – –

Druk op de knop [Download] en sla het
systeemlogboek op een tablet of computer op
vanuit het venster dat verschijnt.
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HTTP Access Log

Hiermee configureert u instellingen met betrekking tot het HTTP-toegangslogboek.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling subonderdeel Standaardinstelling Beschrijving

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Stelt het niveau in waarvoor een vermelding wordt
toegevoegd aan het HTTP-toegangslogboek.

Log Size 200 t/m 1024 1024
Bepaalt de grootte van de vermelding die in het
HTTP-toegangslogboek wordt opgeslagen.

Download
as File – –

Druk op de knop [Download] en sla het HTTP-
toegangslogboek op een tablet of computer op
vanuit het venster dat verschijnt.
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Service

Hiermee kunt u informatie over het apparaat opvragen. Gebruik dit wanneer u contact opneemt met een Sony-
servicevertegenwoordiger.

5-041-957-73(1) Copyright 2022 Sony Corporation

Onderdeel Instelling
subonderdeel Standaardinstelling Beschrijving

I agree to
download device
information.

– –

Zet hier een vinkje om akkoord te gaan dat
apparaatgegevens worden opgehaald en druk op de
knop [OK].
Druk op de weergegeven knop [Download]. De
webbrowser downloadt tijdelijk een bestand met de
naam deviceinformation.dat.

Opmerking

Na het downloaden start het apparaat opnieuw op.
Start handmatig opnieuw op als het apparaat niet
automatisch opnieuw opstart. Na de herstart laadt u
de pagina in de webbrowser opnieuw.
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EULA

Geeft de eindgebruikersovereenkomst (EULA, End User License Agreement) weer.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Software

Hiermee geeft u de softwarelicentie weer.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Externe monitors en opname-apparaten aansluiten

Om opgenomen/af te spelen beelden op een externe monitor af te spelen, stelt u het video-uitvoertype in voor de externe
monitor en gebruikt u de juiste kabel om de monitor aan te sluiten.
U kunt ook een extern opnameapparaat aansluiten en het uitgangssignaal van het apparaat opnemen.
U kunt op een externe monitor dezelfde informatie weergeven als zichtbaar is op het camerabeeldpaneel, zoals
statusinformatie en menu's. Stel het systeemtype voor schermweergave in op On met [Monitoring] > [Output Display] in
het webmenu.

Opmerking

Als u een HDMI-monitor hebt aangesloten die de HDMI-uitvoerindeling niet ondersteunt die is geconfigureerd in het menu
[Monitoring] in het webmenu of cameramenu, wordt het camerabeeld niet uitgevoerd naar de webapp. Streamende video kan dan
ook niet worden uitgevoerd.

U kunt zowel [Output Display] > [SDI] en [HDMI/Stream] instellen op [Off], maar dan kunt u geen cameramenu's en -functies
gebruiken die afhankelijk zijn van de schermweergave. Bovendien zijn foutmeldingen van het apparaten dan beperkt tot de
lampjes (brandend of knipperend) van het apparaat en de weergave van de meldingsmarkering rechtsboven in de webapp. Wilt u
de gedetailleerde status zien, stel dan [Output Display] in op [On].

Hint

Standaard is [Output Display] > [SDI] ingesteld op [Off] en is [HDMI/Stream] ingesteld op [On]. Wilt u streamen gebruiken als
hoofdvideo, stel dan [SDI] in op [On] en [HDMI/Stream] op [Off] en volg de camerastatus op een SDI-monitor.

SDI OUT-aansluiting (BNC-type)

Stel de uitvoerindeling in met het menu [Monitoring] in het webmenu of cameramenu.
Gebruik voor de aansluiting een commercieel verkrijgbare 75 Ω coaxkabel.

Opmerking

Controleer of de verbinding tussen het apparaat en het externe apparaat is geaard voordat u het apparaat inschakelt.

Wij raden aan om het apparaat en het externe apparaat pas in te schakelen nadat ze op elkaar zijn aangesloten
met de 75 Ω-coaxkabel.
Als u het externe apparaat op het apparaat wilt aansluiten als dit is ingeschakeld, sluit dan eerst de 75 Ω-coaxkabel aan
op het externe apparaat en daarna op dit apparaat.

Opnemen op dit apparaat en het externe apparaat tegelijkertijd starten
Terwijl SDI-signaaluitvoer is ingeschakeld, stelt u [Project] > [SDI/HDMI Rec Control] > [Setting] in op [SDI/HDMI Remote
I/F] of [Parallel Rec] in het cameramenu. Nu kan een REC-triggersignaal worden uitgevoerd naar het externe apparaat
dat is aangesloten op de SDI OUT-aansluiting. Dit synchroniseert opname van het externe apparaat met dit apparaat.

Opmerking

Als een aangesloten extern apparaat geen ondersteuning biedt voor een REC triggersignaal, kan het apparaat niet worden
bediend.

Wanneer [Project] > [SDI/HDMI Rec Control] > [Setting] is ingesteld op [SDI/HDMI Remote I/F] in het cameramenu, wordt het
REC-triggersignaal alleen uitgevoerd wanneer er geen opnamemedium is geplaatst en de knop Record START/STOP wordt
ingedrukt.
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HDMI OUT-aansluiting (aansluiting type A)

Schakel de instelling voor uitvoer On-Off en stel de uitvoerindeling in het menu [Monitoring] in het cameramenu in.

Opnemen op dit apparaat en het externe apparaat tegelijkertijd starten
Terwijl HDMI-signaaluitvoer is ingeschakeld, stelt u [TC/Media] > [HDMI TC Out] > [Setting] in op [On] en [Project] >
[SDI/HDMI Rec Control] > [Setting] op [SDI/HDMI Remote I/F] of [Parallel Rec] in het cameramenu. Nu kan een REC-
triggersignaal worden uitgevoerd naar het externe apparaat dat is aangesloten op de HDMI OUT-aansluiting. Dit
synchroniseert opname van het externe apparaat met dit apparaat.

Opmerking

Als een aangesloten extern apparaat geen ondersteuning biedt voor een REC triggersignaal, kan het apparaat niet worden
bediend.

Wanneer [Project] > [SDI/HDMI Rec Control] > [Setting] is ingesteld op [SDI/HDMI Remote I/F] in het cameramenu, wordt het
REC-triggersignaal alleen uitgevoerd wanneer er geen opnamemedium is geplaatst en de knop Record START/STOP wordt
ingedrukt.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Verbinding maken met een RCP/MSU

Sommige functies van het apparaat kunnen op afstand worden bediend door op het apparaat een afstandsbediening
(Remote Control Panel, RCP) zoals de RCP-3500/3501 aan te sluiten, of een hoofdinstelapparaat (Master Setup Unit,
MSU) zoals de MSU-3500 aan te sluiten via een LAN-kabel.
De verbindingsmethode hangt af van de configuratie van de betrokken apparaten en van de toepassing.

Voor nadere informatie over een één-op-éénverbinding tussen het apparaat en en RCP raadpleegt u "Eén-op-
éénverbinding tussen het apparaat en een RCP".
Voor nadere informatie over het aansluiten van meerdere camera's met een MSU of camerabedieningssoftware
raadpleegt u "Het apparaat gebruiken in een multicameraomgeving met een MSU/camera-
afstandsbedieningssoftware".

Verwant onderwerp

Eén-op-éénverbinding tussen het apparaat en een RCP

Het apparaat gebruiken in een multicameraomgeving met een MSU/camera-afstandsbedieningssoftware

5-041-957-73(1) Copyright 2022 Sony Corporation
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Eén-op-éénverbinding tussen het apparaat en een RCP

Opmerking

Raadpleeg de "Lijst met ondersteunde functies" en configureer het apparaat zodanig dat het voldoet aan de
gebruiksomstandigheden voor de functies die u wilt gebruiken. Schakel dan op de volgende manier de verbinding met een RCP
in.

Verwant onderwerp

Lijst met ondersteunde functies

5-041-957-73(1) Copyright 2022 Sony Corporation

Schakel alle apparaten in.1

Stel [Technical] > [RCP/MSU] > [CNS Mode] in op [Bridge] in het webmenu van de camera.2

Configureer de volgende instellingen op de RCP.

Voor nadere informatie over de configuratie raadpleegt u de gebruiksaanwijzing van de RCP.

3

Stel de verbindingsmodus in op Bridge-modus.1.
Registreer het IP-adres van de camera.2.
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Het apparaat gebruiken in een multicameraomgeving met een MSU/camera-
afstandsbedieningssoftware

U kunt meerdere camera's aansluiten met een MSU of met camera-afstandsbedieningssoftware.

Opmerking

Raadpleeg de "Lijst met ondersteunde functies" en configureer het apparaat zodanig dat het voldoet aan de
gebruiksomstandigheden voor de functies die u wilt gebruiken. Schakel dan op de volgende manier de verbinding in met een
MSU of met camera-afstandsbedieningssoftware.

Verwant onderwerp

Lijst met ondersteunde functies

5-041-957-73(1) Copyright 2022 Sony Corporation

Schakel alle apparaten in.1

Configureer de systeemnetwerkinstellingen met de MSU of de camera-afstandsbedieningssoftware.

Voor nadere informatie over de configuratie raadpleegt u de gebruiksaanwijzing van de MSU of de camera-
afstandsbedieningssoftware.

2

Configureer de volgende instellingen met [Technical] > [RCP/MSU] in het webmenu van de camera.3

Wanneer u een MSU gebruikt, stelt u [CNS Mode] in op [MCS]. Als u camera-afstandsbedieningssoftware
gebruikt, stelt u [CNS Mode] in op [PC Control].

1.

Stel het IP-adres van de hoofd-MSU of de camera-afstandsbedieningssoftware in bij [Master IP Address].2.
Stel het cameranummer waarmee u de camera wilt registreren in bij [Camera No.].3.
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Lijst met ondersteunde functies

In de volgende tabel vindt u de ondersteunde functies en de bijbehorende gebruiksomstandigheden.

Bedieningspaneel Functies van het apparaat Gebruiksomstandigheden

IRIS Het diafragma handmatig aanpassen –

AUTO IRIS Auto Iris in-uitschakelen –

ND
De ND-filtervoorkeuzepositie schakelen
(Clear/Preset1 op Preset3)

Deze functie is ingeschakeld wanneer
[Shooting] > [ND Filter] > [Mode] is ingesteld op
[Preset] in het cameramenu.

MASTER GAIN
De versterking handmatig aanpassen
(stappen van 3 dB)

Ingeschakeld als de opnamemodus is ingesteld
op de modus Custom en [Shooting] >
[ISO/Gain/EI] > [Mode] is ingesteld op [dB] in het
cameramenu.

WHITE (R/B)
De witbalans (R Gain/B Gain) handmatig
aanpassen

Ingeschakeld als [White Mode] is ingesteld op
[Memory A(R/B)] of [Memory A(T/T)].WHITE (Color

Temp)

De witbalans (kleurtemperatuur/tint)
handmatig aanpassen

RCP – [Color Temp]: kleurtemperatuur
van de witbalans
RCP – [Balance]: tintwaarde van de
witbalans

ATW
De functie ATW (automatisch volgen van de
witbalans) in-uitschakelen

Ingeschakeld als de opnamemodus is ingesteld
op de modus Custom.

BLACK R/B Aanpassen van de zwartbalans
Ingeschakeld als de opnamemodus is ingesteld
op de modus Custom.
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Opmerking

Configureer het apparaat zodanig dat het voldoet aan de gebruiksomstandigheden voor de functies die u wilt gebruiken. Schakel
dan de verbinding met een RCP/MSU in. Als u de gebruiksomstandigheden wijzigt nadat de verbinding is ingeschakeld, kan
onverwacht gedrag optreden.

5-041-957-73(1) Copyright 2022 Sony Corporation

Bedieningspaneel Functies van het apparaat Gebruiksomstandigheden

MASTER BLACK Het masterniveau voor zwart aanpassen

Ingeschakeld als de opnamemodus is
ingesteld op de modus Custom.
H/V Ratio en Crispening zijn ingeschakeld
wanneer [Paint/Look] > [Detail] > [Manual
Setting] is ingesteld op [On] in het
cameramenu.

DETAIL

De detailfunctie in-uitschakelen
Het detailniveau instellen
H/V Ratio instellen
Crispening instellen

User Matrix

De gebruikers-matrixcorrectiefunctie in-
uitschakelen
De matrixcorrectiewaarden (R-G/R-B/G-
R/G-B/B-R/B-G) instellen

Multi Matrix

De multi-matrixcorrectiefunctie in-
uitschakelen
Stelt de tint en verzadiging in van de
kleur die wordt gebruikt voor multi-
matrixcorrectie

Knee

De kniecorrectiefunctie in-uitschakelen
De automatische kniefunctie in-uitschakelen
Het kniepunt en de compressieverhouding
instellen

BARS De kleurbalken in-uitschakelen

SHUTTER

De sluiterfunctie in-/uitschakelen
De sluitertijd instellen
(Automatische sluitertijd in-uitschakelen,
hoeksluiter instellen, langzame sluiter
instellen, ECS instellen worden niet
ondersteund.)

Opmerking

De RCP-sluiterinstellingen worden
mogelijk niet weergegeven,
afhankelijk van de geconfigureerde
sluitersnelheid.

De RCP-sluiterinstellingen worden
mogelijk niet correct weergegeven
als de sluiter niet kan worden
bediend vanaf de RCP.

Wanneer automatische sluiter is ingeschakeld,
blijft automatische sluiter functioneren, zelfs als u
de sluiter in-/uitschakelt of de sluitersnelheid
wijzigt vanaf de RCP.
Wanneer de sluiter is ingesteld op [Angle], wordt
de sluiter in-uitschakelen of wijzigen van de
sluitersnelheid vanaf de RCP niet ondersteund.
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Bediening met een afstandsbediening RM-IP500 (optioneel)

U kunt het apparaat bedienen met een Sony RM-IP500-afstandsbediening waarop softwareversie 2.2 of later is
geïnstalleerd. De apparaten communiceren via VISCA over IP (LAN).
Afhankelijk van het onderdeel dat u wilt bedienen, kan het nodig zijn dat u de schermweergave van het apparaat kunt
zien. Zorg voor een monitor waarop u de schermweergave kunt bekijken.
De volgende handelingen vanaf de afstandsbediening RM-IP500 worden ondersteund.

Selecteren van de doelcamera
Aanpassen van de kadrering (zwenken, kantelen, zoomen)
Aanpassen van de scherpstelling (behalve bediening met aanraking)
Registreren en oproepen van voorkeuzeposities
Gebruik van het menu van het apparaat (behalve het webmenu)
Aanpassen van de helderheid
Aanpassen van de witbalans
Aanpassen van de zwartbalans
Aanpassen van het audio-ingangsniveau
Starten en stoppen met opnemen
Toewijzen van functies aan toewijsbare knoppen op het apparaat

Voor nadere informatie over de bediening met een RM-IP500 raadpleegt u de gebruiksaanwijzing van de RM-IP500.

Hint

Wanneer u een RM-IP500 gebruikt, gebruik dan de paneelindeling voor dit apparaat dat wordt meegeleverd met de RM-IP500.

RM-IP500 (met paneelindeling voor dit apparaat)
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Verbinding maken met een afstandsbediening RM-IP500

Voor nadere informatie over het toewijzen van functies raadpleegt u de gebruiksaanwijzing van de RM-IP500.

5-041-957-73(1) Copyright 2022 Sony Corporation

Zet SETUP-schakelaar 3 van het apparaat in de stand ON om VISCA over IP-communicatie mogelijk te
maken.

Opmerking

De schakelaarstand wordt toegepast wanneer u het apparaat de volgende keer aanzet.

1

Verbind de RM-IP500 met hetzelfde netwerk als het apparaat.2

Volg de procedure in de gebruiksaanwijzing bij de RM-IP500 en configureer de VISCA over IP-verbinding
(LAN) op de RM-IP500.

Wijs dit apparaat toe met het RM-menu > AUTO IP SETUP > ASSIGN CAM.

3

Wijs functies van dit apparaat naar believen toe aan knoppen met behulp van de volgende RM-
menuonderdelen van de RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Synchroniseren met een extern apparaat

Wanneer u met meerdere apparaten filmt, kunt u de apparaten synchroniseren met een specifiek referentiesignaal of
tijdcode via de GENLOCK-aansluiting van de apparaten.

Voor nadere informatie over Genlock raadpleegt u "De fase van het videosignaal synchroniseren (Genlock)".
Voor nadere informatie over het synchroniseren van tijdcodes raadpleeg u "De tijdcode met die van andere
apparaten vergrendelen".

Verwant onderwerp

De fase van het videosignaal synchroniseren (Genlock)

De tijdcode met die van andere apparaten vergrendelen

5-041-957-73(1) Copyright 2022 Sony Corporation
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De fase van het videosignaal synchroniseren (Genlock)

U kunt een referentiesignaal naar de GENLOCK-aansluiting sturen om Genlock in te schakelen.
De invoerreferentiesignalen die u kunt gebruiken variëren afhankelijk van de systeemfrequentie van de geselecteerde
opname-indeling.

U kunt de externe synchronisatiestatus controleren met [Technical] > [Genlock] > [Reference] in het cameramenu.

Opmerking

Als het referentiesignaal niet stabiel is, kan Genlock niet worden gerealiseerd.

Het subdragersignaal wordt niet gesynchroniseerd.
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Systeemfrequentie van opname-indeling Ondersteunde invoerreferentiesignalen

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i

454



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

De tijdcode met die van andere apparaten vergrendelen

Stel het apparaat dat de tijdcode verzendt in op een modus waarin de tijdcodeverzending actief blijft (zoals Free Run of
Clock).

Opmerking

Controleer dat de geleverde referentietijdcode en het geleverde referentievideosignaal een faserelatie hebben die voldoet aan de
SMPTE-norm voor tijdcodes.

Bij gebruik met externe vergrendeling realiseert de tijdcode onmiddellijke vergrendeling met de externe tijdcode en de externe
tijdcodewaarde verschijnt in het gegevensweergavegebied. Start de opname echter niet onmiddellijk. Wacht een paar seconden
tot de tijdcodegenerator stabiliseert, alvorens op te nemen.

Als de frequentie van het referentievideosignaal en de beeldfrequentie op het apparaat niet hetzelfde zijn, kan geen vergrendeling
worden gerealiseerd en werkt het apparaat niet correct. Als dit zich voordoet, ontvangt de tijdcode geen succesvolle
vergrendeling met de externe tijdcode.

Als de verbinding met de externe tijdcodebron wordt verbroken, mag de tijdcode één frame per uur verspringen ten opzichte van
de referentietijdcode.

Externe vergrendeling vrijgegeven
Wijzig de instelling [TC/Media] > [Timecode] in het cameramenu.
Externe synchronisatie wordt ook vrijgegeven als de systeemfrequentie wordt gewijzigd en als opname wordt gestart in
een speciale opnamemodus (Slow & Quick Motion of Interval Rec).

5-041-957-73(1) Copyright 2022 Sony Corporation

Stel het volgende in met [TC/Media] > [Timecode] in het cameramenu.

Stel [Mode] in op [Preset].
Stel [Run] in op [Free Run].

1

Druk op een toewijsbare knop waaraan de functie [DURATION/TC/U-BIT] is toegewezen om de tijdcode op
het scherm weer te geven.

2

Voer een HD- of SD-referentievideosignaal naar de GENLOCK-aansluiting en de referentietijdcode naar de
TC IN-aansluiting.

De tijdcodegenerator van het apparaat realiseert vergrendeling met de referentietijdcode en "EXT-LK" verschijnt op
het scherm.
Als er ongeveer tien seconden zijn verstreken nadat de tijdcode is vergrendeld, wordt de externe
vergrendelingsstaat behouden, zelfs als de bron van de externe referentietijdcode wordt losgekoppeld.

3
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Een externe microfoon of extern geluidsapparaat aansluiten

U kunt het signaal van een externe microfoon of extern geluidsapparaat invoeren en deze audio opnemen in de
opgenomen video of de uitvoervideo van het apparaat.

Sluit een externe microfoon of extern geluidsapparaat aan met een XLR-kabel.

Wanneer de audio is ingesteld op [LINE] met [Audio] > [Audio Input] > [AUDIO IN Select] in het cameramenu, werkt
de AUDIO IN-aansluiting als de AUDIO IN CH-1-aansluiting en AUDIO IN CH-2-aansluiting.

1

Pinnr. Functie

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Schakel het apparaat uit en sluit de XLR-kabel aan op de AUDIO IN-aansluiting.2

Stel zo nodig SETUP-schakelaar 2 in voor phantomvoeding.

Schakel de +48 V-voeding (phantomvoeding) zoals hieronder beschreven.
Schakelaar 2
Stelt in of de +48 V-voeding (phantomvoeding) wordt in- of uitgeschakeld wanneer u een geluidsinvoerapparaat
aansluit.

3

Instelling Beschrijving

OFF
(standaard)

De +48 V-phantomvoeding wordt uitgeschakeld en LINE of MIC wordt ingesteld als CH-1- en
CH-2-invoergeluidsbron.
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Opmerking

Wanneer u deze schakelaar in de stand ON zet en een microfoon aansluit die niet compatibel is met +48 V kan het
aangesloten apparaat beschadigd raken. Controleer de instelling, alvorens het apparaat aan te sluiten.

Instelling Beschrijving

ON
De +48 V-phantomvoeding wordt ingeschakeld en de met phantomvoeding compatibele
microfoon wordt ingesteld als CH-1- en CH-2-invoergeluidsbron.

Schakel het apparaat in en stel het type aangesloten apparaat in met [Audio] > [Audio Input] > [AUDIO IN
Select] in het cameramenu.

4
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Clips beheren/bewerken met behulp van een computer

U kunt clips beheren en bewerken met een computer.

Clips importeren met een kaartlezer (optioneel)

Sluit een kaartlezer CFexpress Type A of SD-kaartlezer aan op uw computer en gebruik software die de opname-indeling
van dit apparaat ondersteunt, zoals Catalyst Browse, om de clips te importeren.

Een non-lineair bewerkingssysteem gebruiken

In een non-lineair bewerkingssysteem is bewerkingssoftware (optioneel) vereist die de indelingen ondersteunt die door
het apparaat worden opgenomen.

5-041-957-73(1) Copyright 2022 Sony Corporation

458



Help-gids

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Een glasvezelsignaal uitvoeren

U kunt een SDI-signaal dat is geconverteerd naar een optisch signaal uitvoeren door een SFP+-module (optioneel) aan
te sluiten op de OPTICAL-aansluiting van het apparaat. Gebruik een SFP+-module die past bij de signaalband van de
betreffende indeling.
Signaalband

4K (59.94p, 50p): 12G
4K (anders dan 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (anders dan 59.94p, 50p): 1.5G

Opmerking

Gebruik een module die voldoet aan de volgende normen.

SFF-normen
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-normen
ST297/ST292/ST424/ST425/ST2081/ST2082

Hetzelfde signaal als de SDI-uitgang wordt uitgevoerd naar de SFP+-module.

Het apparaat ondersteunt geen invoer via glasvezel.

Gebruik een SFP+-module voor glasvezeluitvoer. Voor nadere informatie over geverifieerde SFP+-modules neemt u contact op
met uw leverancier of Sony servicevertegenwoordiger.

5-041-957-73(1) Copyright 2022 Sony Corporation

* Power Level I (1,0 W)
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Een tallysignaal aansluiten

In dit onderwerp wordt regeling met tallysignaal beschreven.

Het tallylampje bedienen met een signaal vanaf een afstandsbediening

U kunt het tallylampje bedienen met een VISCA over IP-opdracht vanaf een extern apparaat, zoals de RM-IP500.
Stel [Technical] > [Tally] > [Tally Control] in op [External] in het webmenu of cameramenu.

Het tallylampje bedienen vanaf een extern apparaat

U kunt het tallylampje rood of groen laten branden vanaf een extern apparaat, zoals de RM-IP500 of een switch. U kunt
de tally bedienen met opdrachten via het netwerk of een tally-invoersignaal gebruiken op de OPTION-aansluiting van het
apparaat.
Stel [Technical] > [Tally] > [Tally Control] in op [External] in het webmenu of cameramenu.
Wanneer u een tallysignaal invoert via de OPTION-aansluiting, sluit pin 7 dan kort met GND (pin 4 of 5) om het
tallylampje groen te laten branden of pin 8 met GND (pin 4 of 5) om het tallylampje rood te laten branden.

Opmerking

Wanneer [Tally Control] is ingesteld op [External], wordt de opnamestatus van het apparaat niet aangegeven door het tallylampje.

Wanneer een rood en een groen tallysignaal tegelijkertijd worden ingevoerd, gaat het tallylampje van het apparaat rood branden.

Pinspecificaties van de OPTION-aansluiting

Pinnr. Signaalrichting Signaalspecificaties

1 – RS-232C TX-signaal (voor objectiefcontroller)

2 – RS-232C RX-signaal (voor objectiefcontroller)

3 OUT

Groene tallylampuitvoer
Uitvoer op laag niveau wanneer het groene tallylampje brandt.
Hi-Z (opendrain-uitvoer) wanneer groene tallylampje niet brandt.

4 – GND (aarde)

5 – GND (aarde)
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Het tallylampje van een extern apparaat bedienen met een signaal vanaf het apparaat

U kunt het tallylampje van een extern apparaat bedienen met een signaal vanaf het apparaat door pin 3 en pin 6 van de
OPTION-aansluiting te verbinden zoals hieronder weergegeven.
Voorbeeld OPTION-aansluiting, pinnen 3 en 6

Opmerking

Zet geen spanning op de pinnen 7 en 8.

Sluit geen extern apparaat aan dat spanning kan zetten op de OPTION-aansluiting.

Als een invoerstroom of omgekeerde spanning die hoger is dan nominaal wordt gezet op pin 3 of 6 kan dit een storing, rook of
brand veroorzaken.

Stel het uitvoersignaal in met [Technical] > [Tally] > [Tally Control] in het webmenu of het cameramenu.
[Internal]: opnamestatus van het apparaat
[External]: logische EN van rode/groene tallysignalen die worden ontvangen door het apparaat via de IN-signalen of de
afstandsbedieningen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Pinnr. Signaalrichting Signaalspecificaties

6 OUT

Rode tallylampuitvoer
Uitvoer op laag niveau wanneer het rode tallylampje brandt.
Hi-Z (opendrain-uitvoer) wanneer het rode tallylampje niet brandt.

7 IN
Externe regelinvoer voor groene tally
Bij kortsluiting met aarde (pin 4 of 5) gaat het tallylampje van het apparaat groen branden.

8 IN
Externe regelinvoer voor rode tally
Bij kortsluiting met aarde (pin 4 of 5) gaat het tallylampje van het apparaat rood branden.
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Volggegevens uitvoeren (free-d)

Met het apparaat kunt u zwenk-/kantel-/zoom-, scherpstellings- en diafragmagegevens uitvoeren die zijn
gesynchroniseerd op een synchronisatiesignaal.
De gegevensuitvoer voldoet aan het free-d-protocol, een branchenorm. U kunt de uitvoermethode selecteren, waarbij u
kiest tussen constante uitvoer en uitvoer op verzoek van een client. Selecteer de uitvoermethode conform uw VR-/AR-
systeem.

Gegevensuitvoerindeling

Hint

U vindt technische gegevens in de "Integratiehandleiding voor free-d". Neem contact op met een verkoopvertegenwoordiger van
Sony.

De volggegevens die het apparaat uitvoert bestaan uit de volgende gegevens, conform de indeling die is gespecificeerd
in Type D0/D1 van het free-d-protocol.
Type D0 – poll/command

Controleer dat het apparaat aan staat.1

Stel de uitvoermethode voor volggegevens in.

Voor constante uitvoer

Voor uitvoer op verzoek van een client

2

Stel [Technical] > [Tracking Data Output] > [Transfer Mode] in op [Always] in het webmenu.1.
Stel de id van het apparaat in [Camera ID].2.
Geef het IP-adres van het uitvoerdoel op bij [Destination Address].3.
Geef het poortnummer van het uitvoerdoel op bij [Destination Port].4.
Druk op de knop [OK].5.

Stel [Technical] > [Tracking Data Output] > [Transfer Mode] in op [On Demand] in het webmenu.1.
Stel de id van het apparaat in [Camera ID].2.
Geef het poortnummer voor het luisteren naar aanvragen van clients op bij [Listen Port].3.
Druk op de knop [OK].4.

Symbool Inhoud Beschrijving

<D0> Message type

<CA> Camera ID

<CD> command

Ondersteunt de volgende opdrachten:
00 Stop stream mode
01 Start stream mode
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Type D1 – camera position/orientation data

Opmerking

Volggegevens kunnen vertraagd zijn of de waarden worden niet bijgewerkt in de volgende situaties:

Bij het uitvoeren van RAW-video
Wanneer S&Q Motion is ingeschakeld
Wanneer u het cameramenu weergeeft
Wanneer u het pictogrammenscherm weergeeft
Wanneer u opgenomen clips afspeelt
Wanneer u het webmenu weergeeft

5-041-957-73(1) Copyright 2022 Sony Corporation

Symbool Inhoud Beschrijving

<CK> Checksum

Symbool Inhoud Beschrijving

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Zwenkhoek (−170° tot +170°)

<TH><TM><TL> Camera Tilt Angle Kantelhoek (−30° tot +195°)

<RH><RM><TL> Camera Roll Angle Niet ondersteund (altijd 0)

<XH><XM><XL> Camera X-Position Niet ondersteund (altijd 0)

<YH><YM><YL> Camera Y-Position Niet ondersteund (altijd 0)

<HH><HM><HL> Camera Height Niet ondersteund (altijd 0)

<ZH><ZM><ZL> Camera Zoom Brandpuntsafstand

<FH><FM><FL> Camera Focus Scherpstelafstand

<SH><SL> Spare/User Defined Diafragmapositie

<CK> Checksum
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Een objectiefcontroller aansluiten

U kunt de zoom van een handmatig zoomobjectief bedienen vanuit de webapp, RM-IP500 (optioneel) of
infraroodafstandsbediening door een in de handel verkrijgbare objectiefcontroller (optioneel) aan te sluiten die compatibel
is met dit apparaat.
Raadpleeg voor nadere informatie over het aansluiten van een objectiefcontroller de gebruiksaanwijzing van de
objectiefcontroller.
Voor nadere informatie over het aanpassen van de zoom met een objectiefcontroller raadpleegt u "De zoom aanpassen
met een objectiefcontroller".

Opmerking

Voordat u een objectiefcontroller gaat gebruiken, leest u de gebruiksaanwijzing van de objectiefcontroller zorgvuldig door en u
zorgt ervoor dat u het gebruik ervan goed begrijpt. Sony is niet aansprakelijk voor aanspraken van welke aard dan ook ten
gevolge van het gebruik van een objectiefcontroller.

Clear Image Zoom is niet beschikbaar wanneer een objectiefcontroller is ingeschakeld. U kunt het beste de Clear Image Zoom-
verhouding instellen op 1.0× of Clear Image Zoom uitschakelen.

Wanneer de objectiefcontroller is ingeschakeld, kunt u geen camera-kadreringshandelingen opnemen of afspelen.

Verwant onderwerp

De zoom aanpassen met een objectiefcontroller

5-041-957-73(1) Copyright 2022 Sony Corporation
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De zoom aanpassen met een objectiefcontroller

Volg de volgende procedure om een objectiefcontroller (optioneel) aan te sluiten en de zoom aan te passen.

De status van de objectiefcontroller controleren
Druk op de knop  (Camerastatus) in het gemeenschappelijke deel van het webapp-scherm om het
camerastatusscherm weer te geven.

Sluit een objectiefcontroller aan op de OPTION-aansluiting op het aansluitblok van het apparaat.

Raadpleeg voor nadere informatie over het aansluiten de gebruiksaanwijzing van de objectiefcontroller.

1

Stel de objectiefcontroller in voor uw zoomobjectief.

Raadpleeg voor nadere informatie de gebruiksaanwijzing van de objectiefcontroller.

2

Vergrendel de zwenk-/kantelfunctie van het apparaat en bevestig het zoomobjectief.

Voor nadere informatie raadpleegt u "Een objectief bevestigen".

3

Pas de objectiefcontroller zo aan dat deze het zoomobjectief kan bedienen.4

Houd de voorwaartse/achterwaartse balans van de camerakop goed zodat de schuifvoet horizontaal staat.

Raadpleeg voor nadere informatie de gebruiksaanwijzing van de objectiefcontroller en "Een objectief bevestigen".

5

Stel [Technical] > [Lens Controller] > [Setting] in op [On] in het webmenu en druk op de knop [OK].

Het apparaat start opnieuw op. Wacht tot de zwenk-/kantelhandeling is voltooid.

6

Druk op de knop  (Objectiefcontroller initialiseren) op het tabblad  (Others) in het
camerabedieningspaneel in het live-bedieningsscherm van de webapp.

De objectiefcontroller beweegt om het zoombereik vast te stellen. Raadpleeg voor nadere informatie de
gebruiksaanwijzing van de objectiefcontroller.
Wanneer de indicator  (Objectiefcontrollerfout) wijzigt in  (Objectiefcontroller gereed) linksboven in het
camerabeeldpaneel is de voorbereiding voltooid.

Opmerking

Merk op wat het bedieningsbereik van het objectief is wanneer u de objectiefcontroller initialiseert.

7

Pas de zoom aan met de schuifbalk [Zoom] in de webapp of met de zoomregelaars van de
infraroodafstandsbediening.

8
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Op dit scherm kunt u de status van de objectiefcontroller controleren.

Opmerking

Wanneer u het objectief vervangt, initialiseert u de objectiefcontroller.

Clear Image Zoom is niet beschikbaar wanneer een objectiefcontroller is ingeschakeld. U kunt het beste de Clear Image Zoom-
verhouding instellen op 1.0× of Clear Image Zoom uitschakelen.

5-041-957-73(1) Copyright 2022 Sony Corporation

Status Beschrijving

Off Gebruik de power-zoom in een objectief met E-bevestiging.

Communication
Error

Er is een communicatiefout opgetreden tussen het apparaat en de objectiefcontroller.
Controleer de verbinding tussen het apparaat en de objectiefcontroller. Raadpleeg de
gebruiksaanwijzing van de objectiefcontroller en initialiseer de objectiefcontroller.

Uninitialized Voer initialisatie uit.

Initializing Wacht tot de initialisatie voltooid is.

Initialization
Failed

Controleer de verbinding tussen het apparaat en de objectiefcontroller. Raadpleeg de
gebruiksaanwijzing van de objectiefcontroller en initialiseer de objectiefcontroller.

Working Bedien de zoom met de objectiefcontroller.

Rotation Error
Het opgeslagen zoombewegingsbereik en het objectiefbewegingsbereik komen misschien niet
overeen. Initialiseer de objectiefcontroller.

System Error Controleer de verbinding tussen het apparaat en de objectiefcontroller. Raadpleeg de
gebruiksaanwijzing van de objectiefcontroller en initialiseer de objectiefcontroller, of zet het
apparaat en de objectiefcontroller uit en weer aan.Unknown Error
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Voorzorgsmaatregelen voor gebruik

Voorzorgen bij transport en inpakken
Wanneer u het apparaat vervoert of verpakt, zorg dan voor de volgende omstandigheden en voorkom blootstelling aan
sterke trillingen of schokken.

Verwijder het objectief en bevestig de bodydop.
Nadat u de camerakop (A) naar voren heeft gedraaid, draait u de camerakopgrendel (B) in de richting van de pijl om
de camerakop te vergrendelen.

Richt de camerakop zo dat deze naar voren wijst en vergrendel deze met de zwenk-/kantelvergrendeling.

Verwijder de verbindingskabels.

Condensatie
Als het apparaat rechtstreeks van een koude in een warme omgeving wordt gebracht of als de omgevingstemperatuur
plots stijgt, kan er zich vocht vormen op de buitenzijde en/of in het toestel. Dit wordt condensvorming genoemd. Schakel
in geval van condensvorming het toestel uit en gebruik het niet opnieuw tot de condens verdwenen is. Als u het toestel
toch gebruikt terwijl er condens aanwezig is, kan het toestel beschadigd raken.

Camera CMOS beeldsensor-verschijnselen

Opmerking

De volgende verschijnselen die kunnen voorkomen in afbeeldingen zijn specifiek voor beeldsensoren. Dit wijst niet op een
storing.

Witte vlekken
Hoewel de beeldsensoren worden geproduceerd met hoogwaardige precisietechnologieën, kunnen er in zeldzame
gevallen kleine witte vlekjes worden gegenereerd op het scherm, veroorzaakt door kosmische straling, etc.
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Dit is inherent aan het principe van beeldsensoren en is geen defect. Voer regelmatig APR uit.
De witte vlekjes kunnen vooral te zien zijn in de volgende gevallen:

Bij werken in een hoge omgevingstemperatuur
Als u de versterking heeft verhoogd (sensitivity)

Flikkeren
Bij het filmen onder belichting van fluorescerend licht, natriumlampen, kwiklampen of leds kan het scherm flikkeren of
kunnen kleuren variëren.

Aandrijvingsdeel voor objectief en zwenken/kantelen
Als het aandrijvingsmechanisme voor het objectief en de zwenk-/kantelmotor langere tijd niet worden gebruikt, kan de
viscositeit van het interne vet groter worden waardoor het mechanisme blokkeert. Gebruik het mechanisme voor het
objectief/zwenken/kantelen regelmatig.

Op verbruiksartikelen
De ventilator en ingebouwde oplaadbare batterij zijn verbruiksartikelen die af en toe vervangen moeten worden.
Wanneer u het apparaat bij kamertemperatuur gebruikt, moeten deze onderdelen ongeveer elke 5 jaar vervangen
worden. Merk op dat deze termijn een algemene richtlijn is en geen garanties biedt aangaande de levensduur van
deze onderdelen.
Neem contact op met een onderhoudsdienst van Sony of uw leverancier voor meer informatie over het vervangen
van onderdelen.

De verwachte levensduur van de AC-adapter en de elektrolytische condensator is ongeveer 5 jaar bij normale
werkingstemperaturen en normaal gebruik (8 uur per dag, 25 dagen per maand). Als het gebruik de normale
gebruiksfrequentie overschrijdt, kan de levensduur dienovereenkomstig verkorten.

Periodieke inspecties worden geadviseerd om het apparaat goed werkend te houden en de bruikbare levensduur te
verlengen. Neem contact op met een Sony service- of verkoopvertegenwoordiger voor meer informatie over inspecties.

Over de ingebouwde oplaadbare batterij
Het apparaat heeft een ingebouwde oplaadbare batterij voor het opslaan van de datum, tijd en andere instellingen, zelfs
als het apparaat wordt uitgeschakeld. De ingebouwde oplaadbare batterij wordt na 24 uur opgeladen als het apparaat is
aangesloten op een stopcontact met de netadapter of via PoE++-voeding, ongeacht of het apparaat is in- of
uitgeschakeld. De oplaadbare batterij wordt in ongeveer 2 maanden volledig ontladen als de netadapter niet is
aangesloten op een voeding. Gebruik het apparaat na het opladen van de batterij. Als de oplaadbare batterij echter niet
is opgeladen, wordt de werking van het apparaat niet beïnvloed zolang u de datum niet hoeft op te nemen.

Gebruiks- en opslaglocaties
Opslaan op een vlakke geventileerde plaats.
Vermijd gebruik of opslag op de volgende plaatsen.

Plaatsen die kunnen worden blootgesteld aan regen of water (zoals onder dakranden)
Buitenshuis en op plaatsen die warmer kunnen worden dan 40 °C
Bedenk dat in de zomer in warme klimaten de temperatuur in een auto met gesloten ramen makkelijk boven 50 °C
kan komen.
Plaatsen die kouder kunnen worden dan 0 °C.
In vochtige of stofrijke omgevingen. Locaties waar het apparaat blootstaat aan regen
Plaatsen die onderhevig zijn aan trillingen of schokken
Plaatsen waar straling, röntgenstraling en krachtige magnetische velden kunnen ontstaan.
Dichtbij radio- of tv-ontvangers die sterke elektromagnetische velden produceren.
Langere periodes in direct zonlicht of dichtbij verwarming

Opmerking over laserstralen
Laserstralen kunnen de CMOS beeldsensor beschadigen. Als u een scene filmt waarin een laserstraal voorkomt, pas
dan op dat de laserstraal niet op het CMOS-beeldsensor van de camera wordt gericht. Vooral ultrasterke laserstralen van
medische apparatuur of andere apparaten kunnen schade veroorzaken, als gevolg van reflecterend en verstrooid licht.
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Elektromagnetische interferentie van draagbare communicatieapparatuur voorkomen
Gebruik van draagbare telefoons en andere communicatieapparaten in de buurt van dit apparaat kan resulteren in
storingen en interferentie met audio- en videosignalen. Geadviseerd wordt om de draagbare communicatieapparatuur in
de buurt van dit apparaat uit te schakelen.

Plaats dit product niet dichtbij medische apparatuur
Dit product (inclusief de accessoires) bevat magneten die de werking kunnen hinderen van een pacemaker,
programmeerbare shunt-ventielen voor de behandeling van hydrocefalie (waterhoofd), of andere medische apparatuur.
Plaats dit product niet dichtbij mensen die dergelijke medische apparatuur gebruiken. Raadpleeg uw arts voordat u dit
product gebruikt in het geval u dergelijke medische apparatuur gebruikt.

Veiligheidsmaatregelen
SONY IS NIET AANSPRAKELIJK VOOR WELKE SCHADE DAN OOK DIE VOORTKOMT UIT HET NIET NEMEN
VAN VOLDOENDE BEVEILIGINGSMAATREGELEN OP TRANSMISSIEAPPARATEN, ONVERMIJDBARE
GEGEVENSLEKKEN DOOR TRANSMISSIESPECIFICATIES OF BEVEILIGINGSPROBLEMEN VAN WELKE AARD
DAN OOK.
Afhankelijk van de gebruiksomgeving kunnen onbevoegden via het netwerk toegang krijgen tot het apparaat.
Wanneer u het apparaat verbinding laat maken met het netwerk, zorg er dan voor dat het netwerk goed is beveiligd.
Om beveiligingsredenen kunt u het beste, wanneer u het apparaat gebruikt terwijl dat is aangesloten op het netwerk,
het controlevenster openen in een webbrowser. Wijzig vervolgens de toegangsinstellingen, blijf niet de
fabrieksinstellingen gebruiken. Verder kunt u het beste een wachtwoord instellen met een voldoende lange
tekenreeks die moeilijk te raden is voor anderen. Bewaar dit op een veilige plaats.
Wanneer u dit product aansluit op een netwerk, maak dan verbinding via een systeem dat beveiliging biedt, zoals een
router of firewall. Als u verbinding maakt zonder dergelijke bescherming kunnen beveiligingsproblemen ontstaan.

Voeding
Het apparaat heeft geen aan-uitschakelaar. Wilt u het apparaat uitschakelen, controleer dan dat alle activiteiten zijn
afgesloten en dat het apparaat in stand-bystand staat. Ontkoppel dan de netadapter. Wanneer u PoE++-voeding
gebruikt, ontkoppelt u de LAN-kabel.
Gebruik zo mogelijk een voeding op een plek waar u de stekker gemakkelijk insteken en lostrekken.
Als u een stopcontact gebruikt op een stoffige plek, maak dan de ruimte rond het stopcontact regelmatig schoon om
kruipstroom te voorkomen.
Koppel de voeding los wanneer u deze niet gebruikt.

Voorzorgen voor bewegende onderdelen
Zorg ervoor dat er geen vreemd materiaal in bewegende onderdelen kan komen.
Gebruik geen grote kracht als u onderdelen met de hand beweegt. Dit kan een storing tot gevolg hebben.
Grijp niet in wanneer er onderdelen bezig zijn met bewegen. Dit kan tot letsel of storing tot gevolg hebben.
Bewegende onderdelen kunnen soms niet normaal functioneren als het apparaat langere tijd niet is gebruikt. Gebruik
regelmatig de zwenk-/kantelfuncties van het apparaat.

Voorzorgen bij continu gebruik
Het apparaat kan 24 uur per dag, 365 dagen per jaar worden gebruikt (wachtstand).
Voer altijd een opnametest uit en controleer of het apparaat normaal functioneert.

Filmen gedurende perioden langer dan 24 uur wordt niet gegarandeerd.
Als u langer dan 24 uur filmt, zet het apparaat dan in wachtstand en start het apparaat opnieuw.

Merk op dan Sony niet aansprakelijk is voor enige vorm van compensatie voor de inhoud van beelden die u niet kunt
opnemen vanwege een defect tijdens het gebruik van het apparaat.
Controleer altijd of het apparaat correct werkt voordat u dit gaat gebruiken. SONY KAN OM GEEN ENKELE REDEN
ALS GEVOLG VAN SCHADE AAN HET APPARAAT AANSPRAKELIJK WORDEN GESTELD EN COMPENSEERT
OF VERGOEDT NIET HET VERLIES VAN HUIDIGE OF TOEKOMSTIGE INKOMSTEN DOOR DEFECTEN AAN
HET APPARAAT (TIJDENS DE GARANTIEPERIODE OF NA VERLOOP VAN DE GARANTIE).
SONY KAN NIET AANSPRAKELIJK WORDEN GESTELD VOOR WELKE AANSPRAKEN DAN OOK DOOR
GEBRUIKERS VAN HET APPARAAT OF DOOR DERDEN.
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SONY IS NIET AANSPRAKELIJK VOOR HET BEËINDIGEN OF NIET DOORGAAN VAN ENIGE DIENST MET
BETREKKING TOT DIT APPARAAT DIE HET GEVOLG IS VAN WELKE OMSTANDIGHEID DAN OOK.

Voorzorgen voor de opnamefunctie
Maak altijd een proefopname en controleer of deze correct is opgenomen. SONY KAN NIET AANSPRAKELIJK
WORDEN GESTELD VOOR SCHADE AAN HET APPARAAT EN LEVERT GEEN COMPENSATIE OF
VERGOEDING ALS GEVOLG VAN DEFECTEN AAN HET APPARAAT OF DE OPNAMEMEDIA, OF ANDERE
MEDIA OF OPSLAGSYSTEMEN VOOR HET OPNEMEN VAN WILLEKEURIG MATERIAAL.
Controleer altijd of het apparaat correct werkt voordat u dit gaat gebruiken. SONY KAN OM GEEN ENKELE REDEN
ALS GEVOLG VAN SCHADE AAN HET APPARAAT AANSPRAKELIJK WORDEN GESTELD EN COMPENSEERT
OF VERGOEDT NIET HET VERLIES VAN HUIDIGE OF TOEKOMSTIGE INKOMSTEN DOOR DEFECTEN AAN
HET APPARAAT (TIJDENS DE GARANTIEPERIODE OF NA VERLOOP VAN DE GARANTIE).
SONY KAN NIET AANSPRAKELIJK WORDEN GESTELD VOOR WELKE AANSPRAKEN DAN OOK DOOR
GEBRUIKERS VAN HET APPARAAT OF DOOR DERDEN.
SONY IS NIET AANSPRAKELIJK VOOR VERLIES, REPARATIE OF REPRODUCTIE VAN GEGEVENS DIE ZIJN
OPGENOMEN OP HET INTERNE OPSLAGSYSTEEM, OPSLAGMEDIA OF WELKE MEDIA OF
OPSLAGSYSTEMEN DAN OOK.
SONY IS NIET AANSPRAKELIJK VOOR HET BEËINDIGEN OF NIET DOORGAAN VAN ENIGE DIENST MET
BETREKKING TOT DIT APPARAAT DIE HET GEVOLG IS VAN WELKE OMSTANDIGHEID DAN OOK.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Uitvoerindelingen en beperkingen

In dit onderwerp worden de uitvoerindelingen en beperkingen beschreven.

Opmerking

De resolutie van de uitvoerindeling wordt beperkt door de instellingen [Project] > [Rec Format] > [Frequency], [Codec] en [Video
Format] in het webmenu of cameramenu.

De resolutie van de uitvoerindeling wordt bovendien beperkt door de combinatie met de S&Q-beeldsnelheid. Naast de tabel met
uitvoerindelingen vanaf de aansluitingen SDI OUT/HDMI OUT wijzigt de HDMI-uitvoer naar Full HD of lager wanneer aan al de
volgende voorwaarden is voldaan.

[Shooting] > [S&Q Motion] > [Setting] is ingesteld op [On]
[Shooting] > [S&Q Motion] > [Frame Rate] is hoger dan 60fps

Als aan bovenstaande voorwaarden is voldaan, worden de selectieopties HDMI-uitvoer 4096×2160P en 3840×2160P voor
[Monitoring] > [Output Format] > [SDI/HDMI] grijs weergegeven en kunnen deze niet worden geselecteerd.

Het beeld wordt niet uitgevoerd als een hogere resolutie dan die van het afspeelbeeld is geconfigureerd.

Uitvoerindelingen van de SDI OUT-/HDMI OUT-aansluitingen

Wanneer de systeemfrequentie 50/59.94 Hz is

Instelling Selecteerbare uitvoerindeling

Opname-/afspeelmodus
RAW-uitvoerresolutie/

Interne
opnameresolutie

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(standaard)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(standaard)
1920×1080i
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Wanneer de systeemfrequentie 25/29.97 Hz is

Instelling Selecteerbare uitvoerindeling

Opname-/afspeelmodus
RAW-uitvoerresolutie/

Interne
opnameresolutie

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standaard)

1920×1080P
(standaard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standaard)

1920×1080P
(standaard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(standaard)

1920×1080P
(standaard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Uitvoer onderbroken)
720×480P2)

720×576P3)

 Er kan niet over de schermweergave worden geprojecteerd.1)

Wanneer de systeemfrequentie 59.94 is2)

Wanneer de systeemfrequentie 50 is3)
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Wanneer de systeemfrequentie 23.98 Hz is

Instelling Output Format (uitvoerresolutie)

Opname-/afspeelmodus RAW-uitvoerresolutie/
Interne opnameresolutie SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (standaard)

3840×2160
(RAW) (3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (standaard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standaard) 1920×1080i (standaard)

3840×2160

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standaard) 1920×1080i (standaard)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Instelling Output Format (uitvoerresolutie)

Opname-/afspeelmodus RAW-uitvoerresolutie/
Interne opnameresolutie SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (standaard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (standaard)
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Wanneer de systeemfrequentie 24 Hz is

5-041-957-73(1) Copyright 2022 Sony Corporation

Instelling Output Format (uitvoerresolutie)

Opname-/afspeelmodus RAW-uitvoerresolutie/
Interne opnameresolutie SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (standaard) 1920×1080P (standaard)

3840×2160
3840×2160 (2SI) 3840×2160P

1920×1080P

1920×1080P (standaard) 1920×1080P (standaard)

1920×1080 1920×1080P (standaard) 1920×1080P (standaard)

Instelling Output Format (uitvoerresolutie)

Opname-/afspeelmodus RAW-uitvoerresolutie/
Interne opnameresolutie SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (standaard)

XAVC-I 4096×2160 4096×2160 (2SI)
1920×1080P (standaard)

4096×2160P
1920×1080P (standaard)
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Problemen oplossen

Voeding

Beelduitvoer

Symptoom Oorzaak Oplossing

Het apparaat
gaat niet aan.

De netadapter is niet goed aangesloten op de
DC IN-aansluiting.

Steek het netsnoer zo ver als mogelijk in.

Het netsnoer is niet goed aangesloten op de
netadapter of het stopcontact.

Steek het netsnoer zo ver als mogelijk in.

De LAN-kabel is niet goed aangesloten tussen
de PoE++-voeding en het apparaat.

Zorg ervoor dat u de kabel zo ver insteekt dat
hij inklikt.

De LAN-kabel is aangesloten op de OPTION-
aansluiting maar niet op de LAN-aansluiting.

Sluit de LAN-kabel correct aan op de LAN-
aansluiting.

Het apparaat is aangesloten op een voeding die
geen PoE++ (IEEE802.3bt type 4 klasse 8)
ondersteunt.

Sluit aan op een voeding die PoE++
(IEEE802.3bt type 4 klasse 8) ondersteunt.

De totale stroomafname is groter dan het
nominale maximum van de PoE++-voeding.

Raadpleeg de gebruiksaanwijzing bij de
PoE++-voeding.

Een netwerkkabel is aangesloten met een
categorie die geen PoE++-voeding ondersteunt.

Gebruik een netwerkkabel van categorie 5e of
hoger die u aansluit op de LAN-aansluiting.

De camera, de PoE++-voeding en de
randapparaten zijn niet aangesloten op de aarde.

Sluit de camera, de PoE++-voeding en de
randapparaten aan op de aarde.

Symptoom Oorzaak Oplossing

Geen beelduitvoer.

Aangesloten apparaten zijn niet correct aangesloten.
Sluit de aangesloten apparaten
correct aan.

Eerste installatie is niet voltooid.
Voer de eerste installatie uit met
de webapp.

Geen beeld vanaf de
HDMI-aansluiting.

Er is een signaal geconfigureerd dat niet wordt
ondersteund door het HDMI-uitvoerdoelapparaat.

Wijzig de HDMI-uitvoerindeling
of gebruik een apparaat dat het
uitvoersignaal ondersteunt.

U gebruikt een kabel die de HDMI-uitvoerindeling niet
ondersteund.

Gebruik een kabel die de
gebruikte HDMI-indeling
ondersteunt.

475



Afstandsbediening

Infraroodafstandsbediening

Symptoom Oorzaak Oplossing

Geen beeld vanaf de SDI-
aansluiting.

U gebruikt een kabel die de SDI-uitvoerindeling niet
ondersteund.

Gebruik een kabel die de
gebruikte SDI-indeling
ondersteunt.

De monitor die is aangesloten op de SDI-aansluiting
ondersteunt het uitvoersignaal niet.

Gebruik een monitor die de
gebruikte SDI-indeling
ondersteunt.

De uitvoerindeling is ingesteld voor RAW-uitvoer.
Wijzig de opname-indeling naar
een instelling die niet RAW is.

De HDMI-uitvoer is ingesteld op SD-resolutie.
Stel de HDMI-uitvoer in op een
andere resolutie dan SD.

Geen beeld vanaf de
glasvezelaansluiting of
vervormd beeld.

De module die u gebruikt voldoet niet aan de SFF- of
SMPTE-norm of aan Power Level I (1,0 W).

Raadpleeg "Een
glasvezelsignaal uitvoeren".

Geen beeld of vervormd
beeld bij gebruik van
externe synchronisatie.

Er wordt geen extern synchronisatiesignaal ingevoerd
dat geschikt is voor de geconfigureerde
videosignaalindeling.

Voer een synchronisatiesignaal
in dat geschikt is voor de
geconfigureerde
videosignaalindeling.

Ruis in de audio.

De camera, de PoE++-voeding en de randapparaten
zijn niet aangesloten op de aarde.

Sluit het apparaat, de PoE++-
voeding en de randapparaten
aan op de aarde.

Het apparaat wordt gebruikt in een omgeving met
apparaten die sterke elektrische en magnetische
velden genereren (zoals tv-/radiozenderantennes,
amateurradiozenders, luchtverversingsmotoren,
voedingstransformators).

Blijf uit de buurt van apparaten
die sterke elektrische en
magnetische velden genereren.

Het objectief, de objectiefsteun en de aandrijfeenheid
maken contact met het apparaat of een object in de
omgeving en er klinkt abnormaal geluid.

Bevestig het objectief
correct.

Controleer op obstakels in
de buurt van de camera.

Symptoom Oorzaak Oplossing

De infraroodafstandsbediening
werkt niet als u op een knop
drukt.

Bediening met de
infraroodafstandsbediening is
uitgeschakeld.

Stel [Technical] > [IR Remote] > [Setting] in
op [On] in het webmenu.

De batterij is leeg of verkeerd-om
ingestoken.

Gebruik de infraroodafstandsbediening
dichtbij de IR-sensor van het apparaat. Als
het voedingslampje knippert, vervangt u de
batterij.

Eerste installatie is niet voltooid. Voer de eerste installatie uit met de
webapp.
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RM-IP500

Webapp

Symptoom Oorzaak Oplossing

Zwenken/kantelen verloopt
langzaam.

De zwenk-/kantelsnelheid vanaf de
infraroodafstandsbediening is
ingesteld op normale modus.

Zet SETUP-schakelaar 4 op het
aansluitblok van het apparaat in de stand
ON.

Een andere camera dan de
bedoelde camera reageerde.

Het infraroodsignaal wordt
opgevangen door een andere
camera dan de bedoelde camera.

Stel [Technical] > [IR Remote] > [Setting] in
op [Off] in het webmenu van de camera die
u niet wilt bedienen.

Symptoom Oorzaak Oplossing

De camera reageert niet op de
afstandsbediening RM-IP500.

De voeding van de camera is
niet aangesloten.

Controleer dat het POWER-lampje van het
apparaat groen of oranje brandt.

De camera of
afstandsbediening is niet
verbonden met het netwerk.

Controleer de verbindingen van het apparaat
en de afstandsbediening.

De eerste installatie van de
camera is niet voltooid.

Voer de eerste installatie uit met de webapp.

VISCA over IP-communicatie
is niet ingeschakeld.

Zet SETUP-schakelaar 3 op het apparaat-
aansluitpaneel in de stand ON en start het
apparaat opnieuw op.

Het IP-adres van de camera
is gewijzigd.

Controleer het IP-adres van de camera met
[Network] > [Wired LAN] in het webmenu of
cameramenu.

Het IP-adres van de camera is
gewijzigd met AUTO IP SETUP op
de afstandsbediening RM-IP500.

Er is meer dan 20 minuten
verlopen sinds de camera is
ingeschakeld.

Start het apparaat opnieuw op. Het IP-adres
kan binnen 20 minuten na inschakelen van het
apparaat AUTO IP SETUP worden gewijzigd
met.
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Symptoom Oorzaak Oplossing

Kan geen verbinding maken met
een webbrowser.

Er is geen LAN-kabel van
categorie 5e of hoger
aangesloten.

Sluit een LAN-kabel aan van categorie 5e of
hoger.

Niet correct aangesloten op een
LAN of het netwerk functioneert
niet goed.

Controleer dat de Link-led van de LAN-
aansluiting brandt. Als de Link-led niet brandt,
neem dan contact op met uw
netwerkbeheerder.

De voeding van de camera is
niet aangesloten.

Raadpleeg het gedeelte "Voeding" hierboven.

Er is geen geldig IP-adres
geconfigureerd voor het
apparaat.

Stel het netwerk terug.

Het geconfigureerde IP-adres
wordt gebruikt op een ander
apparaat.

Controleer dat de IP-adressen van de
randapparaten uniek zijn.

Het geconfigureerde subnet-
masker komt niet overeen met
het gebruikte netwerk-subnet.

Stel het netwerk terug.

Het apparaat wordt gebruikt op
hetzelfde lokale netwerk via een
proxyserver.

Wijzig de configuratie zo dat er geen
proxyserver wordt gebruikt.

De geconfigureerde standaard-
gateway van het apparaat is
niet correct.

Stel het netwerk terug.

Het ingevoerde webadres is
incorrect.

Voer het juiste webadres in en probeer het
opnieuw.

De HTTP-poort is incorrect.

Geef het cameramenu weer op een externe
monitor en controleer de instelling [Network] >
[Wired LAN] > [HTTP Port]. Als er een waarde
hoger dan 80 is geconfigureerd, voeg dan het
HTTP-poortnummer toe aan de hostnaam of
het IP-adres dat u invoert in de browser.
Voorbeeld: als de HTTP-poort is ingesteld op
8080, voer dan http://<IP-adres>:8080 in

HTTP-poortnummer van het
apparaat wordt gefilterd of
geblokkeerd.

Wijzig het HTTP-poortnummer van het
apparaat naar een poortnummer dat niet
wordt gefilterd of geblokkeerd.

Een oude cache van de
webbrowser zorgt voor
problemen.

Verwijder de cache van de webbrowser.
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Symptoom Oorzaak Oplossing

Kan geen verbinding maken met
de webapp met de 2D-code (QR-
code).

Het gebruikte apparaat
ondersteunt mDNS niet.

Gebruik een apparaat dat mDNS ondersteunt.
Als u een apparaat gebruikt dat mDNS niet
ondersteunt, voert u het IP-adres rechtstreeks
in de webbrowser in.

De tablet of computer is
verbonden met een ander
netwerk dan de camera.

Verbind de tablet of computer met hetzelfde
netwerk als het apparaat.

Kan geen verbinding maken met
de webapp door handmatige
invoer van het webadres.

Het gebruikte apparaat
ondersteunt mDNS niet.

Gebruik een apparaat dat mDNS ondersteunt.

De tablet of computer is
verbonden met een ander
netwerk dan de camera.

Verbind de tablet of computer met hetzelfde
netwerk als het apparaat.

Het verificatievenster wordt
voortdurend weergegeven.

U hebt niet de juiste
gebruikersnaam en het juiste
wachtwoord ingevoerd.

Voer de geregistreerde gebruikersnaam en
het wachtwoord in. Als u de gegevens van de
geregistreerde gebruikers bent vergeten,
raadpleeg dan "De RESET-schakelaar" in
"Aansluitblok" om de gebruikersgegevens
voor de netwerkverbinding te initialiseren.

De gebruikersnaam en het
wachtwoord kunnen zijn
gewijzigd door een gebruiker
die is aangemeld vanuit een
andere webbrowser.

Vraag de juiste gebruikersnaam en het juiste
wachtwoord op bij de apparaatbeheerder.

Het camerabeeld verschijnt niet in
de webapp.

De HDMI-uitvoer van de camera
is ingesteld op 720×480 of
720×576.

Wijzig de resolutie van de HDMI-uitvoer van
het apparaat.

Er is een HDMI-monitor
aangesloten die het HDMI-
uitvoersignaal van de camera
niet ondersteunt.

Verwijder de HDMI-monitor of gebruik een
HDMI-monitor die de HDMI-uitvoerinstellingen
ondersteunt.

Het apparaat is opnieuw
opgestart en de sessie is
verbroken.

Wacht ongeveer een minuut en laad de
webbrowser opnieuw.

Een oude cache van de
webbrowser zorgt voor
problemen.

Verwijder de cache van de webbrowser.

De resolutie van het camerabeeld
in de webapp is laag.

De resolutie voor videostream 3
die door de webapp wordt
gebruikt is laag ingesteld.

Verhoog de waarde met [Stream] > [Video
Stream] > [Size 3] in het webmenu.

Het cameramenu verschijnt niet
wanneer u op de knop [Menu]
drukt.

Het cameramenu is zo
geconfigureerd dat het niet
wordt meegenomen in het
HDMI-uitvoersignaal.

Stel [Monitoring] > [Output Display] >
[HDMI/Stream] in op [On] in het webmenu.
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Filmen

Camera

Symptoom Oorzaak Oplossing

De waarde van een instelling in
het instellingenvenster wordt niet
correct bijgewerkt/weergegeven.

Het instellingenvenster van de
webapp geeft niet automatisch
de instellingen weer die in een
andere webapp zijn gewijzigd.

Druk op de knop [Reload] onderaan het
instellingenvenster van de webapp. De
waarden van de instellingen in het
weergegeven instelscherm worden opnieuw
geladen en bijgewerkt.

De instellingen van de tijdelijke
internetbestanden hebben een
invloed.

Verwijder de cache van de webbrowser.

Kan configuratiebestand of
logboek niet downloaden.

De functie voor het downloaden
van bestanden van de
webbrowser is uitgeschakeld.

Schakel de functie voor het downloaden van
bestanden van de webbrowser in.

Het instellingenvenster van de
webapp kan worden geopend,
maar u kunt geen handelingen
verrichten in het live-
bedieningsscherm en het afspeel-
bedieningsscherm.

Het actiescherm van de webapp
is vergrendeld.

Zet de actievergrendelingsschakelaar
rechtsboven in de webapp in de stand 
(Bediening ontgrendeld).

Het duurt even voordat het
webapp-scherm wordt
weergegeven.

Het streambeeld van het
apparaat wordt door meerdere
gebruikers tegelijkertijd
bekeken.

Verlaag het aantal gebruikers dat tegelijkertijd
de webapp kan gebruiken.

Het beeld is vervormd of schokt.

De videogegevens worden niet
correct overgebracht door
opstopping in het
communicatiepad.

Verlaag de streambitsnelheid, stel de codec
van [Video Stream 3] > [Size] in op de kleinste
optie of verlaag de snelheid om voor een
marge te zorgen in de communicatieband.

Er zijn meerdere webbrowsers
gestart op de tablet die
geheugen bezet houden.

Sluit alle webbrowsers die op de achtergrond
worden uitgevoerd.

Er staan te veel webbrowser-
tabbladen open, waardoor de
werking wordt vertraagd.

Sluit alle niet-gebruikte tabbladen.

De webbrowsercache en
webbrowsergeschiedenis zijn zó
vol dat de werking wordt
vertraagd.

Wis de cache van de webbrowser.

Symptoom Oorzaak Oplossing

Het beeld bij het begin en einde
van een zwenk-/kantelactie is
vervormd.

Het beeld kan vervormd zijn als de
beeldstabilisatiefunctie van het objectief is
ingeschakeld.

Schakel de
beeldstabilisatiefunctie van het
objectief uit.

Beeldhoek verandert zonder actie
van de gebruiker.

Er is lensadem opgetreden. Raadpleeg "Ademcompensatie".
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Zwenken/kantelen

Symptoom Oorzaak Oplossing

Kan niet scherpstellen, zoomen of
het diafragma aanpassen.

De schakelaars op het objectief zijn
misschien verkeerd ingesteld.

Raadpleeg "De
objectiefschakelaars
controleren".

Symptoom Oorzaak Oplossing

Kan het
zwenken/kantelen niet
terugstellen.

De zwenk-/kantelvergrendeling staat
in de stand LOCK.

Schuif de zwenk-/kantelvergrendeling naar de
stand UNLOCK.

Camera stopt niet op de
verwachte plek.

Het camerablok is uit balans.

Beweeg het camerablok vooruit-achteruit naar
een geschikte positie, zoals beschreven bij "Een
objectief bevestigen" en schakel het apparaat
opnieuw in.

Er is een objectief gemonteerd dat
zwenken en kantelen niet
ondersteunt.

Raadpleeg de compatibiliteitsgegevens van het
objectief en monteer een objectief dat
zwenken/kantelen ondersteunt. Schakel dan het
apparaat opnieuw in.

Kan zwenken/kantelen niet
terugstellen.

Voer het terugstellen van zwenken/kantelen uit
zoals beschreven bij "De zwenk-/kantelfunctie
terugstellen".

Er is een onverwachte kracht
uitgeoefend op de camerakop
waardoor een zwenk-/kantelfout is
opgetreden.

Camera keert niet terug
naar voren wanneer u op
de knop 
(Zwenken/kantelen
terug) drukt.

De plafondmontagemodus is
ingeschakeld.

Stel [Pan-Tilt] > [P/T Direction] > [Ceiling] in het
webmenu in conform de daadwerkelijke installatie
en schakel dan het apparaat opnieuw in. Bij
plafondmontage zit het camerablok op de
voorkant van de camera.

Zwenken/kantelen is
beperkt.

Er is een zwenk-/kantelbereiklimiet
geconfigureerd.

Wis zo nodig de bereiklimieten voor
zwenken/kantelen zoals beschreven bij "P/T
Range Limit".

Er is een onverwachte kracht
uitgeoefend op de camerakop
waardoor een zwenk-/kantelfout is
opgetreden.

Voer het terugstellen van zwenken/kantelen uit
zoals beschreven bij "De zwenk-/kantelfunctie
terugstellen".

Zwenken/kantelen ging
de verkeerde kant op.

De plafondmontagemodus wijkt af
van de werkelijke montagestand.

Stel [Pan-Tilt] > [P/T Direction] > [Ceiling] in het
webmenu in conform de daadwerkelijke installatie.

Instellingen met betrekking tot de
zwenk-/kantelrichting zijn gewijzigd.

Controleer de instelling [Pan-Tilt] > [P/T Direction]
in het webmenu.
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Symptoom Oorzaak Oplossing

Het beeld beweegt niet
soepel bij het begin en
einde van een
zwenk-/kantelactie.

De instelling voor versnelling-
vertraging voor zwenk-/kantelacties is
te hoog.

Verlaag de instelling voor versnelling-vertraging
voor zwenk-/kantelacties zodat de beweging bij
het begin en einde van zwenk-/kantelacties
soepeler verloopt met [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] in het webmenu of
cameramenu. Hierdoor zal het objectief er langer
over doen om de maximale snelheid te bereiken.

Zwenken/kantelen is
gestopt.

Het camerablok is uit balans.

Beweeg het camerablok vooruit-achteruit naar
een geschikte positie, zoals beschreven bij "Een
objectief bevestigen" en schakel het apparaat
opnieuw in.

De instelling Ramp Curve
(versnelling-vertraging) is te hoog
voor het gemonteerde objectief.

Als u een groot objectief hebt gemonteerd,
verlaag dan de waarde [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] in het webmenu of
cameramenu.

U gebruikt een groot objectief. Neem contact op met uw Sony-
servicevertegenwoordiger.

Het apparaat wordt
geblokkeerd bij
zwenken/kantelen.

De klemhendel voor de
bevestigingsschroef van de
objectiefsteunvoet raakt de camera.

Draai de klemhendel voor de bevestigingsschroef
van de objectiefsteunvoet zodat hij omhoog wijst.

De klemhendel voor de objectiefsteun
raakt de camera.

Draai de klemhendel voor de objectiefsteun zodat
hij omhoog wijst.

De vergrendelingsbeugel voor de
camerakop raakt de camera.

Controleer of de vergrendelingsbeugel voor de
camerakop helemaal in de stand LOCK staat.

Abnormale geluiden
tijdens het
zwenken/kantelen.

De camera is uit balans.
Beweeg het camerablok vooruit-achteruit naar
een geschikte stand zodat de schuifvoet
horizontaal staat.

De instelling Ramp Curve
(versnelling-vertraging) is te hoog
voor het gemonteerde objectief.

Als u een groot objectief hebt gemonteerd,
verlaag dan de waarde [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] in het webmenu of
cameramenu.

De camerakop is niet op zijn plek
vastgezet en u hoort een geluid van
beweging tijdens het gebruik.

Stel vergrendelingsbeugel voor de camerakop in
de stand LOCK.

Kan een
voorkeurspositie niet
opslaan.

Een voorkeuze kan niet worden
opgeslagen als u Clear Image Zoom-
gebruikt.

Stel de Clear Image Zoom-verhouding terug naar
1×. (Status waarbij de verhouding niet wordt
weergegeven rechts van  (Zoomverhouding))
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Opnemen/afspelen

Symptoom Oorzaak Oplossing

De kadrering is
verschoven wanneer u
een voorkeurspositie
afspeelt.

De temperatuur van de omgeving is
misschien sterk gewijzigd tussen het
opslaan van een voorkeurspositie en
het afspelen ervan.

Sla de voorkeurspositie opnieuw op.

Het objectief wordt niet gekalibreerd.
Voer de kalibratie uit met [Technical] > [Lens] >
[Lens Calibration] in het cameramenu.

Er is een ander objectief bevestigd
dan het objectief dat was bevestigd
toen de voorkeuze op werd geslagen.
Of de zoompositie voor handmatige
zoom is anders.

Sla de voorkeurspositie opnieuw op.

Het kadrerings-
bedieningspaneel in de
webapp is grijs en kan
niet worden gebruikt.

Zwenken/kantelen is niet beschikbaar
wanneer het pictogrammenscherm
wordt weergegeven en tijdens
afspelen.

Geef het afspeel-bedieningsscherm weer en
verlaat het pictogrammenscherm of stop het
afspelen.

Zwenken/kantelen is niet beschikbaar
wanneer het camerabeeld niet kan
worden weergegeven in de webapp.

Raadpleeg "De webapp" in "Problemen oplossen".

De zwenk-/kantelvergrendeling staat
in de stand LOCK.

Schuif de zwenk-/kantelvergrendeling naar de
stand UNLOCK.

"Execute Pan-Tilt Reset"
wordt weergegeven in
het kadrerings-
bedieningspaneel in de
webapp.

Er is een onverwachte kracht
uitgeoefend op de camerakop
waardoor een zwenk-/kantelfout is
opgetreden.

Voer het terugstellen van zwenken/kantelen uit
zoals beschreven bij "De zwenk-/kantelfunctie
terugstellen".

Symptoom Oorzaak Oplossing

Bij het indrukken van de
knop START/STOP
wordt opname niet
gestart.

De geheugenkaart is vol.
Vervang de geheugenkaart door een kaart met
voldoende vrije opslagruimte.

De geheugenkaart moet worden
hersteld.

Herstel de geheugenkaart zoals beschreven bij
"Geheugenkaarten herstellen".

Het opname-/tallylampje is
geconfigureerd als tallylampje, zodat de
opnamestatus niet kan worden
afgelezen van het lampje.

Configureer het opname-/tallylampje als
opnamelampje, zoals beschreven in "Een
tallysignaal aansluiten".

Audio-opname is niet
mogelijk.

Er is geen microfoon aangesloten.
Sluit een microfoon of geluidsapparaat aan op
de AUDIO IN-aansluiting van het aansluitblok.

De instelling [Master Input Level] is op
zijn laagst ingesteld.

Pas [Master Input Level] aan.
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Bestandsoverdracht

IP-streamen

Symptoom Oorzaak Oplossing

Opgenomen geluid klinkt
vervormd.

De audioniveau-instelling is te hoog.

Pas [CH1 Input Level] t/m [CH4 Input Level] en
[Master Input Level] aan.

Wanneer u de microfoon in een luidruchtige
omgeving gebruikt, zoals een live-concertzaal,
past u eerste [AUDIO IN CH1 MIC Ref.] en
[AUDIO IN CH2 MIC Ref.] aan.

Opgenomen geluid heeft
een hoog ruisniveau.

De audioniveau-instelling is te laag.

Pas de instellingen [Audio Input Level] en
[Audio] > [Audio] > [Audio Input] > [AUDIO IN
CH1 MIC Ref.] of [AUDIO IN CH2 MIC Ref.]
aan.

Clips kunnen niet
worden afgespeeld.

De clip wordt momenteel bewerkt.

Clips kunnen niet worden afgespeeld als u de
bestandsnamen of mappen heeft gewijzigd, of
als de clip in gebruik is op een computer. Dit is
geen defect.

De clip is opgenomen met een andere
camera dan dit apparaat.

Clips die zijn opgenomen met een andere
camera dan dit apparaat kunnen mogelijk niet
worden afgespeeld of weergegeven op de
correcte grootte. Dit is geen defect.

Symptoom Oorzaak Oplossing

Het uploaden van een
bestand mislukt.

De gebruikersnaam en het
wachtwoord op de server zijn niet
correct.

De gebruikersnaam en het wachtwoord op de server
zijn mogelijk niet correct. Voer de juiste waarden in.

Symptoom Oorzaak Oplossing

Streamen is niet beschikbaar.

De gebruikersnaam of het
wachtwoord is onjuist ingevoerd
in de client-toepassing voor het
bekijken van streams vanaf het
apparaat.

Als de streamindeling van het apparaat is
ingesteld op [RTSP], [SRT-Listener] of
[NDI|HX], dan moet u in de client-toepassing de
gebruikersnaam en het wachtwoord invoeren
die voor dit apparaat zijn ingesteld. Voer de
correcte gebruikersnaam en het juiste
wachtwoord in.

Het streamprotocol is niet
ingesteld.

Selecteer het doelprotocol met [Stream] >
[Stream Setting] in het webmenu.

Zes of meer RTSP-sessies zijn
ingesteld.

Stel het aantal sessies in op vijf of minder.

Het UDP-poortnummer is
verkeerd ingesteld.

Stel het poortnummer en andere instellingen
voor het doelprotocol in met [Stream] >
[Stream] > [Stream Setting] in het webmenu.

UDP-communicatie wordt
geblokkeerd.

Controleer de instellingen van uw
beveiligingssoftware.
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Verbinding met externe apparaten

Externe synchronisatie

Symptoom Oorzaak Oplossing

Er wordt geen geluid
gestreamd.

De audio-uitvoerstream is
ingesteld op [Off].

Stel [Stream] > [Audio Stream] > [Setting] in op
[On] in het webmenu.

De stream-verbinding werd
verbroken.

De protocolinstellingen of
streamcodec-instellingen zijn
gewijzigd tijdens het streamen.

Stel de protocolinstelling en streamcodec-
instellingen in voordat u gaat streamen.

De beeldgrootte van [Video
Stream 1] kan niet worden in
gesteld op 4096×2160 of
3840×2160.

De beeldgrootte is 1920×1080
wanneer [Output Format] is
ingesteld op HDMI.

De beeldgrootte voor streamen kan niet hoger
worden ingesteld dan de HDMI-beeldgrootte.
Wijzig de HDMI-beeldgrootte met [Monitoring] >
[Output Format] in het webmenu.

De beeldsnelheid van [Video
Stream 1] kan niet worden
ingesteld op 60 FPS of 50 FPS.

De beeldsnelheid voor streamen
is ingesteld op 29.97 of lager.

De beeldsnelheid voor streamen wordt
begrensd door de systeemfrequentie. Wijzig de
systeemfrequentie met [Rec Format] >
[Frequency] in het webmenu.

Geen toegang tot [Video Stream
3].

[Video Stream 3] ondersteunt
geen RTSP/SRT/NDI.

Gebruik [Video Stream 1] of [Video Stream 2].

Het RTSP-/SRT-scherm wordt
niet correct
bijgewerkt/weergegeven.

Het poortnummer dat wordt
gebruikt voor RTSP of SRT
wordt gefilterd of geblokkeerd.

Wijzig het RTSP- of SRT-poortnummer naar
een poort die niet wordt gefilterd of geblokkeerd
door apparaten die de stream ontvangen. Of
wijzig het poortnummer dat voor RTSP of SRT
wordt gebruikt op het apparaat.

Het beeld is vervormd of schokt.

De videogegevens worden niet
correct overgebracht door
opstopping in het
communicatiepad.

Verlaag de streambitsnelheid of stel de codec
van [Video Stream 2] ([Codec 2]) in op [Off] om
voor een marge te zorgen in de
communicatieband.

De volgorde van de
videopakketten is gewijzigd
binnen het communicatiekanaal.

Gebruik dezelfde internetaanbieder aan
apparaatzijde en ontvangerzijde.

Niet gedetecteerd als NDI-
apparaat.

Het streamprotocol is niet
ingesteld op NDI|HX.

Het streamprotocol moet ingesteld zijn op
NDI|HX als u het apparaat wilt detecteren als
NDI-apparaat. Stel [Stream] > [Stream Setting]
in op [NDI|HX] in het webmenu.

Kan niet worden gebruikt als
NDI-apparaat.

Er is geen NDI|HX-licentie
geïnstalleerd.

Installeer een NDI|HX-licentie. U kunt
controleren of er een NDI|HX-licentie is
geïnstalleerd met [Stream] > [Stream] >
[Stream Setting] > [NDI|HX] > [License] in het
webmenu.
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Tally

Objectiefcontroller

Symptoom Oorzaak Oplossing

Kan niet
synchroniseren met
externe bron.

Er wordt geen extern
synchronisatiesignaal ingevoerd dat
geschikt is voor de geconfigureerde
videosignaalindeling.

Voer een synchronisatiesignaal in dat geschikt is
voor de geconfigureerde videosignaalindeling.

Het apparaat is dubbel-afgesloten.

Het apparaat heeft een ingebouwde 75 Ω-
afsluiting. Verbind rechtstreeks met een
signaalbron (één op één) of gebruik een
distributeur (splitter).

Symptoom Oorzaak Oplossing

Het tallylampje
gaat niet branden.

De helderheid van het tallylampje is
ingesteld op Off.

Stel de gewenste helderheid in met [Technical] >
[Tally] > [Tally Lamp Brightness] in het webmenu.

Het opname-/tallylampje is
geconfigureerd als opnamelampje.

Configureer het opname-/tallylampje als tallylampje
zoals beschreven in "Een tallysignaal aansluiten".

RM-IP500 is aangesloten en VISCA over
IP is uitgeschakeld.

Zet SETUP-schakelaar 3 op het aansluitblok van
het apparaat in de stand ON.

De OPTION-aansluiting is onjuist of de
doelpin is niet kortgesloten naar de
aarde.

Sluit pin 7 of pin 8 van de OPTION-aansluiting kort
naar GND zoals beschreven in "Een tallysignaal
aansluiten".

Symptoom Oorzaak Oplossing

[Communication Error]
wordt weergegeven in

 (Camerastatus).

De camera kan niet
communiceren met de
objectiefcontroller.

Controleer de verbinding tussen het apparaat en de
objectiefcontroller en zet vervolgens het apparaat en de
objectiefcontroller uit en weer aan.

[Rotation Error] wordt
weergegeven in 
(Camerastatus).

Een draaifout is
opgetreden in de
objectiefcontroller.

Het opgeslagen zoombewegingsbereik en het
objectiefbewegingsbereik komen misschien niet overeen.
Initialiseer de objectiefcontroller.
Als het probleem blijft bestaan, neem dan contact op met de
vertegenwoordiger van de fabrikant van de objectiefcontroller.

[System Error] wordt
weergegeven in 
(Camerastatus).

Een systeemfout is
opgetreden in de
objectiefcontroller.

Controleer de verbinding tussen het apparaat en de
objectiefcontroller. Raadpleeg de gebruiksaanwijzing van de
objectiefcontroller en initialiseer de objectiefcontroller, of zet
het apparaat en de objectiefcontroller uit en weer aan.
Als het probleem blijft bestaan, neem dan contact op met de
vertegenwoordiger van de fabrikant van de objectiefcontroller.

[Unknown Error] wordt
weergegeven in 
(Camerastatus).

Een onbekende fout is
opgetreden in de
objectiefcontroller.

Controleer de verbinding tussen het apparaat en de
objectiefcontroller. Raadpleeg de gebruiksaanwijzing van de
objectiefcontroller en initialiseer de objectiefcontroller, of zet
het apparaat en de objectiefcontroller uit en weer aan.
Als het probleem blijft bestaan, neem dan contact op met de
vertegenwoordiger van de fabrikant van de objectiefcontroller.
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Verwant onderwerp
Een glasvezelsignaal uitvoeren

Aansluitblok

Ademcompensatie

De objectiefschakelaars controleren

Een objectief bevestigen

De zwenk-/kantelfunctie terugstellen

P/T Range Limit

Geheugenkaarten herstellen

Een tallysignaal aansluiten
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Fout-/waarschuwingsmeldingen

Als een waarschuwing of bedieningssituatie optreedt die moet worden bevestigd op het apparaat, wordt een melding
weergegeven in het camerabeeldpaneel. De lampjes POWER en NETWORK op het voorpaneel en het
opname-/tallylampje gaan knipperen.

Opmerking

De opname-/tallylampjes gaan alleen knipperen als zowel [Technical] > [Tally] > [Tally Control] is ingesteld op [Internal] en [Tally
Lamp Brightness] niet is ingesteld op [Off] in het webmenu of cameramenu.

Foutmeldingen

Als de lampjes POWER en NETWORK knipperen zoals hieronder beschreven, neemt u de volgende maatregelen.

Het apparaat stopt met werken als het volgende venster worden weergegeven.

Waarschuwingsmeldingen

Volg de instructies als het volgende scherm wordt weergegeven.

POWER-
lampje

NETWORK-
lampje Oorzaak en oplossing

Langzaam
oranje
knipperend

Langzaam
groen
knipperend

Het apparaat kan niet normaal werken. Voor nadere informatie raadpleegt u
[Maintenance] > [System Log] in het webmenu. Als het probleem blijft bestaan,
zelfs nadat u het apparaat in stand-bymodus heeft geplaatst of het apparaat uit- en
weer ingeschakeld hebt, neemt u contact op met uw Sony
servicevertegenwoordiger.

Snel oranje
knipperend

Snel groen
knipperend

Er is een fout opgetreden in het apparaat. Neem contact op uw Sony
servicevertegenwoordiger.

Meldingweergave Opname-/tallylampje Oorzaak en oplossing

E + foutcode Snel knipperend

Geeft een abnormale situatie in het apparaat aan. De opname stopt,
zelfs als ●REC wordt weergegeven in het camerabeeldpaneel.
Schakel het apparaat uit en controleer op problemen met aangesloten
apparaten, kabels of media. Als de fout aanhoudt als het apparaat weer
opnieuw wordt ingeschakeld, neem dan contact op met uw Sony
servicevertegenwoordiger. Afhankelijk van de status van het apparaat
wordt er mogelijk geen weergave van de fout of waarschuwingsgeluid
weergegeven.

Meldingweergave Opname-/tallylampje Oorzaak en oplossing

Temperature High Knipperend
De interne temperatuur is hoog.
Schakel de camcorder uit en laat deze afkoelen voordat u hem
opnieuw gebruikt.
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Waarschuwings- en systeemmeldingen

Meldingweergave Opname-/tallylampje Oorzaak en oplossing

Media Temperature
High

Knipperend
De temperatuur van de CFexpress geheugenkaart is hoog.
Vervang de kaart of laat deze afkoelen, alvorens opnieuw te
gebruiken.

Voltage Low Knipperend
Het ingangsvoltage (DC IN) is laag (level 1). Controleer de
stroombron.

Insufficient Voltage Snel knipperend
Het ingangsvoltage (DC IN) is laag (level 2). Opname is
uitgeschakeld.
Sluit een andere stroombron aan.

Media Near Full Knipperend
De resterende capaciteit van de geheugenkaart wordt lager.
Zo snel mogelijk vervangen.

Media Full Snel knipperend
Clips konden niet worden opgenomen of gekopieerd omdat de
resterende capaciteit op de geheugenkaart onvoldoende is.
Onmiddellijk vervangen.

Clips Near Full Knipperend
Het aantal aanvullende clips dat kan worden opgenomen op de
geheugenkaart wordt minder.
Zo snel mogelijk vervangen.

Clips Full Snel knipperend

Het maximale aantal clips dat kan worden opgenomen op de
geheugenkaart is bereikt.
Opnemen of kopiëren van meer clips is niet mogelijk. Onmiddellijk
vervangen.

Last Clip Recording Knipperend
De clip die momenteel wordt opgenomen is de laatste clip die kan
worden opgenomen, omdat het maximale aantal clips is bereikt.
Prepareer een nieuwe geheugenkaart.

Media(A) Life Near
End1) Knipperend

De levensduur van de geheugenkaart is bijna verstreken. Zo snel
mogelijk vervangen.

Media(A) Life End1) Snel knipperend
De levensduur van de geheugenkaart is verstreken. Onmiddellijk
vervangen.

Media(A) Near Full1) Knipperend Bij gebruik van de functie Simul Rec

Media(A) Full1) Snel knipperend Bij gebruik van de functie Simul Rec

Media(A) Clips Near
Full1) Knipperend Bij gebruik van de functie Simul Rec

Media(A) Clips Full1) Snel knipperend Bij gebruik van de functie Simul Rec

Media(A) Last Clip
Rec1) Knipperend Bij gebruik van de functie Simul Rec

(Geen weergave) Knipperend

Een onbekende fout is opgetreden in de objectiefcontroller.
Controleer de status in de camerastatus in de webapp.
Voor nadere informatie raadpleegt u het systeemlogboek in de
webapp.

"(B)" wordt weergegeven voor de kaart in kaartsleuf B.1)
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De volgende waarschuwings- en systeemmeldingen kunnen op het scherm verschijnen. Volg de vermelde aanwijzingen
om het probleem op te lossen.

Melding op het scherm Oorzaak en oplossing

Backup Battery End
Please Change

De resterende capaciteit van de back-upaccu is onvoldoende.
Sluit het apparaat ten minste 24 uur lang aan op een voeding om de back-
upbatterij op te laden.

Unknown Media(A)1)

Please Change

Er is een geheugenkaart geplaatst die is gepartitioneerd of een
geheugenkaart die meer clips bevat dan door het apparaat wordt
ondersteund.
De kaart kan niet worden gebruikt in het apparaat en moet worden
vervangen.

Cannot Use Media(A)1)

Unsupported File System

Er is een niet-geformatteerde kaart geplaatst of een kaart die een ander
bestandsysteem ondersteunt.
De kaart kan niet worden gebruikt door het apparaat en moet worden
vervangen of worden geformatteerd met het apparaat.

Media Error
Media(A) Needs to be Restored1)

Er heeft zich een fout voorgedaan op de geheugenkaart en de kaart moet
worden hersteld.
Herstel de geheugenkaart.

Media Error
Cannot Record to Media(A)1)

De geheugenkaart is mogelijk beschadigd en kan niet langer worden
gebruikt voor opname.
Afspelen is mogelijk, dus maak een kopie. Vervangen van de
geheugenkaart wordt geadviseerd.

Media Error
Cannot Use Media(A)1)

De geheugenkaart is mogelijk beschadigd en kan niet langer worden
gebruikt voor opname of afspelen.
De kaart kan niet worden gebruikt in het apparaat en moet worden
vervangen.

Media(A) Error1)

Recording Halted
Playback Halted

Opnemen en afspelen is gestopt omdat zich een fout heeft voorgedaan bij
gebruik van de geheugenkaart.
Als het probleem aanhoudt, vervang dan de geheugenkaart.

Media Reached Rewriting Limit
Change Media(A)1)

De levensduur van de geheugenkaart is verstreken.
Maak een backup en vervang de geheugenkaart onmiddellijk. Als u de
kaart blijft gebruiken kan er mogelijk niet meer worden opgenomen of
afgespeeld.
Raadpleeg voor details de gebruiksaanwijzing van de geheugenkaart.

The specified address is invalid.
Het opgegeven adres is ongeldig.
Controleer of de instelling correct is.

Cannot Use Specified Port Number
Het aangegeven poortnummer is ongeldig.
Controleer of de instelling correct is.

Lens I/F Error(xx:xx)

Er is een objectieffout gedetecteerd bij de I/F-communicatie van het
objectief bij bevestiging van een objectief met E-bevestiging.
Controleer de status van de verbinding met het objectief met E-
bevestiging.
Als het probleem aanhoudt, neem dan contact op met uw Sony
servicevertegenwoordiger en vermeld de foutcode (vijf tekens tussen
haakjes).
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RTMP-streamfoutgegevens

De volgende foutgegevens worden mogelijk weergegeven op het apparaat. Voer de volgende handelingen uit, indien
nodig.

SRT-streamfoutgegevens

De volgende foutgegevens worden mogelijk weergegeven op het apparaat. Voer de volgende handelingen uit, indien
nodig.

Melding op het scherm Oorzaak en oplossing

Cannot add auto upload job of Proxy file
because maximum number of upload
jobs was reached.

Het maximale aantal overdrachten is bereikt.
Wis niet gewenste overdrachten. De instelling voor automatische
uploadbestemming voor proxybestanden is mogelijk ook incorrect.
Controleer of de instelling correct is.

Fan Stopped

De ventilator is gestopt met draaien.
Controleer of er geen stof of vreemde voorwerpen zijn.
Als de fout aanhoudt nadat u het stof of het vreemde voorwerp hebt
verwijderd, neem dan contact op met uw Sony servicevertegenwoordiger.

"(B)" wordt weergegeven voor de kaart in kaartsleuf B.1)

Foutcode
Beschrijving Oplossing

RTMP RTMPS

1002
1004

2002
2004

Kan geen verbinding maken met
RTMP-server.

Controleer of de serveradresinstelling correct is.
Controleer de netwerkverbinding.

1003 2003 Kan de domeinnaam niet omzetten.
Controleer of de serveradresinstelling correct is.
Controleer de DNS-serververbinding.

–
2005
2008

CRL-fout
Controleer of de serveradresinstelling correct is.
Controleer of het verbindingsdoel een vertrouwde website
is.

2006 CA-certificaatfout
Controleer of de klokinstelling correct is.
Controleer of het CA-certificaat correct is.

– 2007
Er is geen CA-certificaat
geïnstalleerd.
Servercertificaat-verificatiefout.

Installeer een CA-certificaat.
Controleer of het verbindingsdoel een vertrouwde website
is.

4002 De RTMP-sessie is afgebroken.

Het apparaat is misschien aan RTMP-serverzijde
afgebroken.
Controleer of de instellingen overeenkomen met de
aanbevolen codec-parameters van de dienst.

4003
De netwerkverbindingskwaliteit is
laag.

Controleer de netwerkverbinding.

Overig Overige fouten.
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Foutcode

Beschrijving OplossingSRT-
Caller

1001 Onverwachte fout
Het apparaat functioneert mogelijk niet normaal. Zet het
apparaat uit en weer aan.

1002
Communicatie verbroken omdat
instellingen zijn gewijzigd

De communicatie is verbroken, omdat er instellingen zijn
gewijzigd.
Herstel de verbinding.

5001 Onverwachte fout Het apparaat functioneert mogelijk niet normaal. Zet het
apparaat uit en weer aan.

5005 Verbindingsfout Controleer of de verbindingsdoelinstelling correct is.

5006 Versleutelingsfout Controleer of de versleutelingsinstelling correct is.

5007 Onverwachte fout Het apparaat functioneert mogelijk niet normaal. Zet het
apparaat uit en weer aan.5008 Onverwachte fout

5009 Overdrachtsfout
De communicatie met het apparaat is afgebroken.
Controleer de netwerkverbinding.
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Lijst met menu-onderdelen

In de volgende tabellen vindt u de menu-onderdelen van het apparaat.

Legenda
"Cameramenu" en "webmenu"
●: beschikbaar
▲: sommige onderdelen beschikbaar
–: niet beschikbaar

"All File" en "Scene File"
Ja: onderdeel wordt opgeslagen in een ALL-bestand of scenebestand
Nee: onderdeel wordt niet opgeslagen

"All Reset (except for Network Settings)"
Wanneer [Reset]> [Reset] > [All Reset (except for Network Settings)] in het webmenu wordt uitgevoerd:
Ja: onderdeel wordt geïnitialiseerd (uitgezonderd netwerkinstellingen)
Nee: niet toepasbaar

"Network Reset"
Wanneer [Reset]> [Reset] > [Network Reset] in het webmenu wordt uitgevoerd:
Ja: onderdeel wordt geïnitialiseerd (netwerkinstelling)
Nee: niet toepasbaar

"Factory Default"
Ja: onderdeel wordt teruggesteld naar de standaardwaarde
Nee: niet toepasbaar

Shooting

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

ISO/Gain/EI ● – Ja Ja Ja Ja Ja

ND Filter ● – Ja Ja*1 Ja Nee Ja

Shutter ● – Ja Ja Ja Nee Ja

Iris ● – Ja Ja Ja Nee Ja

Auto Exposure ● – Ja Ja*2 Ja Nee Ja

White ● – Ja Ja*3 Ja Nee Ja

White Setting ● – Ja Nee Ja Nee Ja

Offset White ● – Ja Nee Ja Nee Ja

Focus ● ▲ Ja Nee Ja Nee Ja

S&Q Motion ● – Ja Nee Ja Nee Ja
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Project

Paint/Look

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

LUT On/Off ● – Ja Nee Ja Nee Ja

Noise
Suppression

● – Ja Ja Ja Nee Ja

Flicker Reduce ● – Ja Nee Ja Nee Ja

SteadyShot ● – Ja Nee Ja Nee Ja

[Mode] niet toepasbaar*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] niet toepasbaar*2

[Preset White] niet toepasbaar*3

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Base Setting ● ● Ja Nee Ja Nee Ja

Rec Format ● ● Ja Nee Ja*1 Nee Ja

Cine
EI/Flex.ISO Set

● – Ja Nee Ja Nee Ja

Simul Rec ● ● Ja Nee Ja Nee Ja

Proxy Rec ● ▲ Ja Nee Ja Nee Ja

Interval Rec ● ● Ja*2 Nee Ja Nee Ja

Picture Cache
Rec

● ● Ja*2 Nee Ja Nee Ja

SDI/HDMI Rec
Control

● – Ja Nee Ja Nee Ja

Assignable
Button

● – Ja Nee Ja Nee Ja

All File – ● Nee Nee Nee Nee Nee

[Frequency] niet toepasbaar*1

[Setting] niet toepasbaar*2

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Scene File ● – Nee Nee Nee Nee Nee

Base Look ● ▲ Ja*1 Nee Ja*1 Nee Ja*1

Reset Paint
Settings

● – Nee Nee Nee Nee Nee
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Pan-Tilt

TC/Media

Monitoring

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Black ● – Ja Ja Ja Nee Ja

Knee ● – Ja Ja Ja Nee Ja

Detail ● – Ja Nee Ja Nee Ja

Matrix ● – Ja Ja Ja Nee Ja

Multi Matrix ● – Ja*2 Ja*2 Ja Nee Ja

LUT-gegevens geïmporteerd als basisuiterlijk niet toepasbaar*1

[Axis] niet toepasbaar*2

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

P/T Speed – ● Nee Nee Ja Nee Nee

P/T
Acceleration

● ● Nee Nee Ja Nee Nee

P/T Range
Limit

– ● Nee Nee Ja Nee Nee

P/T Direction – ● Nee Nee Ja Nee Nee

P/T Preset – ● Nee Nee Ja Nee Nee

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Timecode ● – Ja*1 Nee Ja Nee Ja

TC Display ● – Ja Nee Ja Nee Ja

Users Bit ● – Ja*1 Nee Ja Nee Ja

HDMI TC Out ● – Ja Nee Ja Nee Ja

Clip Name
Format

● – *2 Nee Ja Nee Ja

Update Media ● – Nee Nee Nee Nee Nee

Format Media ● – Nee Nee Nee Nee Nee

Media Life ● – Nee Nee Nee Nee Nee

[Setting] niet toepasbaar*1

[Auto Naming] toepasbaar, [Camera ID] niet toepasbaar*2
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Audio

Thumbnail

Technical

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output Format ● ● Ja Nee Ja Nee Ja

Output Display – ● Ja Nee Ja Nee Ja

Display On/Off ● – Ja Nee Ja Nee Ja

Video Signal
Monitor

● – Ja Nee Ja Nee Ja

Marker ● – Ja Nee Ja Nee Ja

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Audio Input ● ▲ Ja Nee Ja Nee Ja

Audio
Output

● ▲ Ja Nee Ja Nee Ja

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Display Clip
Properties

● – Nee Nee Nee Nee Nee

Set Clip Flag ● – Nee Nee Nee Nee Nee

Lock/Unlock
Clip

● – Nee Nee Nee Nee Nee

Delete Clip ● – Nee Nee Nee Nee Nee

Transfer Clip ● – Nee Nee Nee Nee Nee

Transfer Clip
(Proxy)

● – Nee Nee Nee Nee Nee

Filter Clips ● – Nee Nee Nee Nee Nee

Customize View ● – Ja Nee Ja Nee Ja

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Color Bars ● – *1 Nee *1 Nee Ja

Genlock ● – Nee Nee Nee Nee Nee

Tally ● ● Ja Nee Ja Nee Ja
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Network

Stream

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Rec
Review

● – Ja Nee Ja Nee Ja

Zoom ● – Ja Nee Ja Nee Ja

IR Remote – ● Nee Nee Ja Nee Ja

Lens ● – Ja Nee Ja Nee Ja

APR ● – Nee Nee Nee Nee Nee

[Type] toepasbaar, [Setting] niet toepasbaar*1

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Camera Name – ● Nee Nee Nee Nee Ja

User – ● Nee Nee Nee Ja Ja

Wired LAN*1 ▲ ● Nee Nee Nee Ja Nee

File Transfer ● ▲ Ja Nee Ja Ja Ja

FTP Server 1 – ● Nee Nee Ja Nee Ja

FTP Server 2 – ● Nee Nee Ja Nee Ja

FTP Server 3 – ● Nee Nee Ja Nee Ja

SSL – ● Nee Nee Nee Ja Ja

Referer Check – ● Nee Nee Nee Ja Ja

Brute Force
Attack Protection

– ● Nee Nee Nee Ja Ja

Niet configureerbaar met het cameramenu (alleen weergegeven)*1

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Stream
Setting

– ● Nee Nee Ja*1 Nee Ja*1

Video
Stream

– ● Ja Nee Ja Nee Ja

Audio
Stream

– ● Ja Nee Ja Nee Ja
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 [NDI|HX] > [License] niet van toepassing*1

Onderdeel
(niveau 2) Cameramenu Webmenu All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Language ● ● Ja Nee Ja Nee Ja

Accessibility – ● Ja Nee Nee Nee Ja

Clock Set ● ● Ja*1 Nee Ja*2 Nee Ja

Reset – ● Nee Nee Nee Nee Nee

Hours Meter ● – Nee Nee Nee Nee Nee

Information – ● Nee Nee Nee Nee Nee

System Log – ● Nee Nee Nee Nee Ja

HTTP Access
Log

– ● Nee Nee Nee Nee Ja

Service – ● Nee Nee Nee Nee Nee

EULA – ● Nee Nee Nee Nee Nee

Software – ● Nee Nee Nee Nee Nee

Datum-/tijdgegevens niet toepasbaar*1

[Time Zone], datum-/tijdgegevens niet toepasbaar*2
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Opgeslagen onderdelen in voorkeuzes

"Ja" geeft aan dat de instelling wordt opgeslagen in de voorkeuze, "Nee" geeft een instelling aan die niet wordt
opgeslagen.

Zwenk-/kantelonderdelen

Zoomonderdelen

Scherpstelonderdelen

Weergavelocatie Onderdeel Doel wordt
opgeslagen

Kadrerings-bedieningspaneel in het live-
bedieningsscherm

Zwenk-/kantelpositie Ja

[Pan-Tilt Speed] Nee

[Pan-Tilt] in het webmenu

[P/T Speed] Nee

[P/T Acceleration] Nee

[P/T Range Limit] Nee

[P/T Direction] Nee

[P/T Preset] > [Pan-Tilt] Nee

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Ja1)

 De waarden van de instellingen bij het opslaan van een voorkeurspositie worden opgeslagen als de waarden van die voorkeurspositie. Nadat de
waarden zijn opgeslagen, kunt u de waarden per voorkeurspositie aanpassen. Voor nadere informatie raadpleegt u "De overgangssnelheid
wijzigen (zwenken-kantelen/zoomen/scherpstellen) van een voorkeurspositie".

1)

Weergavelocatie Onderdeel Doel wordt
opgeslagen

Kadrerings-bedieningspaneel in het live-
bedieningsscherm

Zoompositie
(scherpstelafstand)

Ja

[Zoom Speed] Nee

[Pan-Tilt] > [P/T Preset] > [Default] in het webmenu
[Zoom Sync] Ja1)

[Zoom Speed] Ja1)

[Technical] > [Zoom] in het cameramenu [Zoom Type] Nee

 De waarden van de instellingen bij het opslaan van een voorkeurspositie worden opgeslagen als de waarden van die voorkeurspositie. Nadat de
waarden zijn opgeslagen, kunt u de waarden per voorkeurspositie aanpassen. Voor nadere informatie raadpleegt u "De overgangssnelheid
wijzigen (zwenken-kantelen/zoomen/scherpstellen) van een voorkeurspositie".

1)
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Verwant onderwerp
De overgangssnelheid wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie

5-041-957-73(1) Copyright 2022 Sony Corporation

Weergavelocatie Onderdeel Doel wordt
opgeslagen

Camerabeeldpaneel van het live-
bedieningsscherm

Volgdoel dat is opgegeven voor AF-volgen in echttijd Nee

Opgegeven coördinaten voor spotscherpstelling Nee

Tabblad  (Focus) van live-
bedieningsscherm

Schakelaar [Touch Focus] Nee

Schakelaar [Auto Focus] Ja

Knopinstelling [Focus Hold] Nee

Knopinstelling [Push AF/MF] Nee

[Face/Eye Detection AF] Ja

[AF Subj. Shift Sens.] Ja

[AF Transition Speed] Ja

Scherpstelpositie Ja1)

[Shooting] > [Focus] in het webmenu

[Push AF Mode] (inclusief instellingen met toewijsbare
knoppen)

Nee

[Touch Function in MF] Nee

[AF Assist Control] Nee

[Pan-Tilt] > [P/T Preset] > [Default] in
het webmenu

[Focus Recall] Ja2)

[MF Speed] Ja2)

[Shooting] > [Focus] in het
cameramenu

Scherpstelgebiedgrootte en scherpstelgebiedpositie
ingesteld met [Focus Area]

Ja

Scherpstelgebiedpositie ingesteld met [Focus Area (AF-
S)]

Ja

 Wordt niet hersteld wanneer de schakelaar [Auto Focus] is ingesteld op On stand. Wordt hersteld indien ingesteld op Off.1)

 De waarden van de instellingen bij het opslaan van een voorkeurspositie worden opgeslagen als de waarden van die voorkeurspositie. Nadat de
waarden zijn opgeslagen, kunt u de waarden per voorkeurspositie aanpassen. Voor nadere informatie raadpleegt u "De overgangssnelheid
wijzigen (zwenken/kantelen/zoom/scherpstelling) bij het herstellen van een voorkeurspositie".

2)
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Blokschema's

Audio Input

Audio Output

5-041-957-73(1) Copyright 2022 Sony Corporation
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De software van een objectief met E-bevestiging bijwerken

U kunt de software van een objectief met E-bevestiging met het apparaat bijwerken.
Raadpleeg de website voor het objectief om te zien welke objectieven kunnen worden bijgewerkt en voor de
bijbehorende software.
De software wordt bijgewerkt met het webmenu.

Opmerking

Voer geen van de volgende handelingen uit voordat het bijwerken is voltooid.

Het netwerk loskoppelen
Een objectief verwijderen
Het apparaat uitschakelen

Als er een melding verschijnt dat het bijwerken is mislukt, controleer dan de weergegeven beschrijving en probeer opnieuw bij te
werken.

5-041-957-73(1) Copyright 2022 Sony Corporation

Bevestig een objectief met E-bevestiging op het apparaat.1

Controleer [Maintenance] > [Information] > [Lens] > [Model Name] en [Version Number] in het webmenu.

Aan de zijkant wordt de softwareversie van het objectief met E-bevestiging weergegeven.
Controleer het versienummer van de software en werk zo nodig de software bij.

2

Download het bijwerkbestand voor de objectiefsoftware voor Windows (uitgang .exe) op het apparaat
waarop u de webapp gebruikt.

3

In [Maintenance] > [Information] > [Lens] > [Version Up] drukt u op de knop [Choose File] en selecteert u
het gedownloade bijwerkbestand.

4

Volg de instructies op het scherm.5
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De afdekking voor de objectiefvrijgaveknop bevestigen

U kunt per ongeluk verwijderen van het objectief voorkomen door de afdekking voor de objectiefvrijgaveknop te
bevestigen die wordt meegeleverd met de CIB-PCM1-plafondbeugel (optioneel).

Opmerking

Hiermee wordt niet voorkomen dat het objectief in zijn geheel wordt verwijderd.

Verwant onderwerp

Een objectief bevestigen

5-041-957-73(1) Copyright 2022 Sony Corporation

Bevestig een objectief.

Voor nadere informatie over het bevestigen van een objectief raadpleegt u "Een objectief bevestigen".

1

Schuif de zwenk-/kantelvergrendeling in de stand LOCK om zwenken/kantelen van de camerakop te
vergrendelen.

2

Verplaats het camerablok naar een positie zodat de objectiefuitwerpafdekking kan worden bevestigd.3

Bevestig de objectiefuitwerpafdekking zó, dat hij de objectiefvrijgaveknop afdekt.4

Zet de objectiefuitwerpafdekking vast met de bevestigingsschroef voor de objectiefuitwerpkap.5
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Licenties

MPEG-4 AVC Patent Portfolio-licentie

DIT PRODUCT IS GELICENSEERD ONDER DE AVC PATENT PORTFOLIO-LICENTIE VOOR PERSOONLIJK
GEBRUIK VOOR EEN CONSUMENT OF ANDER GEBRUIK WAARBIJ GEEN VERGOEDING VOOR
(i) VIDEO ENCODEREN OVEREENKOMSTIG DE AVC-STANDAARD ("AVC-VIDEO") EN/OF
(ii) DECODEREN VAN AVC-VIDEO DIE IS GECODEERD DOOR EEN CONSUMENT DIE BEZIG IS MET
PERSOONLIJKE ACTIVITEITEN EN/OF IS ONTVANGEN VAN EEN VIDEOLEVERANCIER DIE IS GELICENSEERD
VOOR HET LEVEREN VAN AVC-VIDEO.
VOOR ANDER GEBRUIK IS GEEN LICENTIE INGESLOTEN EN WORDT DEZE NIET VERLEEND. AANVULLENDE
INFORMATIE IS VERKRIJGBAAR BIJ MPEG LA, L.L.C. ZIE HTTP://WWW.MPEGLA.COM

Software verkrijgen onder de GPL/LGPL-licentie

Dit product gebruikt software waarop de GPL/LGPL-licentie van toepassing is. Hierin wordt vermeld dat u het recht heeft
tot toegang, modificeren en herdistribueren van de broncode voor deze softwareprogramma's onder de voorwaarden van
de GPL/LGPL.
De broncode is beschikbaar op internet. Gebruik de volgende URL en volg de downloadinstructies.
https://oss.sony.net/Products/Linux/
Wij vragen u vriendelijk geen contact met ons op te nemen betreffende de inhoud van de broncode.

μT-Kernel-broncode

Dit product gebruikt de broncode van μT-Kernel onder T-licentie 2.1, verleend door TRON Forum (www.tron.org).

5-041-957-73(1) Copyright 2022 Sony Corporation
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Specificaties

Algemeen

Massa
Ong. 4,6 kg (alleen behuizing)
Ong. 6,0 kg (inclusief SELP28135G-objectief)

Afmetingen
Zie "Externe afmetingen".

Netvoedingsvereisten
19,5 V gelijkstroom
PoE++ (voldoet aan IEEE802.3bt, type 4, klasse 8)

Stroomverbruik
19,5 V gelijkstroom: 80,0 W (max.)
PoE++: 71,3 W (max.)　

Bedrijfstemperatuur
0 °C tot 40 °C

Opslagtemperatuur
−20 °C tot +60 °C

Opname-indeling (video)
XAVC Intra
XAVC-I 4K/QFHD-modus: VBR, bitsnelheid 600 Mbps (max.), MPEG-4 AVC/H.264
XAVC-I HD-modus: CBG, 223 Mbps (max.), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD-modus: VBR, bitsnelheid 150 Mbps (max.), MPEG-4 H.264/AVC
XAVC-L HD 50-modus: VBR, 50 Mbps (max.), MPEG-4 H.264/AVC
XAVC-L HD 35-modus: VBR, 35 Mbps (max.), MPEG-4 H.264/AVC

Opname-indeling (audio)
LPCM 24-bit, 48 kHz, 4-kanaals

Beeldsnelheid opname

XAVC Intra
XAVC-I 4K-modus: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD-modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD-modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Opname/afspelen tijd
XAVC Intra
XAVC-I QFHD-modus: 59.94P, ong. 30 minuten (met CEA-G160T)
XAVC-I HD-modus: 59.94P, ong. 78 minuten (met CEA-G160T)

XAVC Long
XAVC-L QFHD-modus: 59.94P, ong. 115 minuten (met CEA-G160T)
XAVC-L HD 50-modus: 59.94P, ong. 155 minuten (met CEA-G80T)
XAVC-L HD 35-modus: 59.94P, ong. 210 minuten (met CEA-G80T)

Opmerking

De opname/afspeeltijd kan variëren afhankelijk van gebruikscondities en geheugeneigenschappen. De opname- en afspeeltijden
gelden voor een aaneengesloten opname als enkelvoudige clip. De werkelijke tijden kunnen korter zijn, afhankelijk van het aantal
opgenomen clips.

Aandrijving zwenken/kantelen

Minimale zwenksnelheid: 0,02°/s
Minimale kantelsnelheid: 0,02°/s
Maximale zwenksnelheid: 60°/s
Maximale kantelsnelheid: 60°/s
Zwenkbereik: −170° tot +170°
Kantelbereik: −30° tot +195°
Geluidscriteriumniveau: NC35 of lager
Voorkeuzeposities: 100

Cameradeel

Beeldsensor
35 mm volledig frame (35,6 × 23,8 mm), Exmor R CMOS-sensor

Aantal pixels
Ong. 12,9 megapixels (totaal pixels)
Ong. 10,3 megapixels (effectieve pixels)

Auto focus
Detectiemodus: fasedetectie/contrastdetectie

Interne ND-filters
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineair variabel ND-filter: 1/4ND t/m 1/128ND

ISO-gevoeligheid
ISO 800/12800 (Cine EI-modus, D55-lichtbron)

Objectiefbevestiging
E-bevestiging

Breedtegraad
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15+ diafragma's

Sluitertijd
64F t/m 1/8000 sec. (23.98P)

Sluiterhoek
5,6° t/m 360°, 2 t/m 64 beelden

Slow & Quick Motion
XAVC QFHD: 1 fps t/m 120 fps
XAVC HD: 1 fps t/m 240 fps
XAVC 4K: 1 fps t/m 60 fps
XAVC HD (S35): 1 fps t/m 120 fps

Witbalans
2000 K t/m 15000 K

Versterking
−3 dB t/m +30 dB (stappen van 1 dB)

Basisuiterlijk
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Audiodeel

Bemonsteringsfrequentie
48 kHz

Kwantisering
24-bit

Frequentiebereik
XLR-ingang MIC-modus: 20 Hz tot 20 kHz (±3 dB of minder)
XLR-ingang LINE-modus: 20 Hz tot 20 kHz (±3 dB of minder)

Dynamisch bereik
XLR-ingang MIC-modus: 80 dB (normaal)
XLR-ingang LINE-modus: 90 dB (normaal)

Vervorming
XLR-ingang MIC-modus: 0,08% of lager (−40 dBu ingangsniveau)
XLR-ingang LINE-modus: 0,08% of lager (+14 dBu ingangsniveau)

Ingangs-/uitgangssectie

Ingangen
DC IN

EIAJ compatibel, 19,5 V gelijkstroom

AUDIO IN

XLR type, 5-pins, vrouwelijk
LINE / MIC / MIC+48V omschakelbaar
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MIC: referentie −30 dBu t/m −80 dBu

GENLOCK IN

BNC-aansluiting, 1,0 Vp-p, 75 Ω

TC IN

BNC-aansluiting

Uitgangen
SDI OUT

BNC-aansluiting, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Aansluiting type A

Uitgang OPTICAL

Voldoet aan SFP+
* Het apparaat ondersteunt geen optische signaalinvoer.

Invoer-uitvoer
LAN-aansluiting

RJ-45, 1000BASE-T

OPTION-aansluiting

RJ-45-tally-in-uitgang

Mediumsleuvengedeelte

CFexpress Type A-/SD-kaartsleuf (2)

Meegeleverde accessoires

Netadapter (1)
Netsnoer (1)
Infraroodafstandsbediening (1)
Rompkap (1) (bevestigd aan het apparaat)
HDMI-kabelbevestigingsplaat (1)
Voordat u het apparaat gebruikt (1)
Garantieboekje (1)

Buitenmaten

Afmetingen zijn bij benadering
Eenheid: mm

Camerabehuizing
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Plafondbeugel
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Ontwerp en specificaties kunnen zonder kennisgeving worden gewijzigd.

5-041-957-73(1) Copyright 2022 Sony Corporation
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Merken

 is een merk van Sony Group Corporation.
XAVC en  zijn gedeponeerde merken van Sony Group Corporation.
De begrippen HDMI, HDMI High-Definition Multimedia Interface en het HDMI-logo zijn merken of geregistreerde
merken van HDMI Licensing Administrator, Inc. in de Verenigde Staten en andere landen.
Microsoft en Windows zijn merken of gedeponeerde merken van de Microsoft Corporation in de Verenigde Staten
en/of andere landen.
Mac en macOS zijn gedeponeerde merken van Apple Inc. in de V.S. en andere landen.
Het logo "Catalyst Browse" is een merk of gedeponeerd merk van Sony Group Corporation.
IOS is een merk of gedeponeerd merk van Cisco in de VS en andere landen en wordt gebruikt onder licentie.
iPadOS, Safari, iPad zijn geregistreerde merken van Apple Inc. in de VS en andere landen en regio's.
Android en Google Chrome zijn merken of gedeponeerde merken van Google LLC.
Wi-Fi is een gedeponeerd merk van Wi-Fi Alliance.
Het SDXC-logo is een merk van SD-3C, LLC.
CFexpress en het CFexpress Type A-logo zijn merken van de CompactFlash Association.
NewTek™ en NDI® zijn merken of gedeponeerde merken van NewTek, Inc.
JavaScript is een gedeponeerd merk van Oracle en/of diens gelieerde bedrijven.
Intel, het Intel-logo en Intel Core zijn merken van Intel Corporation of diens gelieerde bedrijven.
QR Code is een merk van Denso Wave Inc.
Alle andere bedrijfsnamen en productnamen zijn gedeponeerde merken of merken van de betreffende eigenaren.
Onderdelen die merk zijn, worden niet gekenmerkt door ™ of ®-symbolen in dit document.
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